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MINISTER                         

                                     

MESSAGE 

I applaud the Department of Forest and Park Services for coming up with the Forest 
and Nature Conservation Code of Best Management Practices of Bhutan which is an 
updated version of the erstwhile Forest Management Code of Bhutan, 2004. The erst-
while code only covered sustainable management of Forest Management Units. How-
ever, with the shift of forest management paradigm to include other important aspects 
such as climate change, wetland and watershed management, biodiversity conserva-
tion & monitoring, agroforestry, payment for ecosystem services etc., a more com-
prehensive guideline has become imperative. The revised Code broadens the scope of 

applicability covering wide range of contemporary forestry practices providing detailed guidelines on the 
technical aspects of forest resources management and biodiversity conservation.  

The revision of the Code is timely and will play a significant role towards sustainable management of our 
forest resources especially in light of the global climate change and its anticipated impacts on our fragile 
mountain ecosystems. The Code will also take into account the application of advanced technologies in 
forest management and biodiversity conservation and will provide strong emphasis on monitoring and eval-
uation of forest and forestry programs which has always been our weakness. 

The revised Code will also become handy to our colleagues in the field as it will serve as the single source 
of scientific guideline for all forestry management regimes in the country. 

With the publication of this Code, Bhutan joins many countries who manage their forest through such tech-
nical guidelines. Our country now establishes a robust technical guideline for management of all forest 
resources in the country and I am confident that it will fulfill our aspiration of bringing all forest resources 
under sustainable management fulfilling the objectives of our National Forest Policy and the Constitutional 
mandate of maintaining 60% of forest cover all times to come. 

I would like to commend the efforts and hard work of our colleagues in the Department of Forest and Park 
Services, particularly those who were involved in the revision of this Code and I hope this code will be 
useful to wide range of stakeholders outside of the Department as well. 

Tashi Delek! 

 

 

 

Yeshi Penjor 
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 SECRETARY 

MESSAGE 

I commend the Department of Forest and Park Services in bringing out the revised 
Forest and Nature Conservation Code of Best Management Practices of Bhutan 
which presents a comprehensive technical guideline for sustainable management of 
forest resources and biodiversity conservation in the country.  

The intricate combination of several programs and activities on sustainable forest 
management and biodiversity conservation is fundamental to sustainable develop-
ment, from their vital role as climate regulator, carbon sequestration and the vital 
ecosystem services they provide. Sustainable management of these forest resources 

are therefore essential if these benefits for the environment and societies are to be maintained for future 
generations. Such long-term feats can be achieved only if we are able to manage the huge forest base re-
sources holistically.  

Such holistic achievement can only be possible through a science based technical guideline - the Code. Its 
implementation will also ensure that the forests in Bhutan are managed through the integration of good 
science, research, technology and decades of forest management experiences.  

The code also provides consistent and transparent approach to planning and implementation of sustainable 
forest management plans, conservation plans and activities at all levels and across all other cross-cutting 
management regimes. The Code now provides the deep nexus in making appropriate science-based deci-
sions on several forestry and conservation issues. 

I would like to congratulate the Department and in particular the technical working group members for 
coming up with this code which is a milestone in our effort towards sustainable forest management and 
biodiversity conservation.  

I urge all relevant stakeholders, government and non-government, besides the colleagues of the Department 
of Forest and Park Services to actively use and implement the Code in managing our forest resources for 
the benefit of present and future generations. 

 

Tashi Delek! 

 

 

Rinzin Dorji 
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DIRECTOR                                               

 

FOREWORD 

Forests have always played a key role in the livelihood of Bhutanese and is intrinsi-
cally intertwined with the social, culture and tradition of our country. In view of its 
pivotal role not only on socio economic development but also on climate regulatory 
function through several means and vital ecosystem services, sustainable forest re-
sources management has always played a key role in sustaining our natural forest 
resources. Bhutan is one of the few countries in the world that enshrines forest and 
environmental conservation aspects in its Constitution. Article 5 of the Constitution 
of the Kingdom of Bhutan reflects commitment to ensure that, in order to conserve 

the country’s natural resources and to prevent degradation of the ecosystem, a minimum of sixty percent of 
Bhutan’s total land shall be maintained under forest cover for all time. Bhutan also committed to remain 

carbon neutral at the 15th Conference of Parties to the United Nations Framework Convention on Climate 
Change (UNFCCC) in 2009 in Copenhagen, Denmark. In addition, the Intended Nationally Determined 
Contribution (INDC) submitted in September 2015 towards finalization of Paris Agreement further re-iter-
ated Bhutan’s pledge to remain carbon neutral.Today with over 71% of the total land of Bhutan under forest 
cover (2,717,161 ha), forests form an important and indispensable national asset sequestering around 8.5 
million tonnes of carbon,, generating continuous water flow to sustain our hydro power systems, providing 
timber and firewood resources to Bhutanese citizens etc.. Out of the total forest area (2,717,161 ha) about 
33.29% (904,423.78 ha) fallwithin thee Protect Area Systems (National Parks, Wildlife Sanctuaries and 
Strict Nature Reserve) and about 19.96% (542,346.32 ha) is managed as Forest Management Units, Com-
munity Forests and Local Forest Management Areas.  

Therefore, in order to fulfill our international commitment to remain carbon neutral and constitutional man-
date of maintaining 60% forest cover for all times to come besides harnessing other benefits such as social, 
cultural, economic and ecosystem services, it is imperative that the Department possesses a Code outlining 
science based management of the overall forests and biodiversity resources which will enhance the produc-
tive and ecological functions of our forest ecosystems. This Code has been developed through integration 
of good science, research, technology and decades of forest management experiences.It gives me a great 
pleasure in congratulating the entire Technical Working Group involved in the preparation of this Code. 
This Code will definitely strengthen the sustainable forest resources management and biodiversity conser-
vation practices in Bhutan for eons to benefit the present and future generations.  

Tashi Delek!  

 

 

 

Lobzang Dorji 
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INTRODUCTION 

Volume III of the Forest and Nature Conservation of Bhutan Code of Best Management Practices of Bhutan  
(hereinafter referred to as the Code) provides technical guidance on the preparation of forest management 
plans for Forest Management Units (FMU), Local Forests Management Areas (LFMA), Community Forests 
(CF), and Private forests. The Forest Management Code of Bhutan (FMCB) 2004 included only the FMU 
Planning and implementation guidelines. In order to include other sustainable management aspects, and to 
make the Code more comprehensive, Volume III of the Code has been updated and includes the following 
chapters. 

Chapter 1: Forest Management Unit 

Chapter 2: Community Forest Management 

Chapter 3: Local Forest Management Area 

Chapter 4: Private Forest Management 

The Department identifies potential forest production areas based on the forest potential resources assess-
ment carried out as per the prescriptions defined in Volume II of this Code. This volume, therefore, includes 
guidelines on the purpose, principles and process of preparation, approval and implementation of forest 
management plans by field offices and other authorized implementing agencies.  

While the Code shall guide the forest managers in the preparation and implementation of forest management 
plan for state reserved forest (SRF), it shall also provide or suggest appropriate management practices for 
private forest, if necessary or as and when private owenrs wish to seek technical guidance for scientific 
management of their private forest.  
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ACRONYM 

AAC Annual Allowable Cut 

A  Adjustment period (the period during which the difference between normal and 
actual GS is adjusted) 

AAC Annual allowable cut 

AGB Above Ground Biomass 

BA Basal Area 

BGB Below Ground Biomass 

CF Community Forest/Community Forestry 

CFMG Community Forest Management Group 

CFMP Community Forest Management Plan 

CFO Chief Forestry Officer 

cft Cubic foot/feet 

CV Coefficient of variance 

dbh Diameter at Breast Height 

DEM Digital Elevation Model  

DFO Divisional Forest Offices 

DoFPS Department of Forests and Park Services 

DT Dzongkhag Tshogdu 

EA Environmental assessment  

EFS Economic Feasibility Study 

FMCB Forest Management Code of Bhutan 

FMP  Forest Management Plan 

FMU Forest Management Unit 

FNCA Forest and Nature Conservation Act, 1995 

FNCRR Forest and Nature Conservation Rules & Regulations, 2017 
FRA forest resources assessment  

FRMD Forest Resources Management Division 

FYP Five Year Plan 

GIS Geographic Information System 

GPS Global Positioning System 

GS Growing stock 

GSa Present (actual) GS 

GSr Desired (normal) GS 

GT Geog Tshogde 

ha Hectare 

I Increment of the entire forest  

IEE Initial Environmental Examination  

IPCC Intergovernmental Panel on Climate Change  

LFMP Local Forest Management Plan 

LG Local Government 

LULC Land Use and Land Cover  

M3 Cubic meter 

MA&D Market Analysis and Development 

MAI Mean annual increment 

MoAF Ministry of Agriculture and Forests 
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NB Biodiversity Protection  

NRDCL Natural Resources Development Corporation Limited 

Nu Ngultrum 

NWC Wildlife Conservation  

NWFP Non-Wood Forest Produce 

NWP Wildlife Protection  

OP Operational Plan 

PFMP Participatory Forest Management Project 

PRA Participatory Rural Appraisal 

R Rotation (or felling cycle) 

RFI Reconnaissance Forest Inventory  

RRA Rapid Rural Assessment 

SES The Socio-Economic Study  

SFM sustainable forest management  

SocL Social (Local Use Only) 

SocRS Social (Religious Site Protection) 

SRFL State Reserves Forest land 

TMB Tree marking book  

UWICER Ugyen Wangchuck Institute for Conservation and Environmental Research  
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1. Forest Management Units  

1.1. Management Context 

1.1.1. Background 

Forest is seen as a major component of the socio-economic development of Bhutan and a means to alleviate 
rural livelihood.  The Thrimzhung Chenmo, 1953 provided for open access to use of forest resources, which 
led to unregulated extraction of timber. A need for scientific management of forest was increasingly realized 
and the first working plan division was established in Samtse before the advent of the first five-year plan. 
The first working plans for two areas viz., Manas and Gaylegphug were approved by the Government and 
implemented as working schemes in 1964-65 (Seltzer 1991).  

The National Forest Policy 1974 provided the foundation for scientific management of forests which was 
reiterated in the Forest and Nature Conservation Act 1995, which further emphasized to bring all forests 
under scientific management. As a result, more areas were managed under scientific management through 
the establishment of Forest Management Units (FMU) and subsequently, Forest Management Code of Bhu-
tan (FMCB) was developed in 2004 to guide and standardize the planning and implementation of scientific 
management of FMUs. 

The Code provides an updated guidance and prescriptions for the preparation and implementation of man-
agement plan for FMU and derive the legal basis from the forest legislations. Further, the Code also provides 
guidance on the preparation of an annual operational plan (OP) for the FMU. The OP shall be prepared for 
all FMUs to ensure that the operation is in accordance with the prescriptions of the Forest Management Plan 
(FMP) or any other revisions hereafter. 

1.1.2. General Principles  

FMP shall be prepared following some of the important principles which are based on national policies, and 
best sustainable forest management practices. 

Objective-led 

FMU management plans should be objective-led and inclusive. Activities (e.g. timber harvesting, grazing 
management, NWFP collection, watershed management, management of protection, conservation areas, 
etc.,) need to be identified to achieve specified management objectives. 

Identifying and stating the management objectives shall make the FMP more logical and science based. 
Objective setting and agreement on objectives should be one of the first planning steps which can be done 
in a participatory manner with the FMU-level management committee. 

Inclusive 

A management plan for an FMU needs to combine national with locally derived (FMU specific) forest 
management objectives which sometimes gives rise to conflicting objectives. Often it requires compromise 
or trade-off between such conflicting objectives. Such trade-offs, if any, should be decided during the stake-
holder consultation meeting. 

Adaptive  

Ideally, a FMP implementation needs to be carried out as per prescriptions. However, in the event of un-
foreseen natural events such as pest and disease outbreak, forest fire disasters, etc., the FMP needs to be 
amended with suitable prescription for that particular forest stand/area. 

Time-bound 

FMU plans should be time-bound. The current system in Bhutan is to prepare science based FMP for a 10-
year period. There shall be a mid-term evaluation (reviewing the level to which forest management objec-
tives have been achieved) during the fifth year and during which alterations can be made to the plan. A 
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similar evaluation shall take place during the last quarter of the ninth year, to review the level of achievement 
of management objectives. Results of this final evaluation shall be incorporated into the next 10-year plan. 

1.2. Roles and Responsibilities  

The Divisional Forest Offices (DFO) shall prepare the management plan with technical support from Forests 
Resources Management Division (FRMD). The FMP is a holistic science based sustainable forest manage-
ment plan prepared in consultation with the Local Government (LG) and other relevant stakeholders. The 
implementation of FMU activities should be based on annual OP approved by the Department of Forests 
and Park Services (DoFPS) (hereinafter referred to as the Department). The Natural Resources Development 
Corporation Limited (NRDCL) or any other authorized agency shall ensure that the activities are imple-
mented as per the prescription of the OP and the management plan. Some of the most important roles of the 
key actors in the management planning and implementation process are suggested in Table 1.1. 

Table 1.1 Roles and responsibilities 

Offices Roles and Responsibilities 

FRMD 

 

• Conduct Forest Resources Potential Assessment (FRPA) 

• Provide technical support for the conduct of Reconnaissance Survey (RS).  

• Provide technical support for the conduct of resource inventory. 

• Provide technical support for forest function mapping. 

• Conduct cold and hot check during forest resource inventory 

• Review the FMP prepared by the field offices and process for approval from the 
Ministry. 

• Process for Environmental Clearance (EC) from National Environment Commis-
sion Secretariat (NECS). 

• Review and approve the operational plan (OP) prepared by the field offices. 

• Monitor and evaluate the implementation of FMU activities. 

DFO • In coordination with FRMD, identify new potential FMU areas recommended by 
the FRPA 2013.  

• Prepare the FMP following the steps detailed out in the Code. 

• Coordinate the formation of and participate in FMU-level management committee 
meetings and discussions (CFO acts a chairman of the committee). 

• Prepare and ensure the implementation OP. 

• Regulate and monitor the implementation of the FMPs. 

• Report on progress in implementing activities within OP (annually through an 
FMU annual monitoring report). 

Authorised 
agency 

• Participate in preparation of FMP and OP. 

• Implement the FMP and OP activities. 

• Fund the FMU implementation activities. 

• Participate in FMU-level forest management committee meetings.  

• Carry out afforestation and reforestation. 

LG • Participate in the planning and implementation of social and extension-oriented 
activities.  

• Participate in FMU-level forest management committee meetings as representa-
tives of local stakeholders. 
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The DFO shall ensure that the approved plan is implemented effectively through establishment of FMU-
level Forest Management Committee. The objectives, legal basis, membership, meeting cycles and terms of 
reference of the committee are provided in Table 1.2. 

Table 1.2 Composition and ToR of FMU-level Forest Management Committee 

FMU-Level Forest Management Committee 

Objective(s) Ensure effective participation of stakeholders in FMU planning and imple-
mentation 

Basis FNCRR 2017 

Forests and Nature Conservation Code of Best Management Practices of 
Bhutan 

FMP 

Membership Members 

1. CFO (Chair), DFO 
2. Regional Manager, NRDCL or any other Authorized Agency 
3. Unit Incharge, FMU 
4. Production Incharge, NRDCL or any other Authorized Agency 
5. Gup of concerned Gewogs  

Meeting cycle During preparation of FMP: Up to four meetings 

Thereafter: minimum once a year (at discretion of chair) 

Terms of reference FMP preparation 

• Consult with stakeholders & represent their interests during planning  
• Discuss & agree management objectives  
• Review & endorse the draft FMP 

Operational planning & implementation 

• Represent interests of stakeholders during operational planning  
• Review achievements of previous year, advise & act on any issues 

identified in FMU annual report 
• Endorse activities, priorities & funding arrangements within the draft 

OP before submission to FRMD  
• Hold additional meetings as required in response to specific issues 

arising from FMP & OP implementation 
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1.3. Forest Management Planning Process 

The FRPA identifies potential area for production forest. Thereafter, the creation of FMU involves a series 
of processes from reconnaissance survey to the implementation of the management plan. The overall frame-
work is depicted in Figure 1.1 and described briefly in Table 1.3. 

 

Figure 1.1 FMU Planning Process
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1.4. Reconnaissance survey 

Reconnaissance survey is a preliminary survey conducted in the area proposed for creation of FMU. The 
reconnaissance survey shall examine the area with respect to forest types, wildlife, NWFPs, general topog-
raphy, road connectivity and accessibility, cultural significance, past and current management history, socio-
economic status of the people living within the area, climate, weather, etc. The reconnaissance survey is a 
first step in the FMU planning process and is a more detailed assessment of a particular forest area that has 
been defined as a potential FMU by the FRPA.  

1.4.1. Objective  

To provide the decision makers of the Department and authorized agency with all the social, environmental 
and economic information that is required to decide whether or not an FMU should be operationalized and 
managed on a commercial basis. 

1.4.2. Preparation of Reconnaissance Survey 

Before the actual reconnaissance survey is carried out in the field, a thorough preparation of the survey in 
the office is required. 

1.4.2.1 Identification of FMU and Verification of Boundary 

The FRPA has identified, on a macroplanning level, areas which might be suitable to be managed as FMU 
on a commercial basis. This preliminary identification was based on the following criteria: 

• Topography (slope); 
• Forest condition (type and density); and  
• Exclude already protected and/or managed areas. 

At this stage, the boundaries of the proposed FMU should be checked whether they are practical and logical. 
Once, the boundary has been identified, it has to be marked on a topographic map 1:50,000 and set of 
photocopies should be prepared (at least 10). 

However, before the actual work starts, it needs to be ensured, that the proposed FMU is not located in a 
protected or otherwise restricted area, Community forest (CF), or included under some other form of man-
agement regimes. 

1.4.2.2 Collection of Information and Preparation for Field Work 

All available information on forest cover and land use types should be collected. The objective is to prepare 
a base map indicating actual forest/non-forest boundary, preliminary forest types and potential operable and 
accessible areas. For this purpose, the following working documents are required: 

1. Topographic map with 40 m contour lines at a scale 1:50,000 (including FMU boundary); 
2. Land Use and Land Cover (LULC) map at a scale 1:50,000; 
3. Satellite image (if available); and 
4. Aerial photos (if available). 

The preparation of the preliminary forest type map should be done based on the latest LULC maps. Experi-
ences made during field truthing exercises in forest management planning have shown that LULC maps are 
quite accurate as far as forest/non-forest boundaries are concerned. Forest land-use, however, has been often 
misinterpreted by LULC. Therefore, the forest/non-forest boundary should be determined based on LULC 
working map (if available, verify with satellite imagery or aerial photographs), the forest types, however, 
should be derived from the forest type maps. 

(GIS) A slope map at a scale 1:50,000 with 90 m contour intervals based on the Digital Elevation Model 
data (or better contour maps with smaller intervals if available), should be prepared with the following slope 
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classes marked on: (i) < 46.63 % (25°), (ii) 46.63 % (25°) - 70.02 (35 °), (iii) 70.02 % (35 °) - 100 % (45 °) 
, (iv) > 100 % (45 °).  

Areas with slopes above 100 % (45 °) should be considered as inoperable1. Overlay the inoperable area from 
the slope map to the preliminary forest type map. This shall be the base map for the reconnaissance survey. 
This map should be available at a scale of 1:25,000 and 1:50,000. 

1.4.3. Components of the Reconnaissance Survey  

Before the actual Reconnaissance Survey takes place, a Pre-RS Field Check must be carried out to check 
whether the area is suitable for commercial forest management. This step is very important. A short field 
visit may provide a quite different view of the proposed FMU and should reveal any obvious errors. Infor-
mation available may have been superseded or may be wrong. For example, an area may already have been 
logged. Local people should be informed at that stage, that the Government has the intention to check 
whether this area is suitable to be opened as FMU on a commercial basis. They should also be informed 
about the subsequent steps of the reconnaissance survey, in particular on the Reconnaissance Forest Inven-
tory (RFI).  During the Pre-RS Field Check, an experienced forester should assess: 

• FMU boundaries; 
• current road access - condition, suitable for heavy trucks, etc.;  
• forest types, including degraded areas; 
• estimate of operable and In-operable areas (basically checking and perhaps revising the estimate from 

the slope map); 
• road construction feasibility; 
• any possible environmental risk; 
• current forest use; and, 
• field conditions, transportation, food and accommodation for the reconnaissance survey crews. 

This field check should take approximately two to three days. Based on its result, which has to be summa-
rized in the form on Pre-RS Field Check (Table 1.4), the CFO should decide whether or not a Reconnais-
sance Survey shall be carried out. 

 

 

 

 

 

 

 

 

 

 

                                                      

 

1 According to § 14 a (iii) of the Forest and Nature Conservation Act (1995) "no permits shall be issued to fell and to take any timber 
where the slope is greater than 45 degrees (100%) unless authorized under an approved management plan or by the Head of the 
Department.". 
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Table 1.4 Pre-RS Field Check Form 

                                      

Reconnaissance  

Survey   

       Pre-RS Field Check           

                           

                           

Name of 
FMU:                Area:        ha         

                   Gewogs:                      

                                                    

Confirmation that the FMU boundaries as defined are reasonable: 

   

 

 

 

Is the forest type classification map updated? (including degraded forests)? 

 

 

 

 

 

IIs the mapping of operable and non-operable areas reasonable? If not, suggest changes 

   

 

 

 

 

 Describe significant environmental risks: 
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Describe current forest uses (legal, illegal, local) and concerns with respect to forest use: 

 

 

 

 

 

For the field work, describe general conditions (food and accommodation, transport options, camp 
sites 

 

 

 

 

 

 

 

Other observations, personal opinion/recommendation: 

 

 

 

 

 

 

Date:                                          Completed by:  

                                                   Name and Rank 
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If this check comes to a positive result, the actual reconnaissance survey is carried out. This consists of the 
following four components: 

• Socio-Economic Study (SES) 
• Reconnaissance Forest Inventory (RFI) 
• Initial Environmental Examination (IEE) 
• Economic Feasibility Study (EFS)  

The results of the individual components have to be compiled into a Reconnaissance Survey Report and 
submitted to the head of the Department for decision making.  

Figure 1.2 shows the process of conducting a Reconnaissance Survey.  

 

 

Figure 1.2 Process of conducting a Reconnaissance Survey
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1.4.3.1 Socio-Economic Study (SES) 

The SES is based on a Rapid Rural Assessment (RRA) as well as key social data. Information on local 
resource use should also be collected. The most important aspect, however, is to identify whether there is 
any social opposition, perception or constraint which might affect the management of FMU. 

1.4.3.1.1 Objective 

The objective of the SES is to: 

• identify whether there is any social opposition, perception or constraint which might affect com-
mercial forest management; 

• collect key social data; 
• provide information on local resource use and potential forest management restrictions; andcollect 

information on flora and fauna for the IEE.  

1.4.3.1.2 Data Collection and Source of Information 

The information required for the SES are provided through the RRA and the RNR Census data.  

• Rapid Rural Assessment 

The RRA, in this context, is an informal meeting with the villagers and local people living in the concerned 
FMU area. It should be conducted, whenever possible, during the course of the Pre-RS Field Check. It is of 
importance, that the RRA is headed by a forester who has experience in participatory approaches and in the 
implementation of village meetings. During the RRA the following topics should be dealt with. 

i. Information on the intention to open FMU: The objective of the RRA is, first of all, to inform 
the local people on the intention of the Government to open a FMU in their area. They have to 
be informed at this early stage about the consequences and possible effects (positive and nega-
tive) of forest management on their livelihood and on the environment. 

ii. Informal discussions to identify objections and constraints: During informal discussions (at-
tention should be paid that male and female are equally addressed) the local people should be 
informed of the intended commercial forest management. It is the objective of these meetings to 
identify potential management constraints.  
If the people are actively involved from the very beginning in the whole FMU establishment 
process, future conflicts can be avoided. If during the course of this discussion, strong opposition 
against the establishment of the FMU comes up; this needs to be recorded and convince people. 

iii. Analysis of problems of local people: The local people should be encouraged to discuss openly 
about their problems and should try to rank them. Special attention should be paid to those prob-
lems that have a potential interlinkage with forest and land use (e.g. accessibility, forest and 
agricultural products, water availability, crop damage by wildlife, etc.).  

iv. Assessment of the expectations of the local people and possible changes in livelihood and 
land use: It is of importance, that the expectations of the local people that are linked with future 
commercial forest management (i.e. road access, job opportunities, etc.,) are discussed objec-
tively. Exaggerated or unrealistic expectations should not be discussed at this stage in order to 
avoid future disappointment and resulting conflicts. 

v. Assessment of present forest resource use: For the economic assessment, it is of importance 
to know the approximate operable area for commercial operation. Forest areas, which are inten-
sively used by the local population should be set aside for their local use only (Section 1.9). A 
rough estimate of the area is sufficient at this stage. Furthermore, information should be collected 
on types and quantities of forest products, grazing rights (tsamdo) and other forest and land uses. 

vi. Information on wildlife and environmental issues: For the IEE, information should be col-
lected on the occurrence of protected or rare wildlife species and their respective habitats, rare 
flora and ecosystems, problems with erosion or water availability and quality, etc. 
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vii. SES-Format: The Socio-Economic Study should contain a brief analysis of the socio-economic 
conditions within the potential FMU area. It consists of a standardized cover page, where the 
most essential information is summarized and of an informal and unformatted report, which 
should not exceed two pages. The SES report should be prepared by the officer in charge of the 
RRA and has to be submitted to the CFO for onward submission to FRMD. 

 
• RNR Census data. 

The analysis of Dzongkhag and other statistics should be done before the RRA is conducted, in order to 
make the forester familiar with the basic socio-economic information on the potential FMU area. The fol-
lowing data should be collected from Gewog/ Dzongkhag/ National Statistical Bureau (NSB): 

• number of villages and settlements; 
• number of households and population; 
• figures on livestock (number of cattle, horses, mules, goats and sheep); and, 
• information on grazing rights (tsamdos). 

Information on forest production, logging activities or afforestation should be compiled. Furthermore, the 
demand of the local wood-based industry in the vicinity of the potential FMU should be assessed. 

1.4.3.2 Reconnaissance Forest Inventory (RFI)  

The Reconnaissance Forest Inventory (RFI) is essential step in assessment of the suitability of the proposed 
area for management as FMU. The RFI is expected to provide important information for the economic 
analysis of the proposed FMU and provide necessary information to decide whether investment is worth-
while to open a particular potential forest area as an FMU on a commercial basis. 

1.4.3.2.1 Objectives  

In general, the objective of RFI is to generate preliminary information such as  

• estimate of average gross volume per diameter class and species/species group  
• estimate of exploitable commercial timber volume and potential AAC; and,  
• observations on wildlife, minor forest products, human impacts and biodiversity  

Specifically, estimates of following information shall be handy for planning and investment for establish-
ment of FMUs.  

i. Number of trees per ha  
ii. Basal area per ha  
iii. Growing stock  
iv. Coefficient of variation  
v. Margin of error  
vi. Standard error  
vii. Sample variance 

1.4.3.2.2 Sampling Design  

There are various sampling designs suitable for RFI. Unless there is intention to maintain consistency of 
sampling design with National Forest Inventory and Forest Management Inventory, which uses the system-
atic sampling grid, simple random sampling or stratified random sampling can be adopted. Based on the 
number of sample size required for the assessment, generate sampling points using either SRS, SS or any 
other sampling design method.  

1.4.3.2.3 Sample Size  

The minimum sample size recommended for RFI is 30 samples. However, based on availability of the re-
sources and time, the sample size can be increased. For large forest area encompassing different forest types, 
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it is recommended to lay 30 samples for each forest type to generate reliable estimate of average tree pa-
rameters as well as coefficient of variation, which may be useful for determining final sample size.  In 
general, the larger the sample size, smaller the variance of mean. However, for RFI, sampling error of about 
20% at 95% confidence interval is assumed to provide reasonable estimate. 

1.4.3.2.4 Sampling Plot/Point sampling  

There are two basic methods of sampling commonly used in forestry, fixed area plots and point sampling. 
Fixed area plots are simply a fixed size plots of rectangular, square, circular or any appropriate shape that is 
selected within which all trees are measured. In case of point sampling, the area is not fixed and plot radius 
is determined by the diameter/basal area of the trees.  

Both fixed area plot and point sampling are statistically valid method. The inventory estimates generated 
from point sampling are comparable and as accurate as estimates generated with fixed area plot (Lund, 1981; 
Druszcz et. al., 2015; Mulyana, Rohman & Purwanto, 2018). This method is used for resource inventories 
in many countries such as Finland (Kangas et al., 2006), USA (Lund, 1981; Druszcz et. al., 2015), Bhutan 
(FRMD, 2004), Indonesia (Mulyana et al., 2018; Jinguiji, 2014) and other countries. In point sampling, each 
sample tree represents a fixed basal area per unit area and is used for the rapid assessment of resources. 

1.4.3.2.5 Data Collection  

Point Sampling  

Point sampling estimates the stand parameters from sample plots with imaginary plot boundaries (Laar & 
Akea, 2007) and it is suitable rapid assessment of area (Lund, 1981; Bellhouse, 1981) and other stand pa-
rameters (Lund, 1981; Laar & Akea, 2007; UNFCCC, 2015). The commonly used instruments for point 
sampling are wedge prism, relascope, angle gauge (Lund, 1981; Laar & Akea, 2007; UNFCCC, 2015; 
Kohl& Magnussen, 2016).  The basal area factor or critical angle factor is used to determine whether the 
tree is “IN” or “OUT”.  The inventory field method for data collection using wedge prism is described 
below:  

Steps of Point Sampling using wedge prism  

• Select the sampling locations as determined in the sampling design by random/systematic sampling  
• Stand at the plot centre location and establish the plots  
• Collect plot information and complete the Form 1.1 (Form F1/7) based on instruction provided in 

table Table 1.5. 
• Correct holding of the wedge prism is important. It should be held straight and shall not be tilted 
• Establish a reference direction from where to start a sweep (typically the north). A flag can be fixed 

on a distant tree in this direction so as to make this direction clearly visible and to avoid overshooting 
the sweep beyond 360 degrees. 

• Wedge prisms bend reflecting light rays causing an image to be displaced along a desired angle by 
diffraction of light. When viewing trees through a prism, a section of the tree appears to be offset. 
If the offset section of the tree overlaps the tree stem, then the tree qualifies to be tallied. With no 
overlap, the tree is "out". Borderline trees are those in which the edge of the offset section exactly 
meets the edge of the tree stem is tallied as half. Refer Figure 1.3 to decide whether tree is to select 
or deselect.  
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For all counted or selected trees, identify the species, measure the diameter and record the following instruc-
tion provided in  Table 1.6 record in Form 1.2. Also summarize the number of trees recorded in plot in 
summary sheet.  

• If a tree cannot be viewed by virtue of being hidden behind another tree, the observer should move 
sideways in such a way that the distance from the observation point to the tree being sighted remains 
constant. If that is not possible, following methods may be adopted  

i. Look for a tree of same or smaller diameter within same distance from the observation or 
further away and view through the prism, if that tree is “in”, the tree in question shall be 

tallied  
ii. Otherwise use the limiting distance method to determine whether the tree isn “in’ or “out” 

(UNFCCC, 2015). Measure the distance between observation point and dbh of tree and then 
apply the limiting distance formula 

 
 

𝐷𝑙 =  
0.5 𝑋 𝑑𝑏ℎ

√𝐵𝐴𝐹
 

(1) 

 
Where,  
Dl is limiting distance, BAF is basal area factor 
If the distance between tree and observation point is same or smaller than limiting distance, the tree 
shall be tallied otherwise not.  

• The basal area is obtained by multiplication of number of ‘in’ trees by constant factor (Basal Area 

Factor of prism) which is usually inscribed on the prism itself.  

 

 

 

 

 

 

Figure 1.3 Counting trees using wedge prism 
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Table 1.5: Instruction of collection of plot information 

SN Data Item Definition/Description Instructions 

1 District 
Name  

Name of the District in which proposed 
LFM is located  

Type in the field form  

2 Name of 
the Geog 

Name of the geog for which is LFM is 
proposed  

Type in the field form  

3 FMU 
Name 

Refers to the proposed name of the FMU.  Type in the field form  

4 Plot No. This is the unique identification number 
given to RFI Inventory Plots  

Type in the field form   

5 Date Refers to date of day of data collection  Record the date  

6 Time Refers to time at the time of data collec-
tion 

Record the time  

7 Altitude Refers to the elevation from mean sea 
level at which the plot is located. It is 
measured in meter. 

Use the GPS to obtain altitude reading. 
Record altitude in meter, as it appears 
on GPS. 

8 Accessi-
bility  

Refers to if the Inventory Plot is accessi-
ble or not. 

Select ‘Yes’ if the Plot was accessible, 

‘No’ if it was not accessible. 

9 Land use  Refers to class of land cover and land use. 
Land cover and land type and definition is 
provided in BOX 1.3. 

 

Use the technical definition provided in 
Error! Reference source not found. 
for identifying the Land cover class and 
select the appropriate land use/ Land 
cover 

10 Forest 
type 

Refers to Forest type as classified in the 
Flora of Bhutan. The characteristic fea-
tures of different forest types are provided 
in Error! Reference source not found.. 

Refer Error! Reference source not 
found. to classify the forest type and 
type forest type code in the field form. 
Select the appropriate forest type.  

11 Slope up Slope Up describes the gradient, inclina-
tion of the up-hill slope from the Plot Cen-
ter (PC). 

From the plot center, measure the slope 
up using clinometer and record in de-
grees 

12 Slope 
down 

Slope down describes the gradient, incli-
nation of the down-hill slope from the PC. 

From the plot center, measure the slope 
down using clinometer and record in 
degrees 

13 Manage-
ment type   

Refers to suitability of plot for different 
management functions.  
1. Production  
2. Protection  
3. Conservation  

Based on the slope of the plot and ac-
cessibility, plot location such as (ripar-
ian, presence absence of key wildlife 
species) 
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Form 1.1 Plot information 

 

 

 

1. District Name:  
 
 

2. Geog Name:  
 

3. Local Forest Management Name:   

 

4. Plot No:  

 

5. Date                                                 6. Time 

 

1. Altitude (m)    8. Accessibility:  a) Yes                  b) No    
2. Land use:  

               i. Forest land   ii. Cropland                       iii. Grassland  

               iv. Wetland               v. Settlement                    vi. Other land  

 

3. Forest Type: 

 i. Subtropical Forest       ii. Warm Broadleaf Forest                iii. Chirpine Forest 

 iv. Cool Broadleaf Forest      v. Evergreen Oak Forest                vi. Blue Pine Forest   

 vii. Spruce Forest                    viii. Hemlock forest         ix. Fir forest 

 x. Juniper-Rhododendron Scrub                           xi. Dry Alpine Scrub  

   

4. Slope (Degrees): i. Slope Up                             ii. Slope Down  

  

5. Forest Management Function   
i. Production                ii.   Protection                  iii.   Conservation                    

Remarks:     

6. ................................................................................................................................... 

Table 1.6: Instruction collection of tree data 

Department of Forests and Park Services 
Forest Resources Management Division 

Plot Information (Form I) 

F1/7 

/ 

 

 

  

 

 

 

 

      /          / 
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SN Parameters Description/ Definition Instructions or how to fill in Data Dic-
tionary 

1 Plot No This is the unique plot number for in-
ventory data collection  

Type the plot number   

2 Date  Date of data collection   

3 Time  Time of data collection   

4 Scientific 
Name 

Refers to scientific or botanical name 
which conforms to the International 
Code of Botanical Nomenclature 
(ICBN) 

Type/record the appropriate tree name  

5 Common 
Name/Local 
Name 

“Common name” herein is referred to 

the commonly used name of a tree in 
English. 

Type/record the appropriate tree name if 
know. Can be English, dzongkhag or any 
other language.  
 

6 DBH Refers to Diameter measured at Breast 
Height. 

Measure the DBH and record accord-
ingly. 

7 Tally   Refers to whether the tree is “in” or 

“borderline”  
Fill as “I” for in trees and “B” for border-

line trees 

7 Condition of 
Tree 

Refers to state of the tree, whether live 
or dead.  

Observe and record the condition of tree  

8 Summary 
sheet  

Summary of tree count in each plot by 
DBH class  

Count of number of trees in each plot by 
diameter class and record in the appropri-
ate diameter class. For example, if there 
are three trees of Abies densa diameter 
10, 25 and 50. Then record one each in 
diameter class 10-20, 20-30 and 50-60.  
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Form 1.2 Tree data collection form 

Department of Forests and Park Services 
Forest Resources Management Division 

Tree Data Collection Form-2  
 

 

1. Plot No  

 

2. Date     4. Time                       hrs 

 

Tree Data Form (≥10 cm DBH) 

SN Scientific Name Local Name  DBH 
(cm) 

Tally  
(I /B)  

Condition  

     Live Dead 

       

       

       

       

       

       

 Summary of live trees in a plot: (Sum the trees of each species in a plot)   
 

SN Spe-
cies  

DBH CLASS (total count of each species in each dbh class) 

  10-20 20-
30 

30-
40 

40-
50 

50-
60 

60-
70 

70-
80 

80-
90 

90-
100 

100-
110 

110+ 

             

             

             

 

 

 

 

/     /    /      
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1.4.3.2.6 Data analysis  

If the data is collected by point sampling or variable radius plot, use the data analysis methodology described 
in chapter 3, section 3.3.5.  You can also use following to generate some useful information  

i. Estimate the forest area as proportion of the sample plots multiplied by total area  
 

𝐴𝑖 =
∑ 𝑃𝑖

𝑃
 x A  

(2) 

Where,  

Ai is area under stratum i (e.g. Forest, grassland, settlement, wetland, cropland, other land); 
Pi  is the sample plots falling on stratum i (e.g. Forest, grassland, settlement, wetland, cropland, 
other land);  
P is total number of sample point/plot; and  
A total forest management area  

 
ii. Area of production area is estimated as the number of plots falling in forest with slope less than 35 

degrees divided by all plot multiplied by total LFM area  
 

𝐴𝑓𝑝 =
∑ 𝑃𝑓𝑝

𝑃
 x A  

(3) 

 

    Where,  

Afp is area of forest with slope less than 35o  
Pfp sample plots falling on forest with slope less than 35o  
P is total number of sample point/plot  
A total forest management area  
 

The basal area, stem density and volume per hectare is estimated based on general formula (Laar & Akea, 
2007) as described below.  

iii. Basal Area of Individual tree  
 

𝐵𝐴 = 𝜋(
𝑑

2
)2 

 

(4) 

iv. Basal area per hectare  
 𝐵𝐴ℎ𝑎 = 𝑇𝑖𝑛 X BAF 

 

(5) 

v. Volume per ha    
 

𝑉ℎ𝑎 = 𝐵𝐴𝐹 𝑋 ∑
𝑉𝑖

𝑔𝑖

𝑛

𝑖

 

(6) 

vi. Number of trees per hectare  
 

𝑇ℎ𝑎 = 𝐵𝐴𝐹 𝑋 ∑
1

𝑔𝑖

𝑛

𝑖

 

(7) 
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Where,  

     BA  is basal area;  

     d  is dbh of a tree;  

     BAF is basal area factor of prism;  

     BAha  is the basal area per hectare;  

     Vha  is the volume per hectare; 

     Tha  tree count per hectare; 

     gi is the basal area of the trees counted “in”; and  

     vi is the volume of the trees counted “in” 

1.4.3.3 Initial Environmental Examination (IEE) 

1.4.3.3.1 Objective 

The objective of the IEE is to: 

• valuate the environmental conditions; 
• assess the environmental risks of commercial forest management; and 
• provide a preliminary estimate of protected areas and their location. 

This is not a full environmental assessment (EA) but the information generated by this step should contribute 
to EA that is conducted as part of the FMU Planning process. 

1.4.3.3.2 Sources of Information 

Information for the IEE is collected during the courses of: 

• Pre-RS Field Check; 
• Socio-Economic Study (in particular RRA); 
• Reconnaissance Forest Inventory; and  
• Preparation of Reconnaissance Survey, contacts with other institutions. 

1.4.3.3.3 IEE-Format 

The Preliminary Environmental Examination should contain a brief description of the environmental con-
ditions within the potential FMU area and an analysis of the environmental risks of forest management. It 
should include a map indicating proposed protected areas for wildlife, soil and watershed protection and 
recommendation for forest road construction and harvesting systems. It consists of one standardized page 
(Table 1.7) with an attached map indicating proposed protected areas and buffers. 
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Table 1.7 Initial Environment Examination Form 

  Reconnaissance Survey 
Initial Environmental Examination 

1 Name of FMU:   Area:   

Gewogs:   

2 Occurrence of Wild-
life  

Provide the list of wild animals found in the FMU area: 

3 Ecosystems and flora  Provide the list of plants found in the FMU area: 

4 Soil Protection and 
water catchments  

Verify the slope and water catchment with the map and note any differ-
ences found: 

5 Length of road re-
quired (Km) 

  

6 General analysis of 
environmental risks 

List the possible impact of the operation of FMU on sl. No 2, 3, 4 and 5. 

  Date:   Completed by: 
Name and designation 

  

 

The IEE should be prepared by the officer in charge of the reconnaissance survey based on the information 
obtained from the Pre-RS Field Check, RFI, PRA and from institutions concerned with environmental pro-
tection. 

1.4.3.4 Economic Feasibility Study (EFS) 

1.4.3.4.1 Objective 

The objective of the EFS is to forecast, whether commercial forest management of the FMU can be finan-
cially viable in the long run or not and whether it is worthwhile to operate the concerned area as a commer-
cial FMU. The EFS is the most important component of the RS as it helps to avoid expensive and uneco-
nomic investments in future. 

The EFS at the reconnaissance level, needs to be simple without time consuming analysis. It shall, therefore, 
not replace a full-fledged economic assessment later on at forest management planning level. The EFS 
should be conducted by the concerned planner, DFO in collaboration with the authorized agency and FRMD. 
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1.4.3.4.2 Sources of Information 

The EFS is based on the results of the RFI, SES, IEE, and basic economic data of authorized agency. Pre-
liminary decision on the harvesting system and a draft road construction and accessibility plan have to be 
prepared during the EFS, taking into consideration the proposals made by the IEE, in order to allow an 
estimate of the investment and operational costs. 

1.4.4 Reconnaissance Survey Report 

The final RS-Report is a compilation of the individual reports of the: 

• Pre-RS Field Check 
• Socio-Economic Study 
• Reconnaissance Forest Inventory 
• Initial Environmental Examination  
• Economic Feasibility Study 

It should be prepared by the CFO of concerned field office and submitted for approval to the Head of De-
partment, DoFPS. The table of contents including some keywords for the content of the Report is listed in 
Table 1.8. 

Table 1.8 Content for the Reconnaisance Report 

Section heading Information to include 
1 Brief Summary 
 

• brief description on different activities carried out (when by 
whom);  

• recommendation whether to open FMU or not; 
• main constraints and problems 

2 General Information  
2.1 Location and Terrain • names of Dzongkhag and Gewogs; 

• boundary alignment and adjoining FMUs, national parks, pro-
tected areas, etc.; 

• size of potential FMU and approximate size of operable area; 
• topographic features such as altitude, slopes, exposition, drain-

age, watershed;  
• accessibility. 

2.2 Climate • brief description of climate (climatic zone, temperature, 
rain/snowfall, etc.). 

2.1 Soils • brief description on soil types, rocky areas, waterlogged sites 
and swamps, etc.;  

• brief valuation of site suitability for forest production. 
2.2 Wildlife • describe most common wildlife species,  

• occurrence and habitat of protected and rare species; 
• describe problems with animal pest (i.e. wild boars) 

2.3 Flora • specify most common tree species; 
• briefly describe ground flora; 
• mention occurrence of rare and protected plants. 

2.4 Forest Types and Forest 
Condition 

• describe different forest types and their spatial distribution; 
• describe forest condition (development stages, damages, dis-

eases, natural disasters, natural regeneration, etc.). 
3 Socio-Economic Study 

(maximum 2 days) 
• brief analysis of the socio-economic conditions within the po-

tential FMU area.  
3.1 RRA  • information on the intention to open FMU 

• informal discussions to identify objections and con-
straints  

• analysis of problems of local people 
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• assessment of the expectations of the local people and 
possible changes in livelihood and land use 

• assessment of present forest resource use  
• information on wildlife and environmental issues 

3.2 RNR Census data • number of villages and settlements; 
• number of households and population; 
• figures on livestock (number of cattle, horses, mules, 

goats and sheep); and, 
• information on grazing rights (tsamdos). 

4 Initial Environmental Ex-
amination 

• add IEE-Report 

5 Reconnaissance Forest In-
ventory 

 

5.1 Introduction   
5.2 Inventory Results   
5.3 Operable Area and Areas 
of Priority for Forest Management  

 

5.4 AAC-Estimate   
6 Economic Feasibility 
Study 

• add EFS-Report 

Annexes 1 Forest type map 
2 Map on protected and inoperable areas, proposed road alignment 

 

1.5 Contents of Forest Management Plans 

This section provides an outline of the contents of a FMP along with guidelines on the information that 
should be included under the various headings (Table 1.9).  A common format or structure should be applied 
to FMPs; however, the guidelines presented here should not be considered as absolutely prescriptive, some 
customization may be done if required.  

As described, a FMP is the result of a process or series of steps. Whilst preparing a FMP, it is important to 
keep in mind both the importance of the process and the intended final structure and contents of the plan in 
order to ensure that the process is providing the information necessary for the production of the final docu-
ment. Within this section, cross-references are made between the relevant sections of the forest management 
plan content and the stages or steps in the forest management planning process.  These cross-references can 
serve as a check for the planner to ensure that all areas are effectively covered. 

The structure or format of the management plan should be designed in such a way as to best communicate 
the relevant information to those involved with operational planning and implementation.  To achieve this, 
it is essential that forest management planners consult thoroughly and effectively with the users of the man-
agement plan from the start of the management planning process. 

Planners should continually reflect upon the suitability of the format, structure and contents of the manage-
ment plan and strive to continually improve them.  This Code should incorporate revised guidelines as and 
when appropriate. 

The preparation of management plans for new FMUs shall involve, to some extent, a different set of steps 
to the preparation of revised (i.e. second or subsequent) management plans for existing FMUs.  The structure 
and contents of each management plan shall need to reflect this accordingly. 

A structure with detailed headings and sections for the FMP is provided as a guide that should be included 
within the management plan.  Any other additional information which is critical can be included as a part 
of the management plan.
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1.6. Spatial Organization of the FMU 

1.6.1. Objective 

The objective of the spatial organization of the FMU is to sub-divide the FMU in order to aid in the preparation 
and effective implementation of annual activities. 

1.6.2. Outputs 

At the end of this activity, it is expected that the FMU is mapped and described in terms of blocks, compartments 
and sub-compartments, as appropriate. 

1.6.3. Lead Responsibility 

The respective DFO shall take the lead role with technical backstopping from FRMD. 

1.6.4. Organization of the Forest Management Unit 

To facilitate management and administration, forests are subdivided in a number of ways. These are generally 
influenced by the topography, forest type, functions and land ownerships and the subdivisions are made primar-
ily for the purpose of (1) organizing forest operations and controlling yield, and (2) defining territorial respon-
sibility and providing a permanent basis for locating stands and maintaining records. 

FMU is divided into blocks (identified by name of locality) which should be further divided into a compartment 
(identified by Roman numeral: I, II) and sub compartment (identified by a lowercase letter; a, b , c) for better 
administration and effective implementation purposes (Figure 1.4). 

 

Figure 1.4 Spatial Organization of an FMU 

Example of Spatial Organization, Korila FMU 
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Blocks 

FMUs are divided into blocks which the basic orientation and administrative units within the FMU. They are 
essentially major water-catchments separating easily recognizable major parts of the FMU. Therefore, the block 
boundaries shall in most cases follow ridges separating individual water-catchments. Other prominent topo-
graphic features such as large streams or rivers can also be used to identify block boundaries.  

For all practical purposes, the FMU should be divided into no more than 4 – 6 blocks with an average area of 
about 1,500 to 2,500 hectares each block (if determined by topography it can be much smaller, or larger). It 
should be kept in mind that eventually, with increased management intensity, the block could become an ad-
ministrative unit within the FMU, such as a beat. The name of a block must be an easily recognizable, commonly 
used name for that particular area. In name selection, a care has to be taken to avoid using unfamiliar or confus-
ing names. 

Compartments 

Blocks are divided into compartments which are basically orientation units created to facilitate easy orientation 
within each block to provide for easy administration, recording and monitoring of operations within the FMU. 
The boundaries of the compartments follow easily identifiable topographic or planimetric features such as roads, 
streams, rivers, main ridges, etc. In some cases, boundaries could follow major forest type lines. 

The size of the compartment would depend on the intensity of management, intensity of road network and a 
topographic makeup of the area. Typically, it would be anywhere between 100 and 500 hectares.   

Sub-compartments 

Compartments are divided into sub-compartments which are both orientation and management units (unless a 
stand-wise approach to planning is applied, in which case a sub-compartment is an orientation unit and the stand 
becomes the management unit). They are created when required for planning, management and implementation 
purposes. This is especially in the situations when the compartments are too large or when the area obviously 
requires a separate management regime and prescription. (Example; an area of a clear cut that had been replanted 
to one or a mixture of species, thus creating a homogeneous area either in terms of species composition or age). 

In most cases the sub-compartment boundaries follow the forest type lines, to clearly indicate the uniqueness of 
a certain area within the compartment for management purposes. The size can vary from one hectare in the 
intensively managed forest to an area of up to 50-100 hectares. 

Stands 

A stand is a contiguous area that contains a number of trees that are relatively homogenious or have a common 
set of characteristics and form. It is the basis of silvicultural planning which is identified during operational 
planning.  In some cases, the stand corresponds to a forest type.  Most of the time the selection criteria is identical 
to that of a sub-compartment with the exception that the orientation criteria is a secondary consideration. In an 
intensively managed forest, a stand wise planning and subsequent monitoring of operations is carried out in 
each compartment.  
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Box 1.1 Concept of a Stand 

Organisation of forest based on forest operation and controlling yield 

Trees, Stands, and Forest 

A forest is a complex thing to manage for two main reasons: the large size and longtime horizons in-

volved. A combination of tree, stand, and forest level perspectives is fundamental to an understanding 

of forest management. 

A tree is the basic element of a stand which is made up of many trees of various species competing 

with each other for survival and growth. A stand is the basic element of a forest. 

A forest is made up of many stands at various stages of development. Much as a tree is one element of 

a stand, so a stand is one element of a forest (see below). 

tree

stand

forest

 

The character of a stand in terms of species composition, size structure and canopy structure changes 

over time.  Silvicultural measures such as creation of new stands, ability to speed up development of a 

stand, tending of a stand through thinning and other measures and finally regenerating a stand through 

harvesting are powerful tools of forest management. 

An example of a basic organisation of a FMU is provided on the map (Figure 1.4).  

Standardized annotation of each basic organisational unit on forest management maps follows interna-

tional conventions. 

Block is identified by a name only. An example of a block name is: Korila Block. 

Compartment is identified by Roman numeral: I 

Sub-compartment is identified by a low case letter: a 

Stand is usually identified with a silvicultural or forest type unit and may be identified by a forest type 

class (FCb).  
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Delineation of Boundary, Blocks, Compartments and Sub-compartments 

Delineation of Boundary, Compartment and Sub-compartment shall be carried out using Google Earth Pro and 
QGIS 3.12. This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS 
version 3.12 and above. 

➢ Open Google Earth Pro 
➢ In Google Earth Pro, navigate to the area of interest where Boundary, Blocks, Compartments and Sub-

compartments need to be delineated.  

 

➢ Right click on My Place > Add > Folder 
➢ Give appropriate name to the folder and save it 
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First the overall boundary of FMU need to be created (Note: in this case, boundary shall be created using line 
features and not polygon features) 

Draw FMU boundary using line features 

➢ Right click on newly created folder (Korila) > Add > Path (Path is line features in Google Earth) 
➢ Draw the line taking natural features the boundary of area of interest (Note: it need not be one single 

line to cover the boundary of area of interest. Multiple segments of lines can be used to make the bound-
ary by joining them, however, make sure end on one segment of line is over lapped with starting point 
of another segment of line as shown in the figure below) 
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Draw lines for Blocks using line features 

➢ Right click on newly created folder (Korila) > Add > Path 
➢ Draw the line taking natural features which can be served as boundary of Blocks (Note: it need not be 

one single line to cover the boundary of Blocks. Multiple segments of lines can be used to make the 
boundary by joining them, however, make sure end on one segment of line is over lapped with starting 
point of another segment of line, overlap with boundary of area of interest). 
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Draw Lines for Compartments 

➢ Right click on the newly created folder (Korila) > Add > Path 
➢ Draw the line taking natural features which can be served as boundary of Compartments (Note: it need 

not be one single line to cover the boundary of Compartments. Multiple segments of lines can be used 
to make the boundary by joining them, however, make sure end of one segment of line is over lapped 
with starting point of another segment of line, overlap with boundary of area of interest, Blocks and 
Compartments). 
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Repeat the process to draw the boundary of Sub-compartment if required. 

Once delineating of FMU boundary, Blocks, Compartments and Sub-compartments as line features is com-
pleted, import the Keyhole Markup Language (KML) file to QGIS. 

➢ Right click on newly created folder (Korila) > Save Place As 
➢ Save the file KML file in the designated folder. 

 

 

Opening KML file in QGIS 

➢ Open QGIS 
➢ Navigate to Layer < click Add Layer >Click Add Vector Layer… 
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➢ In the source, browse your KML file 

 

➢ Select the KML file > click open 
➢ Click Add 
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KML file need to be converted into ESRI Shapefile format for further analysis. 

➢ Right click on file > Export > Save Features As  
➢ Format: Select ESRI Shapefile 
➢ CRS: DRUKREF 03/ Bhutan National Grid 
➢ Save the file with appropriate name in working directory 
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Converted shapefile is still in line features. We need to convert the line features into polygon features.  

➢ Type Polygonize in processing toolbox 
➢ Navigate to Vector geometry and select Polygonize tool 
➢ In Input Layers: Select the file you want line feature file 
➢ Save the file with appropriate name in working directory 
➢ Click run 
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Now the line features have been converted into polygon features. We need to give the appropriate name of 
FMU, Blocks, Compartments and Sub-compartments. 

➢ Right click on polygon layer > Click Open Attribute Table 
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➢ Click Toggle Editing Mode 

 

➢ Click on New field  
➢ Name: Type FMU 
➢ Type: Select Text (String) 
➢ Length: 50 
➢ Click Ok 
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➢ Click Open Field Calculator 
➢ Check Update existing field  
➢ Select FMU 
➢ In the expression box; type Name of FMU within inverted coma e.g. (‘Korila FMU’) 
➢ Click ok 
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➢ Click on New field  
➢ Name: Type Block 
➢ Type: Select Text (String) 
➢ Length: 50 
➢ Click Ok 
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➢ Minimize attribute table 
➢ Click Select Feature  
➢ Identify each different Blocks, we need to name the block one at a time 
➢ Move your mouse and click one polygon (it shall be highlighted yellow). We can also select multiple 

polygons by pressing control on keyboard and clicking on multiple polygons to be selected. Select all 
the polygons that falls under one Block 
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➢ Open/maximize attribute table 
➢ Select Show Selected Features (this shall show only polygons that are selected) 

 

➢ Click Open Field Calculator 
➢ Check Update existing field  
➢ Select Block 
➢ In the expression box; type Name of Block within inverted coma e.g. (‘Korila’) 
➢ Click ok 
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Repeat the process to name all the Blocks 

 

➢ Click on New field  
➢ Name: Type Compart (Full compartment cannot be typed due to restriction in number of letters for field 

title) 
➢ Type: Select Text (String) 
➢ Length: 50 
➢ Click Ok 
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➢ Minimize attribute table 
➢ Click Select Feature 
➢ Identify each different Compartment, we need to name the Compartment one at a time 
➢ Move your mouse and click one poygon (it shall be highlighted yellow).  
➢ Open/maximize attribute table 
➢ Select Show Selected Features (this shall show only polygon that is selected) 
➢ Click Open Field Calculator 
➢ Check Update existing field  
➢ Select Compart 
➢ In the expression box; type Number of Compartment within inverted coma in Roman numerals e.g. (‘I’) 

or (‘II’) or (‘III’) 
➢ Click ok 
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➢ Click on New field  
➢ Name: Type SubCompart (Full Sub-compartment cannot be typed due to restriction in number of letters 

for field title) 
➢ Type: Select Text(String) 
➢ Length : 50 
➢ Click Ok 

 

➢ Minimize attribute table 
➢ Click Select Feature 
➢ Identify each different Sub-compartment, we need to name the Sub-compartment one at a time 
➢ Move your mouse and click one poygon (it shall be highlighted yellow).  
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➢ Open/maximize attribute table 
➢ Select Show Selected Features (this shall show only polygon that is selected) 
➢ Click Open Field Calculator 
➢ Check Update existing field  
➢ Select SubCompart 
➢ In the expression box; type Number of Sub-compartment within inverted coma in small alphabetical 

letter e.g. (‘a’) or (‘b’) or (‘c’) 
➢ Click ok 

 

 

 

Once all the naming of FMU, Blocks, Compartments and Sub-comparted are completed save the edits 

➢ Click Toggle editing mode > Click Save 
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Display Blocks in different colour in map viewer. 

➢ Right click on polygon layer > Click Open Attribute Table > Click Properties. 
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➢ Click Symbology > Select Categorized  
➢ In the Value: Select Block 
➢ Click Color ramp and select appropriate colour 

 

➢ Click Classify 
➢ Click Apply  
➢ Click OK 
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Display the name of Blocks, Compartments and Sub-compartments in Map Viewer 

➢ Right click on polygon layer > Click Open Attribute Table > Click Properties. 
➢ Click Labels > Select Rule-based Labelling  

 

➢ Click Add Rule 
➢ In the Label Value: Select Blocks 
➢ In Placement: Select Horizontal 
➢ Click OK 
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➢ To add more rules click Add Rule 
➢ In the Label Value: Select Compart 
➢ In Placement: Select Horizontal 
➢ Click OK 

 

 

➢ To add more rules click Add Rule 
➢ In the Label Value: Select SubCompart 
➢ In Placement: Select Horizontal 
➢ Click OK 
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➢ In the Layer Properties dialogue box click Apply and OK 
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1.7. Socio-economic Survey and Resources use mapping 

1.7.1. Socio-Economic Survey (SES) 

1.7.1.1 Introduction 

This section includes guidelines on socio-economic survey, participatory resource use assessment, stakeholder 
analysis, establishment of the FMU-level committee and problem analysis and objective setting.  These planning 
steps and processes are essential to ensuring that the FMP effectively incorporates stakeholder needs, interests 
and priorities. 

A socio-economic survey is required in order to collect socio-economic information about the communities who 
live in and adjacent to an existing or proposed FMU.  It provides useful information on local populations and 
their forest product requirements. Much of this information shall already be available and can be collected by 
the forest management planner from secondary sources e.g. Dzongkhag or Gewog. 

It is essential that local people are actively involved in the planning process; the participatory techniques de-
scribed in this section shall help to ensure that they are actively involved in the process. Some element of veri-
fication of socio-economic information on the ground is useful. This involves visiting local villages and getting 
reliable idea of settlement patterns and land usage.  

1.7.1.2 Objectives 

The objectives of a socio-economic survey are to:  

● prepare a socio-economic overview of villages/communities; 
● raise awareness of the FMU; to ascertain what is already known and perceived and what information is 

needed and to inform communities at an early stage about the FMU planning process; 
● prepare a complete overview of local use of the forests (including holy sites, Tsamdro and Sokshing); 
● identify possible ways in which the community can fairly benefit from the FMU; 
● minimize any negative impacts that might result from the establishment or continued management of 

an FMU and to pre-empt and avert future conflicts. 

1.7.1.3 Outputs 

The outputs of the socio-economic survey are: 

● communities informed about the FMU and their involvement in planning; and  
●  socio-economic survey report containing socio-economic information on stakeholders (especially local 

stakeholders). The report is included or summarized in the forest management plan. The report shall 
include a participatory resource use map (showing how the forest is used by local people). 

The socio-economic survey contributes to the forest function map by delineating the local/social uses of the 
forests; therefore, socio-economic survey should be conducted at the same time as forest function mapping. 

1.7.1.4 Lead Responsibility 

The Respective DFO shall take the lead role in collaboration with the Local Government.  

1.7.1.5 Methodology 

The following steps (Table 1.10) should be adopted to conduct the socio-economic survey in the FMU (Nepal, 
2002; Branney, 2002).  
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Table 1.10 Socio-economic survey methodology 

Activity Purpose/objectives Output 

Develop ToR 
To define the scope of the survey, identify key tasks and 
work plan 

Agreed ToR 

Coordination with 
Dzongkhag & Ge-
wog 

To ensure cooperation from local and government 
stakeholders 
To source official data from RNR staff 

Agreed by Dzongkhag & 
Gewog staff.   
Data made available. 

Community meet-
ing 

To introduce concept of FMU and planning, to inform 
villagers of work plan & to elicit initial views on FMU 
(aim for a minimum of 80% participation)  

Minutes of meeting 

Timeline map 
To track the history & development of the commu-
nity/village 

Community timeline dia-
gram 

Social mapping 
To gain insight into institutions & strengths of commu-
nity organization in order to assess organizational ca-
pacity 

Social map 

Participatory re-
source use map-
ping 

To involve local people in the planning process  
To map village & forest resources 

Participatory resource map 

Forest utilization 
calendar 

To identify use of forest resources throughout the year Forest utilisation calendar 

Household inter-
views 

To collect socio-economic information & to gain further 
insight into interests and perceptions (minimum of 25% 
of households)  

Detailed information for 
SES report 

 

a. Terms of reference 

Terms of reference for the SES team should include the following: 

● Brief background and rationale  
● Objectives 
● Anticipated outputs 
● Agencies/organisations involved 
● Tasks to be undertaken by the team (Box 1.2 Key Task of SES team) 
● Timing 
● Data requirements 
● Team members and experience/qualification  
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Box 1.2 Key Task of SES team 

The key tasks of the SES team are to: 

● raise awareness and determine information needs regarding the FMU; particularly community 

involvement in planning 

● collect and analyse existing socio-economic data and design a survey based on this secondary 

data 

● prepare, with the communities, a list of where and how they use the forests  

● conduct household interviews, including awareness raising about the FMU 

● collect detailed information about the local forest use (size, location, products etc.); their fu-

ture plans for use 

● identify all local uses in the field (including holy places and water protection sites mentioned by 

the communities); GPS can be used for this 

● assess the impact of a road construction on the community (as appropriate) 

● propose possible roles for the communities in the FMU (e.g. partnerships, FMU-level committee 

etc.) 

● identify the ways in which communities can benefit from the FMU 

● prepare a report on the survey. 

 

b. Community meeting 

The next step is to conduct a community meeting in order to: 

● introduce the concept of an FMU  
● introduce the planning process 
● inform community members of the SES work plan  
● elicit preliminary views on the idea of an FMU in their immediate environment including possible im-

pacts of the road if built for log extraction 
● aim for minimum of 80% participation 

 

c. Timing of the activity 

A flexible approach is required to the timing and sequence of meetings.  Optimal use of community time must 
be ensured. 

d. Timeline 

After the community meeting a PRA exercise in the form of a timeline can be done to map the development 
context of the community. The main objective of doing this activity is to track the history of development in the 
village.  

e. Social mapping exercise 

A social mapping exercise can be done after the timeline with the same participants in order to get an insight 
into the institutions and strengths of community organisation in order to assess the organisational capacity of 
the people and the implications of the FMU for the village and vice-versa if established in the area.    

A social mapping exercise is a fairly simple exercise that identifies institutions and community organizations 
and represents them in a diagram.  The diagram should be drawn so that it shows  various institutions and 
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organizations that are within the community and also those which influence or interact with the community. An 
example of the output of this exercise is shown in Figure 1.5. 

 

Figure 1.5 Social map for a Community 

 

f. Participatory resource use mapping 

The purpose of participatory forest use mapping is not to extract information from the participants, but to involve 
local people in the planning process. Being involved in the planning process shall encourage a sense of owner-
ship and responsibility for the forest management plan amongst local stakeholders, which would not be present 
if the plan were prepared solely by the planner. 

This is a useful point for the forest management planners to explain to groups of local people what is being 
proposed for the area of the FMU e.g. why it has been selected and how it shall be managed. It shall be useful 
to explain that planning for the management of the area shall be done through close involvement of local com-
munities (through stakeholder representatives).  

g. Forest utilisation calendar  

A forest resource use calendar can be created in order to illustrate use of forest resources throughout the year.  
An example of the format is shown in Table 1.11. In the user columns ‘X’ can be added to represent a user and 

XX to represent a major user.  The location column may need to be extended to accommodate multiple locations. 
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Table 1.11 Forest Utilization calendar format 

No Products 
User  

Location 
Bhutanese Months 

Male  Female 1 2 3 4 5 6 7 8 9 10 11 12 

1.  Firewood                

2.  Fencing poles                

3.  House Construc-
tion timber 

  
 

            

4.  Shingles                

5.  Bamboo                

6.  Broom                

7.  Flagpoles                

8.  Incense                

9.  Mushroom                

10.  Others (specify)                

 

h. Household interviews 

Individual household interviews can be done in order to collect socio-economic information and to gain further 
insight into interests and perceptions.  The questionnaire that is included in Form 1.3 (or adapted as appropriate) 
can be used as the basis for this interview. A minimum of 25% of households should be sampled randomly. The 
information collected can then be collated and summarized following the guidelines on structure and content of 
the SES report as outlined below.  All data should be saved and carefully filed for future reference. 

Form 1.3 Socio-economic survey form 

SOCIO-ECONOMIC SURVEY FOR FMU 

 

Name of Enumerator……………..……             Date of Interview……………………. 

  

Name of Supervisor……………………    Date Checked……..…………………. 

A. General Information 

Name of respondent………….……………   Language Spoken……….     

Gewog……………...…      Village………………...….          

Dzongkhag………………………...…….…           Ethnic group…………….. 
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B. Demography 

No Name of 
Family 
member 

Relation  

to Hh 
head 

Sex 

(Tick 
box) 

Age 

(Years) 

 

Marital 
status 

Education 
level (Formal/ 

Informal) 

(Completed) 

Occupation Resident 
for 

Last 6 m 

Yes/No 

 M F  

1  H/h head        

2          

3          

4          

5          

6          

7          

8          

9          

 

C. ACCESS TO SERVICES 

Facility Time Unit 

   

Health   

Walking distance from the respondent’s house to the nearest health facility 

(ORC/BHU/Hospital) 
 Days 

  Hours 

  Minutes 

   

Education   

Walking distance from the respondent’s house to the nearest school (Commu-

nity/Primary/Lower Secondary/Higher Secondary) 
 Days 

  Hours 

  Minutes 
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Roads   

Walking distance from respondent’s house to nearest motorable road  Days 

  Hours 

  Minutes 

   

RNR Extension Centres    

Walking distance from the respondent’s house to the RNR centre  Days 

  Hours 

  Minutes 

   

Markets   

Walking distance from the respondent’s house to the nearest market  Days 

  Hours 

  Minutes 

 

Household Amenities 

Drinking Water                                      

Observe and please tick type/source of water                

source the respondent is using-                                         

 

 

 

 

 

 

Sanitation  

Observe and please tick the type of toilets used- 

 

a. Piped water in the house  

b. Common tap stand  

c. Protected spring  

d. Spring  

e. Others (specify)  

a. Modern type  

b. Pit type  

c. In the open (jungle)  

d. Others (specify)  



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        76 

Observe and tick the type of lighting         Observe and tick cooking energy   

energy used 

a. electricity  

 b. solar   

c. kerosene  

d. candle  

e. pine shavings  

f. Others (specify)  

D. Landholding 

Land type Area (in acres) Owned & operated Sharecropped (acres) Fallow (acres) 
 Leased in Leased out   
Dryland      
Tseri      
Orchard      
Kitchen garden      
Pasture      
Tsamdrog      
Sokshing      
Private forest      

Plantation      
Commercial plot      
Others (specify)      

 

E. Livestock owned (L=local; I=improved) 

Cows Bulls Horse Mules Sheep Pig Yak Poultry Goat Others? 

F. Source of Income (in Nu) in the last one year   

L I L I L I  L I L I  L I   

               

 

 

a. Fire wood  

b. Kerosene  

c. LPG  

d. Electricity  

e. Others (specify)  

No Income source Unit price Quantity sold Amount 
earned 

Market sold in 

1 Crops 
Paddy/Rice 
Wheat 
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G. Expenditure    

No Expenditure head Unit price Amount 
spent 

Market bought 
in 

1 Food items (specify) 

a. Grain 

b. Meat 

c. Fish 

d. Salt 

e. Cooking Oil 

f. Vegetables 

g. Others…. 

   

Maize 
Buckwheat 
Barley 
Mustard 

2 Processed food (specify)     
3 Vegetables     
4 Fruits     
5 Livestock     
6 Livestock products     
7 Craftsmanship (specify) 

a. 
b. 
c. 

    

8 On-farm labour 
Specify type: 
 
 

    

9 Off-farm labour 
Specify type: 
 
 

    

10 Forestry products (cane, 
mushroom, wood, etc.) 

    

11 Wholesale trade     
12 Retail trade     
13 Remittances     
14 Others (specify)     
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2 Clothing    

3 Education    

4 House maintenance/improvement    

5 Livestock purchase/maintenance    

6 Religious ceremonies    

7 Transportation and communication    

8 Recreation and entertainment    

9 Medicines    

10 Personal care and effects    

11 Purchase of durable and non-durable goods    

12 Taxes    

13 Gift and contribution    

14 Farm machinery and tools    

15 Others (specify)    

 

Savings  

Amount 
saved last 
year 

Reason for 
savings 

Place savings 
kept 

Source of 
spending sav-
ings 

Decision on 
spending by  

Spent by 

      

 

Credit 
Amount 
borrowed 
last year 

Amount bor-
rowed from 

Reason for bor-
rowings 

Borrowing ar-
rangements  

Decision on bor-
rowing 

Borrowed by 

      

 

J. Participation in local political bodies 

Village zomdue GYT DYT 

Attend Discuss Decide Attend Discuss Decide Attend Discuss Decide 
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Committee Others 

Attend Discuss Decide Attend Discuss Decide 

      

 
K. Food security 

No. of months food 
shortage last year 

Grain borrowed 
last year (kg) 

Other coping mechanisms 

With food insecurity 

 

 

  

 

L. Migration 
Relationship 
of migrant to 
h/h head 

Age Sex Year of 
migration 

Reasons for migration Type of Contribution to family 

 

 

 

 

     

 

M. Products utilised from forest 
Product Qty 

used 

/Year 

 

Collection  

period 

(months) 

Name of collec-
tion site 

Remarks on 
status of  

stock & rea-
son 

Plan to continue collect 
in future or alternative 
location? 

Construction tim-
ber 

     

 

Shingles      

 

Firewood      

 

Fodder      

 

Litter      
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Leaf mould      

 

NWFP (e.g. cane, 
bamboo, burr, 
mushroom, dye, 
medicines, edible 
plants and nuts) 

     

Grazing (by spe-
cies) 

     

 

 

Road Construction 

What are your views about the road construction that is planned?  

 

Do you think it shall benefit the community? Why? 

 

FMU management 

Do you see that creating a FMU in your area would benefit the community?  Why? 

 

What role can the community and members play in the management of the Forest Management Unit in future 
if a FMU is established?  

 

Views on present grazing situation by yaks and cattle of local people? 

 

Views on present grazing situation by yaks and cattle of outsiders (dratshang, other people? 

 

 

1.7.1.6 Structure and Content of Socio-Economic Survey 

a. Introduction 

The socio-economic appraisal covers aspects such as demography, access to social services, employment, liter-
acy, migration, credit and savings, land and livestock holdings, income and expenditure and food grain security. 
Further, key issues relating to the feasibility of establishing an FMU, namely forest grazing, extent and locations 
of use of forests can also be addressed in the survey.  

Brief guidelines are presented here that indicate a typical structure and contents of the SES report. 
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b. Information required 

The information or data required can be included under a number of headings and presented in tables as shown. 
Details of households can be summarized as in Table 1.12. Study sample. 

Table 1.12. Study sample 

Village Actual No. of house-
holds 

No. of households in-
terviewed 

Gewog 

    

    

    

c. Area  

Area of potential or actual FMU, estimated operable area, administrative divisions. Number of households by 
Gewog. 

d. The people  

Ethnic groups, dialects, systems of inheritance e.g. (matrilineal) and residence (e.g. matrilocal). Livelihoods of 
the people (e.g. subsistence farming, rearing of livestock like cattle, commercial crops). 

e. Development  

Origins of community (estimate of date from timeline), ancestors. Development projects/activities; land use, 
infrastructure development, health, education and training, hydro etc.  Development of institutions in the com-
munity (from social mapping exercise). 

f. Demography 

Total number of persons, no. of households, average household size, age class distribution and implications.  
See Table 1.13. 

Table 1.13. Population/Demographic profile by sex, age and hamlet 

Village Total No. in Population Sex Age group (years) 

Male Female <6 7 to 14 15-64 >64 

        

        

Total (n=30)        

In % of total        

 
g. Migration 

Human migratory trends to gauge the magnitude of populations moving out of the community with possible 
effects on household labour and other aspects of community life. Proportion of the total population as non-
resident. Proportion of M: F migrating. Related cash flow.  See Table 1.14. 
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Table 1.14. Migrants by age, sex, year of migration and contribution to household 

Age No. of 
Persons 

Sex  Year of migration  Contribution to household 

 Male  Female  
 Before 
1985 

 1985-
95 

 1995-
2002 

 Don't 
know  

 
Cash 

 
Kind Cash & Kind 

 
No 

1 to 6              

7 to 14              

15 
above              

Total              

In % of 
total              

 

h. Employment 

Common occupations; e.g. farming, as housewives to migrants like army, government and private sector per-
sonnel or as gomchens.  See Table 1.15. 

Table 1.15. Employment by category and hamlet 

 

i. Access to social services 

Nearest school. Persons who have obtained education ranging from the Primary to High School level. Illiteracy 
rates. People having had no access to formal or traditional education. minors who have not reached the age for 
school attendance. See Table 1.16. 

Table 1.16. Literacy by standard and hamlet 

Hamlet Education 
 Primary  
 (PP-VI) 

 Junior High 
 (VII-VIII) 

High 
(IX-X) 

 Monastic  Illiterate  Minor 

       
       
Total       
In % of Total       
 

j. Household amenities 

Access to piped water from a protected source, protected and unprotected springs, sanitation facilities. Lighting 
energy. See Table 1.17. 

 

Hamlet Occupation 
Farmer Housewife 

 
Lay 
monk 

Monk Govt. 
servant 

Army Private 
sector 

Minor Student 

          
          
Total          
In % of total          



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        83 

Table 1.17. Access to household amenities 

 Hamlet Water Source Latrine 
Type 

Source of lighting energy Fuel 
source 

Common tap 
stand 

 Protected 
Spring 

 Unprotected 
Spring 

 Pit  
 Type 

 Kero-
sene 

 Kerosene & 
 Pine shav-
ings 

 Kerosene 
& 
 Electricity 

 Firewood 

No. of  house-
holds         

In % of total         
 

k. Landholding 

Land ownership and the size of landholdings; Dry land (DL), wetland (WL), kitchen garden (KG) registered 
pastureland (PL), registered sokshing.  Lease arrangements.  See Table 1.18 

Table 1.18. Land holdings (in acres) by category and hamlet 

Hamlet DL DLOO DLLO DLFLW WL WLLO WLFLW KG PL 

          

          

Total          

In % of total     

 

l. Livestock 

Livestock development, agricultural and livelihoods system source of income.  Cattle, yak, horses, sheep and 
poultry; owned, breed and used by households.  See Table 1.19. 

Table 1.19. Livestock 

 Cows Bulls Total 

Cattle 

Horse Sheep Pigs Yak Poultry 

Hamlet Local Impvd. Local Impvd. Local Impvd. Sheep Local Impvd.  

             

             

Total             

In % of total             

 

m. Income 

Exchange of goods and services for cash in the marketplace. Off-farm labour; wage labourers for civil construc-
tion works, sawing wood or working on farms etc. NWFPs.  
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Table 1.20. Total income (in Nu.) per year by source and hamlet 

Rank  
No.  

Income source    Total % 

1 Religious services      
2 Potatoes      
3 Remittances      
4 Off-farm Labour      
5 Cheese      
6 Animal Products      
7 Porter age      
8 On-farm labour      
Total      
%      

 

n. Expenditure 

On food, annual religious ceremonies, transportation and communications, education expenses, rural taxes, per-
sonal care and effects, gifts/contributions. See Table 1.21. 

Table 1.21. Total Expenditure (in Nu.) per year by source and hamlet 

Rank No.  Cost head Hamlet 1 Hamlet 2 Hamlet 3 Etc. Total % 

1 Food       

2 
Religious  
ceremonies       

3 Clothing       
4 Transportation & Communication       
5 Taxes       
6 Education       
7 Personal care & effects       
8 Gift/Contribution       
9 Recreation       
Total       
%       

 

o. Savings and Credit 

Amount, shortfall, source of credit 

Table 1.22. Local credit status by hamlet 

Village Credit availed in last year 

   Amount        loan (Nu.)   Reason for taking loan  Creditor  Terms of Loan  

     
     
Total     
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p. Food grain security 

Percentage self-sufficiency, households facing food grain insufficiency, coping mechanisms.  

Table 1.23. Grain security by hamlet 

Village No of months grain shortage Coping mechanisms 

No. of households 0 1 to 3 4 to 6 7 to 9 >9   
       
       
Total       
In % of total       

 

q. Social Uses of the Forests 

Introduction  

A core activity in the ToR is to determine the social uses of the forest by residents as an input to the overall 
Forest Functions Map. To reach this objective participatory group exercises involving village and resource 
mapping was done with two groups of farmers followed by construction of a Forest Utilisation Calendar. 

Information required 

Forest Produce 

Construction timber, shingles, firewood, fodder, litter, mushroom, bamboo, Daphne and broom etc. from the 
forests. See Table 1.24. 

Table 1.24. Forest products – quantity collected, stocks and collection plans 

Forest Pro-
duce 
  

Quantity 
Collected 
  

Situation of Stocks 
(No. of h/h) 

Reason for Situation of Stocks  
(No. of h/h) 

Future Collection Location  
(No. of h/h) 

Total Avg Same Less 
Don't 
know 

More use 
Don't 
know 

No. resp. Same Place Don't know 

Construction 
Timber           

 Shingles           

 Firewood            

 Fodder            

 Litter            

 Mushroom            

 

Include information from forest utilisation calendar.  

Water 

Sources and availability of drinking water 

Religious sites 

Location and significance of religious sites 
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Animals 

Reports of wildlife sightings  

r. Grazing situation 

Information required 

Grazing livestock numbers, ownership, distribution, seasonal grazing and migration patterns.  Numbers in rela-
tion to carrying capacity.  Grazing rights, leases, permits etc. 

Community views  

Information required 

A summary statement of community views and perceptions on, for example: 

• FMU establishment 
• participation in FMU management 
• road construction 

 
s. Considerations on establishing a FMU 

Introduction  

The present local uses of forests by communities and access to such areas should be maintained. If certain areas 
currently used need to be taken over by the FMU, it is necessary to ensured that mutual assent be secured 
through a process of dialogue and consultation. 

Information required 

The alignment of roads should be designed to optimally benefit the FMU and the community; to improve access 
for logging but also to markets and to ease community collection and transportation of forest produce.  

i. Factors affecting future demand for wood. 
ii. Creation of employment opportunities 

iii. Approaches for control of grazing in afforested areas.  
 

t. Conclusions & Recommendations 

These might include recommendations on for example: 

• Consultation among grazing stakeholders to discuss grazing scenarios and use-zonations 
• Community rules and regulations on forest use (including grazing) 
• Consideration of possible future community forest designation 

Field truthing 

Field or ground truthing is undertaken in order to verify and map the location of resources etc.   

GPS receivers are useful tools for this task. 

1.7.2. Establishment of FMU-Level Forest Management Committee 

1.7.2.1 Objective 

• To agree on the composition and role of the FMU-Level Forest Management Committee 
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1.7.2.2 Outputs 

• List of committee members 
• Terms of reference (ToR) for FMU-Level Forest Management Committee 
• Office bearers 

1.7.2.3 Lead responsibility 

DFO with technical backstopping from FRMD. 

1.7.2.4 Description of activity 

The CFO, DFO should establish FMU Level Forest Management Committee.  It is critical to ensure that all 
stakeholder groups are represented (either directly or indirectly) in the FMU-Level Forest Management Com-
mittee. The details of objectives, legal basis, membership, meeting cycles and terms of reference of the FMU-
Level Forest Management Committee is detailed in Table 1.25. 

Table 1.25 Composition of FMU Level Forest Management Committee 

 FMU-Level Forest Management Committee 

Objective(s) Ensure effective participation of stakeholders in FMU planning and implementation 

Legal basis Forest Management Code of Bhutan 
Forest Management Plan 

Membership Members 
1.  CFO, Divisional Forest Office (Chair) 
2.  Regional Manager, Authorized Agency 
3.  Unit Incharge, FMU 
4.  Production Incharge, Authorized Agency 
5.  Gup of concerned Gewogs 

Meeting cycle During preparation of FMP: Up to four meetings 
Thereafter: minimum twice a year (at discretion of chair) 

The FMU-level committee members shall ensure their involvement in subsequent planning steps. The ToR for 
FMU Level Management Committee are: 

1. FMP preparation 
• Discuss & agree management objectives 
• Review & endorse the draft FMP  
• Consult with stakeholders & represent their interests during planning 

 
2. Operational planning & implementation 

• Review achievements of previous year, advise & act on any issues identified in FMU annual report 
• Endorse activities, priorities & funding arrangements within the draft OP before submission to 

FRMD  
• Represent interests of stakeholders during operational planning 
• Hold additional meetings as required in response to specific issues arising from FMP & OP imple-

mentation 
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It is particularly important to ensure that committee members understand that whilst on the committee, their 
role is to represent the views and interests of identified stakeholder groups. 

1.7.3. Stakeholder Consultation Meeting 

1.7.3.1 Introduction  

The stakeholder consultation meetings and establishment of FMU-Level Forest Management Committee are 
essential components of the overall FMU planning process.  Effective stakeholder participation is vital to the 
effectiveness of plan preparation and implementation. 

1.7.3.2 Timing of activities 

The stakeholder consultation meetings are undertaken as an integral part of two major planning steps: (i) During 
forest function mapping for participatory resource assessment (PRA) in order to determine social functions; and 
(ii) during the environmental assessment process. A single stakeholder consultation meeting must suffice for 
both of these steps and must be planned accordingly. 

1.7.3.3 Objective 

To effectively involve stakeholders in the planning process and decide how their interests can be best repre-
sented 

1.7.3.4 Output 

Stakeholders are well consulted and their views and interest, which are not contravention to existing policies 
and legislations, are taken on board during the FMU planning process. 

1.7.3.5 Lead responsibility 

Divisional Forest Office 

1.8. Resource Inventory & Data Processing 

FMU inventory is an underpinning component of SFM which provides the data for planning, monitoring, eval-
uation, research, growth and yield management in FMUs. It also provides data on many characteristics of land 
on which the trees are growing. Forest inventories are designed to measure the extent, quantity, composition, 
and condition of forest resources, (Kangas et al., 2006). Therefore, the FMU inventory may be broadly defined 
as the systematic collection of data and information on forest for assessment or analysis; it is a systematic 
collection of data because there are procedures or protocols to follow during data collection to ensure accuracy 
and precision.   

1.8.1. Objectives  

The main purpose of FMU inventory is to gather data using which growing stock is assessed and accordingly, 
prescribe AAC on a sustained yield basis. The AAC is calculated considering the rotation age of the crop or 
stand, area and the growing stock per unit area.  

This information on growing stock is used for determining the AAC on a sustained yield basis. The inventory 
results provide us information on;  

What resources currently exist?  This information (For example volumes of timber, dimensions and species) 
normally comes from a static inventory; this consists of pre-harvest inventories, stock surveys and post-harvest 
inventories and is used to provide a ‘snap-shot’ of the forest resources at a particular point in time. 
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 How fast do the resources grow and what changes occur in response to management?  This information (For 
example, rates of growth, mortality and changes in species composition) is collected from dynamic inven-
tory.  This is usually done through measuring or collecting data from the sample plots.  This type of information 
is mainly used for long-term planning, calculating sustained yields and monitoring. The Department may estab-
lish permanent sample plots, which can be spearheaded by its research institute – Ugyen Wangchuck Institute 
for Conservation and Environmental Research (UWICER). Some of the important objectives of FMU inventory, 
but not limited to, are to;  

i. obtain, in an efficient and practical way, sufficiently accurate key information concerning the compo-
sition of the forest resources in the FMU in the form of thematic maps, tabular overviews, general 
descriptions and interpretations.  In this respect, only data that is really needed and shall be actually 
used during the subsequent data processing should be collected; 

ii. include in the forest resources more specifically; resources of timber and fuel wood (dbh 10+ cm), its 
regeneration potential (dbh<5cm), growing conditions and the quality of the site, non-wood forest pro-
duce, and the presence of key wildlife species. In order to monitor and evaluate the impacts of imple-
mentation on vegetation, flora and fauna; another inventory is recommended with the same or different 
design;  

iii. ensure, as a guide for the precision of the obtained results, a final sampling error for the estimate of the 
overall average gross wood volume of the forest area of +/-10%, at a confidence level of 95%; and  

iv. obtain, during the course of fieldwork, other advanced information, which may assist in the subsequent 
management plan preparation for the FMU.  

These objectives should be considered as guiding and defining parameters for inventory and related procedures. 
In brief, FMU Inventory results provides, not limited to the following information;  

1. Volume per hectare and total volume of timber in the FMU 
2. Basal area per hectare and total basal area in the FMU 
3. Number of stems or trees per hectare and total stems or trees in the FMU 
4. Biomass per hectare and total biomass stock in the FMU 
5. Carbon per hectare and total carbon stock in the FMU. 
6. Increment and growth, etc. 

1.8.2. Methodology 

A standardized forest management inventory has been established based on experience of implementing such 
inventory over several years in Bhutan.  The approach is based on a stratified systematic sampling design using 
fixed-size concentric plots aimed at a wide range of forest resources and this design is also adopted for National 
Forest Inventory (NFI) of Bhutan at different spatial resolution.  

Therefore, this guideline describes a step wise approach for designing and conduct of FMU Inventory. It may 
also be noted that this guideline may be revised from time to time as needed with technological advancement.   

1.8.3. Inventory design 

FMU inventory shall adopt systematic sampling design similar to as of NFI but at much finer spatial resolution with 
single point circular plots. FMU inventory should be designed to achieve estimates at 95% confidence interval and 
10% margin of error/ sampling error. The systematic sample uses a fixed grid to assign plots in a regular pattern and 
its advantages are;  

• Maximize the average distance between plots and therefore minimize spatial correlation on observations  
• Increase statistical efficiency  
• Can be representative in most cases and this is most common in forestry. 
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1.8.4. Sampling design  

The systematic sampling design is used for forest management inventory. In this method, a sample grid is created at a 
predetermined sampling intervals or plot to plot distance. The sampling for FMU inventory is designed to achieve results 
at 95% confidence interval at 10% standard error. 

Number of sample plots  

The sampling intensity for each FMU is determined by the forest type of the particular FMU which in turn is 
determined by the coefficient of variation. Higher the coefficient of variation, larger the same size. The coeffi-
cient of variation for typical forest types of Bhutan (for plot area of 0.05 - 0.1 ha) is described in Table 1.26. 
The use of Land Use and Land Cover data, 2016 or any other update/latest land use and cover product is rec-
ommended for stratification of forest types and land use stratification.  

Table 1.26:  CV% of forest type 

Sl No. Forest Type  CV% 

1 Fir 50 

2 Spruce  70 

3 Blue Pine  105 

4 Mixed Coniferous forest  70 

5 Combined conifers  80 

6 Oak (Quercus semecarpifolia) 65 

7 Mixed broadleaf  85 

8 Combined broadleaf  85 

9 Combined all 85 

 

The sample size is the function of coefficient of variation (Table 1.26) and percentage sampling error (10%) 
and level of confidence. The commonly used formula is shown in equation 8.              

 n =
t2 X CV%2

SE2 
 (8) 

Where,  

n is number of sample plots or it is also called sample size; 

t is t value for 95% confidence interval from t-distribution table; 

CV% is coefficient of variation; and   

SE is standard error or desired margin of error 
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The coefficient of variation (CV) is a statistical measure of the dispersion of data points in a data series around 
the mean expressed in percentage. The coefficient of variation represents the ratio of the standard deviation to 
the mean, and it is a useful statistic for comparing the degree of variation from one data series to another, even 
if the means are drastically different from one another. It shows the extent of variability of data in a sample in 
relation to the mean of the population. The coefficient of variation is determined by Equation (9).  

 𝐶𝑉% =  
𝑠

𝑥̅  
 𝑋 100     (9) 

Where,  

CV% of coefficient of variation in percentage  

S is sample standard deviation  

x̄ is sample mean  

For a sample with a mean of x̄ = 20 and a standard deviation of s = 8, we would estimate the coefficient of 
variation as CV% =0.40 or 40 percent. This coefficient of variation can be used for determining the sample size 
for your inventory area.  

The sample mean and standard deviation can be generated for basal area, tree count, tree height and tree volume. 
However, it is recommended to use the basal area to generate the sample mean and standard deviation to esti-
mate CV%.  

Sample size Calculation  

Let us consider the example of Selela FMU (SFMU) and estimate the sample size  

Step 1: Define the total FMU area  

  e.g Selela FMU, Area = 9157 ha   

 Step 2: Stratify the FMU area into different forest types using the latest available land use land cover/ forest type 
data. For example, SFMU has four forest types of Blue Pine, Broadleaf, Fir and Mixed Conifer forest (Table 1.27  and 
Figure 1.6) (LULC, 2017).  

Table 1.27: Forest Type of Selela FMU 

Sl. No. Forest Type  Area Coefficient of variation (cv%) 
1 Blue pine 2312.67  105 
2 Broadleaf 370.52  85 
3 Fir 1076.59  50 
4 Mixed conifer 4732.14  85 
  Grand Total 8491.92   
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Figure 1.6: Forest Type Map of Selela FMU 

Step 3: Apply the CV% of each forest type to determine the weighted area by CV% of the forest type. This is estimated by 
the equation (10) and (11) and described in Table 1.28. 

 𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐴𝑟𝑒𝑎 𝑏𝑦 𝐶𝑉% = 𝐴1𝐶𝑉1 +  𝐴2𝐶𝑉2+ … . . +𝐴𝑛𝐶𝑉𝑛 (10) 

 𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑  𝐶𝑉% =
𝐴1𝐶𝑉1 +  𝐴2𝐶𝑉2+ … . . +𝐴𝑛𝐶𝑉𝑛

𝐴1 + 𝐴2 … +  𝐴𝑛
 (11) 

   

Where,  

A1, A2 …..An is area of a particular forest type in ha; and   

CV1, CV2…… CVn, is CV% of corresponding forest type  

The weighted area by CV% for Selela is therefore calculated as follow: 
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Table 1.28: Weight CV% for Selela FMU 

Sl. No Forest Type CV% Area (ha) Weighted area 
1 Blue pine forests 105 2312.67 2428.3035 
2 Broadleaf Forest  85 370.52 314.942 
3 Fir forest 50 1076.59 538.295 
4 Mixed Conifer forests 85 4732.14 4022.319 
 Sum  8491.92 7303.8595 

Therefore,  

𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑  𝐶𝑉% =
7303.8595

8491.92
 x 100 

     = 86% 

Step 4: Applying the formula in Equation (8) above, the number of plots or sample size is calculated at confi-
dence interval of 95% with corresponding t-value of 1.96 (rounded to 2), CV% of 86 (as determined in step 3) 
and sampling error (used a synonymous with margin of error (MoE) and Standard Error) of 10%.  

Therefore, number of plots for SFMU is determined using equation (8) as follows;  

   𝑛 =
22 𝑋 862

102 
 

        = 295.9 plots ≈  296 plots 

Step 5: Allocate number of sample plots to each stratum and validate the total number of plots for different 
strata using equation 5 and 6 (Table 4). 

 𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐶𝑉% 𝑏𝑦 𝑠𝑡𝑟𝑎𝑡𝑎 =
𝑊𝑒𝑖𝑔𝑡𝑒𝑑  𝑎𝑟𝑒𝑎 𝑜𝑓 𝑠𝑡𝑟𝑎𝑡𝑎

𝑇𝑜𝑡𝑎𝑙 𝑤𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝑎𝑟𝑒𝑎
 (12) 

𝑃𝑙𝑜𝑡 𝑏𝑦 𝑠𝑡𝑟𝑎𝑡𝑎 = 𝑇𝑜𝑡𝑎𝑙 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑝𝑙𝑜𝑡    𝑋    𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐶𝑉% 𝑏𝑦 𝑠𝑡𝑟𝑎𝑡𝑎 (13) 

 

Table 1.29: Number of plots by strata in Selela FMU 

Sl. No 
Forest Types CV% 

Area 
(ha) Weighted area 

weighted CV 
by strata 

No. of plots by 
strata 

1 Broadleaf forest  85 370.52 314.942 0.043119942 12.75942767 

2 Fir forest 50 1076.59 538.295 0.073700076 21.80825714 

3 Blue pine forests 105 2312.67 2428.3035 0.332468539 98.37926627 

4 Mixed Conifer 85 4732.14 4022.319 0.550711442 162.9585395 

 
 Total    8491.92 7303.8595   

295.9054906 ≈ 

296 
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Step 6: Generate sampling grid area and determine the plot to plot distance using equation (14) and (15). The 
sampling grid is generated using the formula;  

 

                          𝐺𝑟𝑖𝑑 𝑎𝑟𝑒𝑎 =
𝐹𝑀𝑈 𝑓𝑜𝑟𝑒𝑠𝑡 𝑎𝑟𝑒𝑎

𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑝𝑙𝑜𝑡𝑠
   (14) 

   

 𝑃𝑙𝑜𝑡 𝑡𝑜 𝑝𝑙𝑜𝑡 𝑑𝑖𝑠𝑡𝑎𝑛𝑐𝑒 = √𝐺𝑟𝑖𝑑 𝑎𝑟𝑒𝑎    (15) 

 

For example, the grid area for SFMU is  

    𝐺𝑟𝑖𝑑 𝐴𝑟𝑒𝑎 =  
8491.92

296
 

= 28.6889.189 ha, which is equivalent to 286889.189 m2 

        

And the 𝑃𝑙𝑜𝑡 𝑡𝑜 𝑝𝑙𝑜𝑡 𝑑𝑖𝑠𝑡𝑎𝑛𝑐𝑒 = √286889.189 𝑚2 

= 535.62 meters.  

But for the practical purpose, it is rounded to lower 50th value. Therefore, the final plot to plot distance is 500 
m.       

Note: The plot to plot distance is rounded to lower 50th value using the function = floor (estimated plot 

to plot distance, 50) in excel. In this case, = floor (535.62) = 500 m.  

 

Step 7:  Determine the new grid area based on plot to plot distance estimated in step 6 (Equation (16)) in ha 
(e.g. SFMU)   

 𝐺𝑟𝑖𝑑 𝑎𝑟𝑒𝑎 =
(𝑝𝑙𝑜𝑡 𝑡𝑜 𝑝𝑙𝑜𝑡 𝑑𝑖𝑠𝑡𝑎𝑛𝑐𝑒)2

10000
    (16) 

𝐺𝑟𝑖𝑑 𝑎𝑟𝑒𝑎 =
5002

10000
 

       = 25 ha  

Step 8. Determine the final number of plots with new grid area estimated in step using 7 equation (17). 

 

 𝑁𝑜. 𝑜𝑓 𝑝𝑙𝑜𝑡𝑠  =
𝐹𝑀𝑈 𝑎𝑟𝑒𝑎 (𝑎𝑟𝑒𝑎 𝑜𝑓 𝑓𝑜𝑟𝑒𝑠𝑡 𝑢𝑛𝑑𝑒𝑟 𝐹𝑀𝑈)

𝐺𝑟𝑖𝑑 𝐴𝑟𝑒𝑎
   (17) 
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For a) total FMU area  

𝑁𝑜. 𝑜𝑓 𝑝𝑙𝑜𝑡𝑠  =
9157

1625
 

   = 366 (rounded to nearest whole number)  

b) For forest area only  

  

𝑁𝑜. 𝑜𝑓 𝑝𝑙𝑜𝑡𝑠  =
𝟖𝟒𝟗𝟏.𝟗𝟐

25
  = 340 

 

Step 9: Calculate no of plots by strata as per the no. of plots calculated in step 8 using equation  

𝑃𝑙𝑜𝑡 𝑏𝑦 𝑠𝑡𝑟𝑎𝑡𝑎 = 𝑇𝑜𝑡𝑎𝑙 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑝𝑙𝑜𝑡    𝑋    𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐶𝑉% 𝑏𝑦 𝑠𝑡𝑟𝑎𝑡𝑎              

Sl. 
No 

Forest Types 
CV
% 

Area (ha) Weighted area Weighted CV by strata No. of plots by strata 

1 Broadleaf forest  85 370.52 314.942 0.04311994 15 

2 Fir forest 50 1076.59 538.295 0.07370008 25 

3 
Blue pine for-
ests 

105 2312.67 2428.3035 0.33246854 113 

4 Mixed Conifer 85 4732.14 4022.319 0.55071144 187 

   Total    8491.92 7303.8595   340 

 

Generate Sampling Grid  

The regular sampling grid can be generated in ArcGIS, QGIS and any other GIS software. To generate the grid, 
you need to have physical boundary of the FMU either in the .kml file or shape file, which shall be used for 
clipping the area such that only grid intersection falling inside the FMU boundary is selected for further assess-
ment.  

Note: In many cases, you shall need to confirm the coordinate system of the FMU boundary. If it is in 

DrukRef, it has to be converted into WGS coordinate system. For each grid point, we then generate 

the northing and easting or coordinates for each point in degree minute second or decimal degrees as 

may be needed. If you are using QGIS, it is strongly recommended to use WGS coordinate system and 

coordinate in decimal degrees. 

Another point to be noted here is that using the plot to plot distance (sampling grid), which in this 

example is 500 m, the sampling points or sample points shall be generated. Often the sampling points 

generated from GIS may not be exactly same as generated using equation 9 above. This is because in 

GIS we use regular plot distance (500 m) but the actual boundary of the FMU is irregular, hence the 

slight variation between calculated plot number vis-à-vis the one generated from GIS. However, this is 

not a huge cause of concern, just ignore it. 
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In QGIS, you can generate the systematic sampling points following the following step;  

1. Load your forest boundary (FMU boundary in this case) shape file or .kml file, which is a vector layer  
2. Open Vector –> Research Tools –> Regular Points, a new window pops up.  

 
 

3. In the Input Extent, Select Extent on Canvas and select the extent of canvas by dragging the mouse 
covering whole FMU boundary 
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4. In the point spacing/count, type the plot to plot distance (e.g. 500 in SFMU) and save the file as sys-
tematic_points or with any desired name and click on run. Systematic points shall be generated  
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5. Systematic sample points shall be generated  

 

 

6. Since we only want points falling inside the FMU boundary, we need to clip the points using clip func-
tion in QGIS. Open Vector  -> Geoprocessing Tools -> Clip  
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7. Select ‘systematic_points’ as input layer  and FMU boundary as clip layer. Name the file as desired and 
save and run the algorithm  

 

 

 

 

 

 

 

 

 

 

8. Go to the Attribute table for the sampling_point…FMU 
9. Enable the edit mode. 
10. Open the Field calculator and name the new column Plot_ID  
11. Set the Output field type to :Text (string) or as desired  
12. Similarly generate coordinate for each sampling points  
13. Export the sampling point as GPS exchange format for loading into GPS for locating the plots in the 

field  

Note: In many cases, you shall need to confirm the coordinate system of the FMU boundary. If is in 

DrukReff, it has to be converted into WGS coordinate system. For each grid point, we then generate 

the northing and easting or coordinates for each point in degree minute second or decimal degrees as 

may be needed. If you are using QGIS, it is strongly recommended to use WGS coordinate system and 

coordinate in decimal degrees. 

 

1.8.5. Plot design  

For the purpose of FMU inventory, circular2 plot of 12.62 m radius is used for 
collecting inventory data and another circular plot of 3.57 m radius nested inside 
the larger plots is used for collection of regeneration data (Figure 1.7). The con-
centric circular plot is not only easy to establish, but also very sensitive to meas-
urement and cost (Henttonen & Kangas, 2015).  The area of the plot is 0.05 ha for 
all inventory data except regeneration data (plot area is 0.004 ha). 

 

                                                      

 

2 The circular plot is adopted as it is easier to establish in the field compare to rectangular or square plot.  

Figure 1.7: Plot Design 
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1.8.6. Data Collection 

Measurements and observations in the field are made on individual trees (and shrubs) as well as on the whole 
plot and forest ecosystem using the forms. Common tree parameters collected are diameter, height, forest con-
dition, tree condition (live or dead) and taxonomic species. The data collection protocols such as measurement 
of diameter and height, etc., and forms to be used for collecting data too are defined in this section. The suc-
cessful completion of the data collection and/or implementation of field inventory involves following steps;  

Planning for inventory  

It is essential that field inventory is planned in advance by FRMD and the concerned field offices to ensure that 
the field works are conducted on timely manner and execution of the work is completed in one season. There 
should be an adequate logistical arrangement for field work and the field crews should get themselves familiar-
ized on the inventory maps and FMU area. 

Timing of the Activity 

FMU inventories should be scheduled for completion as close to the time of writing the management plan as 
possible; ideally, no more than six months in advance or when the management plan is in the final year of 
implementation.  

Type and data collection methods  

The data can be collected in paper forms and/or digital forms on android based applications. The detailed guide-
lines for data collection are as described and specified below.  The inventory crew shall navigate to and locate 
the plot using GPS and establish the plot. After that the crew shall complete the forms by collecting and record-
ing the data for data forms 1 through 7. These forms and data collection parameters shall remain dynamic and 
change from time to time depending on needs.  

1. Collecting and recording plot description data (F1/7) 

SN Data Item Definition/Description Instructions 
1 District Name  Name of the District in which FMU is 

located. e.g KKFMU001 is located in 
Trashigang or Selela FMU is located 
in Haa.  

1. Select the District Name from the 
dropdown list for electronic form or 
type manually if paper form is used.  

2 FMU Name  Refers to the name of the FMU. The 
FMUs in respective districts shall ap-
pear as soon as district is selected. 

1. Select the name of the FMU from 
the dropdown list for electronic 
form or type manually for paper 
forms 

3 Plot No. This is the unique identification num-
ber given to Inventory Plots in the 
FMU   

1. Select correct Plot No from the 
drop-down list on electronic field 
form or record the correct Plot No, 
if the paper field form is used. 
Note: Paper Field Forms are to be 
used only if the does not function in 
the field.   

4 Region Refers to region under which the 
FMU falls. 20 dzongkhags are placed 
under 3 different regions. 

1. The region field shall automatically 
populate once the dzongkhag is se-
lected.  

5 Expected coordi-
nate 

Refers to the geo-coordinates gener-
ated by sampling design of plot loca-
tion 

1. The design or expected coordinates 
shall be hidden. Crew shall swipe it 
and move on to next parameter. 
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6 Coordinate/Loca-
tion  

Refers to the geo-coordinates of plot 
location. 

1. Click on ‘Start the GPS’ in the data 
logger (android tablet) and coordi-
nates shall be generated automati-
cally. If paper forms are use, use 
GPS to obtain coordinates. 

7 Crew Leader  Refers to name of the Inventory Team 
Leader  

1. Type the name of the person enter-
ing the data or team leader  

8 Date Refers to date of day on which data is 
collected 

1. Record the date by clicking on cal-
endar icon next to it on android tab-
let. 

9 Time Refers to time of day when data for 
Plot is collected 

1. Record the time by clicking on time 
icon next to it on android tablet. 

10 Altitude Refers to the elevation from mean sea 
level at which the plot is located. It is 
measured in meter. 

1. Use the GPS to obtain altitude read-
ing. Record altitude in meter, as it 
appears on GPS. 

11 Land use  Refers to class of land cover and land 
use. For the purpose of FMU inven-
tory following six categories are used, 
as defined in IPCC GPG for LU-
LUCF; 

7. Forest land  
8. Cropland 
9. Grassland 
10. Wetland 
11. Settlement  
12. Other land  

 

1. Use the technical definition pro-
vided in Table 1.30 for identifying 
the Land cover class. 

2. Then record appropriate land cover 
class accordingly in the data dic-
tionary or electronic field forms.  
 
Land Cover Classification Code as 
provided in the Table 1.30Error! 
Reference source not found. may 
be used, if paper field forms have to 
be used. 

12 Forest type Refers to Forest type as classified in 
the Flora of Bhutan. The characteris-
tic features of different forest types 
are provided in Table 1.31. 

1. Refer Table 1.31 to classify the for-
est type.  

2. Select the appropriate forest type 
from the drop-down list in case of 
electronic field form and in case of 
paper field forms, record the Forest 
type Code as provided in Table 
1.31. 

13 Stand height  Refers to height of the forest stand and 
for FMU inventory it would mean an 
arithmetic mean(average) of the 
height of five tallest trees in the plot 

1. Identify five tallest trees having 
DBH above 10 cm located within 
12.62 m radius plot. 

2. Measure the heights of the identi-
fied trees using Hypsometer or cli-
nometers. 

3. Start from North and move in 
clockwise direction to measure 
heights all five identified trees lo-
cated within the plot. 

4. Once the measurement of height is 
completed for all five trees, add the 
height and divide the sum by 5. The 
result is the stand height.  

5. Record the result to the nearest one 
decimal place.  
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14 Canopy Closure  Refers to the cover percent of tree 
canopy. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Points of measurement on circular plot 
 

1. Divide the plot into four quarters 
using or with imaginary lines run-
ning through North-South inter-
secting with East-West line. 

2. Using the Crown Densitometer, es-
timate the canopy cover percent 
from the following ten positions:  
-Plot centre,  
-Four mid-points of the lines join-
ing Plot Center (PC) and four direc-
tions (North, East, South and West) 
-Four points on the edges of the plot 
boundary (Northern, Southern, 
Eastern and Western edges) 
-and one from any random point 
within the plot.  
In total, take 10 points readings for 
canopy per cent calculation. 

3. Record the canopy closure in per-
centage.  
Note: Use of Crown Densitometer 
& calculation is given separately. 

15 Accessibility  Refers to if the Inventory Plot was ac-
cessible or not. 

1. Select ‘Yes’ if the Plot was accessi-

ble, ‘No’ if it was not accessible. 
Upon clicking ‘Yes’ subsequent 

data parameter fields shall open. 
But if recorded as ‘No’ subsequent 
data parameter fields shall remain 
hidden on electronic form. 

16 Aspect Refers to the direction of the slope and 
is classified as: 

1. Northern: When the slope is facing 
North 

2. North-Eastern: When the slope is 
facing North East 

3. Eastern: When the slope is facing 
East 

4. South-eastern: When the slope is fac-
ing South-East 

5. Southern: When the slope is facing 
South 

6. South-western: When the slope is 
facing South -West 

7. North-western: When the slope is 
facing North West 

8. No aspect: When the plot falls on a 
flat area  

1. Use a compass to determine the di-
rection to which the slope is facing. 

2. Record appropriate aspect by se-
lecting from the drop-down list on 
the data dictionary in the electronic 
field form and tick appropriate as-
pect from check list in the paper 
field form. 

17 Slope up Slope Up describes the gradient, incli-
nation of the up-hill slope from the 
Plot Center (PC). 
 

1. For measuring the Slope up, walk 
one of the crew members towards 
the steepest part of the up-hill side 
and position the member on the 
edge of the 12.62 m plot. 
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Note: Slope reading for our purpose 
shall be done in degrees. 

2. Take a clinometer reading to his 
eye height from the PC. 

3. Record the reading accordingly. 
18 Slope down Slope down describes the gradient, in-

clination of the down-hill slope from 
the PC. 

1. For measuring the Slope down, 
walk one of the crew members to-
wards the steepest part of the down-
hill side and position the member 
on the edge of the 12.62 m plot. 

2. Take a clinometer reading to his 
eye height from the PC. 

3. Record the reading accordingly 
Pest and diseases 

19 Common mistletoe  Refers to presence or absence of evi-
dence of Common mistletoe 

4. Observe ocularly within plot and 
around 25 m from the PC and rec-
ord “Yes” is evidence of Common 

mistletoe is observed, otherwise 
“No”. 

20 Dwarf Mistletoe Mistletoe is an obligate hemiparasitic 
plant that grows attached to and pene-
trating within branches of trees.  
Can be identified on trees by the pres-
ence of “witches’ broom” 

1. If mistletoes are observed on the 
plot itself or within 25 m from the 
PC, record as “Yes, mistletoe”, oth-

erwise as “No” 

21 Bark Beetle Refers to occurrence of Bark Beetle 
infection in the forest stand. The visi-
ble symptoms of bark beetle infec-
tions are: 

1. Discoloration of needles from green 
to yellow and eventually from red to 
brown 

2. Tiny holes in the bark of the infected 
trees 

1. If you observe the symptoms of 
Bark Beetle infection in the area, 
record as “Yes”, else “No”. 

22 Dieback Fir Fir dieback is a condition observed in 
Fir, where the following symptoms 
are observed: 

1. Top-dying/shedding of needles 
2. Thinning crown 

1. If fir dieback is observed on the plot 
itself or within 25 m from the PC, 
record as “Yes”, otherwise “No”. 

Forest health, disturbances and NWFP 
23 Understorey cover 

percent 
Refers to the area of plot (in percent-
age) covered by dominant understory 
type. 

1. Observe the understorey cover 
within the plot and make ocularly 
professional calculation. 

2. Record the cover percent of the 
dominant understorey type in per-
centage. 

24 Main Understorey 
type 

Refers to the dominant understorey 
type growing within the plot. The un-
derstorey type is categorized as: 

1. Moss 
2. Grass 
3. Herbs 
4. Bamboos 
5. Shrubs 
6. Others 

1. Observe the understory type within 
the plot. 

3. Record the appropriate under-
growth type from the drop-down 
list for electronic form and tick ap-
propriately for paper forms 
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25 Bamboo cover per-
cent 

Refers to presence or absence of ever-
green perennial flowering plants of 
grass family Poaceae. It is categorized 
as; 

1. None – absence of bamboo 
2. Cover_1-20 % 
3. Cover_21-40% 
4. Cover_41-60% 
5. Cover_61-80% 
6. Cover_81-100% 

1. Observe ocularly for presence or 
absence of bamboo within the plot 
and 12.62 m around the PC. 

2. If bamboos are present within the 
12.62 m radius plot, record as 
“Yes” and then choose appropriate 

category from the drop down list, 
otherwise “No”. 

26 Bamboo type Refers to type of bamboo – either 
Spreading or Clump. 

1. Select from the dropdown list ap-
propriately and record on electronic 
form.  

2. Write correct bamboo type, if the 
paper form is used. 

27 Scientific Name Refers to scientific or botanical name 
which conforms to the International 
Code of Botanical Nomenclature 
(ICBN) 

1. Observe within the plot and record 
the botanical name of the bamboo. 

2. The botanical names of the bam-
boos found in Bhutan are provided 
as drop-down list in the electronic 
field form. 

3. If paper field form is used, record 
appropriately from the list of Bam-
boo provided. 

28 Bamboo dbh Refers to the diameter at breast height 
of the bamboo in the plot and choose 
from the following category; 

1. <2 cm 
2. 2 cm – 4 cm 
3. >4 cm 

1. Measure the bamboo dbh and rec-
ord by selecting the appropriate cat-
egory from the dropdown list. 

29 Cane Cover Percent Refers to percent area of 12.62 m ra-
dius plot covered by cane.  

1. Observe ocularly within plot and 
make expert judgement of percent 
area of plot covered by Cane. 

2. Record the observation in percent-
age. 

30 Cane dbh Refers to the diameter at breast height 
of the bamboo in the plot and catego-
rized as; 

1. < 2 cm 
2. > 2 cm 

 

1. Measure the diameter of breast 
height for Cane present in the plot 
and record accordingly in centime-
ter (cm) to nearest one decimal 
place. 

31 Daphne Cover per-
cent 

Refers to percent area of the 12.62 m 
radius plot covered by Daphne, cate-
gorized as; 

1. None – absence of Daphne 
2. Cover_1-20 % 
3. Cover_21-40% 
4. Cover_41-60% 
5. Cover_61-80% 
6. Cover_81-100% 

1. Observe ocularly for presence or 
absence of daphne within the plot 
and 12.62 m around the PC. 

2. If daphne is present, then choose 
appropriate category from the 
dropdown list, otherwise. 
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32 Snag Refers to dead standing tree within the 
12.62 m radius plot. Such trees shall 
not have any living part at or above 
the DBH. 

1. Look for snag within the plot, rec-
ord “Yes” if snag is present in the 

plot, otherwise “No”. 

33 Snag count Refers to the number of snag present 
in the plot.  

1. Count the number of snag and rec-
ord the count of snag accordingly in 
electronic form or record on paper 
form. 

34 Fallen trees Refers to the number of dead fallen 
trees (of more than 1.37 m length and 
diameter of more than 10 cm at the 
midpoint) within the 12.62 m radius 
plot 

1. Look for fallen trees within the 
plot.  

2. Record “Yes”, if it is present, oth-
erwise “No” 

35 Fallen trees count Refers to total number/count of fallen 
trees found in the plot. 

1. Count the number of fallen trees 
and record and record accordingly 
on electronic form or paper form. 

36 Forest Fire Refers to presence or absence of evi-
dence of forest fire  

1. Observe within plot and 12.62 m 
around the PC for evidence of for-
est fire. 

2. Record “Yes” if evidence is pre-

sent, otherwise “No”. 
37 Intensity of forest 

fire  
Refers to the severity of forest fire 
damage and shall be classified in one 
of the following categories: 

1. Heavy: Where more than 50% of the 
area/crop is affected by fire 

2. Moderate: Where 10-50% of the 
area/crop is affected by fire 

3. Light: Where less than 10% of the 
area/crop is affected by fire 

4. No Fire: Self explanatory 

1. Observe the area ocularly within 
the plot and assess the severity of 
damage as per description of each 
category 

2. Then record the category accord-
ingly from the drop-down list in the 
electronic form or tick appropri-
ately for the paper form.  

38 Type of forest fire  Refers to type of forest fire and is clas-
sified as one of the following catego-
ries: 

1. Underground fire: fire spreading un-
der the surface through roots or any 
other underground means 

2. Surface fire: Fire spreading through 
ground cover, vegetation and litters 
without reaching the tree canopies 

3.  Crown fire: Fire spreading through 
the canopies of woody vegetation 

4. Not Sure/not known: If the nature of 
forest fire cannot be ascertained 

5. Not applicable: When no fire inci-
dence is evident  

1. Classify the type of forest fire that 
had affected the area, as per defini-
tion provided 

2. Then record the appropriate cate-
gory from the drop-down list in the 
electronic form or tick appropri-
ately for paper forms. 

39 Grazing  Refers to presence or absence of evi-
dence of grazing. 
 

1. Observe ocularly for evidence of 
presence or absence of grazing 
within the plot and 12.62 m around 
the PC. 

2. Then record as; 
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a. Yes: When there are signs of graz-
ing, presence of livestock or sight-
ing of cattle or dung etc. 

b. No: When there is no evidence of 
grazing. 

c. Not sure: When you are not sure 
40 Intensity of grazing  Refers to the severity of grazing and 

shall be classified as: 
1. Low 
2. Moderate 
3. Severe 
4. No grazing 

1. Observe ocularly for evidence of 
severity of grazing within the plot 
and 12.62 m around the PC. 

2. Then make expert judgement and 
record the extent of grazing class 
from the drop-down list for elec-
tronic form or tick appropriately on 
the paper form. 

41 Timber extraction  Refers to evidence of timber being ex-
tracted from the plot. 

1. Observe for evidence of timber ex-
traction within the plot and 12.62 m 
around PC. 

2. Record as “Yes” if there is evidence 

of extraction, otherwise “No”. 
42 Type of Timber Ex-

traction  
Refers to type of timber extraction in 
the plot and shall be categorized in 
one of the following: 

1. Clear felling: Felling of all trees in the 
area 

2. Selective felling: Felling of trees se-
lectively/few trees felled 

3. Group felling: Felling of trees in 
group/patch 

4. Others 
5. No felling 

1. Observe and record the observation 
by selecting the type of timber ex-
traction appropriately from drop-
down list for electronic form or tick 
appropriate type of timber extrac-
tion on the paper form 
 
 

43 Mining Refers to evidence of presence or ab-
sence of mining in the plot 

1. Observe ocularly in the plot for ev-
idence of presence or absence of 
mining in the plot and 12.62 m 
around the PC. 

2. Record “Yes” if there is presence of 

mining, otherwise “No”. 
44 Type of Mining Refers to type of mining and shall be 

categorized as: 
1.Yes, Surface collection 
2. Yes, quarry 
3. None 
4. Don’t know 

1. Observe ocularly within plot 
and 50 m around the PC; and 
record your observation as; 
a. Yes, surface collection 
b. Yes, quarry 
c. Don’t know 

45 Transmission lines Refers to the transmission wires run-
ning over-head and/or existence of 
transmission poles. 

1. If the transmission line runs over 
the plot or presence of electric 
poles within plot or boundary, 
then it shall be recorded as 
“Yes”, otherwise “No”. 

46 Garbage Refers to presence or absence of gar-
bage and shall be categorized as: 

1. Food wrappers 
2. PET bottles 

1. Observe within the plot for evi-
dence of any garbage/wastes. 
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3. Construction wastes:  
4. All of above 
5. None 

2. Record the observation under 
any one of the relevant catego-
ries by selecting from the drop-
down list for electronic form or 
tick appropriately on the paper 
form 

Litter, Humus and Fuel bed 
47 Litter Depth Value Refers to the depth of litter on the for-

est floor, measured in centimeters. 
Litter can be defined as the surface 
layer of the forest floor consisting of 
freshly fallen leaves, needles, twigs, 
stems, bark, and fruits. The decompo-
sition would have just begun in this 
layer. 

1. Measure the Litter depth at three 
random points in the plot, using a 
measuring scale. 

2. Record the average value to the 
nearest decimal in centimeters. 

47 Humus Depth 
Value 

Humus is the layer just below the litter 
and comprises of highly decomposed 
organic matter. There shall be no dis-
cernible plant parts.  

1. Measure the Humus depth at three ran-
dom points in the plot, using a measur-
ing scale. 

2. Record the average value to the nearest 
decimal in centimeters.  

42. Fuelbed Depth 
Value 

The accumulated mass of dead, 
woody material on the surface of the 
forest floor.  
It begins at the top of the duff/humus 
layer, and includes litter, fine and 
coarse wood debris and dead woody 
shrubs.  

1. Measure the fuel depth at three ran-
dom points in the plot.  

2. Record the average value to the 
nearest decimal in centimeters.  

43. Litter Cover percent Refers to the coverage of the litter 
measured as a percentage of the total 
area of the plot. 

3. Record the cover percent of litter in 
the 12.62 m radius plot. 

44. Bare soil cover per-
cent 

The extent of plot area that is not cov-
ered by litter and is indicated as the 
percentage of total area. 

4. Record the bare soil cover percent 
in the 12.62 m radius plot. 

Soil 
45. Stoniness Refers to cover percent of stones in 

the 12.62 m radius plot area. The ston-
iness of the plot area may be classified 
as:  

1. None  
2. Rare, <10 percent  
3. Few, 10-20 percent  
4. Common, 20-30 percent  
5. Many, 30-60 percent  
6. Abundant, >60 percent  

1. Walk around the plot and assess the 
area for stoniness. 

2. Record your observations by select-
ing the most appropriate category 
from the drop-down list on the elec-
tronic form or tick appropriately on 
paper form 
 

46. Soil drainage The drainage capacity of the soil is 
observed and classified as under:  

1. Poorly drained: Water removed 
slowly; soil remains wet with water 
table near the surface for considerable 
part of the time. 

1. Observe ocularly in the plot. 
3. Select and record the most appro-

priate soil drainage category based 
on the definition provide.  
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2. Imperfectly drained: Water removed 
slowly; soil remains wet for signifi-
cant part of the year; mottles present 
within 75 cm of the soil. 

3. Moderately drained: Water removed 
somewhat slowly and soil remains 
wet for small part of the time. Mottles 
observed below 75 cm. 

4. Well drained: Water removed rap-
idly. No mottles 

47. Top soil moisture Refers to the moisture content of the 
top soil at the time of data collection 
and classified as:  

1. Dry  
2. Slightly moist  
3. Moist  
4. Wet  
5. Water-logged. 

1. Select and record the most appro-
priate category of top soil moisture 
from the drop-down list on elec-
tronic form or tick appropriately on 
the paper form.  

48. Top soil colour Refers to the colour of the soil and 
classified as:  

1. Dark  
2. Reddish  
3. Yellowish  
4. Others  

1. Select and record the most appro-
priate top soil color from the drop-
down list on electronic form or tick 
appropriately on paper form.  

2.  

49 Top soil texture Refers to assessment of the soil tex-
ture, which shall be classified as:  

1. Sand  
2. Sandy loam  
3. Loam  
4. Silty Loam 
5. Silt 
6. Clay loam  
7. Clay  

Refer the Table 1.32. 

1. Feel the soil particles and assess the 
texture as instructed in the field 
guide provided in Table 1.32. 

2. Record your observation.  
 

Water Bodies 
50 Stream  Stream refers to any flow of water in 

a channel or bed, as a brook, rivulet or 
small river. 

1. If there is a stream within the plot 
or 25 m around the plot, record as 
“Yes”, otherwise “No”. 

51 River A large natural stream of water fol-
lowing in a channel to a sea, a lake or 
to another river. 

2. If there is a river within the plot or 
25 m around the plot, record as 
“Yes”, otherwise “No”. 

52 Wetland/Marshy 
area 

Refers to any inundated /waterlogged 
area or areas with ponds.  
 

3. If the plot area or area within 25 m 
radius from the PC, shows water-
logged/swampy conditions, then 
record as “Yes” else “No”  

53 Lakes A lake is a body of relatively still 
fresh or salt water of considerable 
size, localized in a basin, which is 
surrounded by land apart from a river, 
stream, or other form of moving water 
that serves to feed or drain lake. 

1. If there is lake (irrespective of the 
category) within the plot or within 
25 m radius from the PC, record as 
“Yes” else “No”. 
 

http://en.wikipedia.org/wiki/Depression_(geology)
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Table 1.30 Land Use and Land Class (source: IPCC GPG for LULUCF, 2000) 

Forest land: This category includes all land with woody vegetation consistent with thresholds used to 

define forest land in the national GHG inventory, sub-divided into managed and unmanaged, and also 

by ecosystem type as specified in the IPCC Guidelines3. It also includes systems with vegetation that 

currently fall below, but are expected to exceed, the threshold of the forest land category.  

Cropland: This category includes arable and tillage land, and agro-forestry systems where vegetation 

falls below the thresholds used for the forest land category, consistent with the selection of national 

definitions.  

Grassland: This category includes rangelands and pasture land that is not considered as cropland. It 

also includes systems with vegetation that fall below the threshold used in the forest land category 

and are not expected to exceed, without human intervention, the threshold used in the forest land 

category. The category also includes all grassland from wild lands to recreational areas as well as agri-

cultural and silvi-pastural systems, subdivided into managed and unmanaged consistent with national 

definitions. 

Wetlands: This category includes land that is covered or saturated by water for all or part of the 

year (e.g., peatland) and that does not fall into the forest land, cropland, grassland or settlements 

categories. The category can be subdivided into managed and unmanaged according to national defini-

tions. It includes reservoirs as a managed sub-division and natural rivers and lakes as unmanaged sub-

divisions. 

Settlements: This category includes all developed land, including transportation infrastructure and 

human settlements of any size, unless they are already included under other categories. This should 

be consistent with the selection of national definitions. 

Other land: This category includes bare soil, rock, ice, and all unmanaged land areas that do not 

fall into any of the other five categories. It allows the total of identified land areas to match the 

national area, where data are available. 

  

(Source:en.wikipe-
dia.org/wiki/Lake). 
Lakes can be Alpine lake, Sub-alpine 
lakes, Glacier lakes, Supra Glacial 
lake, Supra snow lake or Tsho. 

54 Remarks Any other additional information that 
crew might want to give. 

1. Crew can provide an additional in-
formation relevant to the cluster 
plot, if any.  
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Table 1.31 Forest Types of Bhutan 

Sl. 
No 

Forest Type Code Characteristics Characteristic species 

1 Subtropical 
Forest 

STFr • Contain many tropical genera 
and species, forming dense jun-
gle 

• Scattered Sal trees in Sarbang 
areas  

• Altitudinal range: 200-1000 
m (-1200m) 

Acraocarpus fraxinifolius,  
Ailanthus grandis,  
Bombax ceiba,  
Crateva regiliosa,  
Dellinia pentgyna,  
Duanbanga grandiflora.  
Gmelina arborea,  
Leea asiatica,  
Musa, Pnadanus,  
Pterospermum aceriflolium,  
Shorea robusta,  
Tetremeles nudiflora, 
Thunbergia 

2 Warm Broad-
leaved Forest 

WBFr • Type of Subtropical forest, but 
occurs at higher altitude with 
lower rainfall 

• Contains mixture of Evergreen 
and deciduous broad-leaved 
species 

• Many of the tropical genera e.g. 
Duabanga, Pterospermum and 
Tetrameles are absent 

• Altitudinal range: 1000-
2000m(-2300m) 

Alangium chinensis, Altingia 
excels, Bischofia javanica 
Calicarpa arborea, Cas-
tanopsis indica, 
Cordia oblique, Dendrocala-
mus hookeri 
Dichroa febrifuga, Engelhar-
dia spicata, 
Eoudia fraxinifolia, Maca-
ranga pustulata, 
Maesa spp., Mussaenda rox-
burghii, Pouzolzia sanguine, 
Raphidophora eximea, Schima 
wallichi, Wandlandia puberula 

3 Chirpine For-
est  

CPFr • Low-altitude xerophytic forest 
occurring in the deeper dry val-
leys of Bhutan 

• Almost no other tree species 
occur in such forest other than 
Chirpine 

• Altitudinal range:900-1800 
m(-2000m) 

Buddleja asiatica,  
B. bhutanica, Cycas pectinata, 
Cymbopogon flexuosus, Eu-
phobia royleana,   
Ficus obligodon, Grewia sap-
ida 
Indigofera dosua, Rhus panic-
ulata, Zizyphus incurve 

4 Cool Broad-
leaved Forest 

CBFr • Found on moist exposed slopes 
• Mixed forest in which oaks are 

LESS COMMON and other 
trees, both deciduous and ever-
green, e.g. Lauraceae, Exbuck-
landia etc., are more abundant 
together with dense shrubs, 
climbers and epiphytes 

Acer campbelli, A. sterculia-
ceum,  
Betula alonoides, Brassiopsis 
alpine,  
Chirita lachensis, Corylopsis 
himalayana, Elatostema mo-
nandrum, E. obtusum, Exbuck-
landia populnea,  
Ilex fragilis, Lecanthus pedun-
cularis, Lindera neesiana, L. 
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• Altitudinal range:2000-
2900m 

pulcherrima, Persea 
clarkeana, Pilea bracteosa,  
Rosa moschata, Rubus line-
atus, Schisandra grandiflora, 
Symplocus dryiphila 

5 Evergreen Oak 
Forest 

EOFr • Characteristic feature of some 
parts of Central Bhutan (for e.g. 
Trongsa and hills above Mon-
gar) 

• Composition varies according 
to altitude and rainfall 

• At lower levels, Castanopsis 
hystrix and C. tribuloides are 
often dominant, higher up 
Quercus lamellose becomes 
commoner 

• With increasing dryness, more 
xerophytic Quercus spe-
cies,e.g. Q.lanata,Q.grifithii 
and Q.semicarpifolia and Pinus 
wallichiana are seen 

• Not much shrub layer, whilst 
shady humid floors are domi-
nated by small herbs 

• Altitudinal range: (1800-
)2000-2600m 

Acer campbelli, Castanopsis 
hystrix, C. tribuloides, Elato-
stema hookerianum, E. sessile, 
Galeola lindleyana, 
Juglans regia, Pilea symmeria, 
Quercus lamellose, Skimmia 
arborescens, Symplocus lucida 

6 Blue Pine For-
est 

BPFr • Temperate equivalent of 
Chirpine forest and occupies 
the dry valleys of Bhutan 

• Bluepine dominant with Quer-
cus species in some places 

• Xerophytic shrubs occurs and 
herbs mostly appear during the 
monsoon season 

• Altitudinal range: 2100-
3000(-3200) m 

Berberis asiatica, Berchemia 
edgeworthii,  
Cotoneaster griffithii, Eleag-
nus parviflora, Euonymus 
grandiflorus, Indigofera heter-
antha, Jasminium humile, 
Prinsepia utilis, Lyonia ovali-
folia, Quercus griffithii, 
 Q.semicarpifolia, Rhododen-
dron arboretum, Rosa sericea, 
Spirea canescens, Zanthoxy-
lum armatum 
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7 Spruce Forest SPFr • Spruce forest with Hemlock 
and Fir forests occupy the mon-
tane cloud-forest zone of Bhu-
tan  

• Often mixed with each other 
but separate forests can fre-
quently be recognized 

• Spruce are found at lower alti-
tude than Hemlock and Fir 

• Altitudinal range:2700- 
3100(-3200) m 

Acer cappadocicum, A. pecti-
natum, Berberis praecipua, 
Enkianthus deflexus, Larix 
grifithiana,  
Lindera heterophylla, Osman-
thus suavis,  
Picea brachytyla, P. spinolosa, 
Salix daltiniana,  
Salvia campanulata, Taxus 
baccata 

8 Hemlock For-
est 

HMFr • Appears at higher altitude than 
Spruce where Tsuga dumosa is 
dominant species mixed with 
Spruce and Fir 

• Shrubby and arborescent rho-
dodendrons are frequent with 
dense growth of ferns, lichens 
and bryophytes 

• Altitudinal range: 2800-
3100m 

Arundinaria griffithiana, Bet-
ula utilis, Buddleja colvilei, 
Daphne bholua, Gaultheria 
fragmentissima, Larix griffithi-
ana, Litsea sericea, Maddenia 
himalaica, Magnolia globosa, 
Pnax pseudo-ginseng, Rhodo-
dendron falconeri, R. hodg-
sonis, R. keysii, Rubus 
calophyllus, R.pentagonus, 
Sorbus thibetica, Tsuga du-
mosa, Viburnum mullaha 

9 Fir Forest FIFr • Occurs in the highest ridges of 
Bhutan below tree line, where 
huge tracts are covered by no 
other tree species than Fir 
(Abies densa) and some Hem-
lock and Birch in places. 

• Luxuriant undergrowth of Rho-
dodendrons and other shrubs 
with many small herbs on 
mossy ground layer are found. 

• As tree lines are approached, 
the firs become stunted and are 
mixed with Junipers and 
smaller Rhododendron species 

• Altitudinal range: 3300- 
3800m 

Abies densa, Arundinaria ma-
ling, Betula utilis, Bryicarpum 
himalaicum, Daphne bholua, 
 Juniperus pseudosabina, 
Maddenia himalaica, 
 Primula denticulate, Prunus 
rufa, Rheum acuminatum, 
Rhododendron cinnabarinum, 
R. hodgsonii, Ribes tikare, 
Rubus fragariodes, Skimmia 
laureola, Sorbus foliolosa, Vi-
burnum nervosum 

10 Juniper-Rho-
dodendron 
Scrub 

JUSc • Moist scrub vegetation occur-
ring above treeline throughout 
Northern and Central Bhutan 

• Consists of scattered shrubs of 
Junipers, Rhododendron and 
Potentilla arbuscula but with 
rich herb layer appearing dur-
ing the monsoon 

Gaultheria trichophylla, Juni-
perus recurva, J.squamata, 
Morina nepalensis, Pedicu-
laris megalantha, Phlomis ti-
betica, Potentilla arbuscula, 
Primula sikkimensis, Rhoden-
dron lepidotum, Thalictrum 
chelidonii, Trollius purnilus 
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• Damp grassy meadow com-
monly found in this zone 

• Altitudinal range: 3700-
4200m 

11 Dry Alpine 
Scrub 

DASc • More xerophytic vegetation 
found  

• Higher altitude than Juniper-
Rhododendron Scrub 

• Altitudinal range: 4000-
4600m 

Aconitum orochryseum, 
Astragalus acaulis,  
Chesneya nubigena, Creman-
thodium thomsonii,  
Ephedra gerardiana, Meco-
nopsis calderiana,  
Rheum nobile, Rhododendron 
anthopogon,  
Salix lindleyana, Saussurea 
gossypiphora, S. obvallata, 
Saxifraga moorcroftiana, 
Tanacetum gossypinum, Ther-
mopsis barbata 

 

Table 1.32 Rough guide for identifying soil texture in the field 

Soil Texture Feel to fingers 
and visual 

Ball formation Stickiness Ribbon formation  

When dry When moist 

Sand Very gritty and 
individual 
grains visible, 
free flowing 
when dry 

Does not form ball 
(falls apart when 
pressure is re-
leased) 

Does not form 
ball (Ball crum-
bles when lightly 
touched) 

Does not 
stain fingers 

No ribbon for-
mation 

Sandy Loam Moderately 
gritty (sand 
characteristic 
predominate) 

Forms a ball 
which falls apart 
when lightly 
touched 

Forms ball but 
easily broken 

Stains the 
fingers 

No ribbon for-
mation 

Loam Neither very 
gritty nor very 
smooth 

Forms ball but 
easily broken 

Forms firm ball Stains the 
fingers 

No ribbon for-
mation 

Silt Loam Smooth or slick 
"buttery "feel".  

Forms ball but 
easily broken and 
has soft flour like 
feel 

Forms firm ball Stains the 
fingers 

Slight tendency to 
ribbon with flaky 
surface 

Silt smooth feel Forms firm ball Forms firm ball   Slight tendency to 
ribbon with flaky 
surface 

Clay Loam Slightly gritty 
feel 

Moderately hard 
ball  

Forms firm ball 
which can be 
handled freely 

Stains fin-
gers 

Ribbons on squeez-
ing but ribbon 
breaks easily 
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Clay Very smooth Forms ball without 
breaking 

Forms firm ball 
which can be 
handled freely 
and cannot be 
crushed with fin-
gers when dry 

Stains fin-
gers 

Squeezes out at 
right moisture into 
long ribbons 

 

2. Collecting and recording regeneration data (F2/7) 

Regeneration data shall be collected only from the circular subplot with 3.57 m radius which shall be laid around 
the Plot Center (PC). All tree species with diameter at breast height (DBH) less than 5 cm and located within 
3.57cm subplot shall be enumerated and recorded in the regeneration data form. 

SN Parameters Description/ Definition Instructions or how to fill in Data Dictionary 

1. Plot No This is the unique identification 
number given to Plot. Eg. 
KKFMU001 

1. Select correct Plot No from the drop-down 
list on electronic field form or record the 
correct Plot No, if the paper field form is 
used. 
Note: Paper Field Forms are to be used only 
if the android Tablet does not function in the 
field.   

2 Date Refers to date on which data was 
collected 
 

1. Record the date by clicking on calendar icon 
next to it on android tablet.  

2. If paper form is used, record the date ac-
cordingly. 

4 Time Refers to time of data collection 
which is auto-generated by the 
data logger/android tablet. 

1. Record the date by clicking on time icon 
next to it on android tablet.  

2. If paper form is used, record the date ac-
cordingly. 

5 Species 
/Scientific 
Name 

Refers to scientific or botanical 
name which conforms to the In-
ternational Code of Botanical 
Nomenclature (ICBN) 

1. Choose appropriate botanical name as it ap-
pears against it as drop-down list. 

 

6 Common 
Name/Local 
Name 

“Common name” refers to the 

commonly used name of that 
tree species in English or local 
dialect. 
"Local name" means name of 
tree in local dialect.  
For NFI, the local names in fol-
lowing dialects shall be used; 
Dzongkha (Dz), Tshanglha Kha 
(Ts), Lhotsham kha (Lh), 
Bumthangp (Bum), Khengkha 
(Kh), Trongsap (Tr) and 
Kurtoep (Kr). 

1. The Crew may note either the common 
name or the local name, or both, of the tree. 

2. In case of local name, Crew must specify di-
alect in which the local name has been 
given. (For Quercus griffithii, it is Bae-
nangshing in Tshanglha Kha, therefore, 
local name must be written as Bae-
nangshing (Ts), Ts indicates it is in 
Tshanglha Kha) 

  

7 Number of 
established 

Established seedlings are plants 
having height more than 2 m. 

1. Count the number of plants having DBH 
less than 5 cm and of height more than 2 m 
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regenera-
tions. 

within 3.57 m sub-plot and record the num-
ber. 

8 Number of 
un-estab-
lished re-
generation 

Un-established regeneration re-
fers to plants which are less than 
2 m height and are more than one 
year old. 

1. Count the number of plants having DBH 
less than 5 cm and of height less than 2 m 
within 3.57 m sub-plot and record the num-
ber. 

9 Number of 
recruits 

Recruits are very small plants 
having 2-4 leaves but are current 
years seedling 

1. Count the number of recruits and record the 
number 

10 Remarks  1. The Crew leader or the data recorder may 
add any additional information that may 
help in assessing regeneration status in the 
plot 

 

NOTE: If the plants cannot be identified by either Scientific name or local name or common name, then 

the plant shall be recorded as “UNKNOWN 1,2,3,4……” for that plot. A picture of the plant may be 

taken and, in the bracket, record the photograph number (e.g. UNKNOWN 1(DSC423)).  

 

2. Tree Data (F3/7) 

Tree is a woody perennial with a single main stem, or, in the case of coppice, with several stems, having a more 
or less definite crown (FAO 2005). Any woody perennial that meet the above definition of tree and has DBH 
of above 10 cm (both live and dead); and falls within 12.62 m are considered tree, for which data should be 
collected.  

SN Parameters Description/ Definition Instructions or how to fill in Data Dic-
tionary 

1 Plot No This is the unique identification number 
given to Plot. Eg. KKFMU001 

1. Select correct Plot No. from the 
drop-down list on electronic field 
form or record the correct Plot 
No, if the paper field form is 
used. 

Note: Paper Forms are to be used only if 
the android Tablet does not function in 
the field.   

2 Scientific 
Name 

Refers to scientific or botanical name 
which conforms to the International Code 
of Botanical Nomenclature (ICBN) 
 

1. Choose appropriate Botanical 
Name as it appears against it as 
drop-down list on electronic 
form. 

2. If the name of the plant is not in 
the list, then provision for typing 
the botanical name is also pro-
vided. 

3. If Paper forms have been used, 
record accordingly. 

3 Common 
Name/Local 
Name 

“Common name” herein is referred to the 

commonly used name of a tree in English. 
1. The Crew may note either the 

common name or the local name 
of the plant. 
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"Local name" means name of tree in local 
dialect.  
For NFI, the Local Names in following di-
alects shall be used; Dzongkha (Dz), 
Tshanglha kha (Ts), Lhotsham kha (Lh), 
Bumthangp (Bum), Khengkha (Kh), 
Mangdep kha (Mg) and Kurtoep kha (Kr). 

2. In case of local name, specify di-
alect in which the local name has 
been given.  
(For Quercus griffithii, it is Bae-
nangshing in Tshanglhakha, 
therefore, local name must be 
written as Baenangshing (Ts), 
Ts indicates it is in Tshanglha 
kha) 

4 DBH Refers to Diameter measured at Breast 
Height.  It is defined as a method of den-
drometric measurements wherein the Di-
ameter is measured at Breast Height 
which is 1.37 m height from the ground. 

1. Measure the DBH and record ac-
cordingly. 

2. Record DBH in centimeter (cm) 
to one decimal place. 

Note: Standard Rules for measuring 
DBH is given in  
 
 
 
Box 1.3 Standard rules for measuring 
Tree DBH. 

5 Total Height  Refers to the height of a tree which is the 
length of tree from Ground till tip of the 
tallest crown pr tallest part of the crown. 

1. Measure the height of tree using 
Hypsometer.  

2. Measure the height by standing 
on uphill side of the tree on a 
slope.  

3. Record the height in meters (m) 
to once decimal place.   

6 Bole Height The distance between ground level and 
crown point (the position of the first 
crown forming living or dead branch) is 
defined as Bole Height. 
However, for the purpose of NFI, the Bole 
height shall be referred to the distance be-
tween ground or base of tree to the point 
on the bole having approximately 10 cm 
diameter. 

1. Measure the bole height using 
hypsometer. 

2. Record the bole height in meter 
to one decimal place. 

3.  
Note: The measurement should 
be taken by standing on uphill 
side of the tree on a slope.  

7 Crown Length The vertical measurement of crown from 
the tip of the crown to the point, half way 
between lowest green branch forming 
green crown all around and the lowest 
green branch on the bole is Crown Length. 

1. Measure the crown length of tree 
using Hypsometer.  

2. Record the crown length in meter 
to one decimal place. 
Note: The measurement should 
be taken by standing on uphill 
side of the tree on a slope. 

8 Crown Posi-
tion 

This refers to the position of crown of a 
tree in relation to the adjacent trees. It is 
categorized as; 

a. Dominant Trees: Trees which 
form the upper most leaf canopy 

1. Observe ocularly and select the 
appropriate category of crown 
position of tree from the drop-
down list on electronic form or 
tick appropriately on paper form. 
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and have their leading shoots free. 
These trees are called best trees. 

b.  Dominated Trees: Trees which 
do not form part of the upper most 
leaf canopy but leading shoots of 
which are definitely not over-
topped by neighboring trees. 
Their height is about 3/4 of the 
tallest tree which falls within the 
plot. 

c.  Suppressed Trees: Trees which 
reach only about 1/2 to 5/8 of the 
height of the best trees, with their 
shoots over-topped by the neigh-
boring trees. 

d. Solitary Trees: Trees which 
stand scattered or stand individu-
ally.   

e. Not Applicable: This option is to 
be selected when the tree is dead 
& has no crown. 

9 Condition of 
Tree 

Refers to state of the tree. The condition 
of the tree shall be categorized as: 

1. Healthy: Tree is free of disease or 
abnormality and damage.  

2. Diseased: Tree is infected with 
pests and diseases. 

3. Abnormal and Damaged: Tree 
is moribund, damaged or hol-
lowed, etc. 

4. Dead: Tree has utility less than 
70%.  

1. Observe and record the condition 
of tree by choosing the appropri-
ate category from the drop-down 
option on the electronic form or 
tick appropriate category on pa-
per form. . 

10 Bark Thick-
ness 

Refers to thickness or amount of bark 
around a tree from outer surface till cam-
bium/wood of a tree. 

1. Measure the Bark thickness 
using Bark gauge. 

2. Measure the bark thickness 
at DBH. 

3. Press Bark gauge against 
bark until wood is reached 
and read the scale to deter-
mine bark thickness.  

4. Record the bark thickness in 
centimeter to one decimal 
place.               

11 Remarks Any useful remarks related to this partic-
ular tree 

1. Crews may or may not provide 
remarks. 
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Box 1.3 Standard rules for measuring Tree DBH 

STANDARD RULES FOR MEASURING DIAMETER AT BREAST HEIGHT (DBH) 

Diameter at Breast Height (DBH) is the diameter of a tree measured at 1.37m above ground.  The DBH 

over bark and under bark are abbreviated as DBH (O.B) and DBH (U.B) respectively. A few but very 

important rules one must follow while measuring DBH are; 

1. Loose bark/ creepers/mosses if found on the tree especially near breast height shall be re-

moved before measuring the diameter. 

2. Mark BH by means of measuring stick or white paint or a soft nail (e.g. aluminum) driven into 

the bark or a scribe mark. 

 

 

 

 

 

3. On a Flat ground and if the tree is straight, the DBH is taken as depicted in figure below; 

 

 

 

 

 

4. If the ground is flat and the tree is leaning, thenmeasure DBH parallel to the tree stem and 

not vertically, on the side of the lean as shown below. 

 

 

 

 

 

5. On a sloping ground with straight tree, the DBH is measured from the up- hill side as shown 

below. 

 

 

 

 

 

 

 

B.H 

1.37 m 
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6. On a sloping ground with tree leaning against the direction of slope, measure DBH parallel the 

tree stem and not vertically, on the side of the lean as shown below. 

 

7. On sloping ground with tree leaning towards uphill slope, measure DBH parallel to the tree stem 

and not vertically, on the side of the lean as shown below. 

 

 

 

 

 

 

 

 

 

 

 

8. If the tree stem is abnormal at Breast Height level, DBH is measured not exactly at 1.37 m but 

measurement mark is slightly shifted up or down (as little as possible) to a more normal position 

of the stem as shown below.  

 

 

 

 

 

 

 

9. If the stem is Forked, then  

 

 

                                                           

1.37m 

B.H 

B.H 

1.37 
m 

Count as One Trees Count as Two Trees Count as One or Two Trees de-
pending on place of measure-

ment 
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10. Tree stem has buttress at breast height level, then DBH is measured at the lowest point above 

which the abnormal formation is not likely to extend. 

 

 

 

 

 

 

  

1.37 m 

B.H 

Buttress 
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4. Sapling Data (F4/7) 

All tree species having DBH above 5 cm but less than 10 cm shall be identified as Sapling. Sapling data shall 
be collected within 12.62 m radius plot  

SN Data Items Description/Definition Instructions 
1 Plot  No This is the unique identification num-

ber given to Plot. Eg. KKFMU001 
1. Select correct Plot No from the drop-

down list on electronic field form or 
record the correct Plot No, if the pa-
per field form is used. 

Note: If Paper Field Forms are to be used only 
if the android Tablet does not function in the 
field.   

4 Scientific 
Name 

Refers to scientific or botanical name 
which conforms to the International 
Code of Botanical Nomenclature 
(ICBN). 
 

1. Choose appropriate Botanical Name 
as it appears against it as drop-down 
list on electronic form. 

2. If the name of the plant is not in the 
list, then provision for typing the bo-
tanical name is also provided. 

3. If Paper forms have been used, record 
accordingly. 

5 Common 
Name/Local 
Name 

“Common name” herein is referred to 

the commonly used name of a tree in 
English. 
"Local name" means name of tree in 
local dialect.  
For NFI, the Local Names in following 
dialects shall be used; Dzongkha (Dz), 
Tshanglha kha (Ts), Lhotsham (Lh), 
Bumthangp (Bum), Khengkha (Kh), 
Trongsap (Tr) and Kurtoep (Kr). 

1. The Crew may note either the com-
mon name or the local name of the 
plant. 

2. In case of local name, Crew must 
must specify dialect in which the lo-
cal name has been given.  

(For Quercus griffithii, it is Baenangshing in 
Tshanglha kha, therefore, local name must 
be written as Baenangshing (Ts), Ts indi-
cates it is in Tshanglha kha ). 

6 Number of 
individuals 

Refers to the number of saplings of that 
particular species found within a plot. 

1. Count the number of saplings of one 
species and record the observation. 

Note: If there are more than one species, open 
same electronic field form (electronic form) 
and fill it up as being done for first species. 

2. For paper field forms, write the spe-
cies name and record the number ac-
cordingly. 

7 Average dbh Refers to average dbh of sapling of a 
particular species 

1. Obtain average dbh of sapling and 
record in cm to nearest one decimal 
place.  

8 Average 
height  

Refers to the average height of sapling 
in meters  

1. Record the average height of the sap-
ling in meters  

9 Cover per-
cent  

Refers to the percentage of the plot 
area that is covered by sapling.  

1. Ocularly estimate as to the extent of 
coverage of sapling within 12.62 m 
plot and record it in terms of percent-
age. 

10 Remarks Any useful remarks related to the sap-
ling 

1. Crews may or may not provide re-
marks. 
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5. Wildlife Data  

The FMU inventory shall also collect some information on wildlife. Wildlife field forms shall collect data on 
Mammals, Birds and Reptiles separately as described. 

Mammal data (F5/7) 

SN Data Item Definition/Description Instruction 
1 Plot No. This is the unique identification 

number given to Plot No. Eg. 
KKFMU001  
 

1. Select correct Plot No from the drop-
down list on electronic field form or 
record the correct Plot No, if the paper 
field form is used. 

Note: If Paper Field Forms are to be used only 
if the android Tablet does not function in the 
field.   

2 Mammal spe-
cies 

Refers to identity of the particular 
mammal that has been sighted or 
identified. 
The list of mammals shall be pro-
vided in Table 1.33. 

1. Select from the drop-down list and rec-
ord the mammal sighted or identified 
from the evidence on electronic field 
form or write down on the paper field 
form. 

2. Select “None” if no mammal is ob-

served. 
3 Mammal evi-

dence  
Refers to the type of evidence using 
which mammal is identified. The 
categories are: 

1. Direct sighting 
2. Sound/calls 
3. Dung/Pellets/Scats 
4. Skeleton/Cadaver 
5. Horns/Antlers 
6. Footprints/pugmarks 
7. Tracks/Paths 
8. Burrow/Den 
9. Browsing 
10. Debarking 
11. Fraying 
12. Digging 
13. Not relevant 

1. Select the appropriate evidence type 
and record. 

2. Not relevant should be selected when 
there are no mammals sighted or ob-
served in the 25 m radius. 

4 Species name Refers to the mammal species 
sighted or observed but not listed in 
above list. Can be local or common 
name 

1. If the mammal is sighted but not listed 
in the above list or not known, write the 
common or local name. 

5 Remarks Refers to any other relevant infor-
mation to be added by the crew. 

1. The Crew Leader or the data recorder 
may add any additional information on 
mammal 
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Table 1.33 List of mammals 

Sl. No Scientific Name Common Name 

1 Hipposideros Pomona Andersen's Leaf-nosed Bat 

2 Soriculus macrusus Arboreal Brown Toothed Shrew 

3 Elephas maximus Asian elephant 

4 Barbastella leucomelas  Asian/Eastern Barbestelle Bat 

5 Scotophilus heathi Asiatic Greater Yellow Bat 

6 Bubalus arnee Asiatic Water Buffalo 

7 Macaca assamenis Assamese Macaque 

8 Soriculus baileyi Bailey's Shrew 

9 Tylonycteris pachypus  Bamboo Bat 

10 Muntiacus mutjak Barking Deer 

11 Martes foina Beech or Stone marten 

12 Vulpes bengalensis Bengal Fox 

13 Arctictis binturong Binturong/ Asian Bearcat 

14 Rattus rattus Black Rat/ House Rat 

15 Taphozous melanopogon Black-bearded Tomb Bat 

16 Ochotana curzoniae Black-lipped Pika3 

17 Lepus nigricollis Blacknaped Hare 

18 Sphaerias blansfordi Blanford's Fruit Bat 

19 Pseudois nayaur Blue sheep 

20 Rhinolophus Lepidus Blyth's Horseshoe Bat 

21 Plecotus auritus Brown long-eared Bat 

22 Mus platythrix Brown Spiny Field Mouse 

23 Trachypithecus pileatus Capped Langur 

24 Rhinolophus subbadius Chestnut Horseshoe Bat 

25 Manis pentadactyla Chinese Pangolin 

26 Axis axis Chital/spotted Deer 

27 Pipistrellus affinis  Chocolate Pipistrelle 

28 Neofelis nebulosa Clouded leopard 

29 Nyctalus noctula Common Noctule 

30 Herpestes edwardsii Common or Grey Mongoose 

31 Lutra lutra Common Otter 

32 Paradoxurus hermaphroditus Common Palm Civet 

33 Ochotona roylei Common Pika 

34 Pipistrellus pipistrellus Common Pipistrelle 

35 Eptesicus serotinus  Common Serotine Bat 

                                                      

 

3 Source: Nature Conservation Division, Department of Forests and Park Servcies 
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36 Herpestes urva Crab-eating Mongoose 

37 Cuon alpinus primaevus Dhole/ Wild Dog 

38 Scotozous dormer Dormer's Bat 

39 Leopoldamys edwardsi Edward's Rat 

40 Nectogale  elegans Elegant/Tibetan water Shrew 

41 Mus saxicola Elliot's Spiny Mouse 

42 Mus cervicolor Fawn-coloured Mouse 

43 Prionailursus viverrinus Fishing cat 

44 Ochotana forresti Forrest's Pika 

45 Rousettus leschenaultia Fulvous Fruit bat 

46 Hipposderous fulvus  Fulvus Leaf-nosed Bat 

47 Platanista gangetica Ganges River Dolphins 

48 Bos gaurus Gaur 

49 Ochotana gloveri Glover's Pika 

50 Catopuma temmincki Golden cat 

51 Trachypithecus geei Golden Langur 

52 Nemorhaedus goral Goral 

53 Petaurista caniceps Gray-Headed Flying Squirrel 

54 Petaurista noblis  Gray's Giant Flying Squirrel 

55 Ia io Great Evening Bat 

56 Rhinolophus luctus Great Indian Horse shoe bat 

57 Rhinoceros unicornis Great one-horned Rhinoceros 

58 Murina leucogaster Great Tube-nosed Bat 

59 Bandicota indica Greater Bandicot Rat 

60 Megaderma lyra Greater False Vampire Bat 

61 Hipposiderous arminger Greater Himalayan Leaf-nosed bat 

62 Rhinolophus ferrumequinum Greater Horseshoe Bat 

63 Semnopithecus entellus Grey Langur/ Hanuman Langur 

64 Crocidura attenuate Grey/Woodland Shrew 

65 Myotis annectans  Hairy-faced Bat 

66 Harpiocephalus harpia Hairy-winged Bat 

67 Kerivoula hardwickii Hardwicke's forest Bat 

68 Scotomanes ornatus  Harlequin Bat 

69 Macroglossus sobrinus Hill Long- tongued Fruit bat 

70 Ursus thibetanus laniger Himalayan Black Bear 

71 Petaurista magnificus Himalayan Flying Squirrel 

72 Paguma larvata Himalayan Palm Civet 

73 Rattus nitidus  Himalayan Rat 

74 Capricornis sumatraensis Himalayan Serow 

75 Soriculus nigrescens Himalayan Shrew/ Sikkim Large Clawed Shrew 

76 Alticola stoliczkanus Himalayan Vole 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        125 

77 Mustela sibirica Himalayan Weasel 

78 Martes flavigula Himalayan Yellow-Throated Marten 

79 Chimarrogale himalayica Himalyan Water Shrew 

80 Canis lupus HimilayanWolf/ Tibetan Wolf 

81 Caprolagus hispidus Hispid Hare 

82 Myotis formosus Hodgson's Bat 

83 Soriculus caudatus Hodgson's Brown Toothed Shrew 

84 Arctonyx collaris Hog badger 

85 Axis porcinus Hog Deer 

86 Hipposiderous larvatus  Horsefield's Leaf-nosed Bat 

87 Crocidura horsfieldi Horsefiled's Shrew 

88 Mus musculus House Mouse 

89 Suncus murinus House/Musk Shrew 

90 Murina huttoni Hutton's Tube-nosed Bat 

91 Golunda ellioti Indian Bush Rat 

92 Pteropus giganteus  Indian Flying Fox 

93 Soriculus leucops Indian long-tailed Shrew 

94 Manis crassicaudata Indian Pangolin 

95 Pipistrellus coromandra Indian Pipistrelle 

96 Rhinolophus affinis Intermediate Horseshoe Bat 

97 Pipistrellus javanicus  Javan's Pipistrelle 

98 Felis chaus Jungle Cat 

99 Hipposiderous lankadiva Lankadiva Bat 

100 Pipistrellus circumdatus Large Black Pipistrelle 

101 Viverra zibetha Large Indian civet 

102 Rhinolophus macrotis Large-eared Horseshoe bat 

103 Ochotona macrotis  Large-eared Pika 

104 Melogale personata Large-toothed Ferret Badger 

105 Dacnomys millardi Large-toothed Rat 

106 Hipposiderous ater Dusky Leaf-nosed Bat 

107 Rhinolophu pusillus Least Horseshoe Bat 

108 Hipposiderous cineraceus Least Leaf- nosed Bat 

109 Panthera pardus Leopard 

110 Prionailursus bengalensis Leopard cat 

111 Bandicota bengalensis Lesser Bandicot Rat 

112 Cynopterus brachyotis  Lesser Dog-faced Fruit bat 

113 Megaderma spasa Lesser False Vampire Bat 

114 Sorex bedfordia Lesser Stripe-backed Shrew 

115 Myotis sicarius  Little Brown bat 

116 Niviventereha Little Himalayan Rat 

117 Murina aurata Little Tube-nosed Bat 
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118 Vandeleuria oleracea Long-tailed Tree Mouse 

119 Eonycteris spelaea Long-tongued Fruit Bat 

120 Canis aureus Lower Risk 

121 Lynx lynx Lynx 

122 Pardofelis marmorata Marbled cat 

123 Bos frontalis Mithun 

124 Ochotona thibetana Moupin's Pika 

125 Moschus chrysogaster Musk Deer 

126 Taphozous nudiventris Naked-rumped Tomb Bat 

127 Myotis muricola Nepalese- whiskered Bat 

128 Megaerops niphanae Niphan's Tailless Fruit bat 

129 Tupaia belangeri Northern Tree Shrew 

130 Rattus norvegicus Norway Rat 

131 Ochotana nubrica Nubra Pika 

132 Kerivoula picta Painted Bat 

133 Mustela altaica Pale Weasel 

134 Felis manul Pallas cat 

135 Hylopetes alboniger Parti-coloured Flying Squirrel 

136 Pipistrellus paterculus  Paternal Pipistrelle 

137 Belomys pearsoni Pearson's / Hairy footed Flying Squirrel 

138 Rhinolophus pearsonii Pearson's Horseshoe bat 

139 Minopterus pusillus  Pusillus Long- Fingered Bat 

140 Sus salvanius Pygmy hog 

141 Pipistrellus mimus Pygmy Pipistrelle 

142 Sorex minutes Pygmy Shrew 

143 Suncus etruscus Pygmy White-toothed Shrew 

144 Cervus elaphus wallichi Red deer/Sikkim Red Deer 

145 Vulpes vulpes Red Fox 

146 Petaurista petaurista Red Giant Flying squirrel 

147 Ailurus fulgens Red Panda 

148 Macaca mulatta Rhesus Macaque 

149 Murina cyclotis Round- eared Tube-nosed bat 

150 Rhinolophus rouxii Rufous Horseshoe Bat 

151 Minopterus schreibersii Schreiber's Long Fingered Bat 

152 Talpa micrura Short - tailed Mole 

153 Cynopterus sphinx Short- nosed Fruit Bat 

154 Mus pahari Sikkim Mouse 

155 Rattus sikkimensis Sikkim Rat 

156 Microtus sikimensis Sikkim Vole 

157 Melursus ursinus Sloth Bear 

158 Nycticebus Bengalensis Slow Loris 
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159 Cervus unicolor Smabar 

160 Viverricula indica Small India Civet 

161 Herpestes javanicus Small Indian Mongoose 

162 Amblonyx cinerus Small-Clawed Otter 

163 Melogale moschata Small-toothed Ferret Badger 

164 Myotis siligorensis Small-toothed Whiskered Bat 

165 Lutrogale perspicillata Smooth Coated Otter 

166 Uncia uncial Snow Leopard 

167 Millardia meltada Soft-furred Field Rat/Metad 

168 Crocidura fuliginosa South east Asian White Toothed Shrew 

169 Peturista elegans  Spotted Giant Flying Squirrel 

170 Prionodon pardicolor Spotted Linsang 

171 Cervus duvauceli Swamp Deer 

172 Coelops frithi Tail-less Leaf-nosed Bat 

173 Budorcas taxicolor Takin 

174 Eptesicus tatei Tate's Bat 

175 Alticolastracheyi Thoma's Mountain Vole 

176 Pipistrellus cadornae Thomas's Pipistrelle 

177 Hesperoptenus tickelli Tickell's Bat 

178 Panthera tigris Tiger 

179 Rhinolophus trifoliatus Trefoli Horseshe Bat 

180 Rattus turkestanicus Turkestan Rat 

181 Myotis daubentonii Water Bat 

182 Myotis mystacinus Whiskered Bat 

183 Niniventer niniventer White-bellied Rat 

184 Sus scrofa Wild boar 

185 Apodemus sylavaticus  Wood Mouse 

186 Eupetaurus cinerus Wooly Flying Squirrel 

187 Lepus oiostolus Wooly Hare 

188 Bos grunniens Yak 

189 Mustela kathiah Yellow-Bellied Weasel 
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5. Bird Data (F6/7) 

SN Data Item Definition/Description Instruction 

1 Plot No. This is the unique identification 
number given to Plot No. Eg. 
KKFMU001  

 

2. Select correct Plot No from the drop-
down list on electronic field form or rec-
ord the correct Plot No, if the paper field 
form is used. 

Note: If Paper Field Forms are to be used only if 
the android Tablet does not function in the field.   

2 Bird species Refers to identity of the particu-
lar bird that has been sighted or 
identified. 

The list of birds shall be provided in  
Table 1.34 

1. Select from the drop-down list and record 
the bird sighted or identified from the ev-
idence on electronic field form or write 
down on the paper field form. 

2. Select “None” if no bird is observed. 

3 Bird evidence  Refers to the type of evidence 
using which the bird is identi-
fied. The categories are: 

1. Direct sighting 
2. Sound/calls 
3. Droppings 
4. Eggs 
5. Skeleton/Cadaver 
6. Feathers 
7. Footprints 
8. Tracks/Paths 
9. Nests/Burrows 
10. Not relevant 

1. Select the appropriate evidence type 
based on which the bird has been identi-
fied and record. 

2. “Not relevant” should be selected when 

there are no birds are sighted or observed 
in the 25 m radius from the PC. 

4 Species name Refers to the bird species 
sighted or observed but not 
listed in above list. Can be local 
or common name 

1. If the bird is sighted but not listed in the 
above list or not known, write the com-
mon or local name. 

5 Remarks Refers to any relevant infor-
mation on bird that crew pro-
vides. 

1. The Crew Leader or the data recorder 
shall add any additional information on 
birds. 
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Table 1.34 Lists of birds 

57 Anthracoceros albirostris Oriental Pied Hornbill

58 Anthreptes singalensis Ruby-cheeked Sunbird

59 Anthus campestris Tawny Pipit

60 Anthus cervinus Red-throated Pipit

61 Anthus godlewskii Blyth's Pipit

62 Anthus hodgsoni Olive-backed Pipit

63 Anthus richardi Richard's Pipit

64 Anthus roseatus Rosy Pipit

65 Anthus rubescens Buff-bellied Pipit

66 Anthus rufulus Paddyfield Pipit

67 Anthus spinoletta Water Pipit

68 Anthus trivialis Tree Pipit

69 Apus nipalensis House Swift

70 Apus acuticauda Dark-rumped Swift

71 Apus pacif icus Fork-tailed Swift

72 Aquila chrysaetos Golden Eagle

73 Aquila clanga Greater Spotted Eagle

74 Aquila hastata Indian Spotted Eagle

75 Aquila heliaca Eastern Imperial Eagle

76 Aquila nipalensis Steppe Eagle

77 Arachnothera longirostra Little Spiderhunter

78 Arachnothera magna Streaked Spiderhunter

79 Arborophila mandellii Chestnut-breasted Partridge

80 Arborophila rufogularis Rufous-throated Partridge

81 Arborophila torqueola Hill Partridge

82 Ardea cinerea Grey Heron

83 Ardea insignis White-bellied Heron

84 Ardea purpurea Purple Heron

85 Ardeola bacchus Chinese Pond Heron

86 Ardeola grayii Indian Pond Heron

87 Artamus fuscus Ashy Woodswallow

88 Asio f lammeus Short-eared Owl

89 Asio otus Long-eared Owl

90 Athene brama Spotted Owlet

91 Athene noctua Little Owl

92 Aviceda jerdoni Jerdon's Baza

93 Aviceda leuphotes Black Baza   
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37 Alcippe nipalensis Nepal Fulvetta

38 Alcippe rufogularis Rufous-throated Fulvetta

39 Alcippe vinipectus White-browed Fulvetta

40 Alophoixus flaveolus White-throated Bulbul

41 Amaurornis phoenicurus White-breasted Waterhen

42 Ampeliceps coronatus Yellow-crested Myna

43 Anas acuta Northern Pintail

44 Anas clypeata Northern Shoveler

45 Anas crecca Common Teal

46 Anas falcata Falcated Duck

47 Anas formosa Baikal Teal

48 Anas penelope Eurasian Wigeon

49 Anas platyrhynchos Mallard

50 Anas poecilorhyncha Indian Spot-billed Duck

51 Anas querquedula Garganey

52 Anas strepera Gadwall

53 Anastomus oscitans Asian Openbill

54 Anser albifrons Greater White-fronted Goose

55 Anser anser Greylag Goose

56 Anser indicus Bar-headed Goose

57 Anthracoceros albirostris Oriental Pied Hornbill

58 Anthreptes singalensis Ruby-cheeked Sunbird

59 Anthus campestris Tawny Pipit

60 Anthus cervinus Red-throated Pipit

61 Anthus godlewskii Blyth's Pipit

62 Anthus hodgsoni Olive-backed Pipit

63 Anthus richardi Richard's Pipit

64 Anthus roseatus Rosy Pipit

65 Anthus rubescens Buff-bellied Pipit

66 Anthus rufulus Paddyfield Pipit

67 Anthus spinoletta Water Pipit

68 Anthus trivialis Tree Pipit

69 Apus nipalensis House Swift

70 Apus acuticauda Dark-rumped Swift

71 Apus pacificus Fork-tailed Swift

72 Aquila chrysaetos Golden Eagle

73 Aquila clanga Greater Spotted Eagle  

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        131 

74 Aquila hastata Indian Spotted Eagle

75 Aquila heliaca Eastern Imperial Eagle

76 Aquila nipalensis Steppe Eagle

77 Arachnothera longirostra Little Spiderhunter

78 Arachnothera magna Streaked Spiderhunter

79 Arborophila mandellii Chestnut-breasted Partridge

80 Arborophila rufogularis Rufous-throated Partridge

81 Arborophila torqueola Hill Partridge

82 Ardea cinerea Grey Heron

83 Ardea insignis White-bellied Heron

84 Ardea purpurea Purple Heron

85 Ardeola bacchus Chinese Pond Heron

86 Ardeola grayii Indian Pond Heron

87 Artamus fuscus Ashy Woodswallow

88 Asio flammeus Short-eared Owl

89 Asio otus Long-eared Owl

90 Athene brama Spotted Owlet

91 Athene noctua Little Owl

92 Aviceda jerdoni Jerdon's Baza

93 Aviceda leuphotes Black Baza

94 Aythya baeri Baer's Pochard

95 Aythya ferina Common Pochard

96 Aythya fuligula Tufted Duck

97 Aythya nyroca Ferruginous Duck

98 Batastur teesa White-eyed Buzzard

99 Batrachostomus hodgsoni Hodgson's Frogmouth

100 Blythipicus pyrrhotis Bay Woodpecker

101 Brachypteryx hyperythra Rusty-bellied Shortwing

102 Brachypteryx leucophrys Lesser Shortwing

103 Brachypteryx montana White-browed Shortwing

104 Brachypteryx stellata Gould's Shortwing

105 Bradypterus luteoventris Brown Bush Warbler

106 Bradypterus seebohmi Russet Bush Warbler

107 Bradypterus tacsanowskius Chinese Bush Warbler

108 Bradypterus thoracicus Spotted Bush Warbler

109 Bubo bengalensis Indian Eagle Owl

110 Bubo bubo Eurasian Eagle Owl  
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111 Bubo nipalensis Spot-bellied Eagle Owl

112 Bubulcus ibis Cattle Egret

113 Buceros bicornis Great Hornbill

114 Burhinus indicus Indian Thick-knee

115 Buteo burmanicus Himalayan Buzzard

116 Buteo hemilasius Upland Buzzard

117 Buteo rufinus Long-legged Buzzard

118 Butorides striata Striated Heron

119 Cacomantis merulinus Plaintive Cuckoo

120 Cacomantis passerinus Grey-bellied Cuckoo

121 Cacomantis sonneratii Banded Bay Cuckoo

122 Cairina scutulata White-winged Duck

123 Calandrella acutirostris Hume's Short-toed Lark

124 Calandrella brachydactyla Greater Short-toed Lark

125 Calandrella cheleensis Asian Short-toed Lark

126 Calandrella raytal Sand Lark

127 Calcarius lapponicus Lapland Longspur

128 Calidris ferruginea Curlew Sandpiper

129 Calidris minuta Little Stint

130 Calidris temminckii Temminck's Stint

131 Callacanthis burtoni Spectacled Finch

132 Calmator jacobinus Jacobin Cuckoo

133 Caprimulgus affinis Savanna Nightjar

134 Caprimulgus asiaticus Indian Nightjar

135 Caprimulgus indicus Grey Nightjar

136 Caprimulgus macrurus Large-tailed Nightjar

137 Carduelis spinoides Yellow-breasted Greenfinch

138 Carpodacus edwardsii Dark-rumped Rosefinch

139 Carpodacus erythrinus Common Rosefinch

140 Carpodacus nipalensis Dark-breasted Rosefinch

141 Carpodacus pulcherrimus Beautiful Rosefinch

142 Carpodacus puniceus Red-fronted Rosefinch

143 Carpodacus rodochroa Pink-browed Rosefinch

144 Carpodacus rubescens Blanford's Rosefinch

145 Carpodacus rubicilloides Streaked Rosefinch

146 Carpodacus thura White-browed Rosefinch

147 Carpodacus trifasciatus Three-banded Rosefinch  
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148 Casmerodius albus Great Egret

149 Celeus brachyurus Rufous Woodpecker

150 Centropus bengalensis Lesser Coucal

151 Centropus sinensis Greater Coucal

152 Cephalopyrus flammiceps Fire-capped Tit

153 Certhia discolor Brown-throated Treecreeper

154 Certhia hodgsoni Hodgson's Treecreeper

155 Certhia nipalensis Rusty-flanked Treecreeper

156 Ceryle rudis Pied Kingfisher

157 Cettia acanthizoides Yellowish-bellied Bush Warbler

158 Cettia brunnifrons Grey-sided Bush Warbler

159 Cettia flavolivacea Aberrant Bush Warbler

160 Cettia fortipes Brownish-flanked Bush Warbler

161 Cettia major Chestnut-crowned Bush Warbler

162 Cettia pallidipes Pale-footed Bush Warbler

163 Ceyx erithacus Oriental Dwarf Kingfisher

164 Chaimarrornis leucocephalus White-capped Water Redstart

165 Chalcophaps indica Emerald Dove

166 Charadrius alexandrinus Kentish Plover

167 Charadrius dubius Little Ringed Plover

168 Charadrius leschenaultii Greater Sand Plover

169 Charadrius mongolus Lesser Sand Plover

170 Charadrius placidus Long-billed Plover

171 Chloropsis aurifrons Golden-fronted Leafbird

172 Chloropsis hardwickii Orange-bellied Leafbird

173 Chroicocephalus brunnicephalus Brown-headed Gull

174 Chroicocephalus genei Slender-billed Gull

175 Chroicocephalus ridibundus Black-headed Gull

176 Chrysococcyx maculatus Asian Emerald Cuckoo

177 Chrysococcyx xanthorhynchus Violet Cuckoo

178 Chrysocolaptes lucidus Greater Flameback

179 Chrysoma sinense Yellow-eyed Babbler

180 Ciconia episcopus Woolly-necked Stork

181 Ciconia nigra Black Stork

182 Cinclidium frontale Blue-fronted Robin

183 Cinclus cinclus White-throated Dipper

184 Cinclus pallasii Brown Dipper  
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185 Circaetus gallicus Short-toed Snake Eagle

186 Circus spilonotus Eastern Marsh Harrier

187 Circus aeruginosus Eurasian Marsh Harrier

188 Circus cyaneus Hen Harrier

189 Circus macrourus Pallid Harrier

190 Circus melanoleucos Pied Harrier

191 Cissa chinensis Common Green Magpie

192 Clamator coromandus Chestnut-winged Cuckoo

193 Clangula hyemalis Long-tailed Duck

194 Cochoa purpurea Purple Cochoa

195 Cochoa viridis Green Cochoa

196 Collocalia brevirostris Himalayan Swiftlet

197 Columba hodgsonii Speckled Wood Pigeon

198 Columba leuconota Snow Pigeon

199 Columba livia Common Pigeon

200 Columba pulchricollis Ashy Wood Pigeon

201 Columba rupestris Hill Pigeon

202 Conostoma oemodium Great Parrotbill

203 Copsychus malabaricus White-rumped Shama

204 Copsychus saularis Oriental Magpie Robin

205 Coracias benghalensis Indian Roller

206 Coracias garrulus Eurasian Roller

207 Coracina macei Large Cuckoo shrike

208 Coracina melaschistos Black-winged Cuckooshrike

209 Corvus levaillantii Eastern Jungle Crow

210 Corvus corax Northern Raven

211 Corvus macrorhynchos Large-billed Crow

212 Corvus splendens House Crow

213 Coturnix coturnix Common Quail

214 Coturnix japonica Japanese Quail

215 Cuculus canorus Eurasian Cuckoo

216 Cuculus micropterus Indian Cuckoo

217 Cuculus poliocephalus Lesser Cuckoo

218 Cuculus saturatus Oriental Cuckoo

219 Culicicapa ceylonensis Grey-headed Canary Flycatcher

220 Cutia nipalensis Himalayan Cutia

221 Cyornis poliogenys Pale-chinned Flycatcher  
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222 Cyornis rubeculoides Blue-throated Flycatcher

223 Cyornis unicolor Pale Blue Flycatcher

224 Cypsiurus balasiensis Asian Palm Swift

225 Delichon dasypus Asian House Martin

226 Delichon nipalensis Nepal House Martin

227 Dendrocitta formosae Grey Treepie

228 Dendrocitta frontalis Collared Treepie

229 Dendrocitta vagabunda Rufous Treepie

230 Dendrocopos atratus Stripe-breasted Woodpecker

231 Dendrocopos canicapillus Grey-capped Pygmy Woodpecker

232 Dendrocopos cathpharius Crimson-breasted Woodpecker

233 Dendrocopos darjellensis Darjeeling Woodpecker

234 Dendrocopos hyperythrus Rufous-bellied Woodpecker

235 Dendrocopos macei Fulvous-breasted Woodpecker

236 Dendrocygna bicolor Fulvous Whistling-duck

237 Dendrocygna javanica Lesser Whistling-duck

238 Dendronanthus indicus Forest Wagtail

239 Dicaeum chrysorrheum Yellow-vented Flowerpecker

240 Dicaeum concolor Plain Flowerpecker

241 Dicaeum cruentatum Scarlet-backed Flowerpecker

242 Dicaeum erythrorynchos Pale-billed Flowerpecker

243 Dicaeum ignipectus Fire-breasted Flowerpecker

244 Dicaeum melanoxanthum Yellow-bellied Flowerpecker

245 Dicrurus aeneus Bronzed Drongo

246 Dicrurus annectans Crow-billed Drongo

247 Dicrurus hottentottus Spangled Drongo

248 Dicrurus leucophaeus Ashy Drongo

249 Dicrurus macrocercus Black Drongo

250 Dicrurus paradiseus Greater Racket-tailed Drongo

251 Dicrurus remifer Lesser Racket-tailed Drongo

252 Dinopium shorii Himalayan Flameback

253 Ducula aenea Green Imperial Pigeon

254 Ducula badia Mountain Imperial Pigeon

255 Egretta garzetta Little Egret

256 Elanus caeruleus Black-winged Kite

257 Emberiza buchanani Grey-necked Bunting

258 Emberiza godlewskii Godlewski's Bunting  
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259 Emberiza melanocephala Black-headed Bunting

260 Emberiza pusilla Little Bunting

261 Emberiza rustica Rustic Bunting

262 Emberiza spodocephala Black-faced Bunting

263 Enicurus immaculatus Black-backed Forktail

264 Enicurus leschenaulti White-crowned Forktail

265 Enicurus maculatus Spotted Forktail

266 Enicurus schistaceus Slaty-backed Forktail

267 Enicurus scouleri Little Forktail

268 Ephippiorhynchus asiaticus Black-necked Stork

269 Epornis zantholeuca White-bellied Epornis

270 Esacus recurvirostris Great Thick-knee

271 Eudynamys scolopacea Asian Koel

272 Eumyias thalassina Verditer Flycatcher

273 Eurystomus orientalis Dollarbird

274 Falco amurensis Amur Falcon

275 Falco chicquera Red-necked Falcon

276 Falco columbarius Merlin

277 Falco peregrinus Peregrine Falcon

278 Falco severus Oriental Hobby

279 Falco subbuteo Eurasian Hobby

280 Falco tinnunculus Common Kestrel

281 Ficedula albicilla Taiga Flycatcher

282 Ficedula hodgsonii Slaty-backed Flycatcher

283 Ficedula hyperythra Snowy-browed Flycatcher

284 Ficedula monileger White-gorgeted Flycatcher

285 Ficedula parva Red-breasted Flycatcher

286 Ficedula sapphira Sapphire Flycatcher

287 Ficedula strophiata Rufous-gorgeted Flycatcher

288 Ficedula subrubra Kashmir Flycatcher

289 Ficedula superciliaris Ultramarine Flycatcher

290 Ficedula tricolor Slaty-blue Flycatcher

291 Ficedula westermanni Little Pied Flycatcher

292 Francolinus francolinus Black Francolin

293 Fringilla coelebs Common Chaffinch

294 Fringilla montifringilla Brambling

295 Fulica atra Eurasian Coot  
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296 Gallicrex cinerea Watercock

297 Gallinago gallinago Common Snipe

298 Gallinago nemoricola Wood Snipe

299 Gallinago solitaria Solitary Snipe

300 Gallinago stenura Pintail Snipe

301 Gallinula chloropus Common Moorhen

302 Gallirallus striata Slaty-breasted Rail

303 Gallus gallus Red Junglefowl

304 Gampsorhynchus rufulus White-hooded Babbler

305 Garrulax affinis Black-faced Laughingthrush

306 Garrulax albogularis White-throated Laughingthrush

307 Garrulax caerulatus Grey-sided Laughingthrush

308 Garrulax erythrocephalus Chestnut-crowned Laughingthrush

309 Garrulax gularis Rufous-vented Laughingthrush

310 Garrulax imbricatus Bhutan Laughingthrush

311 Garrulax leucolophus White-crested Laughingthrush

312 Garrulax monileger Lesser Necklaced Laughingthrush

313 Garrulax ocellatus Spotted Laughingthrush

314 Garrulax pectoralis Greater Necklaced Laughingthrush

315 Garrulax ruficollis Rufous-necked Laughingthrush

316 Garrulax rufogularis Rufous-chinned Laughingthrush

317 Garrulax squamatus Blue-winged Laughingthrush

318 Garrulax striatus Striated Laughingthrush

319 Garrulax subunicolor Scaly Laughingthrush

320 Garrulus glandarius Eurasian Jay

321 Gecinulus grantia Pale-headed Woodpecker

322 Glareola lactea Small Pratincole

323 Glaucidium brodiei Collared Owlet

324 Glaucidium cuculoides Asian Barred Owlet

325 Glaucidium radiatum Jungle Owlet

326 Gorsachius melanolophus Malayan Night Heron

327 Gracula religiosa Common Hill Myna

328 Grandala coelicolor Grandala

329 Grus grus Common Crane

330 Grus nigricollis Black-necked Crane

331 Grus virgo Demoiselle Crane

332 Gypaetus barbatus Bearded Vulture  
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333 Gyps bengalensis White-rumped Vulture

334 Gyps himalayensis Himalayan Griffon

335 Haematospiza sipahi Scarlet Finch

336 Halcyon coromanda Ruddy Kingfisher

337 Halcyon pileata Black-capped Kingfisher

338 Halcyon smyrnensis White-throated Kingfisher

339 Haliaeetus albicilla White-tailed Eagle

340 Haliaeetus leucoryphus Pallas's Fish Eagle

341 Haliastur indus Brahminy Kite

342 Harpactes erythrocephalus Red-headed Trogon

343 Harpactes wardi Ward's Trogon

344 Hemiprocne coronata Crested Treeswift

345 Hemipus picatus Bar-winged Flycatcher-shrike

346 Hemixos flavala Ashy Bulbul

347 Heterophasia annectans Rufous-backed Sibia

348 Heterophasia picaoides Long-tailed Sibia

349 Hieraaetus fasciatus Bonelli's Eagle

350 Hieraaetus kienerii Rufous-bellied Eagle

351 Hieraaetus pennatus Booted Eagle

352 Hierococcyx fugax Hodgson's Hawk Cuckoo

353 Hierococcyx sparverioides Large Hawk Cuckoo

354 Hierococcyx varius Common Hawk Cuckoo

355 Himantopus himantopus Black-winged Stilt

356 Hirundapus caudacutus White-throated Needletail

357 Hirundo daurica Red-rumped Swallow

358 Hirundo rupestris Eurasian Crag Martin

359 Hirundo rustica Barn Swallow

360 Hodgsonius phaenicuroides White-bellied Redstart

361 Hydrophasianus chirurgus Pheasant-tailed Jacana

362 Hypothymis azurea Black-naped Monarch

363 Hypsipetes leucocephalus Black Bulbul

364 Ibidorhyncha struthersii Ibisbill

365 Ichthyaetus ichthyaetus Pallas's Gull

366 Ichthyophaga humilis Lesser Fish Eagle

367 Ictinaetus malayensis Black Eagle

368 Iduna caligata Booted Warbler

369 Indicator xanthonotus Yellow-rumped Honeyguide  
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370 Irena puella Asian Fairy Bluebird

371 Ithaginis cruentus Blood Pheasant

372 Ixobrychus cinnamomeus Cinnamon Bittern

373 Ixos mcclellandii Mountain Bulbul

374 Jynx torquilla Eurasian Wryneck

375 Ketupa flavipes Tawny Fish Owl

376 Ketupa zeylonensis Brown Fish Owl

377 Lanius collurioides Burmese Shrike

378 Lanius cristatus Brown Shrike

379 Lanius schach Long-tailed Shrike

380 Lanius tephronotus Grey-backed Shrike

381 Lanius vittatus Bay-backed Shrike

382 Larus barabensis Steppe Gull

383 Larus canus Mew Gull

384 Larus heuglini Heuglin's Gull

385 Leiothrix argentauris Silver-eared Mesia

386 Leiothrix lutea Red-billed Leiothrix

387 Leptopoecile sophiae White-browed Tit Warbler

388 Leptoptilos javanicus Lesser Adjutant

389 Lerwa lerwa Snow Partridge

390 Leucosticte brandti Brandt's Mountain Finch

391 Leucosticte nemoricola Plain Mountain Finch

392 Liocichla phoenicea Red-faced Liocichla

393 Lioparus chrysotis Golden-breasted Fulvetta

394 Lonchura punctulata Scaly-breasted Munia

395 Lonchura striata White-rumped Munia

396 Lophophorus impejanus Himalayan Monal

397 Lophura leucomelanos Kalij Pheasant

398 Loxia curvirostra Red Crossbill

399 Luscinia brunnea Indian Blue Robin

400 Luscinia calliope Siberian Rubythroat

401 Luscinia pectoralis White-tailed Rubythroat

402 Luscinia svecica Bluethroat

403 Lymnocryptes minimus Jack Snipe

404 Macronous gularis Pin-striped Tit Babbler

405 Macropygia unchall Barred Cuckoo Dove

406 Malacias capistrata Rufous Sibia  
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407 Malacias pulchellus Beautiful Sibia

408 Malacocincla abbotti Abbott's Babbler

409 Megaceryle lugubris Crested Kingfisher

410 Megalaima asiatica Blue-throated Barbet

411 Megalaima australis Blue-eared Barbet

412 Megalaima franklinii Golden-throated Barbet

413 Megalaima haemacephala Coppersmith Barbet

414 Megalaima lineata Lineated Barbet

415 Megalaima virens Great Barbet

416 Megalurus palustris Striated Grassbird

417 Melanochlora sultanea Sultan Tit

418 Melophus lathami Crested Bunting

419 Mergus merganser Goosander

420 Merops leschenaulti Chestnut-headed Bee-eater

421 Merops orientalis Green Bee-eater

422 Merops philippinus Blue-tailed Bee-eater

423 Mesophoyx intermedia Intermediate Egret

424 Metopidius indicus Bronze-winged Jacana

425 Microhierax caerulescens Collared Falconet

426 Microhierax melanoleucos Pied Falconet

427 Milvus migrans Black Kite

428 Minla cyanouroptera Blue-winged Siva

429 Minla ignotincta Red-tailed Minla

430 Minla strigula Bar-throated Siva

431 Mirafra assamica Bengal Bushlark

432 Monticola cinclorhynchus Blue-capped Rock Thrush

433 Monticola rufiventris Chestnut-bellied Rock Thrush

434 Monticola solitarius Blue Rock Thrush

435 Motacilla alba White Wagtail

436 Motacilla cinerea Grey Wagtail

437 Motacilla citreola Citrine Wagtail

438 Motacilla flava Yellow Wagtail

439 Motacilla maderaspatensis White-browed Wagtail

440 Mulleripicus pulverulentus Great Slaty Woodpecker

441 Muscicapa dauurica Asian Brown Flycatcher

442 Muscicapa ferruginea Ferruginous Flycatcher

443 Muscicapa muttui Brown-breasted Flycatcher  
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444 Muscicapa sibirica Dark-sided Flycatcher

445 Muscicapella hodgsoni Pygmy Blue Flycatcher

446 Mycerobas affinis Collared Grosbeak

447 Mycerobas carnipes White-winged Grosbeak

448 Mycerobas melanozanthos Spot-winged Grosbeak

449 Myiomela leucura White-tailed Robin

450 Myophonus caeruleus Blue Whistling Thrush

451 Myzornis pyrrhoura Fire-tailed Myzornis

452 Napothera epilepidota Eyebrowed Wren Babbler

453 Nectarinia asiatica Purple Sunbird

454 Neophron percnopterus Egyptian Vulture

455 Niltava grandis Large Niltava

456 Niltava macgrigoriae Small Niltava

457 Niltava sundara Rufous-bellied Niltava

458 Niltava vivida Vivid Niltava

459 Ninox scutulata Brown Hawk Owl

460 Nisaetus nipalensis Mountain Hawk Eagle

461 Nucifraga caryocatactes Spotted Nutcracker

462 Numenius arquata Eurasian Curlew

463 Numenius phaeopus Whimbrel

464 Nycticorax nycticorax Black-crowned Night Heron

465 Nyctyornis athertoni Blue-bearded Bee-eater

466 Oenanthe isabellina Isabelline Wheatear

467 Oenanthe pleschanka Pied Wheatear

468 Oriolus kundoo Indian Golden Oriole

469 Oriolus tenuirostris Slender-billed Oriole

470 Oriolus traillii Maroon Oriole

471 Oriolus xanthornus Black-hooded Oriole

472 Orthotomus cuculatus Mountain Tailorbird

473 Orthotomus sutorius Common Tailorbird

474 Otus lettia Collared Scops Owl

475 Otus spilocephalus Mountain Scops Owl

476 Otus sunia Oriental Scops Owl

477 Pandion haliaetus Osprey

478 Paradoxornis atrosuperciliaris Lesser Rufous-headed Parrotbill

479 Paradoxornis fulvifrons Fulvous Parrotbill

480 Paradoxornis gularis Grey-headed Parrotbill  
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482 Paradoxornis ruficeps Greater Rufous-headed Parrotbill

483 Paradoxornis unicolor Brown Parrotbill

484 Parus ater Coal Tit

485 Parus dichrous Grey-crested Tit

486 Parus major Great Tit

487 Parus monticolus Green-backed Tit

488 Parus rubidiventris Rufous-vented Tit

489 Parus spilonotus Yellow-cheeked Tit

490 Passer domesticus House Sparrow

491 Passer montanus Eurasian Tree Sparrow

492 Passer rutilans Russet Sparrow

493 Pavo cristatus Indian Peafowl

494 Pelargopsis capensis Stork-billed Kingfisher

495 Pellorneum albiventre Spot-throated Babbler

496 Pellorneum ruficeps Puff-throated Babbler

497 Perdix hodgsoniae Tibetan Partridge

498 Pericrocotus speciosus Scarlet Minivet

499 Pericrocotus brevirostris Short-billed Minivet

500 Pericrocotus cinnamomeus Small Minivet

501 Pericrocotus divaricatus Ashy Minivet

502 Pericrocotus ethologus Long-tailed Minivet

503 Pericrocotus roseus Rosy Minivet

504 Pericrocotus solaris Grey-chinned Minivet

505 Pernis ptilorhyncus Oriental Honey-buzzard

506 Phaenicophaeus tristis Green-billed Malkoha

507 Phalacrocorax carbo Great Cormorant

508 Phalacrocorax fuscicollis Indian Cormorant

509 Phalacrocorax niger Little Cormorant

510 Philomachus pugnax Ruff

511 Phodilus badius Oriental Bay Owl

512 Phoenicurus auroreus Daurian Redstart

513 Phoenicurus coeruleocephala Blue-capped Redstart

514 Phoenicurus erythrogaster White-winged Redstart

515 Phoenicurus frontalis Blue-fronted Redstart

516 Phoenicurus hodgsoni Hodgson's Redstart

517 Phoenicurus ochruros Black Redstart

518 Phoenicurus schisticeps White-throated Redstart  
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519 Phylloscopus mandellii Mandelli's Leaf Warbler

520 Phylloscopus affinis Tickell's Leaf Warbler

521 Phylloscopus cantator Yellow-vented Warbler

522 Phylloscopus chloronotus Lemon-rumped Warbler

523 Phylloscopus collybita Common Chiffchaff

524 Phylloscopus fuligiventer Smoky Warbler

525 Phylloscopus fuscatus Dusky Warbler

526 Phylloscopus humei Hume's Warbler

527 Phylloscopus inornatus Yellow-browed Warbler

528 Phylloscopus maculipennis Ashy-throated Warbler

529 Phylloscopus magnirostris Large-billed Leaf Warbler

530 Phylloscopus pulcher Buff-barred Warbler

531 Phylloscopus reguloides Blyth's Leaf Warbler

532 Phylloscopus trochiloides Greenish Warbler

533 Pica pica Eurasian Magpie

534 Picumnus innominatus Speckled Piculet

535 Picus canus Grey-headed Woodpecker

536 Picus chlorolophus Lesser Yellownape

537 Picus flavinucha Greater Yellownape

538 Picus xanthopygaeus Streak-throated Woodpecker

539 Pitta cyanea Blue Pitta

540 Pitta nipalensis Blue-naped Pitta

541 Pitta sordida Hooded Pitta

542 Ploceus benghalensis Black-breasted Weaver

543 Ploceus manyar Streaked Weaver

544 Ploceus philippinus Baya Weaver

545 Pluvialis apricaria European Golden Plover

546 Pluvialis fulva Pacific Golden Plover

547 Pnoepyga albiventer Scaly-breasted Wren Babbler

548 Pnoepyga pusilla Pygmy Wren Babbler

549 Podiceps cristatus Great Crested Grebe

550 Podiceps nigricollis Black-necked Grebe

551 Polyplectron bicalcaratum Grey Peacock Pheasant

552 Pomatorhinus erythrocnemis Spot-breasted Scimitar Babbler

553 Pomatorhinus erythrogenys Rusty-cheeked Scimitar Babbler

554 Pomatorhinus ferruginosus Coral-billed Scimitar Babbler

555 Pomatorhinus ruficollis Streak-breasted Scimitar Babbler  
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556 Pomatorhinus schisticeps White-browed Scimitar Babbler

557 Porphyrio porphyrio Purple Swamphen

558 Porzana bicolor Black-tailed Crake

559 Porzana fusca Ruddy-breasted Crake

560 Porzana parva Little Crake

561 Prinia atrogularis Hill Prinia

562 Prinia cinereocapilla Grey-crowned Prinia

563 Prinia criniger Striated Prinia

564 Prinia hodgsonii Grey-breasted Prinia

565 Prinia inornata

566 Prinia rufescens Rufescent Prinia

567 Prinia socialis Ashy Prinia

568 Prinia sylvatica Jungle Prinia

569 Propyrrhula subhimachala Crimson-browed Finch

570 Prunella collaris Alpine Accentor

571 Prunella fulvescens Brown Accentor

572 Prunella himalayana Altai Accentor

573 Prunella immaculata Maroon-backed Accentor

574 Prunella rubeculoides Robin Accentor

575 Prunella strophiata Rufous-breasted Accentor

576 Psarisomus dalhousiae Long-tailed Broadbill

577 Pseudibis papillosa Red-naped Ibis

578 Pseudominla cinerea Yellow-throated Fulvetta

579 Psittacula alexandri Red-breasted Parakeet

580 Psittacula eupatria Alexandrine Parakeet

581 Psittacula finschii Grey-headed Parakeet

582 Psittacula himalayana Slaty-headed Parakeet

583 Psittacula krameri Rose-ringed Parakeet

584 Psittacula roseata Blossom-headed Parakeet

585 Pteruthius flaviscapis White-browed Shrike Babbler

586 Pteruthius melanotis Black-eared Shrike Babbler

587 Pteruthius rufiventer Black-headed Shrike Babbler

588 Pteruthius xanthochlorus Green Shrike Babbler

589 Pycnonotus cafer Red-vented Bulbul

590 Pycnonotus jocosus Red-whiskered Bulbul

591 Pycnonotus leucogenys Himalayan Bulbul

592 Pycnonotus melanicterus Black-crested Bulbul  
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593 Pycnonotus striatus Striated Bulbul

594 Pyrrhocorax graculus Yellow-billed Chough

595 Pyrrhocorax pyrrhocorax Red-billed Chough

596 Pyrrhoplectes epauletta Gold-naped Finch

597 Pyrrhula erythaca Grey-headed Bullfinch

598 Pyrrhula erythrocephala Red-headed Bullfinch

599 Pyrrhula nipalensis Brown Bullfinch

600 Recurvirostra avosetta Pied Avocet

601 Regulus regulus Goldcrest

602 Rhipidura albicollis White-throated Fantail

603 Rhipidura hypoxantha Yellow-bellied Fantail

604 Rhodonessa rufina Red-crested Pochard

605 Rhyacornis fuliginosus Plumbeous Water Redstart

606 Rimator malacoptilus Long-billed Wren Babbler

607 Riparia diluta Pale Martin

608 Riparia paludicola Plain Martin

609 Riparia riparia Sand Martin

610 Rostratula benghalensis Greater Painted-snipe

611 Sarcogyps calvus Red-headed Vulture

612 Saroglossa spiloptera Spot-winged Starling

613 Sasia ochracea White-browed Piculet

614 Saxicola caprata Pied Bushchat

615 Saxicola ferrea Grey Bushchat

616 Saxicola insignis Hodgson's Bushchat

617 Saxicola torquata Common Stonechat

618 Saxicoloides fulicata Indian Robin

619 Schoeniparus dubia Rusty-capped Fulvetta

620 Scolopax rusticola Eurasian Woodcock

621 Seicercus affinis White-spectacled Warbler

622 Seicercus burkii Green-crowned Warbler

623 Seicercus castaniceps Chestnut-crowned Warbler

624 Seicercus poliogenys Grey-cheeked Warbler

625 Seicercus whistleri Whistler's Warbler

626 Seicercus xanthoschistos Grey-hooded Warbler

627 Serilophus lunatus Silver-breasted Broadbill

628 Serinus pusillus Red-fronted Serin

629 Serinus thibetanus Tibetan Serin  
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530 Phylloscopus pulcher Buff-barred Warbler

531 Phylloscopus reguloides Blyth's Leaf Warbler

532 Phylloscopus trochiloides Greenish Warbler

533 Pica pica Eurasian Magpie

534 Picumnus innominatus Speckled Piculet

535 Picus canus Grey-headed Woodpecker

536 Picus chlorolophus Lesser Yellownape

537 Picus flavinucha Greater Yellownape

538 Picus xanthopygaeus Streak-throated Woodpecker

539 Pitta cyanea Blue Pitta

540 Pitta nipalensis Blue-naped Pitta

541 Pitta sordida Hooded Pitta

542 Ploceus benghalensis Black-breasted Weaver

543 Ploceus manyar Streaked Weaver

544 Ploceus philippinus Baya Weaver

545 Pluvialis apricaria European Golden Plover

546 Pluvialis fulva Pacific Golden Plover

547 Pnoepyga albiventer Scaly-breasted Wren Babbler

548 Pnoepyga pusilla Pygmy Wren Babbler

549 Podiceps cristatus Great Crested Grebe

550 Podiceps nigricollis Black-necked Grebe

551 Polyplectron bicalcaratum Grey Peacock Pheasant

552 Pomatorhinus erythrocnemis Spot-breasted Scimitar Babbler

553 Pomatorhinus erythrogenys Rusty-cheeked Scimitar Babbler

554 Pomatorhinus ferruginosus Coral-billed Scimitar Babbler

555 Pomatorhinus ruficollis Streak-breasted Scimitar Babbler

556 Pomatorhinus schisticeps White-browed Scimitar Babbler

557 Porphyrio porphyrio Purple Swamphen

558 Porzana bicolor Black-tailed Crake

559 Porzana fusca Ruddy-breasted Crake

560 Porzana parva Little Crake

561 Prinia atrogularis Hill Prinia

562 Prinia cinereocapilla Grey-crowned Prinia

563 Prinia criniger Striated Prinia

564 Prinia hodgsonii Grey-breasted Prinia

565 Prinia inornata

566 Prinia rufescens Rufescent Prinia  
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567 Prinia socialis Ashy Prinia

568 Prinia sylvatica Jungle Prinia

569 Propyrrhula subhimachala Crimson-browed Finch

570 Prunella collaris Alpine Accentor

571 Prunella fulvescens Brown Accentor

572 Prunella himalayana Altai Accentor

573 Prunella immaculata Maroon-backed Accentor

574 Prunella rubeculoides Robin Accentor

575 Prunella strophiata Rufous-breasted Accentor

576 Psarisomus dalhousiae Long-tailed Broadbill

577 Pseudibis papillosa Red-naped Ibis

578 Pseudominla cinerea Yellow-throated Fulvetta

579 Psittacula alexandri Red-breasted Parakeet

580 Psittacula eupatria Alexandrine Parakeet

581 Psittacula finschii Grey-headed Parakeet

582 Psittacula himalayana Slaty-headed Parakeet

583 Psittacula krameri Rose-ringed Parakeet

584 Psittacula roseata Blossom-headed Parakeet

585 Pteruthius flaviscapis White-browed Shrike Babbler

586 Pteruthius melanotis Black-eared Shrike Babbler

587 Pteruthius rufiventer Black-headed Shrike Babbler

588 Pteruthius xanthochlorus Green Shrike Babbler

589 Pycnonotus cafer Red-vented Bulbul

590 Pycnonotus jocosus Red-whiskered Bulbul

591 Pycnonotus leucogenys Himalayan Bulbul

592 Pycnonotus melanicterus Black-crested Bulbul

593 Pycnonotus striatus Striated Bulbul

594 Pyrrhocorax graculus Yellow-billed Chough

595 Pyrrhocorax pyrrhocorax Red-billed Chough

596 Pyrrhoplectes epauletta Gold-naped Finch

597 Pyrrhula erythaca Grey-headed Bullfinch

598 Pyrrhula erythrocephala Red-headed Bullfinch

599 Pyrrhula nipalensis Brown Bullfinch

600 Recurvirostra avosetta Pied Avocet

601 Regulus regulus Goldcrest

602 Rhipidura albicollis White-throated Fantail

603 Rhipidura hypoxantha Yellow-bellied Fantail  
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604 Rhodonessa rufina Red-crested Pochard

605 Rhyacornis fuliginosus Plumbeous Water Redstart

606 Rimator malacoptilus Long-billed Wren Babbler

607 Riparia diluta Pale Martin

608 Riparia paludicola Plain Martin

609 Riparia riparia Sand Martin

610 Rostratula benghalensis Greater Painted-snipe

611 Sarcogyps calvus Red-headed Vulture

612 Saroglossa spiloptera Spot-winged Starling

613 Sasia ochracea White-browed Piculet

614 Saxicola caprata Pied Bushchat

615 Saxicola ferrea Grey Bushchat

616 Saxicola insignis Hodgson's Bushchat

617 Saxicola torquata Common Stonechat

618 Saxicoloides fulicata Indian Robin

619 Schoeniparus dubia Rusty-capped Fulvetta

620 Scolopax rusticola Eurasian Woodcock

621 Seicercus affinis White-spectacled Warbler

622 Seicercus burkii Green-crowned Warbler

623 Seicercus castaniceps Chestnut-crowned Warbler

624 Seicercus poliogenys Grey-cheeked Warbler

625 Seicercus whistleri Whistler's Warbler

626 Seicercus xanthoschistos Grey-hooded Warbler

627 Serilophus lunatus Silver-breasted Broadbill

628 Serinus pusillus Red-fronted Serin

629 Serinus thibetanus Tibetan Serin

630 Sitta cinnamoventris Chestnut-bellied Nuthatch

631 Sitta formosa Beautiful Nuthatch

632 Sitta frontalis Velvet-fronted Nuthatch

633 Sitta himalayensis White-tailed Nuthatch

634 Spelaeornis caudatus Rufous-throated Wren Babbler

635 Spelaeornis formosus Spotted Wren Babbler

636 Spelaeornis troglodytoides Bar-winged Wren Babbler

637 Sphenocichla humei Himalayan Wedge-billed Babbler

638 Spilornis cheela Crested Serpent Eagle

639 Spinus spinus Eurasian Siskin

640 Stachyris chrysaea Golden Babbler  
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641 Stachyris nigriceps Grey-throated Babbler

642 Stachyris ruficeps Rufous-capped Babbler

643 Stachyris rufifrons Rufous-fronted Babbler

644 Staphida castaniceps Striated Yuhina

645 Sterna aurantia River Tern

646 Sterna hirundo Common Tern

647 Sternula acuticauda Black-bellied Tern

648 Stigmatopelia chinensis Spotted Dove

649 Stigmatopelia senegalensis Laughing Dove

650 Streptopelia decaocto Eurasian Collared Dove

651 Streptopelia orientalis Oriental Turtle Dove

652 Streptopelia tranquebarica Red Collared Dove

653 Strix nivicola Himalayan Wood Owl

654 Strix leptogrammica Brown Wood Owl

655 Sturnus contra Asian Pied Starling

656 Sturnus malabaricus Chestnut-tailed Starling

657 Sturnus pagodarum Brahminy Starling

658 Sturnus vulgaris Common Starling

659 Surniculus lugubris Drongo Cuckoo

660 Sylvia curruca Lesser Whitethroat

661 Sylviparus modestus Yellow-browed Tit

662 Tachybaptus ruficollis Little Grebe

663 Tachymarptis melba Alpine Swift

664 Tadorna ferruginea Ruddy Shelduck

665 Tadorna tadorna Common Shelduck

666 Tarsiger chrysaeus Golden Bush Robin

667 Tarsiger cyanurus Orange-flanked Bush Robin

668 Tarsiger hyperythrus Rufous-breasted Bush Robin

669 Tarsiger indicus White-browed Bush Robin

670 Tephrodornis gularis Large Woodshrike

671 Terpsiphone paradisi Asian Paradise-flycatcher

672 Tesia castaneocoronata Chestnut-headed Tesia

673 Tesia cyaniventer Grey-bellied Tesia

674 Tesia olivea Slaty-bellied Tesia

675 Tetraogallus tibetanus Tibetan Snowcock

676 Tichodroma muraria Wallcreeper

677 Tickellia hodgsoni Broad-billed Warbler  
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678 Tragopan blythii Blyth's Tragopan

679 Tragopan satyra Satyr Tragopan

680 Tragopan temminckii Temminck's Tragopan

681 Treron apicauda Pin-tailed Green Pigeon

682 Treron bicincta Orange-breasted Green Pigeon

683 Treron curvirostra Thick-billed Green Pigeon

684 Treron phoenicoptera Yellow-footed Green Pigeon

685 Treron pompadora Pompadour Green Pigeon

686 Treron sphenura Wedge-tailed Green Pigeon

687 Tringa erythtopus Spotted Redshank

688 Tringa glareola Wood Sandpiper

689 Tringa nebularia Common Greenshank

690 Tringa ochropus Green Sandpiper

691 Tringa totanus Common Redshank

692 Troglodytes troglodytes Eurasian Wren

693 Turdoides striatus Jungle Babbler

694 Turdus maximus Tibetan Blackbird

695 Turdus albocinctus White-collared Blackbird

696 Turdus atrogularis Black-throated Thrush

697 Turdus boulboul Grey-winged Blackbird

698 Turdus eunomus Dusky Thrush

699 Turdus feae Grey-sided Thrush

700 Turdus kessleri Kessler's Thrush

701 Turdus naumanni Naumann's Thrush

702 Turdus obscurus Eyebrowed Thrush

703 Turdus rubrocanus Chestnut Thrush

704 Turdus ruficollis Red-throated Thrush

705 Turdus unicolor Tickell's Thrush

706 Turnix suscitator Barred Buttonquail

707 Turnix tanki Yellow-legged Buttonquail

708 Tyto alba Barn Owl

709 Upupa epops Common Hoopoe

710 Urocissa flavirostris Yellow-billed Blue Magpie

711 Vanellus cinereus Grey-headed Lapwing

712 Vanellus duvaucelii River Lapwing

713 Vanellus indicus Red-wattled Lapwing

714 Vanellus malarbaricus Yellow-wattled Lapwing  
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715 Vanellus vanellus Northern Lapwing

716 Xiphirhynchus superciliaris Slender-billed Scimitar Babbler

717 Yuhina bakeri White-naped Yuhina

718 Yuhina flavicollis Whiskered Yuhina

719 Yuhina gularis Stripe-throated Yuhina

720 Yuhina nigrimenta Black-chinned Yuhina

721 Yuhina occipitalis Rufous-vented Yuhina

722 Zoothera citrina Orange-headed Thrush

723 Zoothera dauma Scaly Thrush

724 Zoothera dixoni Long-tailed Thrush

725 Zoothera mollissima Plain-backed Thrush

726 Zoothera monticola Long-billed Thrush

727 Zosterops palpebrosus Oriental White-eye

728 Turdus dissimilis Black-breasted Thrush

729 Cyanoptila cyanomelana Black-and-White Flycatcher

730 Erythrura prasina Pin-tailed Parrotfinch

731 Chlidonias hybrida Whiskered Tern

732 Muscicapa ruficauda Rusty-tailed Flycatcher

733 Psittacula cyanocephala Plum-headed Parakeet

734 Todiramphus cloris Collared Kingfisher

735 Pluvialis squatarola Grey Plover

736 Eremophila alpestris Horned Lark

737 Bucephala clangula Common Goldeneye

738 Pellorneum tickelli Buff-breasted Babbler

739 Botaurus stellaris Great Bittern

740 Geokichla wardii Pied Thrush

741 Sternula albifrons Little Tern

742 Pitta brachyura Indian Pitta

743 Rallina eurizonoides Slaty-legged Pitta   
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Reptile Data (F7/7) 

SN Data Item Definition/Description Instruction 

1 Plot No. This is the unique identification 
number given to Plot No. Eg. 
KKFMU001  

 

1. Select correct Plot No from the drop-
down list on electronic field form or record 
the correct Plot No, if the paper field form 
is used. 

Note: If Paper Field Forms are to be used only if the 
android Tablet does not function in the field.   

2 Reptiles spe-
cies 

Refers to identity of the particu-
lar reptile that has been sighted 
or identified. 

The list of reptiles shall be pro-
vided in.Table 1.35 

1. Select and record the reptile from the drop-
down list on electronic field form or record 
on the paper field form. 

2. Select “None” if no reptile is observed. 

3 Reptile evi-
dence  

Refers to the type of evidence 
using which the reptile is identi-
fied. The categories are: 

1. Direct sighting 
2. Sound/calls 
3. Dung 
4. Skin 
5. Skeleton/Cadaver 
6. Footprints/pugmarks 
7. Tracks/Paths 
8. Burrow 
9. Den 
10. Not relevant 

1. Select the appropriate evidence type and 
record by selecting from the drop-down list 
on electronic field form or selecting rele-
vant evidence type on paper field form. 

2. “Not relevant” should be selected when 

there are no reptiles sighted or observed 
within the 25 m radius. 

4 Species name Refers to the reptile species 
sighted or observed but not 
listed in above list. Can be local 
or common name 

1. If the reptile is sighted but not listed in the 
above list or not known, write the common 
or local name. 

5 Remarks Refers to any other relevant in-
formation provided by crew. 

1. The Crew Leader or the data recorder shall 
add any additional information on reptiles  
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Table 1.35 List of reptiles 

SN Scientific name Common name

1 Ahaetulla nasuta common vine snake

2 Ahaetulla prasina Asian vine snake

3 Amphiesma parallelum 

4 Amphiesma platyceps Himalayan keelback 

5 Amphiesma sieboldii Sikkim keelback

6 Amphiesma stolatum Buff striped keelback

7 Boiga cyanea Green Cat Snake

8 Boiga gokool Arrowback tree snake

9 Boiga multifasciata Many-banded tree snake

10 Boiga ochracea  Tawny cat snake

11 Chrysopelea ornata Flying tree snake

12 Coelognathus radiatus Copperhead rat snake

13 Dendrelaphis cyanochloris Wall's Bronzeback

14 Dendrelephis pictus Painted bronzeback

15 Dendrelaphis tristis Tree snake

16 Dinodon gammiei Sikkim False Wolf Snake

17 Dinodon septentrionalis Wolf snake

18 Dryocalamus davisonii 

19 Enhydris enhydris Rainbow water snake

20 Lycodon aulicus Indian wolf snake

21 Lycodon fasciatus Banded wolf snake

22 Lycodon jara Yellow-speckled wolf snake

23 Oligodon albocinctus Light-barred kukri snake

24 Oligodon cinereus Black cross-barred kukri snake, golden kukri snake

25 Oligodon cyclurus Cantor's Kukri Snake

26 Oligodon dorsalis Bengalese kukri snake or Gray's kukri snake

27 Oligodon juglandifer Walnut kukri snake

28 Oreocryptophis porphyracea

Black-banded trinket snake, red bamboo snake, 

Thai bamboo rat snake or red mountain racer

29 Orthriophis cantoris 

30 Orthriophis taeniurus Beauty ratsnake

31 Psammodynastes pulverulentus Common mock viper

32 Psedoxenodon macrops Large-eyed bamboo snake or Chinese false cobra

33 Ptyas korros Chinese ratsnake or Indo-Chinese rat snake

34 Ptyas nigromarginata Green rat snake

35 Ptyas mucosa Oriental ratsnake, Indian rat snake

36 Rhabdophis himalayanus Orange-collared keelback

37 Rhabdophis subminiatus Red-necked keelback

38 Sibynophis collaris Common many-toothed snake

39 Sibynophis sagittarius Cantor's black-headed snake.

40 Trachischium leave Olive Oriental Slender Snake  
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41 Trachischium guentheri Rosebelly worm-eating snake

42 Trachischium tenuiceps Yellowbelly worm-eating snake

43 Xenochrophis piscator Asiatic water snake

44 Bungarus bungaroides Northeastern hill krait

45 Bungarus fasciatus Banded krait

46 Bungarus niger Greater black krait

47 Naja kaouthia Monocellate cobra

48 Naja naja Spectacled cobra, Asian cobra, or binocellate cobra

49 Ophiophagus hannah King cobra

50 Sinomicrurus macclellandii MacClelland’s Coral Snake

51 Python molurus Indian python or Indian rock python

52 Python bivittatus Burmese python

53 Ramphotyphlops braminus Brahminy Blindsnake

54 Typhlops jerdonii Jerom's worm snake

55 Typhlops diardii Diard's Blindsnake

56 Daboia russelii Russel's viper

57 Gloydius himalayanus Himalayan pit viper or Himalayan viper

58 Ovophis monticola Mountain pit viper

59 Protobothrops jerdonii Jerdon's Pit viper

60 Trimeresurus jerdonii Pit viper

61 Trimeresurus albolabris White-lipped pit viper

62 Trimeresurus erythrurus Red-tailed bamboo pitviper

63 Protobothrops himalayanus Himalayan pit viper 

64 Calotes bhutanensis Forest Lizard

65 Calotes jerdonii Ind0-Chinese forest lizard or Jerdon's forest lizard

66 Calotes versicolor Oriental garden lizard

67 Japalura variegata Variegated Mountain Lizard

68 Ophisaurus gracilis Asian glass lizard

69 Cyrtodactylus khasiensis Khasi Hills bent-toed gecko

70 Gekko gecko Tokay gecko

71 Hemidactylus brookii Brooke's house gecko or spotted house gecko

72 Hemidactylus frenatus Common house gecko

73 Hemidactylus platyurus Flat-tailed house gecko

74 Asymblepharus sikimmensis Sikkim ground skink or bronzy-brown skink

75 Eutropis carinata Golden skink

76 Eutropis macularia Bronze grass skink

77 Eutropis quadratilobus 

78 Riopa punctata 

79 Sphenomorphus indicus Himalayan litter skink

80 Sphenomorphus maculatus Spotted forest skink

81 Varanus bengalensis Bengal monitor or common Indian monitor

82 Varanus flavescens Yellow monitor or golden monitor
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1.8.7. Data analysis 

The forest inventory data can be analyzed using any statistical tools including in Microsoft excel, R, python 
and any data base software developed for the same. Following are the important statistics to be estimated 
from inventory result; 

1. Stem density and total stem  

2. Mean basal area and total basal area  

3. Mean volume and total volume  

4. Mean biomass/carbon and total carbon stock  

5. Increment  

6. Regeneration status  

7. Diameter class distribution  

All these statistics are estimated at 95% confidence interval with sampling error of 10% based on the sam-
pling design adopted for the FMU inventory. Currently, all estimates are generated at FMU level and there 
is scope to generate the estimates a block and compartment level to provide adequate information for man-
agement planning and prescription of the interventions.  

Furthermore, the inventory results should; 

• provide all information required to meet the inventory’s objectives. 
• be understandable for those who need the information provided and who shall use the results. 
• be a detailed technical section for the possibly interested expert. 

For estimation of the volume and biomass, appropriate allometric volume and biomass equations should be 
used. In absence of such equations, volume table may also be used for the analysis of the data. The list of 
volume equations is provided below: 

(ii) Northwestern Bhutan  
(Thimphu, Paro, Haa, Wangdue, Punakha, Gasa) 

SL No. Species Volume 
1 Pinus roxburghii  exp((-1.251652 + 1.964424 * log (D) + 1.003778 * log (H))  
2 Pinus roxburghii  exp(( 2.609513 + 2.844257 *  log (D))  
3 Abies densa exp((-0.919947 + 1.859733* log (D) + 0.907633 * log (H)) 
4 Abies densa 0.007107  + -0.515959 * D + 9.364041 * (D^2)  
5 Tsuga dumosa exp((-1.409685+ 1.846742 * log (D) + 1.045675 * log (H))  
6 Tsuga dumosa 0.055312  + -1.37978 * D + 11.394329 * (D^2)  
7 Larix griffithiana exp((-1.409685+ 1.846742 * log (D) + 1.045675 * log (H))  
8 Larix griffithiana 0.055312  + -1.37978 * D + 11.394329 * (D^2)  
9 Pinus wallichiana exp((-1.049334+ 1.926332 * log (D) + 0.967612* log (H))  
10 Pinus wallichiana exp(( 2.697278 + 2.659289 *  log (D))  
11 Picea spinulosa (dbh >75 cm) exp((-1.074891+ 1.893688* log (D) + 0.973121* log (H))  
12 Picea spinulosa(dbh >75 cm) 0.056861  + -1.792121* D + 14.1088 * (D^2)  
13 Picea spinulosa(dbh< =75 cm) exp((-1.074891+ 1.893688* log (D) + 0.973121* log (H))  
14 Picea spinulosa(dbh < =75 cm) exp((2.611759 + 2.487319*  log (D))  
15 Betula exp((-0.46151 + 2.039844 * log (D) + 0.837461* log (H))  
16 Betula 0.050548  + -1.295192 * D + 11.040967 * (D^2)  
17 Acer exp((-0.59555 + 2.02481* log (D) +0.854745* log (H))  
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18 Acer 0.026551 + -1.013426 * D + 9.67034 * (D^2)  
19 Quercus(dbh > 79 cm) 0.002111 + 0.392382 * D^2 * (H) 
20 Quercus(dbh > 79 cm) 0.051611 +-1.589755 * D + 12.242112 * (D^2) 
21 Quercus(dbh <= 79 cm) 0.00211 + 0.392382 * D^2 * (H) 
22 Quercus(dbh <= 79 cm) exp(( 2.435867 + 2.436696 *  log (D))  
23 Juniperus exp((-0.565323 + 1.984601* log (D) + 0.822937* log (H))  
24 Juniperus exp(( 2.101388 + 2.418695 *  log (D))  
25 Cupressus exp((-0.565323 + 1.984601* log (D) + 0.822937* log (H))  
26 Cupressus exp(( 2.101388 + 2.418695 *  log (D))  
27 Rest of species exp((-0.565323+ 1.984601* log (D) + 0.822937* log (H))  
28 Rest of species 0.041566 + -1.075224 * D + 9.402206 * (D^2)  

 
(iii) Southern Bhutan  

(Sarpang, Samtse, Dagana, Tsirang,) 

SL No. Species Volume 
1 Pinus roxburghii  (-0.00156 + 0.32159 * D^2 * (H) 
2 Pinus roxburghii  (0.291801 + 6.041763 * D + -2.430993 * SQRT(D))^2 
3 Picea spinulosa exp((-1.29816 + 1.86384 * log (D) + 1.03333 * log (H))  
4 Picea spinulosa exp((2.763193 + 2.605962 * log (D))  
5 Abies densa exp((-1.38883 + 1.77028 * log (D) + 1.04424 * log (H))  
6 Abies densa 0.10774 + -2.09529 * D + 12.62008  * D^2 + -1.61065 * D^3 
9 Tsuga dumosa exp((-1.409685 + 1.846742 * log (D) + 1.045675 * log (H))  
10 Tsuga dumosa 0.0084144 + -0.597856 * D + 10.619647 * D^2 
11 Quercus 0.002111 + 0.392382 * D^2 * (H) 
12 Quercus 0.20699 + -3.13612 * D + 15.76557 * D^2 + -1.95718 * D^3 
13 Betula exp((-0.46151 + 2.039844 * log (D) + 0.837461 * log (H))  
14 Betula (0.37101 + 5.19075 * D + -2.12667 * SQRT(D))^2 
15 Alnus exp((-0.565323 + 1.984601 * log (D) + 0.822937 * log (H))  
16 Alnus 0.41455 + -1.3712 * SQRT(D) + 11.33119 * D^2 
17 Acer 0.03873 + 0.36273 * D^2 * (H) 
18 Acer 0.20762 + -2.49698 * D + 12.94655 * D^2 
19 Castanopsis (-0.00794 + 0.34759 * D^2 * (H) 
20 Castanopsis (-0.02301 + 0.12721 *D + 2.4127 *D^2 + 8.12834 * D^3 
21 Michelia & Alcimandra 0.00667 + 0.32947 * D^2 * (H) 
22 Michelia & Alcimandra (0.53034 +-1.84392 * SQRT(D) + 11.2917 * D^2 
23 Terminalia myriocarpa (0.00635 + 0.35936* D^2 * (H) 
24 Terminalia myriocarpa 2.52144 + 2.31085 * log(D) 
25 Phoebe hainesiana (-0.0432 + 0.3622 * D^2 * (H) 
26 Phoebe hainesiana (-0.65767 + 3.2165 * D + 0.80684 * SQRT(D))^2 
27 Schima wallichi (-0.565323 + 1.984601 * log(D) + 0.822937 * log(H)  
28 Schima wallichi (0.28069+ 4.6198 * D + -1.65381 * SQRT(D))^2 
29 Aphanomixis polystachya (-0.09768 + 0.01051* H + 0.31875 * D^2 * (H) 
30 Aphanomixis polystachya (-0.00144 +3.94308 * D + -0.79729 * SQRT(D))^2 
31 Tetrameles nudiflora (-1.3361 + 1.75959 * log(D) +0.99492 * log(H)  
32 Tetrameles nudiflora (-0.5098 +2.41166 * D + 1.12639 * SQRT(D))^2 
33 Duabanga grandiflora (-0.565323 + 1.984601* log(D) + 0.822937 * log(H)  
34 Duabanga grandiflora (-0.01217 + 3.3993 * D + -0.28981 * SQRT(D))^2 
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35 Ailanthus integrifolia (-1.94825 + 1.7273  * log(D) + 1.1669 * log(H)  
36 Ailanthus integrifolia (0.32056 + 5.16781 * D + -1.83345 * SQRT(D))^2 
37 Persea exp((-0.56664 + 2.03335 * log (D) + 0.87279 * log (H))  
38 Persea 0.07116 + -1.33867 * D + 9.8397 * D^2 + 2.29781 * D^3 
39 Symplocos spicata 0.00155 + 0.34028 * D^2 * (H) 
40 Symplocos spicata (-0.2433 + 2.44627 * D + 0.48232 * SQRT(D))^2 
41 Bombax ceiba exp((-0.70448  + 2.13777 * log (D) + 0.91127 * log (H))  
42 Bombax ceiba 0.04507 + -0.93461 * D + 5.48513 * D^2 + 9.16037 * D^3 
43 Sterculia villosa 0.00231  + 0.34018* D^2 * (H) 
44 Sterculia villosa (0.35895 + 4.99513 * D + -2.14135 * SQRT(D))^2 
45 Engelharatia spicata exp((-0.14969 + 2.1532* log (D) + 0.76463 * log (H))  
46 Engelharatia spicata exp((2.47635 +2.51046* log (D))  
47 Beilschmiedia exp((-565323 + 1.984601 * log (D) + 0.822937 * log (H))  
48 Beilschmiedia (0.51191 +-1.78643* SQRT(D) + 11.19974 * D^2 
49 Rest of species exp((-565323 + 1.984601 * log (D) + 0.822937 * log (H))  
50 Rest of species (0.12404 + 4.00303 * D + -1.09844 * SQRT(D))^2 

 

(iv) Eastern and Central Bhutan  
(Bumthang, Trongsa, Zhemgang, Mongar, Trashigang, Lhuntse, Pemagatshel, Trashiyangtse, 
Samdrup Jongkhar) 

SL No. Species Volume 
1 Pinus roxburghii  (-0.00156 + 0.32159 * D^2 * (H) 
2 Pinus roxburghii  (0.291801 + 6.041763 * D + -2.430993 * SQRT(D))^2 
3 Pinus wallichiana exp((-1.049334 + 1.926332 * log (D) + 0.967612 * log (H))  
4 Pinus wallichiana 0.185555 + -3.040264 * D + 16.183975  * D^2  
5 Picea spinulosa exp((-1.29816 + 1.86384 * log (D) + 1.03333 * log (H))  
6 Picea spinulosa exp((2.763193 + 2.605962 * log (D))  
7 Abies densa exp((-1.38883 + 1.77028 * log (D) + 1.04424 * log (H))  
8 Abies densa 0.00259071 + -0.314273  * D + 9.530927  * D^2  
9 Tsuga dumosa exp((-1.409685 + 1.846742 * log (D) + 1.045675 * log (H))  
10 Tsuga dumosa (-0.480494 + 2.738112 * D + 0.948655 * SQRT(D))^2 
11 Quercus 0.002111 + 0.392382 * D^2 * (H) 
12 Quercus (-0.020144 + 4.292089 * D + -0.894675 * SQRT(D))^2 
13 Betula exp((-0.46151 + 2.039844 * log (D) + 0.837461 * log (H))  
14 Betula exp((2.460537 + 2.447069* log (D))  
15 Acer 0.03873 + 0.36273 * D^2 * (H) 
16 Acer (0.374246 + 4.759591 * D + -1.89151 * SQRT(D))^2 
17 Castanopsis (-0.00794 + 0.34759 * D^2 * (H) 
18 Castanopsis exp((2.319413 +2.653453* log (D))  
19 Rhododendron exp((-0.565323+ 1.984601* log (D) +0.822937 * log (H))  
20 Rhododendron (0.306492 + 4.31536 * D + -1.749908 * SQRT(D))^2 
21 Michelia & Alcimandra 0.00667 + 0.32947 * D^2 * (H) 
22 Michelia & Alcimandra 0.0788115 + -1.973758 * D + 12.357088 * D^2  
23 Phoebe hainesiana (-0.0432 + 0.3622 * D^2 * (H) 
24 Phoebe hainesiana 0.041943 + -1.807981 * D + 12.730082 * D^2 
25 Persea exp((-0.56664 + 2.03335 * log (D) + 0.87279 * log (H))  
26 Persea 0.136186 + -2.1264 * D + 12.734067 * D^2 
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27 Symplocos spicata 0.00155 + 0.34028 * D^2 * (H) 
28 Symplocos spicata (-0.212798 +3.288996 * D + 0.046417 * SQRT(D))^2 
29 Engelharatia spicata exp((-0.14969 + 2.1532* log (D) + 0.76463 * log (H))  
30 Engelharatia spicata exp((2.535662 + 2.519379 * log (D))  

 

1.9. Forest Function Mapping 

Forest function mapping is an essential step for sustainable forest management planning. The func-
tion mapping is a process of defining the forest management area into categories of area based on 
its function. The forest function map provides information on total sustainable production area, 
area for conservation and areas of ecologically, environmentally and socially important functions 
which needs to be protected with certain management restrictions.  

1.9.1. Categories of forest function 

The entire landscape for management is divided into six main groups depending on its functions (Table 
1.36). These groups include soil conservation, water and watershed conservation, nature conservation, social 
functions, road buffer and production function. These groups are further divided into sub-groups (protection 
and conservation) depending upon the management restrictions. The term protection is used where timber 
extraction is prohibited and the term conservation is used where timber extraction is allowed with limited 
management intervention.  

Table 1.36 List of different forest function groups and sub-functions 

Soil Con-
servation 

Water and Water-
shed Conservation 

Nature Con-
servation 

Social Function Road 
Buffer 

Production 
Function 

Soil Protec-
tion (SP) 

Riparian Reserve Pro-
tection (WRR) 

Wildlife Con-
servation 
(NWC) 

Religious Sites Pro-
tection (SocRS) 
 

Road 
Buffer 
(RB) 

Timber Pro-
duction 

Soil Conser-
vation (SC) 

Local Water Supply 
Protection (WLS) 

Biodiversity 
Conservation 
(NB) 

Social-Local Use 
Only 
(SocL) 

 Research and 
Development 
(PR) 

 Special Management 
Areas around Water 
Courses (WSMA) 

    

 Watershed Conserva-
tion (WC) 

    

 

1.9.1.1 Soil Conservation 

The group “Soil Conservation” is one of the most important functions and it is defined in order to prevent 
land and snow slides, damages caused by falling stones or rocks, protection of arable land, etc. Also, the 
protection of the topsoil from erosion is an essential measure in order to maintain the fertility and production 
capacity of the soil in the long run, which is a pre-condition for sustainable forest management and agricul-
ture. 
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Table 1.37. Soil protection and soil conservation 

 Soil Protection (SP) Soil Conservation (SC) 
Definition 
 

Soil Protection includes all areas which 
are extremely sensitive to soil erosion, 
land and snow slides. These areas include 
in particular very steep slopes, rocky and 
stony areas, water-logged gleys and al-
ready eroded areas. Unstable slopes above 
or near important objects such as villages, 
settlements, individual houses, roads, ag-
ricultural land, etc. are defined for protec-
tion reasons as Soil Protection, too.  

The Soil Conservation function covers all ar-
eas which are sensitive to soil erosion, which 
are, for example, steep slopes, waterlogged 
areas and exposed sites. 
 

Objective (1) to prevent damages caused to the envi-
ronment and infrastructure by land-
slides, snow slides, falling stones and 
other physical impacts; 

(2) to protect the soil from erosion and to 
sustain soil fertility. 

(1) to minimize or prevent negative impacts 
due to forest resource use in order to pro-
tect the soil from erosion and other degra-
dation processes and to sustain soil fertil-
ity. 

 
Legal 
Restrictions 
 

According to § 14 a (iii) of the Forest and 
Nature Conservation Act (1995) "no per-
mits shall be issued to fell and to take any 
timber where the slope is greater than 45 
degrees (100%) unless authorized under 
an approved management plan or by the 
Head of the Department." 

None. 
 

Identification Soil erosion depends largely on geology, site conditions (soil type, water regime, etc.) and 
slope gradient. In general, it can be said, the finer the soil texture, the steeper the slope 
and the higher the water content (saturation) the more sensitive the soil becomes towards 
erosion and landslides.  
Unfortunately, up to date soil maps do not exist for Bhutan. The only parameters, which 
can be easily assessed, are the slope gradient, the land use type and already existing signs 
of erosion (gullies, rills, landslides, etc.).  

GIS Analysis The following areas shall be classified as 
Soil Protection:  
• very steep areas (slope above 45°) 
• unstable areas and sites prone to land-

slides and areas with indications of se-
vere erosion. 

The following areas shall be classified as Soil 
Conservation: 
• steep areas (slopes of 25-45°) 
• areas with indication of slight to moderate 

erosion; 
• exposed sites (ridges, etc.). 
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GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

Open QGIS 

➢ Add FMU boundary layer 

 

Create a buffer of 500m around the FMU boundary to use it as area of interest (aoi). Buffer is being created 
to increase the extend of FMU as next steps involves using combination of vector and raster file. 

➢ Click Vector > Geoprocessing Tools > Buffer 
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➢ Save the buffer layer with appropriate name in working directory 

 

 

 

 

➢ Add Digital Elevation Model (DEM). DEM is raster data. 
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Clip the DEM within the aoi (500m buffer FMU boundary layer) 

➢ Click Raster > Extraction > Clip Raster by Mask Layer 

 

 

➢ Input layer: Select DEM of Bhutan 
➢ Mask layer: Buffered FMU boundary shapefile 
➢ Target CRS: Select EPSG:5266-DRUKREF 03/Bhutan National Grid 
➢ Save the clipped DEM with appropriate name in working directory 
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Generate SLOPE using DEM 

➢ Click Raster > Analysis > Slope 
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➢ Input layer: select FMU Dem (Dem_aoi in the example) 
➢ Leave the rest default 
➢ Save the SLOPE with appropriate name in working directory 

 

 

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        177 

 

 

Reclassify the SLOPE into following classes 

1. 0-35 
2. 35-45 
3. 45 and above 
➢ To carry out this process open NOTEPAD and type as following and save the text file with name 

slopereclass. 

*:35:1 

35:45:2 

45:*:3 

 

 

 

 

 

 

 

 

1 means 35 degree and below slope 

2 means 35 to 45 degree slope 

3 means 45 degree and above slope 
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Open the processing toolbox, if the toolbox is not open 

➢ Click Processing > Toolbox 

 

➢ Type r.recode in the search box of processing toolbox and open script by double clicking 

 

 

➢ Input layer: select FMU Slope 
➢ File containing recode rules: browse the text file containing reclassification code and insert 
➢ Save the reclassified SLOPE with appropriate name in working directory 
➢ Click Run 
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Insert you reclass text file here 
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Convert the reclasified slope rater file into vector file 

➢ Click Raster > Conversion > Polygonize (Raster to Vector) 

 

 

 

➢ Input: Select reclassified slope 
➢ Leave the rest default 
➢ Vectorized: Save the file with appropriate name in working directory 
➢ Click run 
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We need to segregate the reclassified slope into Soil Conservation and Soil Protection 

First, we shall segregate reclassified slope into soil protection 

➢ Right click vector reclassified slope file > Filter 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        182 

 

 

Enter expression as shown in the figure 

➢ Double click DN > Click = sign > click All (this shall display all DN value present in attribute 
table) > double click 3 > ok 
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Export the soil protection layer 

➢ Right click on filtered vector reclassified slope file > Export > Save Features As  
➢ Format: Select ESRI Shapefile 
➢ Save the file with appropriate name in working directory 

 

 

 

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        184 

 

 

 

 

 

In the exported soil protection file, there are several smaller areas surrounded by steep area. Accessing such 
areas are impossible, therefore, we need to include those areas under soil protection. 

➢ In the Processing Toolbox type “delete holes” >double click Delete holes tools 
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➢ In Input layer select soil protection layer 
➢ In Remove holes with area less than enter 100000 m2 (10 ha) 
➢ Save the file with appropriate name in working directory 
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Open the attribute table 

Right click on SoilProtectionFilled layer > click Open Attribute Table 
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Calculate the area of each polygon 

➢ Click Toggle editing mode > Click Open Field Calculator  
➢ Check in the Create a new field and type as follows 

o Output field name: Area_ha 
o Output field type: Decimal number (real) 
o Output field length 10 and Precision 3 

 

The expression field should be filled with area calculating expression 

➢ Click Geometry > double click $area  
➢ In the expression box divide $area with 10000; this is to convert the calculated area unit from m2 

to hectare.  
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➢ Close the editing mode by undo toggle editting 

There are also several isolated smaller steep areas, this should be removed from soil protection and merge 
it with soil conservation layer. 

To remove the isolated small patches (of area less than 5 ha) of steep area, filter the area of the soil protection 
layer for area greater than or equal to 5 ha (>= 5 ha) 

➢ Right click on working layer > click filter > and enter the expression as shown in picture below in 
Query Builder 
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Export the filtered layer and save it as soil protection layer 

➢ Right click on filtered layer > Export > Save Features As 
➢ Format: Select ESRI Shapefile 
➢ Save the file with appropriate name in working directory 

 

 

The exported soil portection layer contains area even outside the FMU boundary as we generated the slope 
for 500 m buffered FMU boundary. Therefore, we need to extract soil protection layer within FMU boundary 

➢ Clip with FMU Boundary 
➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
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➢ In Clip features: select Soil protection layer 
➢ In input features: select FMU boundary layer 
➢ Save the file with appropriate name in working directory 

 

 

Creation of soil protection is completed 
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Follow the aforementioned similar step to export soil protection layer with area less than 5 hectare 

We need to segregate the reclassified slope into Soil Conservation  

➢ Right click vector reclassified slope file > Filter 
➢ Enter expression as shown in the figure 
➢ Double click DN > Click = sign > click All (this shall display all DN value present in attribute 

table) > double click 2 > ok 
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Export the soil conservation layer 

➢ Right click on filtered vector reclassified slope file > Export > Save Features As 
➢ Format: Select ESRI Shapefile 
➢ Save the file with appropriate name in working directory 
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Overlay the soil protection layer with area less than 5 ha 

➢ Add soil conservation layer 
➢ Add soil protection layer less than 5 hectare 

 

 

We need to combine the filtered soil conservation layer and soil protection area less than 5 ha layer  

➢ In the Processing tool box type “Union” 
➢ Double click polygon union under SAGA tools 
➢ In Layer A: Select soil conservation 
➢ In Layer B: Select soil protection below 5 ha 
➢ Save the file with appropriate name in working directory 
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In the combined soil conservation and soil protection less than 5ha file layer, there are several smaller areas 
surrounded by steep area. Accessing such areas are impossible, therefore, we need to include those areas 
under soil conservation. 

➢ In the Processing Toolbox type “delete holes” >double click Delete holes tools 
➢ In Input layer select soil protection layer 
➢ In Remove holes with area less than enter 100000 
➢ Save the file with appropriate name in working directory 
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Since there are numerous polygons of soil conservation, these can be made as one polygon for better visu-
alization.  

➢ Type dissolve in Processing Toolbox 
➢ Navigate to GDAL tool and select Dissolve > double click to open the toolbox 
➢ Input layer: Select combined soil conservation 
➢ Save the file with appropriate name in working directory 
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Calculate the area of each polygon 

➢ Click Toggle editing mode > Click Open Field Calculator  
➢ Check in the Create a new field and type as follow 
➢ Output field name: Area_ha 
➢ Output field type: Decimal number (real) 
➢ Output field length 10 and Precision 3 
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The expression field should be filled with area calculating expression 

➢ Click Geometry > double click $area  
➢ In the expression box divide $area with 10000; this is to convert the calculated area unit from m2 

to hectare.  

 

 

➢ Close the editing mode by undo toggle editting 

 

Similar to soil protection, here too there are also several isolated smaller areas, this should be removed from 
soil conservation. 

To remove the isolated small patches (of area less than 5 ha) of steep area, filter the area of the soil conser-
vation layer for area greater than or equal to 5 ha (>= 5 ha) 

➢ Right click on working layer > click filter > and enter the expression as shown in picture below in 
Query Builder 
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Export the filtered layer and save it as soil conservation layer 

➢ Right click on filtered layer > Export > Save Features As 
➢ Format: Select ESRI Shapefile 
➢ Save the file with appropriate name in working directory 
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The exported soil conservation layer contains area even outside the FMU boundary as we generated the 
slope for 500 m buffered FMU boundary. Therefore, we need to extract soil conservation layer within FMU 
boundary 

Clip with FMU Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select FMU boundary layer 
➢ In input features: select Soil Conservation layer 
➢ Save the file with appropriate name in working directory 
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1.9.1.2 Water and Watershed Conservation 

Water is one of the most valuable natural resources and clean potable water is an indispensable asset for the 
human population. The protection of water resources therefore gains highest priority in resources manage-
ment. The function "Water and Watershed Conservation" focuses on the conservation of the cleanliness of 
the groundwater and surface water bodies and the maintenance of a continuous water supply. According to 
the objective of the function and the imposed management prescriptions/restriction different sub-functions 
are defined (Table 1.38).
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GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

➢ Open QGIS 
➢ Add FMU boundary layer 
➢ Add River networks layer 

 

 

Clip with FMU Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select FMU boundary layer 
➢ In input features: select River network layer 
➢ Save the file with appropriate name in working directory 
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Create buffer of 30m around the rivers 

➢ Click Vector > Geoprocessing Tools > Buffer 
➢ In Input layer: Select river layer 
➢ In distance: enter 30  
➢ Check dissolve result 
➢ Rest parameter leave as default 
➢ Save the file with appropriate name in working directory 
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The exported river buffer layer extends beyound FMU boundary. Therefore, we need to extract river buffer 
layer within FMU boundary 

Clip with FMU Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select FMU boundary layer 
➢ In input features: select river buffer layer 
➢ Save the file with appropriate name in working directory 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        207 

 

 

Note: Any stream that is being used as source of local water supply needs to be mapped as local water supply 
by generating 60m buffer on either side.   

➢ Add water source point layer 

 

Clip with FMU Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select FMU boundary layer 
➢ In input features: select water source point layer 
➢ Save the file with appropriate name in working directory 
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Create buffer of 30m around the water source point 

➢ Click Vector > Geoprocessing Tools > Buffer 
➢ In Input layer: Select water source point layer 
➢ In distance: enter 30  
➢ Check dissolve result 
➢ Rest parameter leave as default 
➢ Save the file with appropriate name in working directory 

 

If the generated buffer is extending beyond FMU boundary, it needs to be clipped with FMU boundary 

Note: If there is any wetland or watershed area that demands protection form sustainable timber harvesting, 
then such area can be designated as watershed special management area.  
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1.9.1.3 Social Functions 

The local population living in and around the forest landscape depend on forest as a resource for construction 
timber, firewood and fence posts. They also use the area for collection of NWFP and as cattle grazing 
ground. To avoid conflicts with commercial logging, the forest area used by the local people must be iden-
tified and, if required, a portion of the forest has to be set aside for their exclusive use (Table 1.39). It is of 
greatest importance, that the identification of the areas used by the local people and the decision on "social 
functions" is made in a participatory way. Therefore, the identification of social functions is subject of the 
PRA. There is one problem in defining and mapping social functions: they are not consistent and they de-
pend largely on social framework. Therefore, when mapping the social forest functions, future trends and 
developments need to be appraised.  

Religion plays an important role in Bhutan. Throughout the country, monasteries, gneys, meditation houses 
and other religious objects are located and many of them are in forested areas. To respect the sanctity of 
these holy places and in order not to disturb people in their religious practice, no forestry operations should 
take place in the immediate vicinity of religious sites. 

Table 1.39.  Social functions 

 Social (SocL) 
(Local Use Only) 

Social (SocRS) (Religious Site Pro-
tection) 

Definition 

 
Forest areas which are, and have been, tradition-
ally used intensively by the local population and 
which are an integrated and indispensable com-
ponent of their subsistence should be set aside 
for Local Use Only. 

Religious sites are lhakhangs/goenpas 
and gneys and all other places used by 
people to practice religion. 

Objective (1) to provide the local population with sufficient 
forest products for their subsistence needs in 
a sustainable way; and 

(2) to exclude forest areas from commercial log-
ging, where the commercial use of the forest 
is in contradiction with objective (1). 

(1) not to disturb people in their reli-
gious practice and to respect the 
sanctity of these places. 

Legal 
Restrictions 
 

None!  None! 

Identification The definition and mapping of social functions 
is done during the PRA after the decision has 
been taken to open a FMU. The procedures for 
identifying the individual functions shall be pre-
scribed in the PRA manual. Criteria for the iden-
tification are:  
• vicinity to settlement or village; 
• accessibility; 
• forest type and condition (can the area provide 

the required product in a sustainable way?) 
• site capability (production potential) 
• traditional use and user (any registered rights?) 
• local demand on wood and NWFP 
• visibility of boundaries (natural features) 
• prospective of future social development (i.e. 

population growth, market structures) 
• other functions. 

During the process of RRA and PRA all 
religious sites should be identified and 
point coordinates collected. 
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GIS Analysis • the local use area boundary agreed during the 
FMU meeting 

 

• 100 m buffer on the point coordinates 
 

Short Descrip-
tion of Man-
agement Pre-
scriptions/ Re-
strictions 

No commercial exploitation! 
 
Note: Removal of trees shall be considered in the 
following cases: 
1. Epidemic out-break. 
2. For silvicultural reasons. 

Strict protection! 
Buffer zones around religious sites 
shall have to be exempted from com-
mercial logging. However, silvicultural 
improvement measures such as plant-
ing, weeding, tending and thinning 
should be planned and implemented if 
the religious site is located on a Soil 
Protection area and if the implementa-
tion of these measures are required for 
protecting these objects Only the local 
forest uses should be permitted which 
do not disturb the sanctity of the place. 
 
Note: Removal of trees shall be consid-
ered in the following cases: 
1. Epidemic out-break. 
On silvicultural reasons. 

GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

➢ Open QGIS 
➢ Add FMU boundary layer 
➢ Add Religious sites layer 

 

Clip with FMU Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select FMU boundary layer 
➢ In input features: select religious site point layer 
➢ Save the file with appropriate name in working directory 
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Create buffer of 100m around religious sites 

➢ Click Vector > Geoprocessing Tools > Buffer 
➢ In Input layer: Select water source point layer 
➢ In distance: enter 100 
➢ Check dissolve result 
➢ Rest parameter leave as default 
➢ Save the file with appropriate name in working directory 

 

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        212 

 

Since the buffer is extending beyond the FMU boundary, clip religious sites buffer with FMU boundary 

Clip with FMU Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select FMU boundary layer 
➢ In input features: select religious site buffer layer 
➢ Save the file with appropriate name in working directory 
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1.9.1.4 Nature Conservation 

According to the objective of nature conservation two different types of functions are distinguished: 

• Conservation of wildlife and wildlife habitats (in particular, rare or endangered species). 
• Protection of areas rich in biodiversity and/or of high ecological value. 

Table 1.40. Nature conservation functions 

 Wildlife Protection 
(NWP) 

Wildlife Conserva-
tion (NWC) 

Biodiversity Protection (NB) 

Definition 

 
This function includes 
all habitats and other 
areas where rare or en-
dangered mammals 
and birds occur and 
where the protection of 
these animals gains 
highest priority. 

All forests areas rich 
in species variety and 
number of wildlife, in 
particular, mammals 
and birds. 
 

Biodiversity can be defined as the diver-
sity of plants, animals and other living or-
ganisms in all their forms and level of or-
ganization, including genes, species, eco-
systems and the evolutionary and func-
tional processes that link them. Biodiver-
sity does not entail merely the preserva-
tion of a few rare, endangered or interest-
ing species, but rather the protection and 
conservation of the diversity of species, 
genetic materials, biophysical processes 
and ecosystem structures that together 
determine biological productivity and 
stability. 
 
The diversity of a given ecosystem is de-
fined by the following three components: 
• Composition: Ecosystems are com-

posed of organisms, species, groups of 
interacting species, genetic diversity 
within species, the remains of dead or-
ganisms, and various inorganic com-
pounds; 

• Structure: Ecosystem structure arises 
from the patterns in which the basic 
building blocks of composition occur. 
There are two types of structure: physi-
cal structure or spatial pattern (i.e. can-
opy layer, patchiness in distribution of 
species, etc.) and social structure (rela-
tionship of individuals, species, group 
of species to each other and to the eco-
system as a whole). 

Function: Function refers to the actions 
or interrelationships between compo-
nents of composition and structure. 

Objective (1) to conserve the hab-
itat of protected 
wild animals and 
corridors for their 
movement; and 

(1) to minimize or pre-
vent negative im-
pacts due to forest 
resource use on 
wildlife habitats 
and to minimize 

(1) to preserve rare and extra-ordinarily 
rich ecosystems and ecological niches 
and to protect them from human interfer-
ence in order to conserve the biological 
diversity within the concerned FMU. 
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(2) to prevent the pro-
tected animals from 
human disturbance. 

disturbances due to 
human impacts. 

 
Legal 
Restrictions 
 

According to § 22 (a) of the 
Forest and Nature Conser-
vation Act of 1995 alto-
gether 23 wild animals are 
totally protected in Bhutan ( 

Table 1.41). 

None! 
 
 

According to § 22 of Forest and Nature Conserva-
tion Act of 1995 the following plants are totally 
protected ( 

Table 1.41) 

Identification The determination of wildlife protection and 
conservation areas should be done during EA 
exercise, which should be carried out in close 
consultation with NCD, NEC, WWF and 
RSPN. Useful information can be derived from 
the FMU inventory and RRA/PRA. Criteria for 
the identification are: type and number of wild-
life species and protection status, actual vegeta-
tion and habitat condition, habitat size, and de-
gree of disturbance.  

The following areas should be allocated 
to forest function "Biodiversity Protec-
tion" (NB). 
• ecosystems rich in biological diversity 

(in particular flora and non-vertebrate 
animals such as reptiles, insects, am-
phibians); 

• rare ecosystems (i.e. swamp forests, 
gallery forests, alpine shrubs); 

• ecosystems and areas with a high per-
centage of protected flora; and 

• forest areas which should be conserved 
because of their extra-ordinary compo-
sition or structure. 

 
NB-areas are generally smaller than 
Wildlife Conservation areas and may 
range between 1 and 100 (or more) hec-
tares. 

GIS Analysis All areas where pro-
tected wildlife species 
occur.  

Areas identified as bi-
ological corridors and 
all areas rich in wild-
life, both in species 
and in number. Espe-
cially breeding areas, 
watering places, etc. 

All areas rich in biological diversity  

Short De-
scription of 
Management 
Prescriptions/ 
Restrictions 

Strict protection! 
Within wildlife refuge 
areas commercial log-
ging is strictly prohib-
ited. Local forest use is 
only permitted if the 
habitat quality and 
structure is not signifi-
cantly changed and dis-
turbance to the pro-
tected animals is not 
long lasting and kept to 
a minimum. Road con-
struction within wild-
life refuge areas should 
be avoided as much as 
possible. 
 

Only management re-
strictions! 
Forest operations 
within Wildlife Con-
servation zones should 
minimize disturbance 
to understory vegeta-
tion, in particular 
bamboo, and to resid-
ual trees. Fruit and 
fodder trees for wild 
animals have to be ex-
cluded from exploita-
tion. Small pasture ar-
eas or gaps have to be 
left open and should 
not be reforested. Log-
ging operations should 

Strict protection! 
Commercial and local forest use are 
strictly prohibited. This refers also to the 
collection of NWFP and other minor for-
est products. If possible, these areas 
should be exempted from grazing. No 
road construction within NB areas. 
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Note: Removal of trees 
shall be considered in 
the following cases: 
1. Epidemic out-

break. 
2. On silvicultural rea-

sons. 

leave behind some un-
disturbed forest 
patches irregularly 
distributed within a 
coup.  
At least one snag tree 
per ha of big diameter 
has to be left in order 
to provide arboreous 
living animals with 
tree cavities.  

 

Table 1.41 List of totally protected wild animals and Plants as per FNCA 1995 

 List of totally protected wild animals 

No. Common Name Scientific Name 
1. Asian Elephant Elephas maximus 
2. Clouded Leopard Neofelis nebulosa 
3. Golden Langur Presbytis geei 
4. Musk Deer Moschus chrysogaster 
5. Pangolin Manis crassicaudata 
6. Pigmy Hog Sus sylvanicus 
7. Snow Leopard Panthera uncia 
8. Takin Budorcas taxicolor 
9. Tiger Panthera tigris 
10. Wild Buffalo Bubalus bubalis 
11. Black-Necked Crane Grus nigricollis 
12. Monal Pheasant Lophophorus impejenus 
13. Peacock Pheasant Polyplectron bicalcaratum 
14. Raven Corvus corax 
15. Rufus-Necked Hornbill Aceros nepalensis 
16. Golden Mahseer Tor tor 
17. Spotted Deer Axis axis 
18. Gaur Bos gaurus 
19. Leopard Panthera pardus 
20. Leopard Cat Felis bengalensis 
21. Himalayan Black Bear Selenarctos thibetanus 
22. Red Panda Ailurus fulgens 
23. Serow Capriocornis sumatraensis 

List of totally protected plants 

No. Local Name Common Name Scientific Name 
1. Agar/agaru Eagle Wood/Indian Aloe Wood Aquilaria malaccensis 
2. Yaetsa-guenboop Chinese caterpillar Cordyceps sinensis 
3. Pang-gen metog  Gentiana crassuloides 
4.  Snow down lily Lloydia yunnanensis 
5. Tsher-ngeon Blue poppy Meconopsis grandis 
6. Kirang-shing Yew Taxus baccata 
7. Bhreeng-gee-ra-dza Ginseng Panax pseudo-ginseng  

 

GIS Steps 
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If there is any threatened and protected flora, fauna and avi-fauna is present within the FMU boundary, their 
habitat should be mapped out. If there are no such threatened and protected species, mapping this function 
may not be necessary. Similarly, in this example FMU, there are no such species. In such cases, soil protec-
tion function can be an overlapping function. Soil protection function can be also mapped as wildlife pro-
tection function. 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

➢ Open QGIS 
➢ Add FMU boundary layer 
➢ Add Soil Protection layer 

 

 

Export this soil protection layer as wildlife protection layer 

➢ Right click on filtered vector reclassified slope file > Export > Save Features As 
➢ Save the file with appropriate name in working directory 
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1.9.1.5 Road Buffer 

Bhutan being a mountainous country, motorable roads are often constructed on steep slope. In order to 
protect the road from falling boulders, soil erosion, land and snow slides, and surface run-off the forest lying 
on either side of the road should be kept undisturbed.  

Table 1.42. Road Buffer Function 

Road Buffer (RB) 
Definition A road buffer is the zone along a road where the implementation of forest activities may 

have direct negative impact on the road itself or on the security of the traffic. 
Objective to protect the road from rock fall, land and snow slides, surface runoff of precipitation and 

erosion and to safeguard traffic. 
Legal 
Restrictions 
 

According to § 14 a (i) of the Forest and Nature Conservation Act (1995) "no permit shall 
be issued to fell and take any timber within 600 feet (200 m) uphill and 300 feet (100 m) 
downhill of motorable roads except forest roads." 

Identification Segregate between public motorable road and forest road 
GIS Analysis • National Highway: 180 m buffer on either side of the road 

• Dzongkhag road: 30 m buffer on either side of the road 
• Farm road: 30 m buffer on either side of the road 
• Access road: 30 m buffer on either side of the road 
• Forest road: 20 m buffer on either side of the road 

Short Descrip-
tion of Man-
agement Pre-
scriptions/ Re-
strictions 

Commercial logging within road buffer zones is prohibited, including felling and removal 
of trees for local use. However, trees which are a source of danger for the road, or the 
traffic on it, shall have to be felled as soon as possible. This refers namely to dead or 
decayed trees, or exposed single trees which may break or fall during storms or heavy 
winds. The collection of NWFP such as fruits, medicinal herb, mushrooms etc. for the 
local use may be permitted as well as the collection of dead wood and fallen branches for 
firewood. 
 
Note: Removal of trees shall be considered in the following cases: 
1. Epidemic out-break. 
2. On silvicultural reasons 

 

GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

➢ Open QGIS 
➢ Add FMU boundary layer 
➢ Add Road network layer 
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Clip with FMU Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select FMU boundary layer 
➢ In input features: select road network layer 
➢ Save the file with appropriate name in working directory 

 

 

Open attribute table and look at the column Road_Type. There are different types of road 

➢ Right click on Road layer > Click Open attribute table 
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Select Primary National Highway through filtering process 

➢ Right click road network layer > Filter 
➢ Enter expression as shown in the figure 
➢ Double click Road_Type > Click = sign > click All (this shall display road types present in attribute 

table) > double click Primary National Highway > ok 
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Create buffer of 180 m on either side of Primary National Highway 

➢ Click Vector > Geoprocessing Tools > Buffer 
➢ In Input layer: Select filtered Primary National Highway layer 
➢ In distance: enter 180 
➢ Check dissolve result 
➢ Rest parameter leave as default 
➢ Save the file with appropriate name in working directory 
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Select Dzongkhag Road, Farm Road, Access Road and Thromde Road 

➢ Right click road network layer > Filter 
➢ Click Clear the selection 
➢ Enter expression following expression: 

"Road_Type" = 'Access' OR "Road_Type" = 'Dzongkhag' OR "Road_Type" = 'Farm' OR 
"Road_Type" = 'Thromde' 

➢ Click Ok 
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Create buffer of 30 m on either side of Dzongkhag, Farm, Access and Thromde road 

➢ Click Vector > Geoprocessing Tools > Buffer 
➢ In Input layer: Select filtered Primary National Highway layer 
➢ In distance: enter 30 
➢ Check dissolve result 
➢ Rest parameter leave as default 
➢ Save the file with appropriate name in working directory 
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Now there are two different road buffer layers, we need to merge it together. 

 

➢ Type merge in processing toolbox 
➢ Navigate to SAGA and select Merge vector layers 
➢ In Input Layers: Select the file you want to merge (PrimaryNationalHighway_Buffer and 

Otherroad_Buffer) 
➢ Rest parameter leave as default 
➢ Save the file with appropriate name in working directory 
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Dissolve merged layers 

➢ Click Vector > Geoprocessing Tools > Dissolve  

 

 

 

➢ In input layer: Select the layer to be dissolved 
➢ Save the file with appropriate name in working directory 
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Dissolved road buffer extends beyond FMU boundary 

Clip with FMU Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select FMU boundary layer 
➢ In input features: select dissolved road buffer layer 
➢ Save the file with appropriate name in working directory 
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1.9.1.6 Production function 

This refers to the stable forest landscape from where timber can be sustainably produced without affecting 
the ecological, environmental and social functions.  

Production function (Pf) Research and Development (PR) 
Definition Forest area where timber production can 

be carried out sustainably 
Forest area set aside for research  

Objective to produce timber on sustainable basis  To study the impact of timber harvesting and 
climate change 

Legal 
Restrictions 
 

None! Limited harvesting shall be adopted 
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Identification Suitable forest area with high growing 
stock which is economically and technical 
feasible for timber harvesting and extrac-
tion 

Ideally undisturbed forest area shall be set 
aside. 

GIS Analysis Forested area left out after mapping of soil 
protection, riparian reserve protection, 
special watershed management area, local 
water supply protection, local use area, re-
ligious site protection, wildlife protection, 
biodiversity protection, road buffer and 
non-forest area. 

Area mapped as identified for research and 
development 

Short Descrip-
tion of Man-
agement Pre-
scriptions/ Re-
strictions 

• As per the prescribed silvicultural sys-
tem in accordance to the forest type  

• As per research objectives  

  

GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

➢ Open QGIS 
➢ Add FMU boundary layer 
➢ Add Land use and land cover (LULC) layer 

 

 

Clip with FMU Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select FMU boundary layer 
➢ In input features: select LULC layer 
➢ Save the file with appropriate name in working directory 
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Soil protection layers, water and watershed conservation layer, religious sites protection layers, nature con-
servation layers, and road buffer needs to be considered as protected areas where sustainable timber har-
vesting is restricted. 

➢ Add soil protection layers 
➢ Add riparian reserve buffer layer 
➢ Add local water supply buffer layer 
➢ Add religious site buffer layer 
➢ Add road buffer layer 
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Merge all the layers as one 

➢ Navigate to SAGA and select Merge vector layers 
➢ In Input Layers: Select the file you want to merge (Soil protection layers, Riparian reserve buffer 

layer, Local water supply buffer layer, Religious site buffer layer and road buffer layer) 
➢ Rest parameter leave as default 
➢ Save the file with appropriate name in working directory 
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Dissolve merged layers 

➢ Type dissolve in Processing Toolbox 
➢ Navigate to GDAL tool and select Dissolve > double click to open the toolbox 
➢ Input layer: Select merged protection layers 
➢ Save the file with appropriate name in working directory 
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Protected area needs to be updated in LULC  

➢ Type update in Processing Toolbox > select polygon update tool > double click to open the tool  
➢ In Layer A: select LULC of FMU 
➢ In Layer B: select merged protection layers 
➢ Save the file with appropriate name in working directory 
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Select only forest area as production area 

➢ Right updated LULC(LULC_andProtection) > Filter 
➢ Enter expression following expression: 

"CLASS" = 'Forests' 
➢ Click Ok 

 

Export the filtered layer and save it as production layer 

➢ Right click on filtered layer > Export > Save Features As 
➢ Format: Select ESRI Shapefile 
➢ Save the file with appropriate name in working directory 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        235 

 

 

 

Production area need to be divided into commercial use and local use 

➢ Add production layer 
➢ Add local use area layer 
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Clip the production layer with local use area 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select local use area layer 
➢ In input features: select production layer 
➢ Save the file with appropriate name in working directory 
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➢ Add production layer 
➢ Add commercial use area layer 

 

 

Clip the production layer with Commercial use area 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select Commercial use area layer 
➢ In input features: select production layer 
➢ Save the file with appropriate name in working directory 
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Apart from production layer, non-production layer also needs to be created, this layer comprises of any area 
apart from forest and protection layer.  

➢ Select only non-production area (Area other than forests and protected layer) 
➢ Right updated LULC(LULC_andProtection) > Filter 
➢ Enter expression following expression: 

"CLASS" = 'Built up' OR "CLASS" = 'Cultivated Agriculture' OR "CLASS" = 'Landslides' OR 
"CLASS" = 'Meadows' OR "CLASS" = 'Shrubs' OR "CLASS" = 'Water Bodies' 

➢ Click Ok 
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Export the filtered layer and save it as non-production layer 

➢ Right click on filtered layer > Export > Save Features As 
➢ Format: Select ESRI Shapefile 
➢ Save the file with appropriate name in working directory 
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1.9.2. Preparation of Forest Function Maps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

1.9.2.1 Soil Conservation Function Map 

Open QGIS 

Add following layers: 

➢ FMU Boundary, Blocks and Compartment layer 
➢ Rivers layer 
➢ Soil Protection layer 
➢ Soil Conservation layer 

Modify the colour of layers  

For polygon layer 

➢ Right click polygon layer > Properties > Symbology > Simple fill  

 

 

 

Adjust the Polygon area colour 

Adjust the Line colour 

Make transparent or opaque polygon area 

Adjust boundary line width 

Make boundary line transparent or opaque polygon  
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For Line layer 

➢ Right click line layer > Properties > Symbology > Simple line  

 

For Point layer 

➢ Right click point layer > Properties > Symbology > Simple marker 

 

Open New Print Layout 

 

➢ Type soil conservation as print layout title > ok 

Adjust the line colour 

Adjust the line width 

Make line transparent or opaque 

Adjust the point colour 

Adjust the outer line colour 

Make outer line transparent or opaque pol-
ygon  

Adjust the point size 
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➢ Click on Add Map 

 

➢ Move the mouse on page > felt click on mouse > drag the mouse to form box on the 

 page 
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➢ Right Click on the page > click page properties 
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In the item properties 

➢ Click Map 1> click Item Properties 
➢ Change the page size to A4  
➢ Orientation to Landscape (this depends on shape of FMU) 

 

 

Change the scale of map  

➢ Click Map 1> click Item Properties > Click Map 1 > Click Main Properties > Scale  
➢ Change to appropriate scale. 

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        245 

  

Insert the title of the map 

➢ Click add label 

  

➢ Move the mouse on page > felt click on mouse > drag the mouse to form box on 

 the page to fit the title 
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➢ In the Item Properties box > type appropriate title 

 

 To change the font and size of title 

➢ Click Font > configure format 
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➢ Change the font and size accordingly 
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Add legend on the map 

➢ Click Add Legend 

 

➢ Move the mouse on page > felt click on mouse > drag the mouse to form box on 

 the page to fit the legend 
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➢ In the item box > Click on legend > Click Item Properties > Click Column >  
Insert the appropriate number of columns required for displaying the legend 

 

➢ Drag and place the legend in the desired position 
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The name in the legend can be changed by renaming the layer 

➢ Right click the layer > Rename Layer > Type appropriate name on the layer 

 

Renamed layer shall be automatically updated in print layout (be sure to click auto update in legend items 
in Print Layout 
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Add scale on the map 

➢ Click on Add scale bar  

➢ Move the mouse on page > Left click on mouse > drag the mouse to form box on the page to fit 
scale 

 

 

Scale can be change to bar or numeric scale 

➢ In the item box > Click on Scalebar > Click Item Properties > Click Scalebar > Click Main Prop-
erties > Style > Change scale to bar scale or numeric scale 

It is also possible to have both bar scale and numeric scale on a map 
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Add North arrow 

➢ Click add North Arrow 

➢ Move the mouse on page > Left click on mouse > drag the mouse to form box on the page to fit 
North arrow 
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Add frame on the map 

➢ In the item box > Click on Map1 > Click Item Properties > Click Frame > Check Frame  

Colour, thickness and style can be adjusted accordingly 

 

Exporting the map 

Map can be exported as in three different format (JPEG, SVG and PDF)  

➢ Click Export as image > save the image in the destination folder with appropriate name 
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Resolution, width and height of map can be adjusted Export Option. 
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1.9.2.2 Water and Watershed Conservation Function Map 

Refer to mapping process for soil conservation function to produce water and watershed conserva-
tion function map 

Layers needed: 

➢ FMU Boundary, Blocks and Compartment layer 
➢ Rivers layer 
➢ Riparian Reserve Protection layer 
➢ Local Water Supply Protection layer 
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1.9.2.3 Social Function Map 

Refer to mapping process for soil conservation function to produce social function map  

Layers needed: 

➢ FMU Boundary, Blocks and Compartment layer 
➢ Rivers layer 
➢ Local use area layer 
➢ Religious sites protection layer 
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1.9.2.4 Nature Conservation Function Map 

Refer to mapping process for soil conservation function to produce social function map  

Layers needed: 

➢ FMU Boundary, Blocks and Compartment layer 
➢ Rivers layer 
➢ Wildlife protection layer 

 

1.9.2.5 Road Buffer Function Map 

Refer to mapping process for soil conservation function to produce road buffer function map  

Layers needed: 

➢ FMU Boundary, Blocks and Compartment layer 
➢ Rivers layer 
➢ Road layer 
➢ Road buffer layer 
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1.9.2.6 Production Function Map 

Production Function Map is divided into commercial production and local use only. The Production layer 
is derived upon excluding soil protection, riparian reserve protection, special watershed management area, 
local water supply protection, local use area, religious site protection, wildlife protection, biodiversity pro-
tection, road buffer and non-forest area layers. 

Refer to mapping process for soil conservation function to produce production function map  

Layers needed: 

➢ FMU Boundary, Blocks and Compartment layer 
➢ Rivers layer 
➢ Local Production layer 
➢ Commercial Production layer 
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1.9.3. Preparation of Management Circle Map 

For the ease of implementation, forest management area is grouped into three management circles viz. Pro-
tection Management Circle, Non-production Management Circle and Production Management Circle (Fig-
ure 1.8 Management Circle for FMU). 

• Protection Management Circle: This circle comprises of all the protection layers derived during the 
forest function mapping.  

• Non-production Management Circle: This circle comprises of non-forest layers after the exclusion of 
Protection Management Circle layers. 

• Production Management Circle: This circle comprises of stable forest area layer from where timber can 
be sustainably produced. The area remaining after exclusion of Protection and Non-production Man-
agement Circles is mapped as the Protection Management Circle. 

Refer to mapping process for soil conservation function to produce management circle map  

Layers needed: 

➢ FMU Boundary, Blocks and Compartment layer 
➢ Rivers layer 
➢ Protected merged layer (Soil Protection layer, Riparian Reserve Protection layer, Local Water 

Supply Protection layer, Religious sites protection layer, Wildlife protection layer, Road buffer 
layer); Rename this layer as “Protection Management Circle” 

➢ Non-production layer (area other than forests and protection layer); Rename this layer as “Non-
Production Management Circle” 
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Production layer; Rename this as “Production Management Circle” 

 

Figure 1.8 Management Circle for FMU 
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1.10. Calculating sustained yield 

1.10.1. Objective 

To determine the sustained yield expressed as annual allowable cut (AAC) for the operable area. 

1.10.2. Outputs 

Estimated allowable AAC for the operable zone (by working circle). Area statement and other tabular data. 

1.10.3. Lead responsibility 

Divisional Forest Offices 

1.10.4. Timing of the activity 

AAC calculation shall be undertaken after forest function mapping, inventory and data processing. 

1.10.5. The importance of yield regulation to sustainable forest management  

A prerequisite of sustainable forest management is that the removal of forest products does not exceed the 
rate of replacement. Without this basic balance, provided by yield regulation, sustainable forest management 
is impossible and the forest resource shall gradually be depleted (Higman et al, 1999).  Yield regulation, 
irrespective of the silvicultural system being applied, provides a basis for deriving a log harvest which is in 
balance with forest increment and for controlling the output to ensure that the cut is neither exceeded nor 
undercut (Armitage, 1998). 

Yield regulation is of great importance to the forest manager who needs to have predictable production 
levels each year. It must be clearly understood that the AAC calculated is the total maximum sustainable 
harvestable timber supply for each year of the plan period.  

All timber removal from the FMU should be within the estimated AAC. AAC is calculated by working 
circle and the summation of AAC of all the working circles shall be the AAC of the whole FMU. 

Box 1.4. A cautionary note 

It is essential that ad hoc and unplanned felling does not take place and that the AAC is not ex-

ceeded, nor timber harvested from areas where it has not been specifically allocated. In the event, 

timber harvesting should be done from unplanned area (e.g., fire burnt, Pest and disease, etc.,), the 

volume extracted shall be adjusted within the total AAC. 

AAC calculations are based on the best possible understanding of the forest resource at the time of plan 
preparation. However, it is essential that the AAC calculated is reviewed during the plan period and any 
necessary revisions are incorporated into the revised forest management and related operational plans.   

1.10.5.1 Regulation of yield 

In even-aged forestry, there are likely to be two types of yield; the final or main yield and the intermediate 
yield from thinning. In irregular (uneven-aged) forestry, the final and intermediate are indistinguishable and 
combined in one felling operation. 

Regulation of yield requires firstly a calculation of what the amount of the yield should be, secondly an 
apportionment of the yield to thinning and final felling and thirdly, construction of a cutting plan which 
determines the identity of stands to be felled or thinned and the timing of their felling or thinning (Osmaston, 
1984).   

The forest management plan should not rigidly prescribe the years in which particular stands shall be felled 
but shall state the sustained yield by working circle within the operable area of the FMU and define the 
principles that the forest manager (CFO/Unit In-charge) should observe in selecting annual coupes. The 
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operational plan shall clearly identify the areas to be harvested on an annual basis. It is essential that there 
is control or annual comparison of what has been prescribed and what is actually done, supported by an 
explanation of the differences. Unless there is such a control, undesirable differences between planning and 
implementation are liable to occur and multiply (Osmaston, 1984). 

1.10.5.2 Calculation of sustained yield expressed as annual allowable cut 

Yield regulation for the harvesting of timber is often defined by AAC.  The guidelines presented in this 
section of the code are designed to guide the forest management planner through the process of working out 
the AAC for an FMU; they should not be considered as rigidly prescriptive. The forest management planner 
should exercise professional expertise and judgement in deciding on the appropriate method to use. This 
section of the code includes both general recommendations and those specific to the Bhutanese context.   

In simple terms, the AAC can be volume-based or area-based: with an area-based approach the area of land 
to be harvested annually is fixed but the volume may fluctuate; with a volume-based approach, the volume 
is fixed but the area of land from which it comes may vary from year to year (Higman et al, 1999). AAC is 
the volume (or area) of timber that is available divided by the number of years required until the next harvest. 
The production area is divided into annual coupes for harvesting; in theory by the time that the last block 
has been cut, the first block should be ready to harvest again.   

Parkash (1986) states that methods of yield regulation based on volume (of growing stock or increment) are 
generally referred to as formula methods and warns that these should rarely be relied on as the sole basis of 
yield regulation as these are liable to inaccuracies when applied to normal forests. In that case of abnormal 
forests (i.e. forests where there is not an even distribution of age classes by area) they are particularly dan-
gerous as they are based on abstract quantities and pay little or no attention to the distribution of age classes 
and the condition of the crop.  The fact that a certain forest has a certain volume, and a certain increment, 
does not indicate whether any part of the forest is of exploitable size and, if so, how much. The use of an 
area check, when using formula methods, is essential. 

Yield regulation becomes a matter or combining the utmost use of what is available with the wise conser-
vation of growth potential until more precision of purpose and method can be attained.  Where uncertainty 
exists, it is essential to apply the precautionary principle, i.e. always stay on the safe side. 

Armitage (1998) states that where a knowledge of the uncut or regrowth, forest resources is incomplete, 
where there is little or no information on forest increment or where forest management is being introduced 
for the first time, the allowable cut should be derived using one of the classical empirical procedures. 

The many methods of yield calculation can be classified by the variables used: 

1. A combination of area and rotation (felling cycle) 
2. A combination of area, volume and rotation (felling cycle) 
3. A combination of volume and forest increment 
4. A consideration of volume only  

Table 1.43 presents a range of approaches to AAC calculation that have been used in FMUs in Bhutan and 
briefly presents the advantages and disadvantages of each. This table is not exhaustive but is designed to 
illustrate to the forest management planner the range of options that should be considered. 
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1.10.5.3 Further comments on AAC calculation 

Whitfield (2001) presents a review of a range of calculation methods that have been used in the FMU man-
agement planning in Bhutan and develops a rationale for the use of one particular approach. 

Which AAC calculation methodology?  

Volume or area? 

Area based approaches require less inventory data than for volume approaches and work well with an even 
distribution of volume over the forest which is not the case in the natural forests of Bhutan. An area based 
AAC would then indicate difficulties for authorized agency in practical planning and operational viability 
as actual volume brought to the market year on year would vary quite dramatically. It may also discourage 
a balanced approach to compiling the annual program. 

Expressing AAC by volume requires greater knowledge of the growing stock to appreciate whether a theo-
retical cut is actually likely to be sustainable but it is more useful in varied forests as it allows timber output 
to be stabilised. 

Standing or felled sale volume 

Felled merchantable volume is used in many countries. Whilst merchantable volume is ideal for authorized 
agency planning, at present it is not an appropriate measure for sustainable management of Bhutan’s forests. 

What about Increment? 

In theory, with a perfectly structured normal forest, it should be possible to sustainably cut the annual in-
crement each year. Some calculation methods rely quite heavily on increment. Unfortunately, data on 
growth rates is still very limited for Bhutan and it shall be some time before valuable data from permanent 
plots is available. In addition, we are not dealing with a perfectly structured forest but a very varied natural 
growing stock, some of which (particularly the fir zone) shall actually be in negative increment at present 
as the rate of decay exceeds new growth.  

In the long term, we would hope increment to increase as over mature stands are replaced by younger stock 
but it shall be many years before this second growth forest is available for harvest. In the meantime, we have 
an over mature growing stock and too little and unreliable increment data to use in determining AAC. 

Selecting the most appropriate method of AAC calculation 

A very wide range of formulae and calculation approaches are available and advantages and disadvantages 
can be argued for each. Whitfield (2001) suggests that whilst it is difficult to define a clear best method for 
Bhutan, there is a strong case for standardisation around a fairly simple and robust single methodology.  
However, as already stated, the forest management planner should exercise professional judgement in de-
ciding on the appropriate method; these guidelines are presented in order to aid this decision making not to 
actually make the decision. 

Whitfield (2001) recommend one particular approach (Equation 11) and comments that whether or not this 
approach is adopted is much less important than ensuring the data inputs to calculations are realistic and 
account for the various factors described.  This is a very important point; the variables that are entered into 
AAC calculations must be arrived at with reference to clearly defined parameters. 

The calculation of the theoretical or normalised cut is simple, easy to work with and communicate to all 
staff. More complex methods are not necessarily more accurate or useful. This method is also less dependent 
on reliable inventory data for the whole FMU, instead focusing on the volume for mature forest, which is of 
greatest interest for medium term planning. The calculation of this theoretical or normalised cut gives a 
reasonable starting point but no indication of whether the current structure of the forest is able to sustain 
that cut. It is then essential to analyse the existing growing stock by estimated maturity (age) class. The 
planner looks at the forest structure and very simply tries different strategies for a sustainable cut. It is then 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        266 

a process rather than a calculation method and should therefore help the planner understand the forest struc-
ture and arrive at a more practical solution than simply using a standard AAC formula.  

Working with uneven aged stands to start with makes the starting point for age class estimation quite ap-
proximate. For future working however, the concept of age classes should work well with the relatively 
even aged, systematic group selection and seed tree cutting approaches. Spreadsheets are also an ideal tool 
for working with these data. 

AAC calculation in detail 

 𝐴𝐴𝐶 =
𝑁𝑒𝑡 𝑜𝑝𝑒𝑟𝑎𝑏𝑙𝑒 𝑎𝑟𝑒𝑎

𝑅𝑜𝑡𝑎𝑡𝑖𝑜𝑛
 𝑥 𝐴𝑣𝑒𝑟𝑎𝑔𝑒 𝑉𝑜𝑙𝑢𝑚𝑒/ℎ𝑎 (18) 

Net operable area 

Beyond establishing the accessible area for the FMU with some precision and even establishing buffers for 
main mapable streams and rivers, other un-mapable minor terrain, rock, water or other conservation features 
shall prevent harvesting of small but significant patches.  

When the cable lines are being laid out, some patches are found to be inoperable due to, for example, small 
rock crags running across the main slope or other minor ridges that limit gravity system cable lines. FMUs 
and even blocks within FMUs can vary significantly in this respect.  

Reducing gross mapped area to net area should be decided with input from experienced Field office and 
authorized agency staff. It is suggested that for most FMUs, a reduction to net area should be applied at 
between 15% and 35%.  This can be expressed as a correction factor finop which is an estimate of the proposed 
operable area; a reduction of 15% would correspond to finop of 85% and a reduction of 35% to finop of 65%.   

This reduction is of course applied after the boundaries of the gross operable area have been decided and 
therefore only relates to those elements that could not be mapped.  

Group selection and other silvicultural systems almost inevitably lead to some small patches of mature tim-
ber being left in later phases due to the presence of new regeneration and the damage that total removal of 
the over-storey would cause. In such challenging terrain as Bhutan, exact geometric group layout is rarely 
possible, interlocking of groups is therefore more approximate and further area is lost. As silvicultural sys-
tems progress, experience can inform what allowance should be made for un-removable over-storey but for 
now it is recommended that area for the AAC calculation is further reduced by around 10%.  This can be 
expressed as a correction factor fsilv which refers to the area that can actually be harvested out of silvicultural 
reasons (i.e. it takes into account patches which shall not be removed due to silvicultural reasons). 

The two correction factors, finop and fsilv, are applied to the gross area in order to calculate the net area: 

 Net area = gross area X finop X fsilv (19) 

Rotation (and regeneration period) 

Rotation is an imprecise concept in silvicultural systems other than clear cutting and replanting. Yield reg-
ulation by size class is more common than by age in selection systems. However, for the group selection 
and seed tree systems in use in Bhutan, the objective is to have more or less even aged regeneration in the 
areas worked at each cut. 

Given that reliable increment data is still very limited for Bhutan, assumed rotation lengths need to be cau-
tious. There are a range of unanswered questions about regeneration potential and establishment of successor 
crops for most of the commercial species. 

If we consider the general age of say a future spruce and hemlock group at maturity to be 120 years, it shall 
clearly be more than 120 years since the stand was harvested. An optimistic regeneration period for most 
species in Bhutan may be years from completion of harvesting which would probably be comfortable for 
pine but perhaps challenging for fir. A minimum 10 years regeneration period should be added to the rotation 
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figure for calculation purposes. In FMU zones where regeneration is problematic and taking longer than 
this, greater allowances should be made. 

Delays in effective regeneration can seriously damage the prospects of achieving good regeneration at all, 
so it is important to address this issue on the ground rather than just build in longer and longer regeneration 
periods into the calculation. It should be ensured that the regeneration is established within the 10-year 
period. However, for subsequent plan period, regeneration period should be determined based on the assess-
ment of the regeneration in the past plan. 

Average standing volume 

The average standing volume is estimated from inventory of trees of ≥10 cm diameter collected as per 
Resource Inventory & Data Processing described in 1.8.  However, about 5 % reduction in the inventoried 
mature standing volume/ha for spruce and fir species above 60-100 years is advised due to death of some 
standing trees prior to harvest.  

The inventory shall of course have excluded any dead trees but working with over-mature natural stands, 
some further unrecoverable volume shall be lost before all the over-mature stands are finally harvested over 
the next say 60, 80, 100 years. Salvage cutting shall not practically be able to address all areas and small 
pockets. 

As the measure of AAC is standing rather than merchantable volume, this is not an allowance for rot but 
only subsequent death of standing trees. An allowance should be made based on experience and research 
findings. 

Table 1.44 Summary of suggested area, rotation and volume reduction factors 

Net Operable Area (applied af-
ter excluding all mappable inop-
erable) 

15-35% Gross to net harvestable area reduction 
10% reduction for un-removable over storey 

Rotation  +10 years minimum regeneration period for first plan 
For subsequent plan, based on regeneration success of past plans  

Mature Standing volume 5% fir & spruce zone mortality reduction 
 

Allowing for the above reductions, theoretical or normalised AACs can be calculated for the FMU. The next 
step is to analyse each by age class to evaluate whether this sustained cut can actually be delivered. 

It is important to remember that the sampling error stated on the inventory sheets must be taken into account 
when calculating AAC and that a reliable minimum estimate should be made.  Subtracting the sampling 
error percentage from the average standing volume per working circle does this. 

Maturity class analysis 

Data on maturity or age is not directly available although it is usually quite possible to categorize by maturity 
and assign estimated age classes to stand groupings. The Forest Type Maps usually provide canopy cover 
and tree height classes and together with inventory data, an average maturity class can be assigned to poly-
gons on the map. It is important to lump small polygons in with their neighbours, as we are only interested 
in a practical scale of working units. If a poorly stocked variable area is unlikely to improve over time then 
it should be classed as mature but of course taking into account the lower volume per hectare. In future, 
improved remote sensed imagery interpretation could provide Forest Type Maps directly by maturity classes 
rather than just canopy cover or tree height.  

To illustrate this point; in the Gidakom plan for the period 1992-2002 ((Dhital et al, 1992), the mixed conifer 
and fir working group included three stand classes; mature high density, immature high density and imma-
ture low density. For Gidakom mixed conifer, the mature class area was of course assumed to be at or above 
the future defined rotation age and the two immature class areas were evenly distributed between assumed 
age classes 30 and 40. Whether or not these stands are actually around that age or not is less important than 
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the judgement that assuming a 120-year rotation, they shall be mature and available for harvest in 80 and 
90 years time. The process of initially allocating stands to quite roughly estimated age classes should then 
be reasonably straightforward. Once harvesting begins, harvested area is recruited into the regeneration 
phase and monitoring of age classes from there on should become more precise.  

The theoretical example below shows how data from two maturity stratum of un-logged area in the mixed 
conifer working group are assessed. Sub-compartments 1 and 2 have been logged once. Data from their sub-
compartment records is summarised and amalgamated with the un-logged areas in this table to provide a 
total estimated age class distribution for the working circle. 

Table 1.45 Maturity class 

Mixed Conifer age class alloca-
tion  

 Area by Age Class 

 
Maturity Classes 

Total Net 
Operable 
Area 

Regen. 0-9 10 20 30 40 ------ 130+ 

Mature 500        500 

Immature  20   10 10     

          

Operational Forest Sub-Compt 1 100 10 20      70 

Operational Forest Sub-Compt 2 150 50       100 

 770 60 20 10 10    670 
 

With age data now structured, we can easily trial how a theoretical AAC of say 1500 m3, equivalent to say 
5 Ha of mature forest would develop over time. The exercise aims simply to check whether there is broadly 
enough mature area available to last until the younger age classes become available.  

In the example, 670 Ha of mature forest needs to last 110 years until the area currently in the 20-age class 
matures and luckily it does. If however there was only 330 Ha of mature forest then the AAC would have 
to be reduced: 330 Ha divided by 110 years = 3 Ha a year and 900m3. 

Balancing AACs for forest types/working groups 

The Gidakom approach works on a sustainable cut from each working group. Whilst this is a good starting 
point, probably the FMU as a whole should be the unit of sustainability, not any given forest type. AAC 
should still be built up by working group and the age class structure again analysed by group but this need 
not be the unit for FMU yield regulation.  

If there is going to be a gap in available mature timber from one working group in say 70 years (after the 
first growth mature stands have all been cut but the younger stands are still immature) another predominantly 
mature working group may be able to plug the gap. If however, on analysing the whole FMU production 
flows there is still going to be a gap in mature stand availability, the AAC of course has to be reduced. The 
process looks at how age class structure shall develop over the first rotation, first for each working group 
and then for the whole FMU. This is easily achieved using a spreadsheet, finally linking the individual zone 
sheets together for the whole FMU summary volume forecast. Different solutions can be tested very easily. 

The worked spreadsheet example provided in Table 1.47 Worksheet shows how volume flows from two 
different working groups may be managed on a whole FMU level.
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Thinning volume? 

Most AACs in current management plans include an element of thinning volume in the final calculation, 
usually for blue pine. Whilst silviculture thinning in pine is highly desirable, market limitations are currently 
preventing much of this planned volume being realised. The result is that the AACs have not been changed 
and the thinning element is just adjusted from the overall AAC. 

Until markets for smaller products are properly developed, annual thinning volume should not be added to 
AAC calculations. 

Considerations for broadleaved FMUs 

There are important unresolved problems with broadleaved silviculture in Bhutan; particularly limited un-
derstanding of regeneration dynamics of valuable species. Good regeneration has proved extremely difficult.  
The best silvicultural systems for managing broadleaved forest is uncertain and require more researches to 
achieve stand succession towards commercially useful species.  

When calculating AACs for broadleaved forest, it is therefore extremely important to be even more cautious 
and leave a considerable safety margin. Assumed rotation lengths used in calculations should be signifi-
cantly longer than the 100 years used in many plans at present.  

What is the unit of sustainability? 

All FMU management plans aim to manage FMU on a sustained yield basis. This, besides fulfiling local 
and national needs, also maintains ecological health. To ensure control and protection of the intensively 
managed forest, adequate staff should be placed for implementation of required interventions. There could 
however be production arguments for exceeding a sustainable cut for a period in some FMUs, particularly 
the pressure to log over mature wood before it is lost or further degraded.  It is recommended that FMUs be 
retained as the principle unit for sustained yield.  

Box 1.6 Avoiding problems and pitfalls with AAC 

Inventory procedures, forest data management, practical harvesting and marketing issues all impact 

on the ability to deliver a sustainable AAC.  These are dealt with in the appropriate sections of the 

code. 

In order to ensure that the AAC is set at a genuinely sustainable level, it is essential that: 

1. Structure of the existing forest should be taken into account. 

2. Assumed rotation lengths are realistic (e.g. account for long regeneration periods). 

3. Account is taken of the possible decline in utilisable standing volume (e.g. resulting from fir 

dieback and spruce bark beetle).  

4. The operable area is accurately estimated and does not include areas that are subsequently 

considered as practically inoperable. 

Sufficient allowance is made for portions of operable stands being inaccessible or inoperable due 

to small terrain features. Gross area must be reduced to a workable net area. 
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1.11. Silvicultural Systems and Prescriptions 

1.11.1. Objective 

To determine appropriate silvicultural systems for FMU. 

1.11.2. Outputs 

Statement of options and recommendations for silvicultural systems, supported by rationale. 

1.11.3. Lead responsibility 

Divisional Forest Offices in collaboration with FRMD. 

1.11.4. Introduction to silvicultural systems 

Silviculture is the art and science of controlling the establishment, growth, composition, health and quality 
of forests and woodlands to meet the targeted diverse needs and values of landowners and society on a 
sustainable basis. Silviculture involves manipulating the natural biological processes of the forest in order 
to achieve specific end results.  It includes all operations that are done between one harvest and the next, 
such as planting, thinning, pruning and weeding. Harvesting operations are a major silvicultural treatment 
(Higman et al, 1999). 

The choice of silvicultural system is crucial in determining whether the forest can produce the desired prod-
ucts and services on a sustainable basis. The sustainability of the forest ecosystem under management de-
pends on the silvicultural systems applied; applying the wrong silvicultural system shall damage the forests 
ability to regenerate or provide the desired results (Higman et al, 1999). For example, past experience shows 
that the strip clear felling was not successful in broadleaf forest of Bhutan. 

1.11.5. Types of Silvicultural Systems  

This section outlines the principles of silvicultural systems commonly adopted in Bhutan and presents some 
ideas on management approaches. Because silvicultural systems depend upon so many factors it should not 
be assumed that they can be applied uniformly across all regions. The system that works well in one forest 
type may not work in another. Long-term research is needed to understand the effects of individual silvicul-
tural interventions and their combined effects (Higman et al, 1999). 

1.11.5.1. Selection System 

In selection systems, felling and regeneration are not confined to certain parts of the forest but are distributed 
all over the operational area. The felling involves removing single tree or small groups of trees.  Felling 
done in this manner are termed selection felling; they result in an uneven-age or irregular type of forest in 
which all the age or size classes are mixed together over every part of the area (adapted from Mathews, 
1999). 

Under selection systems, scattered trees or groups of trees are selected over the whole area and removed.  
Where conditions are favourable, natural regeneration springs up in the gaps so created.  Under ideal con-
ditions this process goes on year after year over the whole forest, the volume being removed being fixed by 
rules of management.  This results in the constant maintenance throughout the whole area of an uneven-
aged or irregular structure (adapted from Mathews, 1999). 

In their most primitive form, selection felling consists of removing all trees that have attained a certain 
diameter, sometimes with the provision that any trees that have attained a certain diameter should be re-
tained.  Such crude and unregulated selection felling are mere exploitation requiring little or no silvicultural 
skill; they do not ensure regeneration nor do they provide for a regular sustained yield and they often result 
in serious deterioration of the forest (Mathews, 1999) 
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Selection felling should provide for sustained yields by making thinnings among the various age classes to 
ensure that: 

1. these are maintained in their correct proportions 
2. a suitable mixture of species is maintained 
3. young saplings are freed from suppression 
4. defective stems are removed wherever they are hampering better ones 

1.11.5.1.1. Single-tree selection system  

In this system, individual trees are removed and new regeneration is expected to occur in their place (Dhital, 
1993b). This system is more suited to shade-bearing than light demanding species, since the gaps created 
by the removal of single trees are too small for the regeneration of light demanders or for the smaller trees 
to escape suppression from the larger ones standing over them (Mathews, 1999). 

Single tree selection system is usually prescribed for even aged to achieve uneven aged stand and result in 
a mixed and stratified structure with a continuous series of age classes, and continual recruitment to the 
growing stock by natural regeneration.  The distribution of stem diameters is such that each diameter class 
has fewer stems than the adjoining smaller diameter class, and also the ratio of the number of stems in a 
class to the number of stems in the adjoining class is constant. 

Further consideration should be given to felling cycle, the structure of the growing stock and yield regula-
tion; refer to Mathews (1999) and Osmaston (1984).  

1.11.5.2. Group selection system 

The group selection system is a form of selection system that is suited to a range of species, ranging from 
light-demanders, through moderate shade-bearers to shade-enduring species (Mathews, 1999).  Group size 
is varied in accordance with light requirements.  The group selection system can be very appropriate for the 
conversion of regular to irregular forest.  

The group selection system is commonly used system in Bhutan in both conifer and broadleaved forest 
types.  No treatment of the forest floor to induce natural regeneration is required in the mixed conifer forests 
managed under the group selection system (Norbu & Desmond, 2000).  Norbu & Desmond, 2000 observed 
a significantly higher number of seedlings on wet sites compared to dry sites for spruce, hemlock, and all 
species combined.  This indicates that the suitability of the group selection system within the mixed conifer 
forest may also depend on site conditions (soil, slope, aspect, etc.). The main practical problem with this 
system is that of securing regeneration of the right species.  This system mainly depends upon natural re-
generation; however, understanding regarding the conditions that shall provide good regeneration of the 
desired species is still incomplete (RGoB, 1991). 

Criteria for selection of groups, as presented by Dhital (1993b) and Statz & Wyrsch (1993), are included in 
the code section on Silvicultural Considerations. From a study of silvicultural systems in mixed conifers 
(Thimphu and Bumthang), group selection is considered an appropriate silvicultural system for managing 
temperate conifer forests.  The system promotes natural regeneration and requires no treatment of the forest 
floor to induce natural regeneration (Moktan, 2003). However, if there is poor natural regeneration, some 
level of floor treatment may be recommended to assist the natural regeneration. 

1.11.5.3. Seed tree system 

The seed tree system is a form of uniform system in which the seed bearers are widely spaced over the area 
to be regenerated.  It is mainly used for light demanding species with seed that is dispersed by wind 
(Mathews, 1999). 

The seed tree system is recommended for pine forest and commonly practiced in the temperate region.  Pines 
are pioneer species that regenerate easily when light is ample and are not suited to selection systems.  The 
pine forest types where the seed tree system can be applied is characterized by sparse ground vegetation, 
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which provides good conditions for natural regeneration; not all pine forest types provide this condition 
(RGoB, 1991). 

It is an even-aged system in which the generation shift is facilitated through a natural regeneration phase.  
During this phase, the mature stand is opened through a number of regeneration felling where the remaining 
trees serve as seed trees.  This phase can be 10-20 years long and include three felling occasions.  The last 
seed trees are removed when the regeneration is established in terms of number or trees per hectare and 
average tree height (RGoB, 1991), or left indefinitely (Dhital, 1993b). 

Box 1.7 Factors determining the success of seed tree methods 

The success of the seed tree method depends on (Mathews, 1999): 

1. selection of superior seed bearers for phenotypic quality of stem and branching habit, ab-

sence of serious damage by disease, evidence of ability to produce seed, and wind firmness 

2. high production of viable seed per tree 

3. adequate dispersal of seed on to well-prepared seed-beds 

4. good survival of seedlings during the critical early stages of growth 

 

The main difference from the shelterwood cutting is that the remaining crown cover is not enough to make 
the cutting area micro-climatically different from a broad, open, clear cut area (Dhital, 1993b). Dhital 
(1993b) states that this system should not be applied on steep and exposed south and southwest sites in Blue 
pine.  On such sites a selection system should be applied. 

1.11.5.4. Clear cutting (and plantation) systems 

Under clear felling systems successive areas are clear felled and regenerated, usually by artificial means but 
sometimes naturally.  

Clear cutting is an appropriate silvicultural system recommended in the event of periodic catastrophic dis-
turbance.  For example, fire burnt, insect and disease infestation, etc. This helps in containing and preventing 
further spread of pest and diseases.  

1.11.5.5. Coppice system 

The coppice system involves reproduction by stool shoots or suckers.  When felled near ground level many 
broadleaved species, up to a certain age, reproduce from coppice from the stool of stump.  Coppice is usually 
cut close to the ground.   

Coppice is essentially a system for the production of fuelwood and small or medium-sized material, but not 
for the production of large timber.  The rotation is determined by the specification of the produce required.  
Coppice can be managed on the basis of annual coupes by area. 

Whilst not widespread or in extensive use in Bhutan, the coppice system may be appropriate for the man-
agement of certain forest types for certain objectives; e.g. evergreen oak forest for fuelwood. 

A variation of the coppice system is coppice with standards, this consists of two distinct elements; a lower 
even-aged storey treated as coppice and an upperstorey of standards (single-stemmed trees usually grown 
for timber) forming an uneven-aged crop and treated as high forest.  This system is not widely applied in 
Bhutan but is worthy of consideration for local use forest areas where timber and firewood production can 
be combined.  

• Coppice and coppice with standards silvicultural system 
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1.11.6. Silvicultural characteristics and considerations in relation to the main forest types and 
tree species 

This sub-section includes information on silvicultural characteristics and considerations with reference to 
the main forest types and tree species.  It has been compiled from research references and other sources in 
order to provide background information and to serve as a reference for the forest management planner. 
Where information is available specific to species it is included under species sub-headings, where infor-
mation is available by forest type it is included under forest type sub-headings.  This information presented 
is not exhaustive and is in the form of an indicative summary; forest management planners should strive to 
continually develop their understanding of applied forest ecology and silviculture and make sure that they 
are familiar with current research reports etc. (such as Gratzer & Glatzel, undated). 

1.11.6.1. Subtropical forest 

Forests along the southern foothills may be broadly classified as subtropical forest, forming dense jungle on 
steep slopes and river banks. Natural Sal forests (Shorea robusta) occurs as scattered patches in Sarpang 
and Samtse Dzongkhags. These forest types occurs at an altitudinal range of 130 to 1000 m.a.s.l , extending 
upto 1200 m.a.sl and characterized with high precipitation ( 2500 to 5000 m.a.s.l).  

Silvicultural characteristics of some of the major tree species found in the subtropical forest are detailed in 
Table 1.49 

Table 1.49 Silvicultural characteristics of some key species in subtropical forest 

Sl. No Name Silvicultural Characteristics 
1 Shorea robusta (Sal) 

 
• large gregarious tree found scattered in Sarpang and Samtse 

Dzongkhags 
• light demander and grows well in well drained sandy loam soil 

with water retention capacity of 85%. 
• sensitive to drought and grazing 
• moderately frost hardy and fire resistant 

2 Duabanga grandi-
flora (Patang shing) 

• Light demander from an early age and seedling thrive in areas 
exposed to light. 

• Young seedling subject to damage by insect, drought & heavy 
shade 

• Require complete drainage and loose moist soil for survival.  
3 Chukrasia tabularis • Seedlings are sensitive to drought. However, excess soil mois-

ture can cause seedlings to damp-off. 
• Usually evergreen in its natural range and deciduous else-

where. 
• Found in well-drained moist soils in the plains. 
• Sensitive to browsing. 
• Require comparatively lighter thinning in the early stages 

 

1.11.6.2. Chir pine forest 

Chir Pine forests in Bhutan are confined to low altitude (900 to 1800 m.a.sl (-2000 m.a.s.l)), xero-
phytic forests which usually occur in the deeper dry/rain shadow valleys namely., Mo 
Chhu/Sunkosh river, Kuri Chu and Kholong Chhu/ Drangme Chhu systems. These valleys have a 
very long dry season during which forest fire is common, and heavy rain occurs only in the mon-
soon season when abundant herbs, especially grasses, appear. Grazing is widespread but Chir Pine 
needles are not palatable to cattle. The annual rainfall ranges from 1000 mm to 1300 mm. 
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1.11.6.3. Pinus roxburghii (Chirpine) 

Chir Pine trees and saplings are usually resistant to fire/burning but the shrub layer is more suscep-
tible and therefore poorly developed. Usually other trees species are not found in this type of for-
ests. The pines are able to expand or maintain their position through infrequent ‘hot’ fires that 

destroy all competing under-growths.  If the fire is frequent and ‘light’, the undergrowth may not 

be killed but the very young pine seedlings are vulnerable.  Under such repeated conditions, Pine 
stands can be degraded over time 
 
Silvicultural characters: Chirpine is a strong light demander. However, it is an undemanding, fast growing 
shade tolerant pioneer in the seedling/juvenile stage. It is capable of colonising sites that are hostile to broad-
leaved pioneers.  It forms almost pure, single–storied, even-aged stands (Dorji & Chong, 1998).  It is frost 
hardy and fire-resistant owing to its thick corky bark. Chirpine usually comes up in almost any type of soil 
nut intolerant to poorly drained and richly calcerous soil 

Regeneration: Chir Pine sheds its seed from April to July and usually germinate within ten days of falling 
in conducive environment.  

Silviculture system: The seed tree system is usually prescribed for Chir pine forests; in this system around 
20 seed trees per hectare are retained and the rest of the crop removed from the annual coupe.  If regeneration 
is unsuccessful supplementary direct seeding or planting may be required. 

In areas with sparse ground vegetation the seed tree system can be suitable and in areas with dense ground 
vegetation, weeding, soil scarification and artificial planting could be practiced to assist the natural regen-
eration (RGoB, 1991). If advanced regeneration is present at the time of felling then special care should be 
taken to avoid damage. 

1.11.6.4. Warm broadleaved forest 

Warm broadleaved forest is essentially a type of subtropical forest, but occurs at a higher altitude (1000 to 
2000 m.a.s.l extending upto 2300 m.a.s.l) with a lower rainfall (2300 to 4000 mm) and contains a mixture 
of evergreen and deciduous broad-leaved tree species. Many tropical genera are absent and more temperate 
genera appear. The transition from lower into higher zone is gradual. In deeper valleys this formation occurs 
far into the interior, as in Kholung Chhu valley south of Trashiyangtse. However, it is most abundant 
throughout southern Bhutan on the hills north of Gelephu and Deothang and in the Mewan chhu valley. 

Sl. No Name Silvicultural Characteristics 
1 Schima wallichii • Moderately light demander and fairly resistant to fire 

• Sensitive to grazing and browsing in seedling stage 
• It has a tap root system and grows in basic soil; prefers 

well-drained soil 
• Good coppice 
• Seeds are light and dispersed by wind. 

2 Engelhardia spicata  • natural regeneration is excellent wherever the seedlings 
get sufficient light and are protected from grazing 

3 Magnolia excelsa • Light demander and requires overhead light for good 
growth but seedlings can establish well under a moderate 
through high canopy. 

• Prefers partial shade and well-drained soil but can tolerate 
acidic soil.  

• Susceptible to frost  and drought. 
• Also associated with cool broadleaved forests. 

4 Macaranga denticulata • a fast growing pioneer that rapidly colonises open gaps af-
ter disturbances such as logging.  Although comparatively 
short-lived it can negatively affect natural establishment 
and growth of more valuable timber species. 
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5 Alnus nepalensis • Tolerates both shade and poorly drained soil 
• Provided that there is sufficient light, Alnus displays the 

habit of springing up gregariously on new ground such as 
landslips and abandoned cultivation. 

• Susceptible to wind demage 
 

Silvicultural System: 

There are important unresolved problems with broadleaved silviculture in Bhutan; particularly limited un-
derstanding of regeneration dynamics of valuable species. Good regeneration has proved extremely difficult.  
The best silvicultural systems for managing broadleaved forest is uncertain and require more researches to 
achieve stand succession towards commercially useful species.  

The working approach at the time of writing is generally that of small-scale patch-cut; however, any silvi-
cultural recommendations should be developed with caution and with thorough consideration to species 
composition, stand dynamics, regeneration processes and protection requirements.  With this in mind it is 
more appropriate to consider a combination of single-tree and patch cut systems with small groups of 20-
30m (Schindele, 2003). 

1.11.6.5. Evergreen oak forest 

The evergreen Oak forests occurs on an altitudinal range of 2000 to 2600 m.a.s.l , and sometimes going 
down to about 1800 m.a.s.l with an annual rainfall ranges from 2000 mm to 3000 mm Evergreen Oak forests 
are a very characteristic feature of some parts of central Bhutan, especially around Trongsa and on the hills 
above Mongar. They apparently receive lower rainfall than Warm broad-leaved forests and composition 
varies according to altitude and rainfall. At a lower levels Castanopsis hystrix and C. tribuloides are often 
dominant, higher up Quercus lamellosa becomes commoners; with increasing dryness more xerophytic 
Quercus species, e.g. Quercus lanata, and Q. semecarpifolia, and sometimes Pinus wallichiana appear. The 
shrub layer is often poorly represented, whilst the shady humid forest floor is dominated by small herbs, e.g. 
Urticaceae and bryophytes.  

Some of the key species found in this forest types are described in Table 1.50. 

Table 1.50 Silvicultural characteristics of some key species in evergreen oak forest 

Sl. No Name Silvicultural Characteristics 
1.  Oaks  
 Q. semecarpifolia • Shade-demanding as a germinant and shade tolerant 

during initial growth.  
• Growth of the seedlings is reported to be slow; it 

coppices and pollards well, although coppice and 
pollard shoots are liable to be bent or broken by 
snow and coppice growth is very slow (Rosset, 
1999). 

 Q. glauca • Found in moist site conditions, can stand a consider-
able amount of shade during regeneration but needs 
direct overhead light for maximum growth; coppices 
freely. 

 Q. lamellosa and lineata; • Although both species are shade bearers they require 
overhead light to fully develop their growth poten-
tial. 

2 Castanopsis hystrix and tribu-
loides 

• Occur in warm broadleaved and evergreen oak for-
ests.  

• Natural regeneration is reported to be fairly good in 
some areas in India and the seedlings can tolerate a 
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good deal of shade for some years; both species cop-
pice well (Kleine, 1996; derived from Grierson & 
Long, 1983 and Troup, 1921). 

3 Juglans regia  • Light demander but can stand some shade in the ini-
tial seedling stages. 

• For the production of straight clean boles it must be 
grown in denser stands, owing to its tendency to pro-
duce large spreading branches. 

 

1.11.6.6. Cool moist broadleaved forests  

Cool moist broad-leaved forest occurs above warm broadleaved forest with cooler climate and are generally 
mixed forest in which oaks are less common, and other trees, both deciduous and evergreen, e.g Persea spp, 
Exbucklandia spp, etc., are more abundant together with dense shrubs, climbers and many epiphytes. In 
Bhutan, Cool Broad-leaved forest is extensive in some of the eastern Dzongkhags (e.g. around Tshilingor-
Wamrong–Khaling stretch) and on the steep hillsides of South east of Sengor.  

The cool moist broad-leaved forest occurs on an altitudinal range of 2000 to 2900 m.a.s.l , with an annual 
rainfall ranges from 2000 mm to 3000 mm. Silvicultural characteristics of some of the key species found in 
the forest type are explained in Table 1.51. 

Table 1.51 Some key species in cool moist broadleaved forest 

Sl. No Name Silvicultural characteristics 
1 Acer cambellii • Shade tolerant 

• Reproduce freely by seed. Coppice well as well. 
2 Persea spp • Usually require well-drained aerated soil 
5 Betula alnoides • Natural regeneration is only possible in open gaps with patches 

of new soil.   
• This species prefers moist site conditions 
• Frost hardy and fairly fast growing 

 

In addition, Symplocos dryophila and Quercus spp are also dominant in this forest type. 

Silviculture System: 

Generally, patch cut system is prescribed for commercial harvesting in broadleaved forest (RNR RC, 2003). 
The “patch” in patch cutting system would mean smaller groups as compared to groups in Group Selection 
System. As per the research findings, the patch cutting system with fencing is proven to be the best option 
in terms of fostering biodiversity, mitigating grazing impact and safeguarding financial viability for sus-
tainable management of mixed broadleaf forests in Eastern Bhutan. If regeneration is unsuccessful supple-
mentary direct seeding or planting may be required in the harvested areas post timber harvesting. 

1.11.6.7. Blue pine forest 

Blue Pine forest occupies the inner dry valleys of Bhutan where rainfall is very low except during the mon-
soon season. It is best developed in Haa, Paro and Thimphu valleys in the west and in Bumthang further 
east. It is often dominant and act as pioneer colonist of burnt or disturbed ground. Tree species commonly 
associated with Blue Pine are Quercus griffithii, Q. semicarpifolia, Q. lanata, Populus ciliata, etc., but many 
xerophytic shrubs also occur and herbs are common during the monsoon season. There is a gradual transition 
between this forest type and Evergreen oak forest and with Spruce, Hemlock and Fir forests on the moisture 
slopes above the main valley. When Blue Pines are found mixed with Spruce, Hemlock and Fir, they get 
protected from forest fires and often attain a greater stature than in the valleys. It is very susceptible to forest 
fires. 
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Bluepine forests occurs on an altitudinal range of 2100-3000 m.a.s.l extending upto 3200 m.a.s.l , with an 
annual rainfall ranges from 700 mm to 1200 mm. The only tree species commonly associated with Bluepine 
is Quercus griffithii.  Q griffithii is deciduous in nature and thrives in all types of soil. 

Blue pine (Pinus wallichiana) 

Blue pine forest is a common pioneer species appearing after disturbance in the cool moist broad-leaved 
forest and lower spruce and hemlock zones . 

Reproduction 

Blue pine starts flowering between the age of 10 and 20 years and has frequent good seed years; more 
frequent than for other conifer species. The germination of blue pine is best on well-drained fresh soil and 
on sites exposed to sunlight. Reproduction may fail on very dry or hard soils as well as on slope with south-
ern exposition when the soil surface can be heated to high temperatures.  Because it is a light-demanding 
species, it is sensitive to strong competition from weeds, shrubs and other trees (Rosset, 1999, Statz & 
Wyrsch, 1993). 

Silviculture characteristics: 

Bluepine are strong light demander. It is fire sensitive and more susceptible to snow damage in comparision 
to other conifer species. 

Regeneration 

If there is enough light and a suitable seed bearer in the neighbourhood, there is no problem to regenerate 
blue pine successfully.  It may be useful to protect the area from grazing, if the pressure from cattle is high.  
The area also has to be protected from fire. 

To regenerate a mature blue pine stand, a short regeneration period should be chosen with seed tree felling 
which removes more than half of the old stand.  Immediately after the regeneration has established the 
remainder of the old stand has to be removed. 

To regenerate blue pine in a mixed stand, the suitable site for regenerating has to be found (ridges and 
southern exposed slopes within the stand) and exposed to light.  If need be, some light scarification of the 
soil may help regeneration. 

Depending upon the desired assortment, the rotation period may lie between 50 (cham assortments) and 90 
to 130 years (timber assortments) on good sites. 

Tending and thinning 

Thinning and tending are important for young blue pine stands, especially where regeneration is very dense, 
in order to augment the stand stability against snowfall and storm damages as well as to improve the quality 
of the future stand.  This has to be carried out regularly starting from the early stages of stand development.  
It is better to conduct moderate thinning operations at frequent intervals.  Blue pine tends to keep dry 
branches.  If high quality timber is to be produced, artificial pruning may be required.  Pruning would also 
reduce fire risk (Rosset, 1999). 

Rosset & Rinchen (1999) describe the effects three different thinning intensities (control, moderate (20% of 
standing volume) and heavy (27 % of standing volume)) of thinning operations on productivity, stability 
and economics of blue pine stands.  The thinning treatments had a clear positive effect on diameter and 
volume increment, resulting in a higher production of usable timber volume.  Thinning treatments had a 
positive effect on individual tree stability.  Moderate thinning intensity is recommended both for optimisa-
tion of economic returns and improvement of stand stability. 
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Silvicultural System 

The seed tree system is usually prescribed for Blue pine forests; in this system around 20 seed trees per 
hectare are retained and the rest of the crop removed from the annual coupe. Research also recommend 
single tree selection or group selection system in areas. However, in case of pest, clear-felling of the mistle-
toe infested site is usually recommended (RNR-RDC, 2014).  

Risks 

On good sites with good increments there is potential danger of broken trees by snow and storms; this danger 
is accentuated on sites where blue pine grows densely.  Blue pine is susceptible to mistletoe (in western 
Bhutan), may be browsed and scraped by cattle and is very sensitive to fire. Blue pine stands can be severely 
damaged by bark beetles especially if logging is carried out during the flying season (summer) and not in a 
proper manner (without collecting lops and tops, debarking of logs and burning of slash) (Rosset, 1999). 

1.11.6.8. Spruce forest 

Though Spruce forest is often found mixed with Fir and Hemlock or with Blue Pine, Larch, Oak, Maple, 
Birch, etc., a separate Spruce forest type can frequently be recognized. Spruce forest generally occupies 
drier site than Hemlock forest at a similar altitude. Spruce forests occurs on an altitudinal range of 2700 to 
3100 m.a.s.l extending upto 3200 m.a.s.l with an annual rainfall ranging from 500 mm to 1000 mm. It is 
commonly found in Thimphu, Paro, Haa, Wangdue Phodrang and Bumthang Dzongkhag. Picea spinulosa 
is the common species in western Bhutan, but in Eastern Bhutan, it is found mixed with Picea brachytyla. 
Together with Blue Pine it may form a sort of pioneer forest. 

Picea spinulosa (East Himalayan spruce) 

Reproduction 

Not much is known about the seed production patterns of spruce but it seems likely that flowering and good 
seed production appear only at intervals of three to seven years.  Having a shade tolerant character in youth, 
spruce can regenerate under hemlock, oak and blue pine, but it also regenerates well in exposed conditions 
on bare mineral soil (Rosset, 1999). 

Silviculture 

Spruce is a moderate light demander but stands some shade, especially in its early youth.  For growth though 
it needs full overhead light in order not to be suppressed.  According to Darabant et al (2001) this species 
proved to be able to increase growth up to full sunlight, and, at the same time it can survive periods of 
moderate shade. Natural regeneration is sometimes very easy, but in some cases very difficult.  Rosset 
(1999) suggests that one major reason for the difficulty of successfully regenerating stands with spruce on 
dry sites might be the excessive size of canopy opening, giving strong competitive advantages to weed 
species, bamboos and bushes.  Long-term studies have shown that competition by herbs can be reduced by 
keeping moderate shade (Darabant et al, 2001).  Another reason might be the presence of thick humus layers, 
hindering seed germination and growth. 

Uneven-aged management of this species has to focus on keeping basal areas below 30m2, the threshold for 
high light dependent seedling mortality (Darabant et al, 2001). 

Logging should be as clean as possible in order to avoid bark beetle attack.  In order to minimise the danger 
of bark-beetle attacks and to avoid subsequent problems with natural regeneration, it is strongly recom-
mended that large canopy openings are avoided whilst operating in dry forest types with spruce. 

A study of regeneration dynamics in mixed conifers (in Thimphu, Bumthang and Haa) found that small-size 
artificial openings (group-cuts of 100m2) trigger profuse natural regeneration of the desired mixed conifer 
species and that grazing impact is negligible and fencing not necessary (Moktan, 2003). 
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Thinning and tending 

Similar to blue pine stands, thinning and tending should be conducted in spruce forests to avoid slim trees 
and unstable stands (Statz & Wyrsch, 1993, Rosset, 1999). 

Silvicultural system  

It is generally recommended to practice group selection system and single tree system in spruce forest. The 
recommended size of the group usually depends on the site and understorey conditions. 

Risks 

As a seedling, spruce is very susceptible to drought, in pole stands mixed with blue pine, it may be suscep-
tible to snow break.  Uprooting or windbreak damage may occur on exposed sites. 

The most important danger is the bark beetle (Ips schmutzenhoferii); drought stress, disturbance of myco-
rhizal fungi by soil trampling and excessive canopy opening seem to be conducive factors for bark-beetle 
attacks. 

1.11.6.9. Hemlock forest 

Hemlock forest is similar to Spruce forest but occupies wetter sites. Shrubby and arborescent Rhododen-
drons are frequent and the high humidity is ideal for dense growth of epiphytic and terrestrial ferns, lichens 
and bryophytes. Hemlock mixed with other montane conifers are common. In Bhutan, Hemlock forest is 
common on the main mountain ridges below the Fir forests, throughout the central and northern part of the 
country at an altitudinal range of 2800-3100 m.a.s.l.  The annual rainfall ranges from 1300 mm to 2000 mm.  

Tsuga Dumosa (Himalayan hemlock) 

Reproduction 

Hemlock flowers nearly every year and a large amount of seed is normally produced; regeneration is nor-
mally no problem provided that there is a little light.  Hemlock is not a light demander; optimal conditions 
for natural regeneration seem to be the shelter of older trees, which prevent the uppermost layer of the soil 
from drying out (Statz & Wyrsch, 1993, Rosset, 1999). 

Silviculture 

Regeneration 

Hemlock has a shade-bearing character (although less so than fir) and can show fast initial growth under 
shady conditions.  It prefers humid sites with or without humus layer.  The critical factor for regeneration 
seems to be soil moisture.  In general, regeneration is not a problem and provided the soil conditions are not 
too dry; there seem to be less silvicultural constraints than spruce as far as the minimal size of canopy 
opening is concerned (Rosset, 1999, Statz & Wyrsch, 1993). 

Hemlock forest seems to have fewer weeds and shrub associates than spruce forests and is therefore less 
subject to regeneration problems due to competition. However, existing undergrowth of bamboos and rho-
dodendrons might inhibit regeneration (Rosset, 1999). Hemlock regeneration is very sensitive to dry site 
conditions; the most suitable conditions seem to be in the shelter of older trees, which prevents the soil from 
drying up.  (Statz & Wyrsch, 1993). 

Group selection systems with small openings which would be closed by the time hemlock regeneration 
reaches sapling stage would provide enough light for growth of regeneration and at the same time maximise 
understorey stocking.  Light levels in the understorey should not drop below 4% sunlight as increased mor-
tality occurs (Darabant et al, 2001).  Larger canopy openings (0.3 ha) have been found to result in lower 
abundance of regeneration with generally higher growth rates especially in the case of hemlock (Rosset & 
Rinchen, 1998, in Darabant et al, 2001). However openings that provide more than 40% of open light cli-
mate would not result in increased diameter growth (Darabant et al, 2001). 
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A study of regeneration dynamics in mixed conifers (in Thimphu, Bumthang and Haa) found that small-size 
artificial openings (group-cuts of 100m2) trigger profuse natural regeneration of the desired mixed conifer 
species and that grazing impact is negligible and fencing not necessary (Moktan, 2003). 

Tending, thinning and felling 

On small areas, hemlock can form dense even-aged pole stands, which seem to undergo natural thinning 
without too many losses.   However, light and frequent thinning may be necessary for larger stands.  Hem-
lock tends to form multi-storied forests, which should be maintained. 

A single-tree or small group/slit selection system may be applied to this type of forest.  Special attention 
should be paid to the middle layer, in which the trees may be slim and weak.  By removing an older tree in 
favour of such a middle layer tree, the latter should still be protected by a larger tree or be strong enough 
not to get broke by wind or snow (Rosset, 1999). 

Silvicultural system  

It is generally recommended to practice group selection system and single tree system in spruce forest. The 
recommended size of the group usually depends on the site and understorey conditions. Prescribed grazing 
should be encouraged in areas dominated by dense bamboo understorey to reduce bamboo height (RNR-
RDC, 2014)_  

Risks 

Older Hemlocks and sometimes younger trees growing in very shady conditions tend to form a broad crown 
with long branches which may be broken by snow, forming a tree with several tops and exposing the timber 
to fungal attacks.  In even-aged pole stands, which may be quite dense, there is also a risk of damage by 
snow, but the risk is not as accentuated as blue pine (Rosset, 1999). 

Saplings may be browsed by cattle and yak, but only when no better fodder species are available (Rosset, 
1999). 

1.11.6.10. Fir forest 

Fir forest is the characteristics of highest forested ridges (3300 to 3800 m.a.s.l), where large tracts are cov-
ered by virtually no tree species other than scattered Hemlock and Birch patches in some locations. The 
dense canopy provides a humid environment for a luxuriant understory of Rhododendron and other shrubs, 
and the mossy ground layer supports many small herbs, e.g. Primula species and Bryocarpum himalaicum. 
As in Hemlock forest, in addition to the high rainfall (1300 mm to 2000 mm), considerable mist-precipitation 
occurs from the frequent cloud cover.   

Abies densa (East Himalayan fir) 

Bürgi et al (1992) state that Fir forests are very sensitive ecosystems, that the sensitivity to disturbances of 
ecosystems increases towards the timberline and that any utilisation should be based on profound knowledge 
of the system such that appropriate utilisation methods, which avoid the destruction of the system, are used. 

Bürgi (2002) states that because the structure (uneven-aged) and species composition of these forests should 
not be altered to any great extent, in order to maintain the protective and ecological function of the forest, 
utilisation involving modern harvesting equipment is not economically viable.  A traditional utilisation, e.g. 
shingle production for the local market, as a single-tree or small group selection forest, is possible without 
changing the forest in an undesirable way. 

At its ecological optimum, fir forms extended monospecific stands which regenerate from single tree gaps 
formed by breakage of severely rotten trees (Rosset, 1999). 
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Box 1.8 Silvicultural treatments for selection management of fir forest 

• Remove few mature trees to promote regeneration on a relatively small area 

• Fell mature trees minimising damage to saplings and seedlings 

• Selective thin out middle layer to stabilise stand structure 

• Perform tending operations removing some broadleaved trees in the middle and lower can-

opies 

• As the fir saplings start to colonise remove a few old trees gradually 

 

Reproduction 

Fir does not flower and produce seed every year.  The flowering interval is not known, but may lie between 
three and seven years.  Fir is a shade bearer, but also regenerates in abundance on open sites (Rosset, 1999).  
As a shade-loving species its competitive advantage against pioneers like maple, birch and other broadleaves 
decreases with increasing opening/group size (Statz & Wyrsch, 1993).  

The seeds of Fir germinate best on slightly hydromorphic (i.e. developed in the presence of excess water) 
humus layers, nurse logs and moss carpets.  In open areas outside of the closed forest, fir regenerates pref-
erentially on bare mineral soils because humus layers tend to overheat and dry out in the high radiation 
environment.  Within the forest, there is frequently a dense sapling bank waiting to be release by formation 
of gaps in the canopy (Rosset, 1999). 

Silviculture 

In its optimal range, Fir regeneration competes with bamboo on better sites and with large-leaf rhododendron 
species on more acidic sites.  On bamboo sites regeneration is on nurse logs and in gaps in the bamboo 
understorey.  Competition with large leaved rhododendrons can be severe, as these rhododendrons occupy 
the same seedbed niches. And outgrow fir in marginal light (Rosset, 1999). 

Darabant et al (2001) describe the silviculture of fir in relation to light environment; light is the single most 
important factor influencing forest dynamics.  Basal area thresholds for management have been derived; the 
median of light levels experienced by recently dead saplings was at 5% sunlight which corresponds to a 
basal area of level of 40 to 60 m2. Gradual opening of the canopy leads to increased radial growth up to 60% 
sunlight, corresponding to basal area of 8 m2.  As forest management has to focus on overall tree growth and 
not only that of saplings, keeping basal area levels as low as 8m2 is not feasible; a compromise has to be 
found between growth of merchantable trees and growth of saplings. 

Single-tree and group selection silvicultural systems are recommended for management of fir forests. 

Risks 

In western Bhutan, die-back of large stands at high altitude was observed during the 1980’s.  It is suspected 

that this episodic die-back was triggered by climatic conditions, possibly drought stress. 

Fir regeneration is highly vulnerable to damage by grazing cattle; this has the potential in the long term to 
lead to the collapse of the fir zone.  

The risk of branches and crowns being broken by storms, snow load and rime ice is very high due to the 
broad and flattened shape of the crown.  Cull percentage in most forest stands is very high (Rosset, 1999). 

1.11.6.11. Rhododendron-Juniper forest and Alpine Scrub forest 

This forest types are characterized by pure Juniper stand, Lyonia and rhododendron species. 

Selection of silvicultural systems 
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Silvicultural decision making is always influenced by considerations related to the forest ecosystem, the 
social environment, technical possibilities and economics.  Silvicultural strategies should be based on silvi-
cultural knowledge and also integrate the social reality surrounding the forest area and take into account the 
institutional and economic constraints of the implementing forest agencies (Kleine, 1996). 

Table 1.52 Factors deciding on choice of silvicultural system 

Factors Categorization of silvicultural 
systems in the Code 

Forest type, species composition and structure Forest types reflecting different bio-
geoclimatic conditions4 Environmental conditions, such as soil, topography, aspect, alti-

tude and climate 

Labour, machinery, road access and other inputs available for man-
agement 

Management types reflecting avail-
able inputs and required products & 
services5 

The end-products and services required 

The possible effects of the choice of silvicultural system should be considered when developing or imple-
menting a silvicultural system and should form part of the description and justification of the silvicultural 
system in the FMP (see Box 1.9 Points to consider when developing or deciding upon a silvicultural system 
(derived from Higman et al, 1999) below). 

Box 1.9 Points to consider when developing or deciding upon a silvicultural system (derived from Higman et al, 1999) 

• Effects on growth rates of harvestable species (timber and non-timber); 

• Effects on forest services (such as watershed protection or aesthetic value); 

• Effects on biodiversity and wildlife (intensive silviculture may simplify the forest struc-

ture); 

• Effects on ecological sustainability (processes such as nutrient and water cycles); 

• Effects on seed production (sufficient seed trees should be left to ensure regenera-

tion); 

• Effects on regeneration (light conditions required by various tree species); 

• Applicability to forest ecology (silvicultural systems should mimic natural disturbance 

dynamics); 

• Social acceptability (particularly to communities within or close to the forest). 

The decision on silvicultural system also depends on forest function. The decision regarding the 

selection of silvicultural system cannot be reduced to simplistic mimicking of textbook techniques 

that may be applicable to other climates, tree species or ecosystems.  In choosing a silvicultural 

system, the forest management planner must combine these considerations with local knowledge of 

the site and species ecology, regeneration requirements of different tree species, stand develop-

ment processes, traditional and new harvesting techniques, and the anticipated silvicultural needs 

of the forests (adapted from British Columbia, 1995). 

                                                      

 

4 Forest types include: sub-tropical, warm-temperate broadleaf, chir pine, cool-temperate broadleaf, evergreen oak, blue pine, hem-
lock, spruce & fir forests; 

5 Management types include: FMU, WS, CF, PF, leased land, GRF outside FMUs, managed forests in PAs. 
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1.11.7. Silvicultural Strategies and Prescriptions 

Silvicultural strategies and operational prescriptions are integral parts of forest management planning; as 
such they depend on the overall management objectives selected for particular forest area.  Silvicultural 
decision-making is required at both strategic (FMU) and operational (compartment/sub-compartment level), 
refer to Table 1.53 From management objective to silvicultural strategy and operational planning. 

Kleine (1996) recommends that during the process of developing ideas for silvicultural management the two 
planning levels must be clearly separated.  Besides well-defined management objectives, a silvicultural 
strategy needs to be described at the FMU level.  In order to successfully translate this silvicultural strategy 
into real field operations, detailed planning at the compartment level is required. 

1.11.7.1.  Strategic Level (forest management unit) 

A silvicultural strategy should be developed from the management objectives.  The strategy should be de-
signed in such a way so as to directly contribute to the achievement of the objectives. The silvicultural 
strategy is mainly reflected in the choice of silvicultural systems as well as the definition of rotation age. 

1.11.7.2.  Operational Level (compartment, forest stand) 

The silvicultural management concept outlined at the strategic level is translated into actual field operations 
with the help of planning at stand level; this step forms part of the operational planning process. The logical 
sequence of this approach is be illustrated by reference to an example (adapted from Kleine, 1996), see 
Table 1.53. Branney (2003) provides a detailed step-wise approach to identifying and implementing silvi-
cultural options in community forests, much of the information includes is of relevance to FMU manage-
ment planning and implementation.  
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Table 1.53 From management objective to silvicultural strategy and operational planning 

Forest management objective (example) 

To manage and improve the forest for the production of hardwoods (timber, firewood, household imple-
ments etc.) as well as fodder (i.e. leaves and grass) on a sustained yield basis whilst maintaining the 
protective functions (i.e. water and soil) and rich biological diversity (derived from Dhital, 1993a by 
Kleine, 1996). 

 

 

 

 

Silvicultural strategy (example) 

● Generally, the broadleaved forests have the potential to be managed for multiple uses relying 
primarily on natural regeneration.  This can be efficiently achieved by manipulating the main 
canopy through harvesting of mature trees in combination with temporary protection from graz-
ing.  Planting is considered a supplementary measure at small scale only.  Silvicultural treatments 
(i.e. weeding, cleaning, thinning) of the natural regeneration shall ensure improved stand condi-
tions in terms of commercial species composition and stocking; 

● In order to operationalise the technical strategy given above, an integrated approach is required.  
Participation of local forest users should ensure a sympathetic attitude towards regulated forest 
management; 

● Under the proposed strategy, planning and monitoring at the stand level shall be required (derived 
from Dhital, 1993a by Kleine, 1996). 

 

 

Silvicultural prescriptions 

These prescriptions shall form part of the annual operational plan and should be guided by; 

● a specific production goal assigned to each stand (with reference to commercial and local use); 
(derived from Dhital, 1993a by Kleine, 1996).  

● the actual stocking conditions of the stand (with reference to the successional development phase 
of the stand; Kleine (1996) describes old-age, fragmentation and building phases) since the se-
quence of operations depends upon the progress of the stand and regeneration growth. 

● the forest function of the stand (this can be derived from the forest function map). (derived from 
Dhital, 1993a by Kleine, 1996). 

1.11.8. Forest grazing 

Cattle farming has always been an important part of Bhutan’s integrated soil utilisation systems.  As an 

important source of ruminant fodder, forest undergrowth has continuously been used for cattle grazing, 
either beyond the cultivated fields, or along migration routes. Forest grazing is still the main fodder resource 
of ruminant feed, especially in the summer period (Roder, 1998 in Rosset, 1998). 

The removal of overstorey by logging releases moisture and nutrients and increases light for herbaceous and 
shrub vegetation (Miller, 1986 in Rosset, 1998). Mechanised forest harvesting systems, with construction 
of forest roads and opening up of forest along cable-crane lines do, therefore, invite an increased concentra-
tion of cattle in managed forest areas. 
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Livestock grazing in forested areas can have strong detrimental effects on forest ecosystems, in particular 
during the critical phase of stand regeneration by browsing of young trees, physical damage to trees from 
trampling, removal of the soil’s protective layer, and soil compaction. 

Tensions are likely to arise between cattle and yak owners and foresters.  But also, Miller (1986, in Rosset, 
1998) suggests cattle grazing can sometimes be beneficial by exposing soils for tree regeneration by reduc-
ing competition between tree seedlings and herbaceous, bamboo and shrub species.  

An analysis of a long-term regeneration trial in Hurchi FMU, Bumthang (hemlock rich, mixed conifer forest) 
illustrates the complexity of the issues of cattle grazing in forest areas.  Observations suggested on the one 
hand that damage by cattle to conifer species is negligible but that damage to broadleaved species were very 
important (Rosset, 1998).  

Box 1.10 Forest grazing; some unanswered questions 

Most of the presently available information (Rosset, 1998) is qualitative and based on rather sub-

jective observations; it is not possible to respond satisfactorily to the following questions: 

1. What are the positive and/or negative effects of cattle grazing on different forest types? 

2. What is the sensitivity of different species to (conifer and broadleaved) to cattle grazing? 

3. What is the carrying capacity of different forest types? 

4. At what stages and for how long should the forest stands under regeneration be protected 

from cattle grazing? 

 

In view of the important social and traditional aspects of cattle grazing in forested areas, a solution to the 
damages by cattle is likely to be found only with an increased participation of cattle owners in the planning 
and management of forestry operations. 

Integrating cattle grazing in forest management is important.  Therefore, an appropriate planning forum is 
needed in order to bring together all stakeholders including graziers.  Consideration should be given to the 
improvement of forage resources (e.g. Tsamdrog) and to the negotiated and agreed regulation of grazing 
through the segregation of grazing areas from timber production areas (at least during the vulnerable regen-
eration period) (Moktan, 2003). 

Norbu (2000) presents a strategy for integrating cattle grazing in broadleaved forests that is based upon 
active participation of stakeholders in forest planning and management. The components of the proposed 
strategy include: 

• Native fodder tree management 
• Regulating grazing in Tsamdrogs and forests through: 

➢ Improvised controlled grazing 
➢ Involvement of herders, farmers and other stakeholders in forest management 

Management of cattle grazing in forest 

1.12. Environmental Impact Assessment 

Environmental assessment is defined as all procedures required under Bhutanese law to identify means to 
ensure that the activities of a project are managed in an environmentally sound and sustainable way (NEC, 
2002). 

An anticipatory environmental management tool for the orderly and systematic evaluation of a proposal 
and its effects on the environment (Wood, 1993). 

EIA is process of predicting and evaluating the likely positive and negative impacts of a proposed FMU on 
environment, socio-economic and culture. 
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Operations in an FMU shall have impacts (both positive and negative) on a wide range of receptors. Exam-
ples of some of these receptors would include watershed areas (including water quality), precious ecology 
(including wildlife), employment levels, local economy and people livelihood.  

Possible negative impacts might include erosion and siltation resulting from road construction or logging 
and disturbance of sites of ecological importance; including endangered and protected wildlife species.  

Possible positive impacts might include increased opportunities for local employment and improvement of 
degraded land, protection of wildlife corridors and protection of watershed and smaller catchments.  

The primary purpose of EA is to ensure that decision makers are provided with sufficient, unbiased and 
balanced information about the likely consequences of a proposed project before a decision is taken on 
whether or not consent should be granted.  

EA consists of three major phases: 

1. Information is collected regarding the state of the environment prior to the initiation of a proposed 
project; 

2. Baseline data from the first phase is used together with information about the project's proposed 
activities, in order to make predictions about the nature and the scale of changes that would be likely 
to occur in the environment if the project were to go ahead; 

3. Baseline data and predictions are incorporated into an environmental impact statement (EIS). The 
EIS is then submitted to the competent authority and taken into account in reaching a decision on 
whether or not the proposed project should be allowed to go ahead. The competent authority is the 
body responsible for granting environmental clearance for projects.  In the case of FMUs, EIS is 
considered to be an integral part of the FMP. 

1.12.1. The Legislative Context 

The Environmental Assessment Act (2000) establishes procedures for the assessment of potential effects of 
strategic plans, policies, programs and projects on the environment, and for the determination of policies 
and measures to reduce potential adverse effects and to promote environmental benefits.   

A project means any activity that may have significant effects on the environment. The direct implication 
for forest management is that for all forest operations, an environmental assessment must be undertaken and 
environmental clearance granted.  The process of preparing a forest management plan includes undertaking 
an environmental assessment in accordance with the requirements of this Act. 

Article 16 of the Act requires that:  The applicant shall ensure that concerned people and organisations are 
informed and consulted before submission of the EA documents to the competent authority. Concerned 
people mean individuals, groups and communities whose interests may be affected by a project.  In the case 
of FMU planning, the forums for consultation are the FMU-level Committees. 

1.12.2. Objective 

To undertake EA of FMUs in accordance with the Environmental Assessment Act (2000) and thereby iden-
tify actual and potential impacts on the environment as a result of planned forestry operations and accord-
ingly plan to minimize, mitigate or avoid negative environmental impacts and maximise positive environ-
mental impacts.  

1.12.3. Output 

An environmental impact statement (EIS), as an integral part of the FMP, fulfilling the environmental stand-
ard requirements of the FMU in reference.  

The environmental impact statement report is submitted to NEC for their review and approval.  
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1.12.4. Lead responsibility 

Divisional Forest Office  

1.12.5. The Environmental Impact Assessment Process for FMUs 

EIA is a multidisciplinary process; this means that it involves team based approach with a range of experts 
and stakeholders following a sequence of steps or stages.  Within the context of FMUs, the EIA process 
shall be complementary to the overall forest management planning process, whereby the Environmental 
Impact Statement section of the Forest Management Plan shall outline the likely environmental impacts and 
the corresponding mitigating measures that the plan should encompass (Table 1.54 Summary of environ-
mental impact assessment process) 

The institutional mechanism and the flow of information regarding the process for obtaining the Environ-
mental Clearance for the FMUs from NECS (Figure 1.9).  The DoFPS directorate shall submit the proposed 
FMP to NECS and upon receipt, the NECS shall review Environmental Statement of the FMP and accord-
ingly make the following decisions for granting/rejecting Environmental Clearance. 

Decision A:   Environmental Clearance granted; 

Decision B:  Further study required: FMP returned to the Head, DoFPS for further information/clarifi-
cation/assessment; 

Decision C:  Environmental Clearance not granted based on justifications provided by NECS. 

 

Figure 1.9 Institutional mechanism for environmental assessment & clearance for FMUs 
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1.13. Financial and Economic Appraisal 

The financial and economic appraisal of an FMU must address a number of different themes; financial 
forecasts for the plan period, long-term cost-benefit analysis including consideration of non-market costs 
and benefits and the supply and demand for forest products. Economic efficiency, economic equity and 
economic sustainability should be demonstrated. 

Forest management often aims to maximise timber production, even though this is just one of many products 
and services which different stakeholders may seek from the forest.  A central aspect of sustainable forest 
management is the need to optimize the mix of products and services from the forest. 

Optimizing benefits in the long-term involves making trade-offs between benefits, which can be reaped 
today, and those that should be left for the future (see Box 1).  It also requires a compromise between saleable 
products, such as timber and NWFPs, and vital services, such as watershed protection and wildlife habitat. 
These services often do not have a market and therefore the forest organisation is not financially rewarded 
for their maintenance (Higman et al, 1999).   

This section of the code considers the objectives of the various elements of financial and economic appraisal 
and presents guidelines on the activities required in order to achieve these objectives. 

Forest management must be economically viable. This is distinct from the financial viability of forest ex-
ploitation. Full economic viability must take account of the reinvestment required for maintenance of the 
system and the additional costs (or income forgone) due to protection of the forest ecosystem and equitable 
distribution of the social costs and benefits of forest management.  Implementation of sustainable forest 
management is rarely as financially attractive in the short-term as unsustainable forest exploitation.  

A need exists for the development of a comprehensive and thorough methodology for the economic ap-
praisal of FMUs. 

1.13.1. Objectives 

● To assess cash flow and financial viability of operations for the plan period 
● To undertake cost-benefit analysis and to consider economic viability over the period of the rotation 

or in perpetuity (including consideration of non-market costs and benefits). 
● To identify factors affecting supply and demand for forest products 

1.13.2. Outputs 

● 10-year cash flow forecast. 
● Long-term cost-benefit analysis (including statement on non-market costs and benefits and impli-

cations for forest management).  
● Statement of factors affecting supply and demand for forest products in the FMU and the implica-

tions for forest management during the plan period. 

1.13.3. Lead Responsibility 

Divisional Forest Office in collaboration with Authorized Agency 

1.13.4. Steps for Financial and Economic Appraisal 

Financial forecasts for the plan period 

The FMP should include a financial forecast for the plan period; this should present in a table or spreadsheet, 
the income (revenue) and expenditure (costs) associated with management and operations in the FMU.  The 
forecast should include different income and expenditure categories as appropriate and show income and 
expenditure for each year of the plan period.  Estimates of royalties should also be presented in the FMP. 
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The financial forecast does not show profitability as such, either for the plan period or for a longer period; 
it does, however, indicate the likely flow of funds directly related to operations in the FMU for the plan 
period.  It can serve as a useful guide to yearly financial planning.   

The financial forecast can also be used to estimate revenues and royalties foregone as a result of rural allot-
ment.  This can be considered as one element of the social value of FMU operations.  However, it does not 
provide a a full picture of social values and an indepth assessment is required.. 

As the time passes, the actual figures of revenues, costs and royalties can be compared to those predicted in 
the financial forecast.  This can be done by inserting an extra column for each year with the heading actual. 
A useful source of information and guidance on forestry budgets and accounts is provided by Bright (2001). 

A financial forecast template proposed byStark, 2003 can be used in order to identify the revenue accruing 
to and costs borne by authorized agencyand to the income in royalties accruing to the Royal Government of 
Bhutan.   

Table 1.55 Financial forecast (cash flow) example; assumptions, summary and spreadsheet   

Assumptions  
m3 to cft 35.31467  
Recover Volume NRDCL (%/AAC) 60  
Road construction (Nu/km) 2,500,000  
Length of proposed new road (km) 5.0  
Length of existing road (km) 31.0  
New road construction (km/yr) 1.0  
Road maintenance (Nu/km/yr) 12000  
Distance to Depot (km) 24.0  
Haulage Cost (Nu/cft/km) (Nu/m3/km) 0.60 21.19 

Cable crane (Nu/cft) (Nu/m3) 8.69 
306.8
8 

Royalty from Rural Allotment is paid by DBH however an average was used for 
this calculation (Nu/yr) (Based on previous plan and adjusted for the new AAC 
allotment) 228135  
Average compensation (penalties and fines) (Nu) 24842  
All Costs:DFO are taken as an average from the last plan period (Nu)   
Pay & Allowance 356863  
OPE 0  
TA/DA 137623  
Vehicle 5417  
Provident Fund 26037  
Rural Allotment (m3) 1350  
Regeneration maintenance (for cable lines) (Nu/ha) 3000  
Hectares of cable lines that require planting in the FMU (approximate) immediately 35  
Hectares of cable lines that require planting per year (approximate) 4  
Coupe regeneration establishment 19000  
Creation of plantations (Nu/ha) (including cable line regeneration) 19000  
Plantation maintenance (Nu/ha) (for first five years of plantation only) 3000  
Hectares of existing plantations in the FMU (from 1998) 18.61  

 

Cost-benefit analysis 

Cost-benefit analysis (CBA) is a relatively simple and robust tool for investment or project appraisal. CBA 
is used to assess the acceptability of different project or investment options and then for comparing those 
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options.  It involves identifying and quantifying all costs and benefits over a specified time period. CBA is 
used to compare the achievement of objectives (benefits) with the costs incurred. It attempts to value market 
and non-market cost and benefits in monetary terms and compare the costs and benefits of managing for 
different combinations of objectives over time. The process of CBA can be very effective ways of helping 
the forest manager identify the costs and benefits associated with a particular course of action. 

Costs and benefits can be tabulated into a spreadsheet; this spreadsheet shall then show the long-term ‘flow’ 

of cost and benefits.  These can then be analysed by applying a range of 'tools', often based on the application 
of discounting and concepts such as net present value (NPV) and land expectation value (LEV).  The cost 
and benefits analsysis for a plan period can be obtained from the financial forecast template shown below. 
However for longer term or rotation period length or for pertuitiy they should be analysed using other fi-
nancial forecasting tools like NPV (Net Present Value) and LEV(Land expectation Value). However, to be 
more dynamic the financial forecast for a plan period (10 years) is recommended. 

Table 1.56 Financial forecast for the plan period 

Estimates of future costs and benefits shall have to be made based upon past and present figures and trends.  
Certain assumptions shall need to be made, for example, future timber prices; these assumptions should be 
clearly stated.

2 0 2 0 2 0 2 1 2 0 2 2 2 0 2 3 2 0 2 4 2 0 2 5 2 0 2 6 2 0 2 7 2 0 2 8 2 0 2 9 10  Ye a rs

Nu Nu Nu Nu Nu Nu Nu Nu Nu Nu T o ta l (Nu )

Re v e n u e : NRDCL

Tim b er- Com m ercial 9800 5400 154.89 5,469.17        29,533,495.86           29,533,495.86           29,533,495.86          29,533,495.86           29,533,495.86         29,533,495.86           29,533,495.86         29,533,495.86         29,533,495.86          29,533,495.86           295,334,958.60           

T im b er- Ru ral 2500
T o ta l Re v e n u e  NRDCL 2 9 ,5 3 3 ,4 9 5 .8 6    2 9 ,5 3 3 ,4 9 5 .8 6    2 9 ,5 3 3 ,4 9 5 .8 6    2 9 ,5 3 3 ,4 9 5 .8 6    2 9 ,5 3 3 ,4 9 5 .8 6   2 9 ,5 3 3 ,4 9 5 .8 6    2 9 ,5 3 3 ,4 9 5 .8 6   2 9 ,5 3 3 ,4 9 5 .8 6   2 9 ,5 3 3 ,4 9 5 .8 6    2 9 ,5 3 3 ,4 9 5 .8 6    2 9 5 ,3 3 4 ,9 5 8 .6 0    

Co s ts : NRDCL

Brid g e Con s tru ction  

Road  Con s tru ction 2,500,000 2150000 2150000 2150000 2150000 2150000 2150000 2150000 2150000 2150000 2150000 21,500,000.00              

Road  Main ten an ce 15,000 75750 75750 75750 75750 75750 75750 75750 75750 75750 75750 757,500.00                  

Markin g  Cos t 0.08 2.82 27691 27691 27691 27691 27691 27691 27691 27691 27691 27691 276,908.80                  

In ven tory Cos ts 30,000.00                  30,000.00                  30,000.00                 30,000.00                  30,000.00                30,000.00                  30,000.00                30,000.00                30,000.00                 30,000.00                  300,000.00                  

Fellin g  an d  Cros s -cu ttin g 5880 1.95 404979.12 404979.12 404979.12 404979.12 404979.12 404979.12 404979.12 404979.12 404979.12 404979.12 4,049,791.20                

Deb arkin g 5880 0.35 72688.56 72688.56 72688.56 72688.56 72688.56 72688.56 72688.56 72688.56 72688.56 72688.56 726,885.60                  

Cab le  Cran in g 5880 20 4153632 4153632 4153632 4153632 4153632 4153632 4153632 4153632 4153632 4153632 41,536,320.00              

T ran s p ortation  to Dep ot 5880 8.32 1727910.912 1727910.912 1727910.912 1727910.912 1727910.912 1727910.912 1727910.912 1727910.912 1727910.912 1727910.912 17,279,109.12               

S tan d  Ten d in g  (S p acin g  etc .) -                               

Cou p e Reg en eration -                               

Reg en eration  Main ten an ce 3,500/ cab le  
lin e

17,500.00                  35,000.00                  52,500.00                 70,000.00                  87,500.00                105,000.00                 122,500.00               140,000.00               157,500.00                175,000.00                962,500.00                  

Creation  of P lan tation 50,000/h a 50,000.00                  50,000.00                 50,000.00                  50,000.00                50,000.00                  50,000.00                50,000.00                50,000.00                 50,000.00                  450,000.00                  

P lan tation  Main ten an ce 8,000/h a 8,000.00                   16,000.00                   24,000.00                32,000.00                  40,000.00                48,000.00                56,000.00                 64,000.00                  288,000.00                  

T o ta l Co s ts  NRDCL 8 ,6 6 0 ,15 1.4 7       8 ,7 2 7 ,6 5 1.4 7       8 ,7 5 3 ,15 1.4 7      8 ,7 7 8 ,6 5 1.4 7       8 ,8 0 4 ,15 1.4 7      8 ,8 2 9 ,6 5 1.4 7       8 ,8 5 5 ,15 1.4 7      8 ,8 8 0 ,6 5 1.4 7     8 ,9 0 6 ,15 1.4 7      8 ,9 3 1,6 5 1.4 7       8 8 ,12 7 ,0 14 .7 2       

T o ta l Re v e n u e  le s s  T o ta l Co s ts  
NRDCL

2 0 ,8 7 3 ,3 4 4 .3 9    2 0 ,8 0 5 ,8 4 4 .3 9    2 0 ,7 8 0 ,3 4 4 .3 9    2 0 ,7 5 4 ,8 4 4 .3 9    2 0 ,7 2 9 ,3 4 4 .3 9   2 0 ,7 0 3 ,8 4 4 .3 9    2 0 ,6 7 8 ,3 4 4 .3 9   2 0 ,6 5 2 ,8 4 4 .3 9   2 0 ,6 2 7 ,3 4 4 .3 9    2 0 ,6 0 1,8 4 4 .3 9     2 0 7 ,2 0 7 ,9 4 3 .8 8    

Ro y a lty

Royalty- Com m ercial 9800 11 388.41 3807496 3807496 3807496 3807496 3807496 3807496 3807496 3807496 3807496 3807496 38,074,960.00             

Royalty- Ru ral

T o ta l Ro y a lty  NRDCL 3 ,8 0 7 ,4 9 6 .0 0      3 ,8 0 7 ,4 9 6 .0 0      3 ,8 0 7 ,4 9 6 .0 0     3 ,8 0 7 ,4 9 6 .0 0      3 ,8 0 7 ,4 9 6 .0 0     3 ,8 0 7 ,4 9 6 .0 0      3 ,8 0 7 ,4 9 6 .0 0     3 ,8 0 7 ,4 9 6 .0 0     3 ,8 0 7 ,4 9 6 .0 0     3 ,8 0 7 ,4 9 6 .0 0      3 8 ,0 7 4 ,9 6 0 .0 0      

Re v e n u e  le s s  Ro y a ltie s  NRDCL

Tim b er- Com m ercial 25,725,999.86           25,725,999.86           25,725,999.86          25,725,999.86           25,725,999.86         25,725,999.86           25,725,999.86         25,725,999.86         25,725,999.86          25,725,999.86           257,259,998.60           

T im b er-Ru ral

T o ta l Re v e n u e  le s s  Ro y a lty  
NRDCL

2 5 ,7 2 5 ,9 9 9 .8 6    2 5 ,7 2 5 ,9 9 9 .8 6    2 5 ,7 2 5 ,9 9 9 .8 6    2 5 ,7 2 5 ,9 9 9 .8 6    2 5 ,7 2 5 ,9 9 9 .8 6   2 5 ,7 2 5 ,9 9 9 .8 6    2 5 ,7 2 5 ,9 9 9 .8 6   2 5 ,7 2 5 ,9 9 9 .8 6   2 5 ,7 2 5 ,9 9 9 .8 6    2 5 ,7 2 5 ,9 9 9 .8 6    2 5 7 ,2 5 9 ,9 9 8 .6 0    

T o ta l Re v e n u e  le s s  Ro y a lty  
Le s s  Co s ts  NRDCL

17 ,0 6 5 ,8 4 8 .3 9     16 ,9 9 8 ,3 4 8 .3 9     16 ,9 7 2 ,8 4 8 .3 9    16 ,9 4 7 ,3 4 8 .3 9     16 ,9 2 1,8 4 8 .3 9    16 ,8 9 6 ,3 4 8 .3 9     16 ,8 7 0 ,8 4 8 .3 9   16 ,8 4 5 ,3 4 8 .3 9    16 ,8 19 ,8 4 8 .3 9     16 ,7 9 4 ,3 4 8 .3 9     16 9 ,13 2 ,9 8 3 .8 8     

AAC 
(m 3 )

Re c .  
Vo lu m e  

(m 3 )

Nu /c f t Nu /m 3
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CBA can narrowly concentrate on financial costs and revenues, or can be broader, and encompass non-
market considerations such as social and environmental values by using a range of valuation techniques.  In 
the context of FMUs in Bhutan it is sufficient for CBA to take into account financial costs and revenues and 
for social and environmental factors to be dealt with by policy and legislation via the instrument of forest 
function mapping.  Economic appraisal is therefore undertaken for essentially commercial operations that 
are planned and implemented in accordance with what might be termed as sustainability criteria.  In practice 
these sustainability criteria are defined by the management restrictions resulting from the forest function 
mapping process. 

Supply and demand for forest products 

The process of forest management planning must take into account the supply and demand of forest prod-
ucts.  FMPs should include statements on supply and demand and the implications for forest management.  
In order to do this, it is necessary to examine past trends in supply and demand and also to make predictions 
about future supply and demand scenarios.  This sub-section presents some guidelines on how these consid-
erations may be incorporated into the planning process. 

Factors affecting supply of forest products 

The supply of forest products from an FMU is determined by the sustained yield of timber and other prod-
ucts.  Past trends can be identified from production records for the previous plan period, in the case of 
planning for the second or subsequent plan period.   Supply forecasts for timber can be derived from the 
AAC calculation and maturity class analysis. Consideration should be given to any expected change in 
product specification such as species composition, stem form and log size over the plan period and in the 
longer term. 

Factors affecting demand for forest products 

The demand for forest products is affected by a number of factors including; population, income per head, 
availability of substitute products, the state of the wood processing technology, tastes for timber products 
and the state of business activity (derived from Price, 1998).  The implications of these factors need to be 
taken into account in the planning process.  In the context of FMUs in Bhutan specific factors such as urban 
expansion, public and private sector construction activity and the availability of alternatives to wood for 
building and heating are likely to significantly affect the demand for forest products. 

1.14. Approval Procedures 

1.14.1. Endorsement by Local Government 

The FMP should be endorsed by the Local Government (LG) after presentation and endorsement by the 
FMU-Level management committee. Endorsement of the FMP by the LG shall be made easier if clear evi-
dence is provided of stakeholder consultation and participation in planning.  Minutes of FMU-level com-
mittee meeting should be included as an annexure to the FMP.  

1.14.2. Endorsement by Department. 

After endorsement of the FMP by the FMU level committee, the FMP has to be presented at FRMD and 
subsequently to the Technical Advisory Committee (TAC) of the Department for endorsement. The Head 
of the Department recommends the FMP duly endorsed by TAC. 

Objective 

In order to ensure that the plan is consistent with the technical standards and other legal provisions as en-
shrined in Acts, Policies and Rules.  
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Output 

FMP endorsed by FRMD and the Head of the Department  

Lead Responsibility 

Divisional Forest Office in collaboration with the FRMD 

Description of Activity 

The endorsed FMP by FMU level committee and Local Government must be submitted to FRMD by con-
cerned Divisional Forest Office at least 3 months before the close of a financial year. The concerned planner 
of the Divisional Forest Office must make an in-house presentation at FRMD at prior fixed date agreed in 
consultation with FRMD. Relevant officials from authorized agency preferably concerned Regional Man-
agers and General Managers shall be invited for the in-house presentation.  FRMD shall review the plan and 
subsequently either recommend for endorsement by TAC or recommend for changes and amendments to 
the concerned Divisional Forest Office. Presentation at the TAC shall be carried out by FRMD. 

The purpose of this step is to ensure that a number of planning criteria have been reached, plan is consistent 
with the technical standards and other legal provisions as enshrined in Acts, Policies and Rules. Normally 
it would take the form of a meeting involving the Head of the Department, FRMD and officials from the 
authorized agency. During the meeting, the salient features of the FMP would be presented and deliberated. 
The following is a list of criteria by which the committee shall be able to assess the plan (it may not be 
exhaustive) 

• Is the FMP (in its objectives) consistent with national level policy? 
• Is the FMP legal in its present format (does it meet all legal criteria)? 
• Is the FMP technically correct? 
• Is the FMP structure and contents consistent with planning codes and guidelines? 
• Have management objectives, options, responsibility, and indicators been identified? 
• Is there an established FMU-level management committee and has the committee been involved in 

the plan preparation? 
• Has the FMU-level management committee had a meeting to endorse the plan? 
• Has the FMP been endorsed by Local Government? 
• Has the environmental assessment been completed? 
• Is the plan financially sound; do authorized agency agree that its implementation is feasible? 
• Are there any alterations that are needed? 

Any comments arising should be noted in writing with an agreed responsibility for action. If there are many 
comments, the meeting may have to be re-convened once the amendments have been made. Consideration 
should be given to ensuring that any changes in the plan are endorsed by the Local Government. FMP 
fulfilling all these criteria should be submitted to the Ministry of Agriculture and Forests with a recommen-
dation from DoFPS for approval.  

1.14.3. Approval by Ministry of Agriculture and Forests 

Objective 

To approve the plan for implementation by Head of the Ministry. 

Output 

The approved FMU management plan; ready for implementation 

Lead Responsibility 

Head of Department shall submit plan to Ministry recommending its approval. 
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1.15. Amendment and plan revision 

The approved Plan may be revised during the implementation period if major changes occur in the area of 
FMU and in the event of major disasters. 

The Head of Department shall authorize a revision of the plan based on proposal for amendment from the 
respective DFO. 

1.16. Operational Planning 

An approved operational plan is the legally binding document basis by which implementation is guided and 
responsibility and accountability are determined for the one-year operational period. Operational plans 
(OPs) are developed to: 

• identify and describe forest management activities which shall be carried out during the coming 
year and (in the case of rolling two-year plans) during the following year; and 

• estimate the cost of carrying out the activities and identify funding sources. 

1.16.1. General Principles 

Operational plans should follow the general principles as indicated below so that they are effective and 
practical forest management tools. 

Simple structure and format 

Since they are prepared annually, OPs should be as simple and concise as possible. A standard format that 
can be easily completed is very appropriate; however, the format must contain all the necessary information 
for planning purposes. 

Objective led 

As with FMPs, OPs should be objective-led. This means that any activity identified for implementation 
in the OP should relate to a specific management objective in the FMP. While preparing the OP, it is 
essential to cross-reference to the FMP. 

Site specific and quantitative 

Since OPs are prepared for operational purposes, they should contain enough information for them to be 
implemented by the FMU Incharge. Any specified activity in the OP should therefore relate to a particular 
identified location in the forest (site specific) and be quantified in terms of costs and physical quantity. 

Participatory  

A number of activities in the OP can have a specifically local interest or potential impact on local stakehold-
ers. In such cases, the plan for that activity should be prepared in a participatory manner with the involve-
ment of the concerned stakeholders.  This is achieved by ensuring that the FMU-level management com-
mittee is an effective forum for participatory planning.  

Prepared annually (for a two-year rolling period) 

OPs are prepared annually but the plan period is for two years (see Box 1.11). Therefore, activities for the 
second year of the plan are carried forward into the first year of the next plan. This has important implica-
tions for budgeting (since it shall then be possible to estimate budgets well in advance of the start of the 
financial planning year) and for participatory processes since these can be carried out a year before the start 
of the activity. 
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Box 1.11 Explanation of ‘rolling’ operational plans 

For each year of the ten-year period of the forest management plan, an operational plan must be in 

place. 

The operational plan shall include detail of activities for the 1st year (let’s call it year 1) and an 

outline of activities for the 2nd year (year 2).  Mid way through year 1, the UIC shall prepare a 

detailed plan for year 2 (based on the outline from the year 1 plan) and an outline plan for year 3. 

The ‘rolling plan’ is a way of describing the operational plan and is not something separate or dif-

ferent to the operational plan. 

This table may help to illustrate the point.  Each separate colour block represents one operational 

plan including detailed planning for the first year and outline planning for the next.  

Year 1 2 3 4 5 6 … 

De-

tailed 

 

Outline 

 

De-

tailed 

Outline De-

tailed 

Outline Etc. 

  

 

 

De-

tailed 

 

Outline 

 

De-

tailed 

 

Outline 

 

De-

tailed 

 

Out-

line 
 

 

The advantages of preparing OPs annually for a two-year rolling period are that budgeting for the following 
year can be anticipated, continuity of management is made easier and participatory planning can be done 
well in advance. 

1.16.2. Timing of Operational Plan Preparation, Submission and Approval 

The timing for preparation and submission of operational plans has been set with the calendar year from 1st 
January to 31st December in order to synchronize with the financial year of authorized agency so that the 
budgeting and financial commitment to the implementation of planned activities is ensured (Table 1.57) 
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1.16.3. Funding and Implementation 

The OP must contain a budget estimate for the activities proposed. Approval of the OP must therefore be 
very closely linked with approval of the budget; otherwise the plan shall be for a proposed set of activities 
with no clear commitment for funding them.   

In practical terms, authorized agency has overall responsibility for funding the activities in the OP as part 
of their role as a development corporation (Roles and Responsibilities). However, the proposed and agreed 
level of funding must be discussed and agreed during the FMU-level management committee meeting held 
to endorse the OP.  

Although authorized agency shall fund the activities in the OP, this does not necessarily mean that they have 
complete responsibility for implementation. It is anticipated that activities with a significant commercial 
harvesting component shall be implemented by the authorized agency; while activities with a significant 
social or extension interest and monitoring and regulating activities shall be implemented by DFOs. 

1.16.4. Types of Activity in the OP 

This list is not exhaustive. Different activities may be included if they are required to achieve certain man-
agement objectives, whilst all these activities are not needed in every OP. Within the plan all activities 
should be specific in site and time, and responsibilities should be clearly identified. 

Nursery and regeneration activities 

● Seed collection 
● Nursery raising 
● Plantation creation and establishment 
● Plantation maintenance 
● Natural regeneration management 
● Protection of regeneration  
● Maintenance of regeneration  

Silviculture 

Silvicultural prescriptions should be developed for each unit of management (i.e. compartment, sub-com-
partment or stand, as appropriate). These silvicultural prescriptions should be based on the specific require-
ments of each stand in accordance with stocking condition and development stage. Examples of specific 
operations to consider are:  

2. Tending operations 
3. Re-spacing operations (of established regeneration) 
4. Thinning 
5. Sanitation logging/Operation 

Harvesting and utilization 

● Operational inventory (to provide data for following year’s harvest) 
● Cable line survey and enumeration 
● Commercial harvesting  
● Rural use harvesting 
● Regeneration survey 

Protection 

● Fire protection 
● Protection from grazing 
● Protection from illicit activities 
● Pests and diseases 
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Environmental and conservation 

● Soil and water conservation measures 
● Erosion control 

Social and local use 

● Awareness raising and environmental education 
● Extension activities e.g. tree planting on private lands 
● Recreational use 

Research and monitoring 

● Research activities 
● Monitoring (for any of the above activities) 

Administration 

● Staff and labour 
● FMU-level management committee 
● Participatory planning with local stakeholders (PRAs) 
● Report preparation 
● Licensing for local forest product collection (NWFPs) 

Infrastructure 

● Building construction and maintenance 
● Road construction and maintenance 
● Vehicle purchase and maintenance 
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Figure 1.10 Operational planning process flowchart 
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1.11.5 Operational Planning Process 

Step 1.  Operational inventory 

An operational inventory is an intensive assessment of a relatively small area. The information produced is 
primarily intended for use in short term “operational” planning, e.g. related to the harvesting of timber vol-

umes within compartments. For the purpose of implementation of any management plan, operational inven-
tory provides required data and information for operational planning.  

Objectives 

The main objective of OP is to: 

• assess the resource availability for the planned harvesting area; and  
• calculate harvestable volume for the year (AAC) 

Output 

A precise estimate of volume to be removed during the coming year from a specifically defined harvesting 
area or block (identified in the FMP). 

Methodology  

Based on the prescription of the management plan, the FMU area has to be stratified in to production, pro-
tection and non-production management working circle. The operational inventory is conducted in the pro-
duction management circle to estimate the growing stock for particular calendar year. From the past expe-
rience, operational inventory should be conducted in 50-200 ha of forest where the harvesting of the timber 
is prescribed in the management plan.  

Although, OP inventory shall be carried out in the production management circle only, under the existing 
condition and considering the overlapping boundaries of the management circles, it shall be difficult to 
clearly demarcate the boundaries for survey. Therefore, after generating the systematic sampling grid, all 
plots falling in the non-production and protection zone shall be not me enumerated. However, the sampling 
intensity minimum of 50 plots or at least 2% of area should be sampled during each operational inventory.   

Plot Design and size  

Each Inventory plot shall consist of two concentric fixed size circular plots viz, major plot and minor plot 
of 12.62 m and 5.64 m radius respectively. The trees with dbh>30 cm shall be enumerated in the major plot 
while trees with dbh10-29 cm shall be enumerated in the minor plot. 

 

 

 

 

 

 

 

 

 

 

 

Major plot 

 

Minor plot 

Figure 1.11 Plot Design 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        308 

 

 

All trees with dbh ≥10 cm shall be enumerated and compiled in Operational Plan Tally sheet (Table 1.59) 
by species and by diameter class.   

 

Plots radius (m) area (m2) area (ha) dbh 

Minor 5.64 40 0.004 10-29 cm 

Major 12.62 500 0.05 > 30 cm dbh 
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Step 2.  Harvesting plan and cable line survey 

Objective 

• To plan for harvesting and extraction activities. 
• To estimate the approximate volume of timber that can be extracted from a cable line. 
• To generate a cable line map showing the identified harvesting area with planned cable lines. 

Outputs 

• Agreed extraction plan for the identified harvesting area 
• Volume of timber in standing form that can be extracted from each cable line. 
• Cable line map showing cable lines and harvesting area 

Lead responsibility 

Authorized agency and DFO 

Description of activities 

The survey takes place within the selected identified harvesting area for the year (identified in the FMP), 
and it may be combined with operational inventory. Within the area allocated for harvesting, the layout of 
the cable lines and extraction routes needs to planned and agreed in advance. 

• To ensure that as much of the identified harvesting area as possible is reached (and therefore as 
much of the available volume can be extracted). This can be done through extending the cable line 
length to the maximum length possible for extraction of available timber stock from a cable line. 

• To ensure that environmental standards and guidelines are being followed. 
• To maximize the economic efficiency of the harvesting operations. 
• To ensure that safety standards are being applied. 

A harvesting plan and cable line survey would involve the production of a cable line map showing the 
proposed cable lines and extraction routes as well as a description of the operations.  

Step 3.  Preparation of operational plan 

Objectives 

• To prepare a costed plan for implementation during the next two years (involving stakeholder par-
ticipation for some activities) 

• To formalize local institutional responsibility for planned activities (e.g. grazing, fire management, 
rural timber distribution) 

Outputs 

• Approved operational plan with budget  
• Identified responsibilities for each planned activity 
• Calculated costs for each planned activity 

Lead responsibility 

FMU Unit Incharge with local stakeholders as required 

Description of actions 

The format of the operational plan should help to: 

(a) Ensure that operational activities are specifically related to management objectives specified in the 
FMP 

(b) Create a greater sense of accountability for both funding and implementing various activities 
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(c) Improve and simplify annual reporting on OP activities (in the FMU annual report) 

1.11.6 Operational plan format 

The recommended format includes six parts as indicated below: 

(a) Title and approval sheet  
(b) Review of Previous year’s plan  
(c) Summary of current year activities Review of previous year’s plan 
(d) Year 1 activities  
(e) Outline for year 2  
(f) Annexures 

Figure 1.12 provides the general framework on the content of the operational plan for January 2018-Decem-
ber 2019 and the components are described briefly. 
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Figure 1.12 OP format 
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A. TITLE AND APPROVAL SHEET 

Period of Operational Plan: 

While OP is for two year rolling plan, only first year of operation of OP is mentioned in the title and approval 
sheet. For example, rolling operational plan for the period January 2018-December 2019, the tile and ap-
proval sheet shall be mentioned “January 2018-December 2018.” 

B. REVIEW OF THE PREVIOUS YEAR’S PLAN (January 2017 – December 2017) 

This section shall review the status of the activities planned and implemented during previous year.  

Note: Plan year shall mean the year for which the plan is being made (eg: January- December 2018). Pre-
vious year shall mean the year for which the targets are being measured (January -December 2017). 

B.1 FMU Annual Report Part 1- Review of activities 

Brief summary of the physical activities undertaken in the previous plan period. Details of the activities 
shall be accounted in the tables following it. All activities planned in the previous plan are mandatory to be 
reported. Target achieved shall be measured against the annual target set for the previous year 

Column 1 (Planned Activities): List all planned activities that has been proposed in the previous OP (Table 
C) 

Column 2 (Objective): Copy the objectives for each activity from table C of the previous year’s OP.  

Column 3 (Planned qty. or number): This is the target set against each activity for the previous year which 
can be in numbers or quantity (Copy from the table c of last OP).  

Column 4 (No. or quantity achieved): This is the achievement of the target set in the previous year. Write 
down the achievement.  

Column 5 (Comments): An under or overachievement of the target should be justified in this column. 

B.2. FMU Annual Report Part 2 - Financial Report (2017) 

This provides a brief summary of the financial achievement for the previous year. Actual expenditure against 
the estimated cost for all the activities must be mentioned for the previous year. 

B.3 Past Inventory Status 

 

• Block/Compartment: Mention Block/compartment name in which the inventory was conducted.  
• Year of inventory: Mention the year in which the inventory was conducted. 
• Number of inventories conducted:  Mention the number of inventories conducted in that particular 

year. 
• Inventory area (in ha): Mention the extend of area covered by the inventory. 
• Sampling plots: This column is divided into two parts viz. total and enumerated. Under total men-

tioned the number of operational inventory plots planned initially. Under enumerated mention the 
number of operational inventory plots which were accessible and enumerated.  

• Total area covered (in ha):  Mention the total area covered during the inventory. In the subsequent 
year, these shall be the cumulative value of the actual area inventoried every year. Please refer the 
table above for clarity. 

Total Enumerated

Helela/ I 2015 1 200 50 47 200 1000 800
Helela/ I 2016 1 200 50 50 400 1000 600
Helela/ I 2017 1 200 50 48 600 1000 400

Net Commercial 
operable area of 
FMU (in ha)

Balance operable 
area (in ha)

Block/Compar
tment

Year of 
inventory

Number of 
inventory 
conducted

 Inventory 
Area (in ha)

Sampling Plots
   Total area 
covered (in ha)
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• Net Commercial operable area of FMU (in ha): This is the total commercial operable area of the 
FMU. This value must be derived from the Forest Management Plan of the FMU. 

• Balance operable area (in ha): The balance operable area shall be the total operable area left after 
the inventory. This shall be (Net Commercial operable area of FMU (in ha)- Total area covered (in 
ha) by the inventory).  

Please note that the information should be till previous year from the start of the plan. If the plan period 
started from 2015, then the information should be from 2015 to 2017. 

B.4. Review of past operations 

This section gives information on the details of timber and other forest produce extracted from the cable line 
and adhoc areas in the previous year. Please note that it is the information on the actual volume of timber 
extracted and not the initially planned. 

B.4.1 Review of standing volume and clear cut area from Cable lines for the previous year. 

This section shall give details of timber harvested in the previous year (2017) from cable line. 

 

• Block/Compartment: Mention Block/compartment in which the cable line is located 
• Cable line No: Mention the cable line no (eg. 2017/1) 
• Length (m): Mention the length of the cable line which was actually harvested. Generally, this 

should be the same length as was initially planned.  
• No of Groups/ Area(ha): Mention the number of group openings created and the total area of the 

clear-felled area within the group. (eg.10/1.2 where 10 is the number of group openings and 1.2 is 
the total area of the clear-felled area in the groups in ha). 

• Corridor area (ha): Mention the cable corridor area to be clear felled. Measure the cable corridor 
width and length. Compute the area using the formula for rectangular plots. For example, if the 
length and breadth of the cable corridor is 1000m and 8m respectively, then area is computed as 
1000m x 8m/ 10000 = 0.8 ha). 

• Total Clear felled area (ha): This is the sum of group opening area and cable corridor area. (eg. 
1.2 + 0.8 = 2.0 ha) 

• Standing volume for each species (m3): Details of standing volume harvested from the cable line 
in the previous year (eg: 2017). The name of the species shall however vary according to the species 
inventoried or found in the respective FMU. 

• Total Standing volume (m3): Accounts for the total standing volume extracted from each cable 
line (Summation of the standing volume extracted from each species). 

 B.4.2 Review of standing volume and clear felled area from other activities for the previous year. 

This section shall give details of timber harvested from areas apart from the cable line and includes other 
activities like farm road constructions, transmission lines in the previous year, etc. (2017). 

No of

Groups/Are
a (ha)

Helela/I 2017/1 1000 10/ 1.2 0.4 1.6 600 200 50 150 1000

Broadleaf 
(m3)

Cable Line
Total clear 
felled area 
(ha)

Standing volume for each species Total 
standing 
volume 
extracted 
(m3)

No.
Length 
(m)

Corridor 
Area (ha)

Blue pine 

(m3)

Block/  
Compartment

Mixed 
Conifer  

(m3)

Chirpine 

(m3)
Hemloc
k(m3) 

Spruce
(m3)

Fir 
(m3)
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• Block/ Compartment: Mention Block/compartment name in which the activities were carried out. 
• Activities: Mention the type of adhoc activities carried out (Eg. Farm road construction, transmis-

sion line etc.,) 
• Clear felled area(ha): Mention the clear-felled area for the activities. For example, in case of farm 

road if the length is 1km (1000m) and the width is 4 m, the total clear-felled area shall be 0.4 ha 
(1000 x 4/10000 = 0.4 ha). 

• Standing volume for each species:  Details of standing volume harvested from other activities in 
the previous year (eg: 2017). The name of the species shall however vary according to the species 
inventoried or found in the respective FMU. 

• Total standing volume (m3): Accounts for the total standing volume extracted adhoc activities 
(Summation of the standing volume extracted for each species). 

B.4.3 Review of Commercial AAC (area and volume) 

This section is the review of the commercial AAC both in terms of area and volume from the start of the 
management plan period till the previous year. If the management plan period is from 2015, then these shall 
account from the year 2015 till 2017 for operational planning in 2018.  
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The Commercial AAC and volume per hectare must be derived from Forest Management Plan of the FMU. 

• Cable Coupe operated area (ha): This is the total clear felled area in the cable lines and groups oper-
ated in a particular year. This information can be derived from section B.4.1 of the OPs. 

• Other operated area (Roads, transmission lines, etc.,) (ha): This is the total clear-felled area due to 
other planned and adhoc activities such as road, transmission lines, sanitation area. This information 
can be derived from section B.4.2 of the OPs. 

• Total Operated area (ha): This accounts for the total area felled for harvesting in the plan period for 
the particular year and is the sum of cable coupe operated area and the adhoc operated areas. 

✓ Total operable area (ha) = Cable Coupe operated area (ha) + Adhoc activities Others oper-
ated area (Roads, transmission lines, etc.). 

• Balance AAC Area (ha): This is the Balance AAC area of the FMU for each year. This can be calcu-
lated by subtracting Total Operated area from the AAC area (ha). 
Balance AAC Area(ha)= AAC area (ha) - Total Operated area (ha) 
This can be positive or negative depending on the excess /less area operated. 
 

❖ AAC Volume (m3):  
• AAC Vol (m3): This is the overall AAC of the FMU in m3 which must be derived from the FMP. 
• Standing volume extracted from Cable line (m3): This is the standing volume harvested from the 

cable lines and corridor in m3 in the previous year. This information can be derived from B.4.1. 
• Standing Volume extracted from adhoc activities (m3): This is the Standing volume in m3 harvested 

from adhoc activities like road, transmission lines, sanitation area etc., This information can be derived 
from B.4.2 

• Total standing volume extracted (m3): This accounts for the total standing volume extracted during 
the previous year. Total standing vol. extracted (m3) = Standing vol. Cable line (m3) + Standing Vol. 
others (m3) 

• Balance AAC Vol. (m3): This is the balance volume calculated against the Commercial AAC of the 
FMU which is left post extraction of timber from cableline and adhoc activities annually.   
 
Balance AAC Vol. (m3) = AAC volume of the FMU (m3) - Total standing vol. extracted (m3)  

This can be positive or negative depending on the overharvesting or under harvesting against the AAC. 

B.5 Commercial Wood Products Supplied 

Year 

Quantity harvested from PLANNED OP ac-
tivities (m3) 

Quantity supplied from UNPLANNED activi-
ties (m3) Total 

standing 
volume 
harvested 
(a)+(b) 

Re-
marks 

Standing 
volume 
harvested 
(a) 

Log 
vol. 

Fire-
wood 

Wood-
chips 

Others  
Standing 
volume har-
vested (b) 

Log 
vol. 

Fire-
wood 

Wood-
chips  

Others 

2015 2400 1500 500 100 100 400 200 100   50 2800   

2016 2800 1400 600 200 300 300 100 50 50   3100   

2017 1550 1000 200 100 50 550 300 50 50   2100   

The section describes the details of wood produce supplied on commercial royalty from the start of the plan till 
the previous year. If the plan period starts from 2015, then these shall account for the commercial wood pro-
duced from 2015 till 2017 (previous year). The table is divided into two sections as follows: 

❖ Quantity harvested from PLANNED OP activities (m3) 
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This section highlights timber extracted from cable lines during the previous year (2017 in the current 
case). Any deviation from the plan should be justified in the “Remarks”column. 
• Standing volume harvested(a): This is the standing volume of timber harvested from cable lines 

in respective year. 
• Log volume: This is the log volume (m3) extracted from cable line in respective year. 
• Firewood: This is the volume of firewood (m3) extracted from the cable line in respective year. 
• Woodchips: This is the volume of woodchips (m3) extracted from the cable line in respective year. 
• Others:  This is the volume of any other wood products (m3) extracted from the cable line in re-

spective year. 
 
❖ Quantity supplied from UNPLANNED activities (m3) 

This section highlights timber extracted from adhoc activities during the previous year (2017 in the current 
case).  Any deviation from the plan should be justified in the “Remarks” column. 

• Standing volume harvested (a): This is the standing volume (m3) of timber harvested from adhoc 
activities in respective year. 

• Log volume: This is the log volume extracted(m3) from adhoc activities in respective year. 
• Firewood: This is the volume of firewood (m3) extracted from adhoc activities in respective year. 
• Woodchips: This is the volume of woodchips (m3) extracted from adhoc activities in respective 

year. 
• Others:  This is the volume of any other wood products (m3) extracted from adhoc activities in 

respective year. 

B.6. Plantation (Afforestation and Reforestation) 

This section accounts for the afforestation and reforestation activities taken in the FMU. It starts from the start 
of the plan year till the previous year (in this case 2017). 

B.6.1. Review of Plantation 

 

• Year of assessment: Year in which the plantation was assessed. 
• Block/Compartment: Name of the Block/ Compartment where the plantation was carried out.  
• Cable Line No: Cable line no in which the plantation was carried out. 
• Geo-Coordinates: Geo-coordinates of the centre of the location of plantation area. The plantation area 

should be mapped and Shapefile /kml should be submitted. 
• Year of Plantation: Year when the plantation was carried out. 
• Plantation Area Planned (ha): Area of plantation planned in a particular year. 
• Plantation Area implemented (ha): Area in which the actual plantation was carried out. 
• Plantation survival percentage: Plantation survival % assessed. 
• Remarks: Any comments and remarks to be entered here regarding over or underachievement of the 

targets.  

The assessment of the plantation must be carried out as per the guidelines developed by SFED. 

Year of 
assessment

Block/ 
Compartmen

t
Cable Line No Geo-cordinates

Year of 
Plantation

Plantation 
area 

planned(ha)

Plantation 
area 

implemented 
(ha)

Plantation 
Survival 

Percentage
Remarks

2015 Helela/1 2011/1 & 2 N……..E……. 2014 4 3.5 40
2016 Helela/1 2012/3 & 4 N……..E……. 2015 3 3 40
2017 Helela/1 2013/ 5& 6 N……..E……. 2016 3.5 3.5 35
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B.6.2 Review of Natural Regeneration Survey 

 

Details of Natural Regeneration survey report should be attached as annexure. 

• Year of Regeneration Survey: Year in which the regeneration survey was carried out. 
• Block/Compartment No: Name of the Block/Compartment in which the survey was caried out. 
• Cable line No: Cable line no in which the survey was carried out. 
• Planned area (ha): Planned area of regeneration survey in hectares 
• Area surveyed (ha): Actual area surveyed against the planned area. 
• Seedlings/ha in Section (corridor): Number of seedlings/ha in cable corridor area. 
• Seedlings/ha in Group openings: Number of seedlings/ha in Group openings 
• Remarks: In this “remarks” column, mention the status as adequate, doubtful or need planting  

Refer the Regeneration survey guidelines for details. 

B.7 Road Construction 

 

Details of area cleared for road construction for the start of the plan till the previous year. If the plan period is 
from 2015, then, these shall account for the area cleared and volume extracted from the year 2015 till previous 
year (2017 in this case). 

• Block/Compartment: Name of the Block/Compartment in which the road was constructed. 
• Year of Construction: Year in which the road was constructed. 
• Road Planned (km): Length of the planned road. 
• Road Implemented (km): Actual length of road constructed 
• Area cleared (ha): Area clear felled for right of way. For eg, if the length is 2 km with a width of 4 m, 

then the area clear felled is 0.8 ha (2000 x 4/10000). 
• Standing volume extracted (m3): Standing volume harvested from the road construction. 
• Remarks: Any remarks to be mentioned here. 

Please note that the Map for new road construction and other activities should be annexed 

 

 

 

Section
(Corridor)

2015 Helela/1 2012/1 2 2 1500 1300 need to plant
2016 Helela/1 2012/2 2 2 1800 2000 doubtful
2017 Helela/1 2012/3 3 3 2500 2400 adequate

Remarks (adequate, 
doubtful, need to 

plant)Group

Year of 
Regeneration 

survey

Block/  
Compartment

Cable 
Line No

 Planned area 
(ha)

 Area 
surveyed 
(ha)

Seedlings/Ha

Block/Compartment
Year of 

construction

Road 
planned 

(km)

Road 
implemented 

(km)

Area 
cleared 

(Ha)

Standing Volume 
extracted (m3)

Remarks

Helela/1 2015 2 1.5 0.8 1000
Helela/1 2016 0 0 0 0
Helela/1 2017 3 3 1.2 1500
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B.8. Non-Wood Forest Produce Supply 

This section highlights the extraction of NWFPs from the FMU from the start of the plan to the previous year. 

Year 

Product Types 

Bamboo 
(No.) 

Sand 
(TL) 

Top Soil 
(TL) 

Stone/ Boul-
ders (TL) 

Gravel 
(TL) 

Leaf Mould/ 
Litters (TL) 

Mush-
room (Kg) 

….. 

(Unit) 

2015 1000 20   50         

2016 2000 100             

2017 10000 0             

 

Under this section mention the quantity of different types of NWFP supplied in a year. 

*Please add additional columns for NWFP not listed above. 

B.9. Rural Timber Supply 

This section highlights the extraction of rural timber from the FMU. 

B.9.1 Review of Rural AAC (volume) 

Block/ com-
partment 

Year of 
operation 

Rural AAC (m3) 
Total Standing vol-
ume supplied (m3) 

Balance Rural 
AAC of the FMU 
(m3) 

Management 
Plan 

Operational 
Plan 

Helela/1 2015 1000 1000 700 300 

Helela/1 2016 1000 900 1300 -300 

Helela/1 2017 1000 800 500 500 

Review of the rural AAC (volume) for the start of the plan till the previous year. If the plan period is from 2015, 
then, these shall account for the rural AAC from the year 2015 till 2017. It is cumulative. 

• Block/Compartment: Name of the Block/Compartment from which the rural timber was supplied. 
• Year of operation: Year of operation. 
• Rural AAC (m3) 

(i) Management Plan: The rural AAC as per the management plan. 
(ii) Operational Plan:  The annual planned target for supply of rural timber. 

• Total standing volume supplied (m3): This is the total rural timber supplied in standing volume. 
• Balance Rural AAC of the FMU (m3): This is the balance volume calculated against the Rural AAC 

of the FMU which is left post extraction of rural timber annually. 
 
Balance Rural AAC Vol. (m3) = Rural AAC (m3)  (Management Plan) of the FMU - Total standing vol. 
supplied (m3)  
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B.9.2 Rural Wood Products supplied 

  Quantity supplied in standing form (m3) Total 
standing 
volume 
supplied 
(m3) 

Remarks Year Drashing  Cham  Tsim  Dangchung/poles  
Fencing 
post 

Fire-
wood  

  No vol No vol No vol No vol No vol No vol 

2015 20 26                         

2016 30 39                         

2017 10 13                         

Details of wood produce supplied on rural purpose for the start of the plan till the previous year. If the plan 
period is from 2015, then, these shall account for the rural wood produced the year 2015 till 2017. 

• Year: Year of rural timber supplied (eg.2015) 
• Quantity supplied in standing form: Total quantity of timber supplied in standing form for 

different produce type; Drashing, Cham, Tsim, Dangchung, Fencing post and Fire wood.  
• No.: Number of the produce supplied (eg. 20 Drashing) 
• Vol: Corresponding standing volume for the produce supplied (Refer Volume Table) 
• log vol: Quantity of log volume from standing volume supplied (No log volume for 

Tsim, Dangchung, Firewood) 
• Total standing volume supplied (m3): Summation of total standing volume (m3) of all 

the forest produce supplied. Any over or underachievement shall be described in “Re-

marks”.  
 

C. SUMMARY OF ACTIVITIES  

This section shall describe briefly the activities that has been planned for the plan year (2018 in this case). 
Details of the activities shall be accounted in the tables following it. Physical and financial target for the plan 
period are set and this shall remain as a benchmark against which the target shall be assessed the following year. 
(Refer REVIEW OF THE PREVIOUS YEAR’S PLAN (January 2017 – December 2017)). 

 

Column 1 (Activity): Add activities that is being proposed for implementation in the plan period (Year 1). The 
activities defined here should be explained in the next column and should be in line with the management plan 
objectives. Note: The activities mentioned in the above table are mandatory for all the FMUs and additional 
activities may be defined as per the FMP. The activities might slightly vary according to the area and location 
of the FMU. 

Column 2 (Objective): The objectives for each activity has been defined. This should be in line with the FMP. 
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Column 3 (Planned qty. or number): This is the Target set against each activity planned in the plan period 
(2018). This can be the total volume in m3 (Commercial and rural harvesting) or area, numbers or others de-
pending on the activity defined in column 1. These shall be the basis on which the OP shall be reviewed next 
year (Section B). 

Column 4 (Responsibility for implementation): Designation/Position of the person responsible for implement-
ing the activity should be mentioned (Eg: Unit Incharge or Production Incharge). 

Column 5 (Responsibility for funding): Mention the organization responsible for funding of the respective 
activity. 

Column 6 (Estimated cost of activity): Total estimated cost of the activity from costing done under Budget and 
sales. 

D. YEAR 1 ACTIVITIES.   

This section pertains to the details of each activities planned for the plan period as indicated in SUMMARY OF 
ACTIVITIES above. The following information should be provided for each activity. 

1. Activity: Name of the activity. This should be in line with the name of activity listed in section C. 
2. Location: Name of block of compartment or block in which the activity is being carried out. 
3. Justification for the activity: Refer to the objective in Section C or the objective in the FMP. 
4. Proposed silviculture system and/or description of what is being proposed: Description of the silviculture 

system prescribed in the FMP. 
5. Timing:  The time of the activity. It can be in a month, few months or throughout the year. 
6. Method of implementation:  Name of the implementing agency and details in implementing the activities. 
7. Details of any participatory process followed: Explanation of any participatory approach conducted 

/done. 
8. Responsibility: The agency/person responsible for making sure the activity is implemented on time. 
9. Additional information and comments: Any additional information. 

E. OUT LINE FOR YEAR TWO  

This section highlights the brief outline of activities for year II. If the OP is from January 2018-December 2019, 
then this section shall consist of outline of activity for the 2nd year (January 2019-December 2019).  

A. ANNEXURES 

The following annexures should be included in the OP. 

ANNEXURE I:    Operational Inventory Tables 

ANNEXURE II:  Budget and Sales 

ANNEXURE III: Cable line Map 

ANNEXURE IV: Minutes of the FMU level Committee Meeting 

ANNEXURE V : Regeneration Survey Report 

ANNEXURE VI : Plantation Monitoring and Evaluation Report 

ANNEXURE VII : Approval for Adhoc activities. 
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1.12 Implementation framework 

1.12.1 Road construction 

All road design, construction and maintenance in FMUs should be in accordance with the principles of environ-
mentally friendly road construction and with NEC Regulations and sectoral guidelines.  This section of the code 
presents guidelines on road construction and maintenance; these are largely derived from NEC (1999) and Dorji 
& Incoll (2001).  A number of existing documents which are highly relevant to the design, construction and 
maintenance of forest roads including authorized authority/WWMP (2002), Visser (2001), Winkler (1999), 
Schaffner & Jimba (1999), RGoB/SNV (2002), Schaffner et al (2002) and Technical guidelines on farm road 
construction. These should be referred for further information. 

The main consideration in all forest road building and maintenance is to ensure that roads properly shed water. 
A cambered profile and good roadside drainage with frequent culverts are therefore very important.  A rutted 
flat surface shall hold water.  

Main routes through FMUs benefit from reconstruction using excavator and vibration roller to provide a good 
cambered profile. Good construction shall not only reduce maintenance liability but also significantly improve 
the usability of the road. 

Road construction and maintenance; impact management recommendations 

The following is an adapted extract from National Environment Commission (1999), Forestry: Bhutanese envi-
ronmental assessment sectoral guidelines. Forestry roads are complex engineering structures, the design, con-
struction and maintenance of which can have significant impacts on the economics of forestry operations and 
on the local environment.  They are almost always the most problematic features of forest harvesting operations, 
often causing more soil erosion and land instability than any other component of forestry operations. 

Roads, because they also provide access to previously roadless areas, can also greatly increase levels of forest 
resource use, in particular firewood collection and domestic grazing.  

Nevertheless, roads are essential part of the managed forest estate, both for timber extraction and to provide 
access for forest management and monitoring. The negative economic and environmental impacts of road access 
can be minimized by adherence to the following general principles and practices:  

1. Trained engineers should be responsible for road design and location surveys, and should supervise 
road construction; 

2. Keep roads and fill-slopes away from streams and outside riparian protection zones wherever possible; 
3. Road lengths and density should be minimized (optimised), consistent with access requirements, so as 

to reduce erosion potential, deforestation and other environmental impacts, and to enhance access eco-
nomics; 

4. Design widths should be the minimum required for safety and access efficiency, so as to minimize the 
total area of disturbance (the maximum cleared width that can be justified for FMU access systems shall 
be 5-6 m); 

5. Avoid areas of wet soils and high erosion risk areas so as to minimize construction and maintenance 
costs and the risk of environmental degradation; 

6. Avoid excessive side-cast fill slopes on steep hillsides through the use of a hydraulic excavator and end-
hauling of excavated material to a safe, stable storage area (use cut and fill methods and identify safe 
dumping sites). 

7. Provide proper equipment for full compaction of the road foundation and allow the road to dry thor-
oughly before use; 
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8. Use roadside ditches and properly spaced cross-drains to channel water away from the road structure 
and onto adjacent stable, vegetated areas; 

9. Estimates of size and spacing of culverts used for cross-drains should be based, wherever possible, on 
local rainfall and runoff information; 

10. Where stream crossings are necessary, the crossing structure should be designed on the basis of a de-
tailed site survey and disturbance to the watercourse minimized during construction; 

11. Stabilize and revegetate cut and fill slopes with low growing (fast growing) shrubs, grasses and legumes 
as soon as possible after construction is completed, adopt appropriate bioengineering measures 

12. Ensure proper maintenance of road surfaces, roadside ditches, cross-drains and stream crossings, and 
enforce road-use restrictions during critical weather conditions 

13. Roads not required for permanent access should be "put to bed" by ripping the road surface and sowing 
of grass and legume mixes (by adopting appropriate bioengineering works) 

14. Road location and design shall be subjected to environmental assessment as part of the forestry man-
agement plan preparation and review while construction, maintenance and abandonment shall be regu-
lated by the application of codes-of-practice in operational contracts.  

15. Carry out bioengineering works as appropriate. 

For consistency and completeness, it is recommended that a comprehensive set of road engineering codes-of-
practice be prepared by the authorized agency, covering the full scope of access development activities as fol-
lows: 

1. Road location criteria, including operational, physical, environmental, and economic considerations, 
and procedures for route surveys; 

2. Road design and construction standards, including maximum grades, formation and running surface 
widths, site preparation, bench cut and end-haul requirements, restrictions on waste spoiling, sub-grade 
and surface material specifications, stream crossing and surface drainage standards, equipment specifi-
cations, and timing; 

3. Road maintenance standards, including grading, resurfacing, ditch and culvert maintenance, and reveg-
etate and stabilization of cut/fill slopes and borrow areas; 

4. Safe storage of fuels and lubricants, and environmentally appropriate means of disposal of used oils and 
grease (safe handling/storage of blasting materials (explosives); see Blasting Manual and Rules on 
Explosives) 

5. Road shut-down indicators (weather or instability risk) and procedures  
6. Road abandonment, stabilization and revegetation prescriptions; (rehabilitation/restoration of aban-

doned roads with bioengineering measures). 
7. Road inspection (monitoring) frequencies and reporting requirements 

1.12.2 Health and Safety 

What is health and safety all about? 

 Safety is about preventing people from being harmed at work.  This is achieved by the workforce taking the 
right precautions and the employer providing a satisfactory working environment.  Health and safety apply to 
all working environments, including offices as well as operational sites in the forest.  However, the focus of this 
section of the code is on operations in the field. 

Regulation on Occupational Health, Safety and Welfare developed by Department of Labour, Ministry of La-
bour and Human Resources shall be applicable for maintaining health and safety during forest operations in the 
FMUs.  
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This section of the code provides only a brief overview of terminology, roles and responsibilities and conducting 
of generic and site-specific risk assessment in relation to harvesting and planting operations. Refer to Bradshaw 
(2003) for comprehensive and detailed guidelines on health and safety in relation to forestry operations.   

Roles and responsibilities 

Employers and employees must look at the intended workplace (i.e. the harvesting site) to identify all possible 
hazards.  They must then try to minimize the risks of those hazards to the workforce and do everything that is 
reasonable and practically possible.  

It is necessary to identify the responsibilities of DoFPS and authorized agency in the planning and implemen-
tation of work at a harvesting site. A chain of command must be in place for every worksite; this usually involves 
two tiers of management (Table 1.64).  

Table 1.64 Forest harvesting risk assessment roles and responsibilities 

Management tier Description Key tasks 

DoFPS 
 

The controller of 
the land on which 
the forestry work 
is taking place 

● Co-ordination of the activities of the overall forest environ-
ment for health and safety. 

● Gathering of information regarding hazards on and around 
the forest site and passing it on to the FWM. 

● Ensuring that the activities of a worksite do not affect the 
health and safety of other people. 

Authorised agency 
 

The person who 
commissions 
work on a for-
estry site 

● Using the information given by the landowner prepare an 
outline risk assessment for work on the site. 

● Select competent contractors who have made adequate 
provision for health and safety. 

● Specifying the health and safety measures for contractors 
working on the site. 

● Liaise with the landowner. 
● Monitor health and safety on the site. 

 

It is necessary to produce a generic risk assessment for all harvesting operations, in all FMUs, prior to com-
mencement. DFO and authorized agency should conduct the generic risk assessment at an early stage of 
operational planning. The authorized agency should implement outcome of the risk assessment potential ex-
ercise. 

1.12.3 Allotment of Subsidized Timber and NWFP 

The Forest and Nature Conservation Rules and Regulations of Bhutan, 2017, define the legal basis for the supply 
of subsidised timber for rural house construction and for the supply of other forest produce in rural areas. Ap-
propriate provisions of the Rules should be referred. 

This section of the code includes guidelines in relation to rural allotment that aim to ensure that marking is 
undertaken that is consistent with the principles of sustainable forest management. It is essential that ad hoc and 
unplanned felling does not take place and that the AAC is not exceeded, nor timber harvested from areas where 
it has not been specifically allocated. 
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Silvicultural Considerations 

It is essential that all marking of standing tree for rural allotment is done in the rural block identified in the 
management plan, on single tree selection basis. The successful implementation of silvicultural systems de-
pends, to a large extent, upon appropriate marking guidelines in place and being followed; refer to the code 
section on silvicultural marking guidelines.  

Under no circumstances should the marking officer mark good quality, healthy trees in the stand if this is not 
consistent with good silvicultural practice. Marking should be done uniformly over the stand to provide enabling 
condition for improvement of the remaining stand.  

After logging by authorized agency, marking for subsequent local use harvesting can further disrupt silvicultural 
systems. Not only does this harvesting threaten developing regeneration but it may also remove trees from the 
interlines and so compromise future passes (Whitfield, 2001). Therefore, harvesting of rural timber from inter-
lines must be avoided. 

Harvesting and utilization 

Manual extraction of timber should be closely supervised in order to ensure that extraction along water course 
does not take place and that repeated extraction along gullies does not lead to soil erosion. Stream buffers should 
be identified and no felling or extraction take place in or through them. Regeneration should be protected from 
manual extraction. 

Sanitation of the harvested area should be ensured through efficient utilization of rural timber. 

Non-wood forest products 

The allotment of non-wood forest products (NWFPs) should be done in accordance with the principles of sus-
tainability; in particular harvest levels should be regulated so that future yields are not reduced.  Surveys of 
NWFP should be undertaken and records kept of allotments.  Volume V of the Code must be referred to for 
necessary guidance of sustainable harvesting of NWFPs. Silviculture Implementation Guideline  

Section on silvicultural systems under this Chapter provides guidelines on the development of recommendations 
for silvicultural systems in FMUs; it is designed to help users exercise their professional judgement in develop-
ing site-specific management strategies and prescriptions in order to achieve forest management objectives. 

This section provides practical guidance on silvicultural implementation; they should, however, be considered 
as indicative and be further developed and refined to suit specific objectives and local conditions. 

Marking guidelines, providing practical guidance on the marking of trees to be harvested, are presented specific 
to silvicultural system and/or forest type.  Notes on other aspects of implementation are also provided. 

The marking guidelines are based on accepted silvicultural theory and field experience; they are derived from 
those presented by Slavicky (1992), Rai (1993), Statz & Wyrsch (1993), Dhital & Pushparajah (1994), Dorji & 
Chong (1998), Rosset & Rinchen (1999). All of these references are specific to the forests of Bhutan. Some 
guidelines have also been derived from Mathews (1999).  

Ongoing research activities and the continuing accumulation of field experience shall result in the development 
and refinement of these guidelines over time. 

The trees selected shall be marked with the authorized marking hammer close to ground level by Unit staff, and 
diameter measurements, along with estimated total tree height and tree species, shall be entered in the Marking 
Register. The volume of each tree shall be estimated using an appropriate Volume Table.  The estimated number 
of logs to be cut shall be calculated and recorded in the Marking Register.   
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Lead Responsibility 

DFO takes the lead role in implementation of silvicultural guidelines. 

1.12.4.1 Implementation of the Single-Tree Selection System 

1.12.4.1.1 Marking guidelines for the single-tree selection system 

Thinning among the immature stems should be made along with felling of trees of exploitable size as a combined 
operation (see Box 1.12). Cleanings should also be done amongst the younger age classes as well as interven-
tions to assist regeneration; these may include removal of raw humus, soil cultivation, and even direct seeding 
or planting in gaps caused by felling and other disturbances. 

Box 1.12 Thinning 

As well as removing trees of harvestable/exploitable size, it is necessary to provide for sustained yields 

by making thinning among the various age-classes to ensure that: 

• these are maintained in their correct proportions 

• a suitable mixture of species is maintained 

• young saplings are freed from suppression 

• defective stems are removed wherever they are hampering better ones 

 

1.12.4.1.2 Single-tree selection system; ensuring sustained yields 

Felling under the single-tree selection system should generally involve the removal of: 

1. dead and dying trees 
2. trees that are diseased misshapen, defective or lacking in vigor or of undesirable species, particularly if 

they are interfering with better stems or promising groups of young growth 
3. trees of exploitable size, particularly if defective or lacking in vigor. Mature and over-mature trees over 

50 cm DBH OB should be marked. 

NO MARKING OF TREES SHOULD BE DONE IN PROTECTION MANAGEMENT CIRCLE AND INTER-

LINES (RURAL ALLOTMENT) 

 

Felling under the single-tree selection system should be done in accordance with the following guidelines: 

1. Trees marked for harvesting shall be evenly distributed throughout the stand. 
2. Diseased, malformed, dead and decaying trees shall be marked on a priority basis, especially where 

these are hampering better ones (unless objectives of biodiversity conservation dictate otherwise). 
These trees can be marked even if below the set diameter limit of 50 cm. However, care should be taken 
that no large openings are created in the stand by marking these trees. 

3. Trees of exploitable size should be marked, particularly if defective or lacking in vigour; mature and 
over-mature trees over 50cm DBH OB to be marked. 

4. No more than one fourth of the stand volume should be marked for harvesting. 
5. In mixed stands, an even and suitable distribution of species should be left standing. 
6. Where cable cranes are to be used, the extraction lines shall be as narrow as possible, and no wider than 

3-4 meters.  
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1.12.4.2 Implementation of the Group Selection System 

1.12.4.2.1 Marking Guidelines for the Group Selection System 

The group selection system aims to secure natural regeneration by imitating nature in the creation of small 
openings in the forest stand; thus, allowing light to reach the forest floor and creating favourable microclimatic 
conditions for seed germination and seedling establishment. It is important to avoid damage to the remaining 
stand by selecting only trees that shall fall into the opening and ensuring that accurate directional felling is 
carried out. 

1. The group selection system shall be used on suitable sites in the mixed conifers, spruce, spruce/pine 
and, to a lesser extent, in fir stands. 

2. Small groups spaced at specified intervals shall be harvested removing all trees over 10cm DBH. 
3. The groups shall be located along the extraction lines 
4. The distance between the extraction lines shall be not less than 60 m (refer to Box 3 and Cable line and 

group layout).  
5. The distance between the groups, along the extraction line, shall be not less than 50 m or more than 70 

m.  
6. The shape of the harvested groups can be irregular, according to the site and terrain conditions. 
7. Existing openings in the stand having already established regeneration should be used as a nucleus for 

marking the groups. 
8. Signs of existing windfall in the stand should form the basis of the opening. In such a case, opening 

boundaries should correspond to changes in soil moisture that is often the cause of the windfall. 
9. Wind firm trees must surround the selection groups. This could be achieved by leaving intermediate 

height trees along the edge of the opening. 
10. Trees falling along the extraction corridors shall be marked for harvesting  
11. The extraction corridors must be 2-4 m.   
12. The maximum size of the groups shall be on average less than 0.1 hectare in the fir stands and, less than 

0.15 hectares in the mixed conifers, spruce, spruce/pine stands, depending on the site characteristics 
and stand condition. 

13. Diseased, dead and malformed trees shall be marked on the priority basis and should be used as a nu-
cleus for creating an opening. 

14. Boundaries of openings should, where possible corresponds to changes in slope. An opening should not 
end in the middle of a steep slope since tree shall slide into the remaining stand during logging. 

15. Care must be taken in choosing the boundary of the opening. Trees which can be expected to fall into 
the opening should be marked while trees leaning out of the proposed opening must be left standing so 
as to minimize damage to the remaining stand. 

16. Trees damaged during harvesting shall be cut and removed in the subsequent cleaning operations. 
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Box 1.13 Avoiding problems with implementation of the group selection system 

In order to ensure successful implementation of the group selection system it is essential that too 

much volume is not removed in the first pass to be consistent with the cutting cycles recommended in 

the management plan.  

In the past, unrealistic AACs, exaggerated expectations of sustainable yield per hectare and lack of 

understanding of the systems have probably pressured operational staff in some cases to reduce or 

work on minimal spacing between cable lines and remove volume from interlines (the matrix between 

first pass lines); the long-term consequences is that future yields shall be lower than originally planned. 

In areas that were thought to be able to sustain say three consecutive passes, only one or two shall be 

possible and periods between passes may well be longer (Whitfield, 2001). 

In some FMUs there has been a tendency to locate cable lines at wider spacing than prescribed in order 

to avoid relatively poorly stocked areas and to favour harvesting of better stocked areas.  Again, the 

consequence of this is that future yields shall be lower than originally planned. 

Both of these scenarios must be avoided; cable line positioning must be carefully and rigorously con-

trolled and monitored. 

 

1.12.4.2.2 Cable line and Group Layout 

The approach of working to a minimum cable line spacing of 60m for the group selection system shall only 
work if matched with appropriate felling group sizes (Figure 1.16). If a total of three passes are intended and 
assuming roughly circular groups, an absolute minimum of 60m cable spacing should just work for 0.15 Ha 
groups. If, however 0.2 Ha groups (25m radius) are used then cable lines shall need to be a minimum of 75m 
apart to prevent subsequent cable lines running through old previously cut groups and damaging regeneration. 
Line spacing and group size then need to be carefully considered on a site-by-site basis and provide for a specific 
number of subsequent passes. One prescription shall not be appropriate everywhere. 

In reality, systematic location of groups is almost impossible. The theoretical layout (Figure 1.13) shall never 
be a practical option in Bhutan’s terrain. Even with well-planned initial lines and groups, further harvestable 
area shall therefore be lost due to less than optimal fitting of first and subsequent groups. This residual volume 
cannot be “swept up” in the final pass due to the damage it would do to regenerating areas. This loss of area is 

of course in addition to net operable area being reduced due to minor terrain features and blank areas. 
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These factors have not been taken account of in current AAC calculations and shall have a very significant 
impact on future sustainable cuts (Whitfield, 2001). 
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Figure 1.13 Likely best-case layout for group selection with 60m in-
itial cable space 
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Figure 1.14 Theoretical model for square interlocking groups 
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1.12.4.2.3 Conversion Period 

It is not necessarily appropriate for an over-mature stand to be fully restructured into a normal forest with 
equalized age structure from zero years to rotation age in the first rotation. The stand is not the unit of sustain-
ability but (most probably) the FMU.  

For a stand with a 120-year rotation, the entire mature stand could be removed and regeneration begun over a 
60 year conversion period. In this case with three passes at 20-year intervals.  

This approach may be particularly useful in stands where over mature volume is expected to degrade signifi-
cantly. It does assume that at this rate of logging, there shall still be enough mature volume in the FMU to last 
until the immature or regenerating stands become available.  

Compressed conversion periods shall have a greater environmental impact than extended ones. If, for example, 
all the operable mature timber in a stand is harvested over two passes 25 years apart, the ecological impact shall 
be quite significant and probably quite unacceptable for the majority of sites in Bhutan. This is a concern for 
areas where, due to inadequate initial line spacing, only one subsequent pass is now practically possible.  

When planning prescriptions and operations, the conversion period adopted, the number of passes and therefore 
the cable line and group spacing, all need to reflect the site sensitivity. Less sensitive sites with degrading very 
over mature stands may require a shorter conversion period resulting in closer initial line spacing and higher 
removal per pass than more sensitive sites. Operations should move away from applying a standard line spacing 
and group size prescription across all sites. Planners need to write detailed guidance into the FMPs and opera-
tional staff at Territorial level need to be much more active in deciding and implementing specific prescriptions 
based on this guidance. 

This is not difficult or complex work and field staff should be capable of adopting the approach with basic 
training and support (Whitfield, 2001). 

1.12.4.2.4 Other Silvicultural Impacts; Sanitation Felling  

Sanitation felling is an essential operation but one that can also limit the viability of future passes under group 
selection. When working a stand for a sanitation or salvage operation, it is essential to consider future normal 
passes and to lay out cable lines accordingly. It then makes sense for the cable lines to be a normal length and 
to carry out operations along that line in unaffected as well as beetle affected parts of the stand. Group salvage 
cuts often have to be larger than for normal working but consideration needs to be given to adhering as near as 
possible to the ideal group layout and again, cutting groups in the unaffected parts of the stand as well (Whit-
field, 2001). 

1.12.4.2.5 Regeneration of harvested areas 

There is little doubt that most conifer forest types in most situations have good regeneration potential; however, 
a variety of factors limit success including: 

● Grazing; a very significant problem. Sometimes over stated as the sole cause of regeneration failure but 
successive browsing can delay or totally prevent establishment, leading to other problems such as weed and 
brush growth. 

● Protracted harvesting periods; the first few years following harvesting are critical for good establishment of 
regeneration. Long periods of residue removal causes disturbance to regeneration. All recoverable volume 
should be harvested by cable at the outset, an approach that makes good silvicultural sense. 

● Weed and brush growth; a significant problem where effective establishment of regeneration has been de-
layed due to protracted harvesting, grazing, desiccation of seedlings etc. This is always a difficult and costly 
situation to remedy; prevention is easier than cure. 
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One of the most serious problems in achieving successful regeneration is delaying action when a weed and 
brush growth problem becomes apparent. As young brush, including bamboo, starts to develop around small 
regeneration (or even prior to harvesting), weeding and cleaning must be carried out promptly.  If carried out at 
the right time, this can be far more cost effective and successful than waiting for the regeneration to be swamped 
by brush and then have to clear and replant. Not only is this going to be an expensive problem to correct but 
time has been lost. Harvesting in the interlines cannot proceed until regeneration of the first pass is complete 
and without prompt attention to threatened regeneration, subsequent passes shall be seriously delayed, the AAC 
may well have to be reduced and the economic sustainability of the FMU becomes doubtful. 

There is a developing understanding by forest and authorized agency staff of the right size of openings to pro-
mote natural regeneration of various species and this knowledge is being supplemented by recent research. 
Hemlock can apparently cope with larger openings than Spruce and being light demanding, Blue pine regener-
ates well in even larger openings. In transition areas between one species zone and another, opening size may 
help target the desired species. It is vital that this silvicultural knowledge is utilized and implemented. Openings 
that are too large or too small for the target species can again lead to excessive weed and brush growth before 
regeneration can become established (Whitfield, 2001).  

Some disturbance of the humus layer has been proven to be often quite important in stimulating regeneration. 
Providing that log dragging is unlikely to create significant channels for water and therefore cause erosion, some 
disturbance during harvesting is certainly beneficial to regeneration prospects. 

Silvicultural expertise needs to be fed back into the management planning process and properly implemented. 

1.12.4.3 Implementation of the seed tree system 

1.12.4.3.1 Marking guidelines for Chir pine under the Seed Tree System  

The following guidelines in carrying out seeding (or first) felling, are not intended to be applied rigidly, but 
may be taken as a basis for the framing of site-specific prescriptions. 

1. Seed tree system shall be applied to Chir pine stands or mixed stands in which conifer is the predominant 
species both in numbers and special distribution. 

2. The larger trees (DBH OB >30cm), with sound, well-developed crowns, should be selected as seed-
bearers (seed trees) and should be spaced at about 15-20 trees per hectare (i.e. approx. 22 -26 metres 
apart). If no such trees are available smaller trees (more trees per hectare) should be retained.  

3. Smaller trees and poles, if thinly scattered, should be felled to create blanks for regeneration.  But well-
stocked groups of promising stands should be left to form part of the future crop. 

4. Well-established advanced growth of both saplings and poles should be completely freed from overhead 
cover. 

5. This system shall not be applied to areas with heavy undergrowth of competing shrubs or herbaceous 
layer unless ground seedbed preparation is undertaken, prior to or soon after the felling operation. 

6. This system should not be applied to stands on steep and over-exposed slopes or on south facing slopes.  
In the case of gentle south facing slopes, the cable lines may be oriented southwest with corresponding 
reduction in corridor width to reduce over-exposure to sunlight.  On hot aspects it may be advisable to 
leave considerably more trees per hectare of the felling may be made in strips or in comparatively small 
groups. 

7. In mixed stands with a predominance of Chir pine, silvicultural treatment shall favour the regeneration 
of pines. 

8. Slope condition, wind firmness of surrounding and retained seed-bearers as well as the visual stand 
value shall be considered whilst using the system. 

9. Diseased, malformed, dying, non-wind firm and fire/resin-tap damage stems shall be cut on a priority 
basis. 
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10. Retained seed bearers should have a complete canopy, capable of bearing viable cones, disease-free, 
wind firm and reasonable form. 

11. Retained stems should not be the oldest or tallest in the stand.  Over-mature trees should be felled on a 
priority basis. 

12. The configuration of the area selected for felling under this system may be irregular in shape. 
13. Maximum size of a contiguous area harvested should not exceed one hectare in extent. 
14. Advanced growth should be retained and protected where possible during felling. 
15. No logs that have not been debarked and lops and tops should be retained; to avoid bark beetle infesta-

tion or build-up of fungal infection. 
16. No resin tapping shall be permitted on retained seed bearers, which shall be marked prior to felling. 

1.12.4.3.2 Marking guidelines for blue pine under the seed tree system 

1. The seed tree system is used in pure pine stands or mixed stands consisting of mixture of pine and 
spruce with pine predominating. 

2. The seed tree system shall be used in the above stands only on suitable sites. 
3. The system shall not be used on steep and exposed, south or south west sites 
4. In mixed stands an equal distribution of pine and spruce shall be left standing. 
5. Slope characteristics, wind firmness and aesthetic values shall be considered. 
6. About 20 to 25 trees per hectare (i.e. approx. 22 metres apart) shall be left standing. 
7. Diseased, dead, dying and malformed trees shall be cut on priority basis. 
8. Trees left standing shall be of good health and form to ascertain good seed source. 
9. Trees left standing shall not be the oldest or tallest in the stand. Over mature trees shall be cut on priority 

basis. 
10. The shape of the area chosen for the seed tree system can be irregular. 
11. Maximum size of a contiguous area harvested using this system should not exceed one hectare. 
12. Gap between two seed tree selection system are should be twice the area of the contiguous area??? 

1.12.4.4 Implementation of Clear-felling Systems 

1.12.4.4.1 Marking Guidelines for Patch Clear-felling  

In general, the following factors are to be considered when determining the spatial framework and sequential 
order of the patches selected for harvest: 

1. Create several patch or group openings along a line totaling 2-3 Ha per sub-coupe (including sky-line 
corridor), and with each opening separated by patch of intact forest (of at least 10-20m) 

2. The direction of the tree lean, and topography has to be taken into account to prevent large trees being 
felled on nearby advanced growth, 

3. Dead or dying trees or those showing symptoms of decay or damage (snags, scars, conk, etc.) shall be 
retained in between patches, and in the interline spaces, to safeguard floral and faunal niches or habitats, 

4. The totally protected Taxus baccata (Yew) shall not be marked for felling under any circumstance and 
all species listed for protection under the existing Forest and Nature Conservation Act must also be 
protected if encountered. 

Box 1.14 A note on protected species in harvest areas 

Protected species as listed under Schedule 1 of the existing Forest and Nature Conservation Act should 

not be felled or cleared during harvesting operations.  Patch clear fell and group felling should be done 

in such a way as to avoid damage to or death of such protected species. 
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1.12.4.5 Implementation of Thinning Operations  

1.12.4.5.1 Marking Guidelines for Thinning  

The objective of thinning is to increase growth and quality of stands and at the same time provide small dimen-
sion. Healthy, vigorous trees shall be released by cutting suppressed, diseased and malformed trees. 

Considering the fact that there is a great variation in the age, density and condition of the immature stands care 
has to be taken not to cause damage to the thinned stands. The primary aim is to achieve even spacing of the 
remaining trees in the stand. 

1. The stands for thinning shall be identified from the forest type maps and verified in the field. 
2. The stands identified for thinning, if falling within the harvestable limits of cable cranes, shall be sub-

jected to thinning. 
3. Observation and monitoring of dwarf mistletoe infestation on blue pine; trees infected with mistletoe 

should be given first priority for felling.  Complete burning of mistletoe infested branches is needed.  
4. Mark for thinning 20% of standing volume 
5. Marking of trees for thinning shall depend on the number of stems per hectare, age or size class, and 

the spatial distribution. 
6. Only low thinning shall be done in most of the stands, where only dead, dying, suppressed, diseased 

and defective trees shall be marked first. 
7. In stands less than 10 m average height the target spacing should be approx. 4.5m x 4.5 m or about 500 

trees per hectare. 
8. In stands with pole crop (average height 10-20 m) the spacing of trees after the thinning should be no 

more than 5-6 m, or approx. 300- 400 trees per hectare. 
9. In stands which at present have less than desired tree density and spacing; only trees which grow in 

clusters, are very close together and therefore compete for light and nutrients can be removed. Diseased 
trees, especially those infected with mistletoe should be removed. 

10. Care must be taken not to create large openings in the thinned stands. 
11. Diseased, malformed and suppressed trees shall be thinned on a priority basis. 

1.12.4.6 Sanitation Felling and Subsequent Passes 

Sanitation felling is a control measure used in response to forest pest and diseases. Major forest pest identified 
are bark beetle and mistletoe infestation. Sanitation felling is an essential operation but one that can also limit 
the viability of future passes. When carrying out sanitation or salvage operation, it is essential to consider future 
normal passes and to lay out cable lines accordingly. It is recommended to carry out operations along that line 
in unaffected as well as affected parts of the stand. Group salvage cuts often have to be larger than for normal 
working but ideal group layout has to be considered (Whitfield, 2001). Prescription for management of forest 
pest and diseases are described in detail in Volume V of the Code. 

1.12.4.7 Pest and Disease 

This section presents outline information on the important forest and forest nursery pests and diseases of Bhutan; 
outline information is provided on symptoms and damage, preventative measures and control measures.  For 
more detailed descriptions including information on life cycles and management, refer to Volume V of this 
Code. 

1.13 Record Keeping 

1.13.1 Objective 

To produce accurate records for improving management and monitoring and evaluation within the FMUs. 
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1.13.2 Output 

Five Monthly and Four Annual recording forms (Rural Allotment, Commercial Allotment, NWFP and Royalty) 
for recording information on a sub-compartment basis. 

1.13.3 Lead responsibility 

Divisional Forest Office staff within the FMU (Unit In-charge and CFO). 

1.13.4 Description 

FMU record keeping has been identified as a critical area that needs improvement.  To date records have been 
kept in ledgers in the territorial offices, these records – although thought to be comprehensive – appear to be 
lacking some vital information.  Furthermore, the comparisons of records from one office to another, for the 
same area, have some major discrepancies and are incomplete.   

Many current records are keeping track of the AAC and other allotments, however the area that has been oper-
ated is not recorded in an easy to follow manner.  If someone who is an outsider to the FMU is looking for a 
particular line or plantation they must be accompanied by one of the FMU staff, this is because there seems to 
be no record of the locations of the activities that have occurred within the FMU.  

This problem of identification is also compounded by the fact that many staff in FMUs are new and proper 
transition periods for familiarization have not been considered.  This leaves many staff unsure as to when cable 
lines were harvested and when or where surveys have been completed. If you don’t know where activities have 

taken place in an FMU then it is very difficult, if not impossible, to manage the area sustainably.  

Other problems have also been identified with record keeping; no compartment registers are being kept and 
trying to find accurate AAC allotments and records is difficult. This has led to several ideas to rectify this 
situation.  It is not felt that it is too late.  

FRMD would like to make record keeping simple yet comprehensive.  To do this it is felt that records should 
be kept by block, compartment and sub-compartment and on year on year basis.  This would ensure that each 
activity that occurs is recorded in an easy to find format.  Totals of the AAC allotment would then be submitted 
monthly to the CFO - as is already required.  In this way, exactly when and where operations occurred can be 
maintained in an easy to review format without using a series of different notebooks or registers.  In addition, 
if the activities within one sub-compartment were required it would not be necessary to search through several 
lines of records to find activities from just one area. 

This guide is intended to direct the way in which records shall be maintained from now on.  Records from the 
check post shall be maintained as usual but records for the activities within the FMU shall now be maintained 
on a sub-compartment basis uniformly throughout the FMUs across the country. 

Required Backup Information 

It is recommended that all previous records of activities within the FMUs be transferred to these formats so that 
all of the operations that have taken place in the FMU are concise and contained within a consistent format.  It 
is recognized that some information from the past is vague or lost completely; it is suggested that the Unit In-
charge investigate and inquire, to the best of their ability, to update and record the necessary information. 

It is essential that all records of activities and operations within the FMU be maintained so that analysis and 
investigation of past management can be carried out and AAC allotments can be followed.  Although record 
keeping may not seem as important as some management activities, it is the backbone of future management 
decisions and the importance must be stressed. 
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Updating and Safekeeping Maps 

Along with the new formats, it is important that proper maps and all field notes of the area are maintained.  
Topographic map sheets of the FMU can be obtained from FRMD. New activities within the FMU should be 
recorded and information should be submitted to FRMD for map updating.  

1.13.5 How to Complete and Maintain the Forms 

The record keeping forms has been divided into two categories viz Monthly and Annual recording keeping 
forms for Commercial and Rural Timbers including NWFPs. The list of forms is as indicated in Table 1.65.  

Table 1.65 Forms for record keeping 

 Monthly Recording keeping forms FORM NO  

1 Monthly Commercial Timber supplied (Cableline) I 

2 Monthly Commercial Timber supplied (adhoc ) II 

3 
Monthly Rural Timber supplied ( New Construction, Renovation, 
Extension) 

III 

4 
Monthly Rural Timber Supplied (Firewood, Fencing Poles, Flag 
poles, others) 

IV 

5 Monthly Commercial and Rural NWFP Supplied V 

 Annual Record keeping forms  

1 Annual Commercial Timber supplied (Cable line) VI 

2 Annual Commercial Timber supplied (adhoc data) VII 

3 Annual Rural Timber Supplied VIII 

4 Annual Commercial and Rural NWFP supplied IX 

1 Royalty Statement form X 

 

Filling out the forms:  

● There are two categories of forms comprising of nine forms in total as indicated in Table 1.65 for re-
cording monthly and annual FMU activities. Monthly forms are meant for keeping records on a monthly 
basis while the annual form summarizes the information for an entire year. 

● Further information required on the Rural Allotment form is mainly the name and address of the permit 
holder along with the permit number, Block and Compartment from which the timber has been marked 
and handed over, species, product type provided etc.,  

● Further information required on the Commercial Allotment form is the designated cable line number 
(year and number, i.e. 2020/01), the length of the cable line and the GPS Co-ordinates of top and end 
mass (in case of annual form for cable line).  The number of groups per line must be recorded along 
with the total area of the cable line.  The number of trees marked in the cable line and groups must be 
recorded with the total standing volume.   
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Further details for filling out the forms are given below.  

1.13.5.1 Monthly Record Keeping Forms 

FORM I: Monthly Commercial Timber supplied (Cable line) 

 

FORM I is for keeping records of the commercial timber supplied/extracted from each cable line in the form of 
logs, poles, firewood and woodchips on a monthly basis. This is not the standing volume marked and handed 
over to authorized agency but the volume that has been extracted by authorized agency post allotment of the 
standing volume.   

FORM II: Monthly Commercial Timber Supplied (Adhoc) 

 

FORM II is for keeping records of the commercial timber supplied/ extracted from each adhoc areas in the form 
of Logs, Poles, Firewood and woodchips. The adhoc areas shall include extraction of timber from areas not 
planned as per the approved Management and Operational Plans. Some examples are timber extraction from 
Transmission line, farm roads, land lease etc.,).  

FORM III: Monthly Rural Timber Supplied (New Construction, Renovation, Extension) 

 

FORM III is for keeping records of the rural timber supplied from the FMUs for new construction/ renovation 
and extension purposes. Note that both the standing volume as well as the corresponding log volumes needs to 
be recorded. 
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FORM IV: Monthly Rural Timber Supplied (Firewood, Fencing Poles, Flag poles, others) 

 

FORM IV is for also for keeping records of the rural timber supplied from FMUs for firewood, flag poles and 
others. Both the standing volume as actual production volume needs to be reflected here. 

FORM V: Monthly Commercial and Rural NWFP supplied 

 

FORM V is for recording the supply of NWFPs from the FMU. 

1.13.5.2 Annual Record Keeping Forms 

FORM VI: Annual Commercial Timber Supplied (Cableline) 

 

FORM VI is for keeping record of the commercial timber supplied from the cablelines for an entire year. The 
information for Volume Extracted can be transferred from FORM I. However, information on Cable Line 
(length of cableline, GPS-Coordinates, No. of groups/ area(ha), and corridor area (ha)) needs to be derived from 
the approved annual Operational Plan of the FMU.  The information for Standing Volume marked can be 
obtained from the tree marking book (TMB) maintained by the unit Incharge/ site Incharge. 
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FORM VII: Annual Commercial Timber Supplied (Adhoc) 

 

FORM VII is for keeping record of the commercial timber supplied from adhoc areas for an entire year. The 
information for Volume Extracted can be transferred from FORM II. The information for Standing Volume 
marked and felled can be obtained from the tree marking book (TMB) maintained by the unit Incharge/ site 
Incharge. 

FORM VIII: Annual Rural Timber Supplied 

 

FORM VIII is for keeping record of the rural timber supplied from the FMU for an entire year. The information 
in this form can be transferred from FORM III and IV. 

FORM IX:Annual Commercial and Rural NWFP supplied (Forms to be annexed) 

 

FORM IX is for keeping record of the NWFP supplied from the FMU for an entire year. The information in this 
form can be transferred from FORM V. 
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FORM X: Royalty Statement 

 

FORM X is keeping records of the royalty which authorized agency is payable every month for timber extraction 
from FMUs. The royalty statement must be prepared every month and submitted to authorized agency for pay-
ment. Please note that royalty is a government revenue which must be remitted on a monthly basis. Keeping it 
pending till the end of the year may invite audit observations and memos. The information for this form can be 
derived from FORM I and II. 

1.14  Monitoring and Evaluation 

The Department shall ensure that authorized agency implement activities as per the forest management plan. 
Towards this, a two-stage verification process is necessary.  The first stage checks that on-ground activities are 
being carried out as planned in the short term, and the second stage checks that the objectives of the plan are 
being achieved over the longer term.  Monitoring (checking on inputs on a year-to-year basis) is the term used 
for the first stage and evaluation (checking achievements against objectives over five-year periods) is the second 
stage. The monitoring shall be guided by the monitoring and evaluation framework as indicated in the following 
section. 

1.14.5 Monitoring 

The Divisional Forest Office shall ensure that the FMU implement the yearly activities as per plan through 
periodic monitoring. Any deviation from the operational plan or the FMP shall be stopped or prior permission 
sought from the Department. FRMD, with the help of the DFOs shall conduct annual monitoring and provide 
recommendations for effective implementation of the plan. Form 1-From 11 should be duly filled by the FMU 
IC, which shall be summarized in Monitoring Form A by the CFO.  One copy should be kept in the CFO office 
and one copy is to be forwarded to FRMD with Monitoring Form A.  The monitoring form A should form the 
basis of annual monitoring by FRMD. 

Timing 

The forms are to be filled in for a one-year period, 1 July to 30 June, when the information about actual pro-
duction is available, during the month following year end (July).  The only exception to this is the monitoring 
of regeneration success; the regeneration in harvested areas is first monitored three years after harvest and 
again subsequently, at a time depending on the forest type. 

1.14.6 Evaluation 

Evaluation is the examination of whether project objectives are being achieved. This requires enough time to 
provide a realistic assessment of progress in fulfilling objectives. Evaluation of the FMU shall be done as per 
the FMP. The Divisional Forest Office shall intimate FRMD for the need for mid-term and final evaluation 
when required.  
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Evaluation committee 

The evaluation committee shall be constituted by the head of the Department and shall comprise of a minimum 
of five member from the following members;  

• FRMD (lead agency) 
• Advisor to the Department (Team Leader) 
• CFO Territorial Division (not from same Division) 
• Authorized agency (Regional Manager (not from same Division),  
• UWICER 
• Local Government 

Timing 

The Mid-term evaluation is to take place during the last quarter of the fifth year of the FMP period and shall 
monitor and ensure that the management of the FMU is geared towards achieving the final objectives of the 
FMP. The Final evaluation is to take place during the last quarter of the ninth year of the FMP period and this 
should directly inform the preparation of the FMP for the subsequent 10-year period. 

1.14.7 Monitoring and Evaluation Process 

The monitoring process for FMU in the country was developed by Third Forestry Development Project (TFDP), 
working closely with the then Forest Resources Development Division (FRMD) of the Ministry of Agriculture 

(MoA), in 1999. It was developed based on selecting and modifying the Montreal Process6 Indicators for use 
on FMUs in Bhutan.  The indicators decided on were divided into three groups:  

1) Indicators for which information must be collected every year (9 indicators). 
2) Indicators involving information that changes relatively slowly. These indicators are to be assessed every 

five years and compared against, for example, the initial FMU plan (8 indicators). 
3) Indicators that are evaluated only once or rarely (9 indicators). These indicators are about policy, institu-

tions, regulations, guidelines and similar matters. 

Different forms were developed for each of these time scales; Monitoring Form A for the annual monitoring 
process, Evaluation Form A for the five-year evaluation, and Evaluation Form B for the once only evalua-
tion. Forms were also developed for field collection of environmental information for the monitoring and eval-
uation process. 

Some indicators are used for both annual monitoring and five-year evaluations (for example, production from 
the forest), while some data are collected annually and only evaluated at five-year intervals (for example, fauna 

diversity). The forms list the indicators, the standards7 that are accepted as satisfactory, and the calculations 
that are necessary to assess the standard and update the Progress score.  

The above forms are used to compare performance against the selected indicators.  It was also necessary to 
provide a set of forms for collection of data in the field.  The field data collection forms consist of Physical and 

                                                      

 

6 The Montreal Process developed through an international consensus (12 countries, including Australia, Canada, Chile, China and the 
USA) a set of indicators for the evaluation of sustainable forestry in temperate and boreal forests. Seven Criteria and 67 Indicators were 
designed for application at a national level. 

7 A standard for an indicator is the value that the indicator will have if that aspect of sustainability is satisfactory. Standards can be either 
quantitative or qualitative. 
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Financial Forms 1-3, Environmental Forms 4-11 and the Physical, Financial and Environmental Sum-
mary Form.  The information from these forms is then used on Monitoring Form A and Evaluation Forms 
A and B. 

The process consists of the following: 

• Field collection of Physical, Financial and Environmental information on the set of Indicators. 
• Self monitoring at a field level in the FMU based on the data collection process. 
• A Monitoring Process, carried out annually, for which the CFO is responsible, including any corrective 

action necessary. 
• An Evaluation Process, carried out at five year intervals by a team composed from the Department, 

NRDCL and external stakeholders. The team is to recommend any corrective action necessary and the 
CFO is responsible for carrying it out. 

Table 1.66 gives an overview of the process and Table 1.67 summarises the purpose of different forms, who 
fills them in and how often. 
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Table 1.67 A Summary of Data Collection, Monitoring & Evaluation Forms & Their Use 

TablForm 
Nos.  

Form Name Purpose of the 
Form 

Who Fills 
In the 
Form? 

How Often? 

Form 1  
Form 2 
Form 3 

Physical & Financial Data – 
Commercial Activities  
Coupes harvested  
Divisional Activities 

Field data collection 
& recording of FMU 
activities 

FMU UIC Every July, for the 
previous year (1 
July to 30 June). 

Form 4 Code of Forest Practice Forms: 
Road Drainage by Culverts   

Field data collection FMU UIC Every March 

Form 5 Code of Forest Practice Forms: 
Road Drainage by Side Drains, 
Batter & Fill Slopes  

Field data collection 
 

FMU UIC Every March 

Form 6 Code of Forest Practice Forms: 
Stream Crossings  

Field data collection FMU UIC Every March 

Form 7 Code of Forest Practice Forms: 
Cable Lines  

Field data collection FMU UIC Every March 

Form 8 Code of Forest Practice Forms: 
Interlines 

Field data collection FMU UIC Every March 

 Physical, Financial and Envi-
ronmental Summary 

Summarise Forms 1 
to 8 

FMU UIC Every July for the 
previous year 

 

Form 9 Monitoring of Animal Indicator 
Species 

Field data collection FMU UIC Every April & Oc-
tober 

Form 10 Monitoring of Plant Indicator 
Species and Regeneration 

Field data collection FMU UIC Every April & Oc-
tober 

Form 11 Community Participation RRA 
Checklist 

Field data collection 
for 5 year Evaluation 

FMU UIC Every 5 Years 

 

Monitor-
ing Form 
A 

Annual Monitoring  Monitoring (data 
from Summary form) 

CFO for 
FMU con-
cerned 

Every Year 

Evalua-
tion 
Form A 

Five-Year Evaluation    Evaluation (data from 
Form A and Forms 9-
11) 

Evaluation 
Team 

Every 5 Years 

Evalua-
tion 
Form B 

1st Five-Year Evaluation    Evaluation (data from 
a range of sources di-
rectly into the Form) 

Evaluation 
Team 

When 1st 5-year 
evaluation is done 
& only rarely there-
after. 
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Instructions for Using the Physical and Financial Monitoring Forms or FMUs 

There are four forms: 

a. Form 1 (Commercial Activities detailed). 
b. Form 2 (Timber Extraction, Plantation and Regeneration survey) 
c. Form 3 (Divisional Activities). 
d. Physical, Financial and Environmental Monitoring Summary Form 

Form 1, Form 2 and Form 3 shall be used to collect detailed information and kept in the Unit Office as the basic 
information about activities in the FMU.These forms are to be filled in by the FMU UIC, using information 
obtained either from the authorized agency or Divisional Forest Offices. 

The fourth form summarises information collected by FMU staff on Forms 1-3 and the Environmental moni-
toring data collection forms 4-10. The Summary Form is to be used by the CFO to fill in Monitoring Form A. 
One copy should be kept in the CFO office and one copy is to be forwarded to FRMD with Monitoring Form 
A. The Summary Form is be filled in by the FMU UIC.  

The forms are to be filled in for a one-year period, 1 July to 30 June, when the information about actual pro-
duction is available, during the month following year end (July).  The only exception to this is the monitoring 
of regeneration success; the regeneration in harvested areas is first monitored three years after harvest and 
again subsequently, at a time depending on the forest type.  These results, when available, are to be entered 
in the Coupe Details (Form 2) for the year of harvest. 

Throughout the forms, ‘Planned’ means given in the Operational Plan. ‘Implemented’ means what actually 
happened. 

If a box has grey shading this means it should not be filled. 
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FMU NAME_____________________REPORT PERIOD______________________
FILLED IN BY (name, designation)___________________________

Planned Implemented Actual cost REMARKS

1. ANNUAL ALLOWABLE CUT (AAC)
1.1  Total standing volume harvested m3 m3
1.2  Area harvested ha ha

2. PRODUCTION BY SILVICULTURAL SYSTEM
 thinning
2.1  Standing Volume from marking list m3 m3 Nu

2.2  Total working area ha ha

2.3 Method of thinning describe

 single tree selection
2.4  Standing Volume from marking list m3 m3 Nu

2.5 Total working area ha ha

 group selection
2.6Standing Volume from marking list m3 m3 Nu

2.7Total  area harvested ha ha

2.8Total corridor area ha ha

 seed tree
2.9 Standing Volume from marking list m3 m3 Nu

2.10Total area harvested ha ha

2.11Number of trees retained per ha # #

 clearcut
2.12Total area harvested ha ha

2.13Standing Volume from marking list m3 m3 Nu

3. NATURAL REGENERATION  (stocking assessment on Form 2)
3.1 Site preparation ha ha Cableline no: Year/no.

3.2 Fencing ha ha Cableline no: Year/no.

3.3 Total regeneration cost Nu

3.4 Weeding ha ha Nu Cableline no: Year/no.

3.5 Enrichment plant'g # # Nu Cableline no: Year/no.

4. Plantation (stocking assessment on Form 2)
4.1 Site preparation ha ha Cableline no: Year/no.
4.2 Area planted ha ha Cableline no: Year/no.

4.3 Fencing ha ha Cableline no: Year/no.

4.4Total Cost Nu

5. ROADS
 5.1 Planning and survey km km

5.2 Formation cutting km km

5.3 Soling km km

5.4 Stabilising walls # #

5.5 Drainage installed km km

5.6 Bioengineering m m

5.7 Road completed km km

5.8 Total construction cost Nu

5.9 Bridges constructed # # Nu

5.10 Maintenance km km Nu

6. RECURRENT COSTS (FMU only)
6.1 NRDCL staff salaries Nu Nu specify number of staff
6.2  NRDCL staff allowances Nu Nu

7. TOTAL OPERATING COST Nu

Form 1 - COMMERCIAL ACTIVITIES (detailed)

For Salvage operation, mention the Block 
and compartment in which the operation was 

carried out.
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Form 1: COMMERCIAL ACTIVITIES (Detailed) 

1. Annual Allowable Cut (AAC).   

The ‘Planned’ values are obtained from the current Operational Plan.  If Total volume and area AACs are given 

in the plan, fill in both boxes.  Otherwise, only provide what is given in the Operational Plan.  ‘Implemented’ 

comes from Form 2, column 10, totaled for the year.  If more than one silvicultural system is being implemented, 
these figures will be the totals for the individual systems. 

2. Production by Silvicultural System.   

Five silvicultural treatments are listed. Only the treatments being applied for the current year in the FMU need 
to be filled in.   If there is more than one treatment, the planned volume will be the AAC determined for the 
different silvicultural treatments. 

Total working area (item 2.2, 2.5), for silvicultural treatments with partial removal (thinning, single tree se-
lection) means the area over which the operation is being carried out. Coupes are to be located and their dimen-
sions measured by Divisional staff in association with NRDCL staff.  All areas, in all the forms, must be 
corrected for slope. 

For thinning, ‘method of thinning’ (item 2.3) requires a description of which trees are being taken and what 

proportion of removal.  For example, ‘from below, 30% of basal area’, ‘from above, 50cm diameter limit’, ‘for 

flag poles, not larger than 15cm dbh’.  If percentage removal is given, it is necessary to say whether it refers to 

number of trees or basal area. 

Total area harvested (item 2.7) for group selection, the individual groups must be measured to estimate their 
area.  The dimensions need to be measured with a tape, using slope correction.  Measure diameter if the group 
is roughly circular, measure length x width if it is rectangular. Total area harvested (item 2.10, 2.12) for seed 
tree and clear cut means the area over which the operation is being carried out. Coupes are to be located and 
their dimensions measured. The best time to do this is when the trees are being marked. 

‘Standing volume from marking list’ (items 2.1, 2.4, 2.6, 2.9, 2.13) are to be calculated from the marking list, 
using the General Volume Table or Local Volume table by FMU UIC.  It is not necessary to prepare summary 
marking lists provided the original marking list, with the volume calculations, is preserved.  In all treatments 
the marked trees are those to be harvested and checks are necessary to ensure that all the marked trees are 
actually harvested. 

In the ‘Actual cost’ column, only one box for each silvicultural treatment has to be filled, for each of the ‘Im-

plemented’ volumes.  The cost of producing the total volume should be entered (marking, felling and extrac-
tion).  This should be obtained from the NRDCL Production Incharge.  If the cost is available as Nu/m3, multiply 
this cost by the ‘Implemented’ column and put this in the box. 

Salvage Production.  Enter information about salvage production under the silvicultural system used to carry 
it out and put ‘Salvage operation’ in the Remarks column along with the name of the Block and compartment 
in which the salvage operation was carried out. Note that if salvage operations are necessary, other operations 
should be postponed to keep harvesting within the AAC, if possible. 

3. Natural Regeneration and 4. Plantation.   

Fill in the area and the cost incurred for natural regeneration preparation works and for plantations carried out 
under these sections. Mention the Cableline no (Yr/no) in which the works are done (Eg.2018/1, 2018/2) in the 
remarks column. Assessments of stocking must be made three years after harvesting of the stand and again after 
that at a time that will vary with the forest type. Stocking assessment results for natural regeneration and plan-
tation shall be filled in the Form 2 for cable line or coupe concerned. 
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5. Roads.   

Details need to be filled in for the various steps in road construction.  This information is to be obtained from 
NRDCL.  

‘Drainage installed’ (item 5.5) means the distance of road for which all drainage works (side drains, culverts, 
cross drains, causeways and culvert entry and exit protection) have been completed. 

‘Maintenance’ (item 5.10) (including bioengineering) is the length of road in the FMU that has received mainte-

nance during the year. 

In the ‘Actual cost’ column, enter the total cost for road construction, bridges (if any) and maintenance for the 
year, in the boxes. 

6. Recurrent costs.   

Enter the budget amount in the ‘Planned’ box and the actual payments in the ‘Actual cost’ box.   

7. Total operating costs.   

Total all the boxes in the ‘Actual cost’ column.
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Form 2: COMMERCIAL ACTIVITIES (Timber Extraction, Plantation & Regeneration survey) 

A. Extraction from Cableline/ adhoc activities 

The first four lines are example data.  Numbers given below refer to columns on the Form.  The examples given 
relate to cable crane lines, but the form can be used for any silvicultural treatment, if one line is used for each 
separate coupe.  If other treatments are entered in the form, enter na (for not applicable) in columns 4 and 5. 

1. Block name (Col 1) and 2.Compt/sub compt (Col 2) :  The Block and Compartment/Sub compartment 
where the coupe is located.  

3. Working Circle (Col 3): Working Circle in which the coupe is located. 

4. Cable Line no (Col 4): Cable line number (Eg, 2018/1). 

5. Cable lines length (Col 5) : Total length of the cable line, adjusted for slope. 

6. No of Groups or Patches (Col 6) : Give the number of individual groups or patches in the cable line.   

7. Total area harvested (Col 7) :  This means the total area of all the groups, patches or clear felled areas in 
the cable line (including the cable corridor), adjusted for slope.  It is the area for which harvesting operations 
have all been completed, ie marking, felling and extraction.  Do not include, for example, areas that have only 
been marked and felled. 

8. Inventory volume (Col 8) : is the volume estimated during the operational inventory. 

9. Standing volume from marking list (Col 9): when the group selection or patch systems are being applied, 
this is the marked volume from both cable corridor and groups or patches. The volume is to be calculated using 
local volume tables or general volume tables for all the trees marked, felled and extracted (including cable 
corridors) in that cable line. 

10. Log volume extracted (Col 10): col 10, is the total volume of logs harvested from the cable line.  The data 
is to be obtained from NRDCL. 

11. Log recovery ( Col 11) : is the value of ‘Log volume extracted’ as a percentage of ‘Marking list volume 

cut’. 

12. Firewood produced (Col 12): is the volume of firewood extracted from the cableline. 

13. Log + firewood recovery (Col 13): is the sum of column 10 and column 12, expressed as a percentage of 
column 9. 

B. Regeneration stock assessment.   

1: Block name (Col 1) and 2: Compartment/ Sub-compartment (Col 2).  The Block and Compartment/Sub-
compt where the regeneration assessment is carried out. 

3: Working Circle (Col 3) and 4: Cableline no (Col 4). The working circle and cableline number where the 
regeneration assessment is carried out. 

5: Area (Ha): Total area of regeneration survey carried out.  

6: Species: Species encountered during regeneration survey 

7. Stocking (%) (Col 5) : The regeneration assessment results in stocking %. This can be derived from FORM 
10.  
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C. Plantation Assessment 

1: Block name (Col 1) and 2: Compt/Sub compartment (Col 2).  The Block and Compartment/Sub compart-
ment where the plantation assessment is carried out 

3: Working Circle (Col 3) and 4: Cableline no (Col 4). The working circle and cableline number where the      
plantation assessment is carried out. 

5: Area (Ha): Total area of plantation carried out.  

6: Species: Species planated 

7: Survival % (Col 5) : The Plantation assessment results in terms of survival % of seedlings. This can be 
derived plantation assessment reports.  
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Form 3 - DIVISIONAL ACTIVITIES (detailed)
FMU NAME____________________________REPORT PERIOD___________________________

OPERATIONAL PLAN COMMENTS
Planned Implemented Actual cost

1.  FOREST FIRES
1.1 Fire lines for prevention m m
1.2 Fuel reduction burning ha ha
1.3 Training (# of courses / trainees) No No
1.4 Number of fires No suppression costs

2.1 Preventive measures specify: e.g. debarking, debris burning

2.2 Incidence specify type of outbreak or damage and area affected

2.3 Control measures e.g. traplocks, salvage logging

3.1 FMU Level Committe meetings held No No
3.2 Meetings re CFMU held? No No
3.3 Meetings on (                             ) No No
3.4 Meetings on (                             ) No No
3.5 Meetings on (                             ) No No

COMMENTS

4.  RESEARCH specify type and action:
4.1 Silviculure/ecology
4.2 Social
4.3 Work study
4.4 Other

5.  EQUIPMENT / INFRASTRUCTURE (DoFS only) specify type and purpose:
5.1 Vehicles  
5.2 Machinery
5.3 Field equipment
5.4 Office equipment
5.5 Constructions

6.  HUMAN RESOURCES specify position and grade:
6.1 Increase/decrease staff No No
6.2 Purchase of external services No No
6.3 Training (# of courses / trainees) No No

 7.  COSTS (FMU staff only)
7.1 Territorial staff salaries Nu Nu specify position and grade
7.2 Territorial staff allowances Nu Nu
7.3 Planning and inventory Nu Nu
7.4 Other incidental expenses Nu Nu

8. TOTAL EXPENSES Nu

3.  SOCIAL ISSUES

2.  DISEASES / EPIDEMICS / OTHER DAMAGES (e.g. landslides, floods etc)
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Form 3: DIVISIONAL ACTIVITIES, (detailed) 

1. Forest fires:   

‘Fire lines for prevention’, item 1.1, are fire lines prepared to protect valuable stands or plantations. 

‘Fuel reduction burning’, item 1.2, when it is carried out. 

‘Training’, item 1.3, relates to fire prevention and control courses. 

‘Number of fires’, item 1.4, is the count of wildfires that occurred and ‘area burnt’, item 1.5, is the area of all 

fires in the FMU for the year. 

The cost of these activities should be entered in the ‘Actual cost’ column. 

2. Diseases / Epidemics / Other Damages:  

Provide information on diseases, epidemics and other damages in terms of area and number. 

3. Social Issues.  

Provide information on any types of meeting and public consultations carried out in the FMU. 

4.        Research : Provide information on the type of researches carried out if any. 

5.        Equipment/Infrastructure.  

For vehicles, machinery and equipment, specify purchase or disposal and number of items and  the cost in-
volved. For ‘constructions’, specify what is being constructed and how many. 

6.         Human resources.  

‘Training’ Specify how many staff were trained and the type of training.  ‘Purchase of external services’ includes 

such things as consultants, accountants, electricians, etc. 

7.        Recurrent costs.   

Enter the total amounts for staff salaries, allowances and other incidental costs, both budgeted and actual, in the 
boxes.  For item 7.3, indicate what sort of activity in the remarks column. 

8.       Total expenses is the total of all the costs recorded on Form 3. 
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PHYSICAL, FINANCIAL AND ENVIRONMENTAL MONITORING SUMMARY FORM 

 

 

PHYSICAL, FINANCIAL AND ENVIRONMENTAL MONITORING SUMMARY FORM (Page 1)
FMU NAME  _________________________________________________________
REPORT PERIOD  __________________
FILLED IN BY (name, designation)___________________________

COMMERCIAL ACTIVITIES
ACTIVITY 1.  Silviculture system………………...………………Working Circle…………

Plan ImplementedCost  Revenue Comments
target (Nu)

1. Area harvested (ha) (AAC)

2. Standing volume harvested (m 3) (AAC)

3. Log volume produced    (m 3)
4. Value of Log sold from FMU (Nu)

5. Firewood volume produced (m 3)
6. Value of firewood sold (Nu)
7. Total royalty paid to DoFPS (Nu)
8. Forest roads constructed (km)
9. Area regenerated/planted (ha) method?

ACTIVITY 2.  Silviculture system………………...………………Working Circle………………………….. 

Plan ImplementedCost  Revenue Comments
target (Nu) (Nu)

1. Area harvested (ha) (AAC)

2. Standing volume harvested (m 3) (AAC)

3. Log volume produced    (m 3)
4. Value of Log sold from FMU (Nu)

5. Firewood volume produced (m 3)
6. Value of firewood sold (Nu)
7. Total royalty paid to DoFPS (Nu)
8. Forest roads constructed (km)
9. Area regenerated (ha) method?

ACTIVITY 3.  Silviculture system………………...………………Working Circle………………………….. 

Plan ImplementedCost  Revenue Comments
target (Nu) (Nu)

1. Area harvested (ha) (AAC)

2. Standing volume harvested (m 3) (AAC)

3. Log volume produced    (m 3)
4. Value of Log sold from FMU (Nu)

5. Firewood volume produced (m 3)
6. Value of firewood sold (Nu)
7. Total royalty paid to DoFPS (Nu)
8. Forest roads constructed (km)
9. Area regenerated (ha) method?

ACTUAL REVENUE & EXPENDITURE 
1. NRDCL Total Revenue for FMU
2. Royalty paid by NRDCL
3. NRDCL expenditure for FMU
4. NRDCL Net Revenue (1 - (2 + 3))
5. Royalty paid to DoFPS
6. DoFPS expenditure for FMU
7. DoFPS Net Revenue (5 - 6)
Total Revenue for FMU (4 + 7)

Item

Item

Item
(Nu)
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PHYSICAL, FINANCIAL AND ENVIRONMENTAL MONITORING SUMMARY FORM 

A. COMMERCIAL ACTIVITIES (Page 1) 

Tables are provided for three different harvesting activities in the FMU, corresponding to the silvicultural sys-
tems detailed on Form 1. Fill up the following details in each table: 

1. Area harvested.  

‘AAC’ (area) is obtained from the ‘Planned’ column for the silvicultural system, from Form 1, items 2.2, 2.5, 

2.7, 2.10,2.12. 

‘Implemented’ (ha) is transferred from Form 1.  For thinning or single tree selection treatments, this is the area 
of forest over which the treatment is being applied – ‘total working area’ items 2.2, 2.5.  For group selection, 

clear cut treatments and seed tree treatments, it is the ‘Total area harvestd’ items 2.7,2.10,2.12.   

2. Standing volume harvested.  

‘AAC’ (Plan Target) is obtained from Form 1, items 2.1, 2.4, 2.6, 2.9, 2.13, ‘Planned’ column. 

‘Implemented’ comes from the same items, ‘Implemented’ column. 

3. log volume produced.  

‘Plan Target’ can be obtained from NRDCL. 

‘Implemented’ comes from Form 2, the total of column 10, ‘Log volume extracted’.  If more than one silvicul-

tural system is in use, separate totals for each will be necessary. 

The cost of production for ‘Log volume produced’ (the total of marking, felling and extraction costs to the road 

head) should be entered in the ‘Cost’ column.  Obtain this from NRDCL. 

4. Value of log sold from FMU.   

This is the total of sales from the FMU during the year, obtained from NRDCL.  It is not the value of the sawlog 
produced, because it may include some sale of previous stocks.  The figure is entered in the ‘Revenue’ column.  

5. Firewood volume produced.   

‘Plan Target’ can be obtained from NRDCL. 

The ‘Implemented’ comes from Form 2, the total of column 12, ‘Firewood produced’ 

The cost of production for firewood, obtained from NRDCL, is entered in the ‘Cost’ column. 

6. Value of firewood sold is obtained from NRDCL and entered in the ‘Revenue’ column. 

7. Total royalty paid to DoFPS is obtained from NRDCL and entered in the ‘Revenue’ column. 

8. Forest roads constructed.  

 Obtain the ‘Plan Target’ from NRDCL.   

‘Implemented’ is obtained from Form 1, item 5.7, ‘road completed’ and ‘Cost’ from the same form, Roads, 

‘Total construction cost’, item 5.8. 
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9. Area regenerated/Planted.   

When natural regeneration is being applied, this area will be the same as the sum of ‘Total harvested area’ from 

column 7 of Form 2.  When plantations are carried out the area comes from, ‘Area planted’ on Form 1, item 

4.2.   

‘Cost’ comes from ‘Total cost’ on Form 1, under either Natural regeneration (item 3.3) or Plantation, (item 4.4). 

 

B. ACTUAL REVENUE AND EXPENDITURE 

NRDCL Total Revenue: 

It is the total of ‘Value of Log sold from FMU’ and ‘Value of firewood sold’, (only if sold through NRDCL) 
items 4 and 6 from the different ‘Activities’ on the Summary Form. 

Royalty paid by NRDCL: 

It is the total of the ‘Total royalty paid to DoFPS’ items for each ‘Activity’ item 7, Summary Form. 

NRDCL Net Revenue: 

It is Total Revenue minus the sum of Royalty and NRDCL expenditure from Form 1. 

Royalty paid to DoFPS: 

It is ‘Royalty paid by NRDCL’ plus ‘Total Royalty’ from the ‘TERRITORIAL ACTIVITIES’, FOREST 

PRODUCTION’ table on the second page of the Summary Form (item 1.3). 

DoFPS expenditure: 

It is the total of the ‘Actual cost’ column on Form 3 (item 8). 

DoFPS Net Revenue: 

It is ‘Total royalty paid to DoFPS’ minus ‘DoFPS expenditure’. 

Total Revenue for FMU: 

It is ‘NRDCL Net Revenue’ plus ‘DoFPS Net Revenue’. 
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DIVISIONAL ACTIVITIES 
1. FOREST PRODUCTION

1.1 Wood Products Quantity Royalty (Nu) Quantity Royalty (Nu)
Trees No No

Chams No No

Tsim No No

Dang chung No No

Fencing posts No No

Flag posts No No

Firewood m3 m3

Other products (royalty only)

1.2. Non-wood Products
Bamboo No No

Extractive oils Kg Kg

Resin Kg Kg

Daphne bark Kg Kg

Mushroom Kg Kg

Other products (royalty only)
1.3. Total royalty

2. FOREST PROTECTION
Offences Number  
Offences detected No

Damaging agents Number Hectares
Forest fire
Insect or disease epidemic
Landslide
Flood
Other
Totals

3. RESEARCH
Type 
Achievement

4. SOCIAL ISSUES
FMU Steering Comm. Meetings held (No)
Meetings with CFMU held? (No)
Meetings for other purposes? (No)
Meetings for other purposes? (No)
Comments

5. ENVIRONMENTAL MONITORING (Scores from Env Mon Forms)
Purpose Roads (culverts)Roads (drains etc)Streams Cable lines Interlines
Form Number 4 5 6 7 8
Progress score*
*Starting score = 140
Regeneration stocking for the area assessed this year (from Env Mon Form 10)

Rural Commercial
Disposal to: 

PHYSICAL, FINANCIAL AND ENVIRONMENTAL MONITORING SUMMARY FORM (Page 2)
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PHYSICAL, FINANCIAL AND ENVIRONMENTAL MONITORING SUMMARY 

DIVISIONAL ACTIVITIES (Page 2) 

1. FOREST PRODUCTION. 

Add together the quantities and royalties for each item (eg trees, chams etc) to obtain totals for the year.  

Enter individual values for the items listed individually in the ‘Wood Products’ table on the Summary Form.   

Add together the totals for the items specified collectively and enter this in the ‘Other products (royalty only)’ 

box on the Summary Form.   

Do the same for the Non-wood Products, in this case entering the individual items listed and totaling for the 
remainder.   

2. FOREST PROTECTION.   

Offences detected: Add the number of all offences detected.   

Damaging agents: Transfer the total number and area from Form 3, for the different items, ‘Forest fire’ (items 

1.4, 1.5), ‘Insect or disease epidemic’, ‘Landslide’, ‘Flood’ (all from item 2.2).  

3. RESEARCH.   

This table provides a summary of information on Research Activities in the FMU.Obtain from Form 3 (items 
4.1 to 4.4). 

4. SOCIAL ISSUES.  

This table provides a summary of information on Social Issues in the FMU.  Obtain from Form 3, items 3.1 to 
3.5.   

5. ENVIRONMENTAL MONITORING.  

Transfer the progress scores from the Environmental Data Collection Forms 4-8.  Regeneration stocking is 
transferred from the Environmental Data Collection Form 10 for the current year.  Note that this area will usually 
be the coupes harvested three years previously. 
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Notes to Assist in Completing Form 10  

Regeneration stocking is measured to assess (by comparison with an acceptable standard) whether or not there 
are enough young trees to develop into a fully stocked mature stand. 

Different standards for acceptable stocking will be nominated for plantations and natural stands.  For stands that 
will be regenerated naturally, a standard will usually be nominated through observation of what seem to be well 
stocked stands of natural regrowth.  For plantations, acceptable stocking is usually defined as percentage sur-
vival of the planted trees, these having originally been planted at a density thought to be sufficient to develop 
into a fully stocked mature stand. 

For broadleaf forests in Eastern Bhutan, even when a stand is regenerated by planting, natural regeneration may 
well occur in addition and it is desirable that the standard adopted can assess the total stocking, not just one 
component or the other. 

Measuring regeneration stocking 

Regeneration stocking can be expressed either as seedling stocking per hectare, or as percentage stocking by 
quadrats of a nominated area.   

Seedling stocking per hectare is estimated by establishing sample plots throughout the area of regeneration, 
counting the acceptable seedlings on each plot, deriving an average for the sampled area and converting it to 
per hectare terms. A detailed Guideline for assessing Regeneration in terms of stocking/ha  in the Forest Man-
agement Units is prescribed in the “ Guideline for Regeneration survey in the Forest Management Units” in the 
following section. 

The stocked quadrat method involves the concept that, for acceptable stocking, a certain area of growing space 
needs to be occupied by at least one free-to-grow individual of a desirable species.  To measure regeneration 
stocking, one would lay out a number of sample plots, each with an area equivalent to this growing space, and 
look to see if there is at least one free-to-grow individual present (i.e., if they are “stocked” or not).  One then 

divides the number of stocked plots by the total number of plots measured to obtain the ‘percentage stocking’ 

of the site.  

The stocked quadrat method is clearly much quicker to apply, since the plot only has to be searched until the 
first acceptable seedling is found.  However, there are problems involved with interpreting the results in the 
context of number per hectare stocking.  If it was decided that 1000 stems/ha were the minimum acceptable 
stocking, and a quadrat size of 0.001 ha were used, it is important to note that 100% stocking by .001 ha would 
not be equivalent to 1000 stems/ha, because at least some of the quadrats would have had more than one stem 
on them, and it is not known how many more, since they were not counted.  The actual density is therefore an 
unknown amount more than 1000 stems/ha.  In practice, since it is the minimum stocking that is considered 
important, the disadvantage of not knowing the exact stocking is considered to be out-weighed by the ease of 
implementing the method.  To allow for the fact that actual stocking is almost always going to be greater than 
the minimum, the acceptable standard used is usually reduced to around 70% for the nominated quadrat size.  
For example, 70% stocking by 0.001 ha plots is roughly equivalent to a stocking of 1000 stems/ha. 

The simplest way to lay out a sample plot (quadrat) is to cut a stick with length equal to the radius of a circle 
that has the area desired.  Taking the example of a target density of 2,000 stems per hectare and, therefore, a 
growing space of 5 m2 (10,000 m2/2,000), this leads to a plot radius (r) of 1.26 m (5 = r2; r2 = 5/; r = 5/).   

The standard proposed for broadleaf forest in Eastern Bhutan is 70% stocking by 5m2 plots, i.e. approx-
imately 2000 acceptable seedlings per hectare, one year after harvesting.
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MONITORING FORM A (ANNUAL) FMU________ Filled in by ________ Date ______ 

Responsibility: Chief Forestry Officer 

Instructions: Each indicator is in a separate box.  Read the bold type describing the indicator in the top left 
hand corner, then the Standard in the next cell to the right.  Then do the Calculations in the cell below.  Then 
update the Progress Score.  Do this for every indicator. 

Abbreviations: CFO = Chief Forestry Officer UIC = Unit in Charge 

 FMU = Forest Management Unit NRDCL = Natural Resources Devel-
opment Corporation Limited. 

 AAC = Annual Allowable Cut  

FINAL SCORE = ..............  (Transfer from end of form)      INITIAL SCORE = 0 

Indicator Standard Progress score Corrective action 
required, if any 

1.1. Annual wood volume 
removed compared with 
AAC  

Annual removal not greater than 
AAC +/- 10% 

If the removal is less than 
the AAC +10%, add 10 
points to the initial score. 
 
                                 PRO-
GRESS SCORE =  
………………………… 

 

Calculations  
Total of all Timber cut this year by NRDCL = __________ 
Any other wood or timber removed        = __________ 
Any timber left in the forest                    = __________ 
Total timber removed from Production WC= ________ 
AAC from FMU plan + 10%                    = __________ 
 
Difference                                                = __________ 

 

1.2. Annual removal of 
NWFP cf sustainable cut  

Annual removal not greater than 
AAC +/- 10% 

If the removal is less than 
the AAC +10%, add 10 
points to the Progress score 

 

Calculations  
Total of all NWFP cut this year from permit statistics  
for the whole FMU                            = _________ 
Any other known removals                            = _________ 
Total for the FMU for the year            = _________ 
AAC from FMU plan + 10%              = _________ 
 
Difference                                             = _________ 
 

If an AAC has not yet been 
calculated, carry the score 
forward unchanged. 
 
PROGRESS SCORE =  
………………………… 
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Indicator Standard Progress score Corrective action 
required, if any 

1.3. Percent of area of 
cut stands successfully 
regenerated  

(See Note No.3, under: 
‘Notes to Assist in 

Completing the Forms’, 

attached below) 

Not less than current 
standard (70%).  If nat-
ural regeneration has 
occurred, include it. 

If the stocking is more than 
70%, add 10 points to the Pro-
gress score 

 

 

Calculations 

Stocking percent for the area utilised                                  
the previous year   = _________ =........... 

 

 PROGRESS SCORE =  

…………………… 

 

 

1.4. Area of forest 
with significant soil 
erosion or risk to water 
quality 

Assessment of roads 
and stream buffers via 
FORM 4-8 

  

Calculations 

Divide the Final Score by 13 and add the result  
to the Progress Score 

 PROGRESS SCORE =  

…………………………… 

 

1.5. Area of forest 
managed to protect 
cultural, social, spir-
itual values 

Not less than at FMU 
establishment 

If new provisions are made to 
protect these values, add 10 
points to the Progress Score.   

 

Calculations 

Obtain area data through RRA during the prepa-
ration of Operational Plans. 

 PROGRESS SCORE =  

…………………………… 

 

1.6. Extent to which 
community needs are 
met from FMU.   

No decrease on base-
line at creation of 
FMU.   

If needs are still met, add 5 
points to the Progress Score 

 

 

Calculations 

Determine through RRA whether community 
needs are still being met this year to the same ex-
tent they were at the start of the FMU Plan 

 PROGRESS SCORE =  

…………………………… 
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1.7. Extent of involve-
ment of local commu-
nities in forest man-
agement 

1. Village meetings 
held this year?  

2. Application form in? 

3. Community involve-
ment in FMU Mgmt or 
Steering Committee? 

Add 5 points to the Progress 
Score for every Yes answer 

 

Calculations 

Review these four questions every year.   

 PROGRESS SCORE =  

…………………………… 

 

1.9.  Institutions pro-
vide for forest plan-
ning including peri-
odic review and cross 
sector coordination 

1. FMU plan current? 

2. Operational plan 
current? 

3. Steering Committee 
convened? 

Add 5 points to the Progress 
Score for every Yes answer 

 

Calculations 

Review these three questions every year.   

 

FINAL SCORE =............. 
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EVALUATION FORM A  (FIVE-YEAR) FMU________ Filled in by ________  

Date ______ 

Responsibility: Evaluation Team 

Instructions: Each indicator is in a separate box.  Read the bold type describing the indicator in the top left 
hand corner, then the Standard in the next cell to the right.  Then do the Calculations in the cell below.  Then 
update the Progress Score.  Do this for every indicator. 

 

Abbreviations: CFO = Chief Forestry Officer UIC = Unit in Charge 

 FMU = Forest Management Unit NRDCL = Natural Resources Devel-
opment Corporation Limited 

 AAC= Annual Allowable Cut  

FINAL SCORE = ..............  (Transfer from end of form)      INITIAL SCORE = 0 

Indicator Standard Progress score Corrective action re-
quired, if any 

1.1. Annual timber volume 
removed compared with 
AAC  

Removal not greater 
than AAC on 5 year av-
erage 

If the removal is less than 
the AAC, add 10 points to 
the Initial Score 
 
 
PROGRESS SCORE =  
………………………… 

 

Calculations 
Total timber removed from Production WC over the  
last five years  
(Get this from the last five annual monitoring Form A) 
Divide by five to give 5 year average 
AAC from FMU plan 
1.2. Annual removal of 
NWFP  sustainable cut  

Removal not greater 
than AAC on 5 year av-
erage 

If the removal is less than 
the AAC, add 10 points to  
the Progress Score. 
If an AAC has not yet been 
calculated, carry the score 
forward unchanged. 
 PROGRESS SCORE =  
………………………… 

 

Calculations 
Total NWFP removed from the FMU                                      
over the last five years  = _________ 
(Get this from the last five Form A)  
Divide by five to give 5 year average = 
_________ 
AAC from FMU plan  = _________ 
1.3. Percent of area of cut 
stands successfully regener-
ated. 
 

Not less than current 
standard (70%).  If nat-
ural regeneration has 
occurred, include it. 

If the stocking is more than 
70%, add 10 points to the 
Progress Score. 
 
 
 PROGRESS SCORE =  
………………………… 

 

Calculations 
Average stocking for the areas utilised    
in the last five years  =........... 
(See Note No.3, under: ‘Notes to Assist in Completing the 

Forms’). 
1.6. Extent to which commu-
nity needs are met from 
FMU.    

No decrease on base-
line at creation of 
FMU.   

If there is no decrease, add 
5 points to the Progress 
Score. 
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Calculations 
Use the data from the last five Form A to determine 
whether community needs are still being met to the same 
extent they were at the start of the FMU Plan. 
 

PROGRESS SCORE =  
………………………… 

Indicator Standard Progress score Corrective action re-
quired, if any 

1.7. Extent of community 
participation in forest man-
agement  

Demonstrable progress to-
wards a Community in-
volvement based on the 
Form A indicators. 

If the fifth year Form A 
score for this indicator is 
higher than the first year, 
add 10 to the Progress 
Score. 
PROGRESS SCORE =  
………………………… 

 

Calculations 
Increasing frequency of meetings, application made, man-
agement plan being prepared.  
(See Note No.5, under: ‘Notes to Assist in Completing the 

Forms’). 
2.1. Forest type area as a % 
of total forest area 

Not less than at FMU es-
tablishment (pre-harvest). 

If none of the forest type ar-
eas have been reduced, add 
10 points to the Progress 
Score. 
 
 
 
PROGRESS SCORE =  
………………………… 

 

Calculations 
Update area statements for forest types in the FMU either 
from remote sensing or ground survey of forest types.  See 
Note 1 re planted forest. 
Has utilisation reduced the area of any forest type com-
pared with the area at FMU establishment?  What % re-
duction? 
FT1.......... FT2.......... FT3.......... FT4.......... FT5.......... 
FT: Forest Type. 
2.2. Forest type area by age 
class 
 

Not less than 15% of total 
forest type area in FMU to 
be mature class.  See Note 
2. 

If the percentage of mature 
forest for all forest types is 
greater than 15%, add 5 
points to the Progress 
Score. 
 
PROGRESS SCORE =  
………………………… 

 

Calculations 
New forest type mature area = initial area for whole FMU 
- area  of mature forest utilised.  Calculate  %. 
FT1.......... FT2.......... FT3.......... FT4.......... FT5.......... 
2.3. Forest type area re-
served from timber utilisa-
tion 

Not less than 15% of area 
at FMU establishment.  
See Note 2. 

If the percentage of all for-
est types in the Protection 
WC is greater than 15%, 
add 5 points to the Progress 
Score.  
PROGRESS SCORE =  
………………………… 

 

Calculations 
Forest type area in Protection WC still > 15% of forest 
type area in FMU?  
FT1.......... FT2.......... FT3.......... FT4.......... FT5.......... 
2.4.  Protection WC con-
nects within FMU and to ex-
ternal Protected Areas  

Yes/No If connectivity has not been 
reduced, add 5 points to the 
Progress Score. 
PROGRESS SCORE =  
………………………… 

 

Calculations 
Examine FMU maps and external land use maps.  Have 
new Operational Plans over the last five years reduced 
connectivity? 
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Indicator Standard Progress score Corrective action re-
quired, if any 

2.5. List of forest dwelling 
species, both flora and 
fauna.  Indicators only 

No significant decrease 
from FMU start 

Add 10 points to the Pro-
gress Score for no decrease 
in Wildlife and a further 10 
points for no decrease in 
Flora. 
PROGRESS SCORE =  
………………………… 

 

Calculations 
Examine trend in observations made on the Wildlife and 
Flora Monitoring Forms for the last five years- consult 
with wildlife and flora experts. 
2.6. Net area of forest 
available for production 

No reduction from base-
line at FMU start except 
for changes needed to 
maintain conservation val-
ues 

If net area has not been re-
duced, add 5 points to the 
Progress Score.  
 
PROGRESS SCORE =  
………………………… 

 

Calculations 
Any reduction in total Net Productive Area for the FMU 
over the five year period (except for new conservation re-
serves)? 
2.7. Total area of planta-
tions   
 

Increase in total net forest 
area through plantations is 
appropriate.  But the re-
generation of utilised for-
est by plantation is only 
acceptable in the short 
term until natural regener-
ation techniques can be de-
veloped. 

If net area of plantations has 
increased, add 5 points to 
the Progress Score.  
 
PROGRESS SCORE =  
………………………… 

 

Calculations 
What is the area of new plantations? Include replanting of 
utilised areas if they failed the test given in Note 1. 
2.8. Area of forest man-
aged for protective func-
tions; watershed, landslide 
protection, riparian zones 

No decrease on baseline at 
creation of FMU 

If area of the Protection WC 
has not been reduced, add 5 
points to the Progress 
Score. 
PROGRESS SCORE =  
………………………… 

 

Calculations 
Area of Protection WC in FMU plan  =........... 
New area  =........... 
2.9.  Calculation of AAC  Area only? 

Area/volume? 
  

Add points to the Progress 
Score according to the fol-
lowing. 
5 points for Area only 
10 points for Area and Vol-
ume 
FINAL SCORE =........... 

 

Calculations 
Examine the FMU plan to determine the basis of calculat-
ing the AAC (See Note 6) 
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EVALUATION FORM B – (1ST FIVE-YEAR) FMU________Filled in by ________ 

Date ______ 

Responsibility: Evaluation Team 

Instructions:  The Evaluation Team should study the documents relating to policy, legislation, institutional 
procedures and Departmental guidelines that apply to forest management and form an opinion as to whether 
each indicator is covered.  If the characteristics required by the indicator are present, the Progress Score 
should be incremented for that indicator. 

FINAL SCORE = ..............  (Transfer from end of form)      INITIAL SCORE = 0 

• Extent to which the legal framework (laws, regulations, MoAF policy) supports the conservation 
and sustainable management of forests, including the extent to which it: 

Indicator Standard Progress Score Corrective action 
required, if any 

3.1. Clarifies property rights, provides for ap-
propriate land tenure arrangements, recog-
nises customary and traditional rights of in-
digenous people, and provides means of resolv-
ing property disputes by due process; 

Presence / 
Absence 

+5 for Presence 
PROGRESS SCORE =  
..........………………. 

 

3.2.  Provides for periodic forest related plan-
ning, assessment and policy review that recog-
nises the range of forest values, including co-
ordination with relevant sectors 

Presence / 
Absence 

+5 for Presence 
PROGRESS SCORE =  
..........………………. 

 

3.3.  Provides opportunities for public partici-
pation in public policy and decision making re-
lated to forests and public access to infor-
mation 

Presence / 
Absence 

+5 for Presence 
PROGRESS SCORE =  
..........………………. 

 

3.4.  Encourages best practice codes for forest 
management; 

Presence / 
Absence 

+5 for Presence 
PROGRESS SCORE =  
..........………………. 

 

3.5. Provides for the management of forests to 
conserve special environmental, cultural, so-
cial and/or scientific values. 

Presence/ 
Absence 

+5 for Presence 
PROGRESS SCORE =  
..........………………. 

 

• Extent to which the institutional framework (departmental guidelines) supports the conservation 
and sustainable management of forests, including the capacity to: 

Indicator Standard Progress Score Corrective action 
required, if any 

3.6. Provide for public involvement activities 
and public education, awareness and exten-
sion of programs, and make available forest 
related information; 

Presence/ 
Absence 

+5 for Presence 
PROGRESS SCORE =  
..........………………. 

 

3.7.  Develop and maintain human resource 
skills across relevant disciplines 

Presence/ 
Absence 

+5 for Presence 
PROGRESS SCORE =  
..........………………. 

 

3.8.  Develop and maintain efficient physical 
infrastructure to facilitate the supply of forest 
products and services and support forest 
management 

Presence/ 
Absence 

+5 for Presence 
PROGRESS SCORE =  
..........………………. 

 

3.9.  Enforce laws, regulations and guidelines Presence/ 
Absence 

+5 for Presence 
FINAL SCORE =  
..........………………. 
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Notes to Assist in Completing Monitoring Form A, and Evaluation Forms A and B  

1. When does re-establishment by planting change the forest type?  

This is important both for the conservation of biodiversity and of forest types (indicators 1.1, 2.1, 2.2, 2.3). 
The important consideration is to what degree the composition of the tree strata has been changed (it is also 
important that the understory species have been relatively undisturbed by the utilisation operation). A list to 
compare number of tree species would be the simplest, but would ignore the fact that the number of stems 
(and basal area) is different for different species. This concept is difficult to implement because year zero 
stem densities would have to be compared with mature age stem densities. The simple solution is therefore 
adopted: plantations do not replace the biodiversity of the existing forest unless more than 80% of the orig-
inal tree species are replaced by planted and naturally regenerated trees. It is important that when a mixture 
of species is used that they are actually mixed up together on a tree by tree basis, not planted in blocks of 
single species. 

2. Why is 15% an adequate reserve for forest types?  

The IUCN has adopted 10% as a reasonable standard for retention of protected areas. Bhutan has already 
set aside 26% of its land area as 'protected'. However, these are concentrated blocks of forest of high con-
servation value. It is also necessary to set aside a reasonable proportion of forest outside reserves to provide 
connection corridors and refuge habitat within forest production areas. Given that Bhutan has a wealth of 
forest resources, it is reasonable to increase the IUCN proportion in anticipation that the long term situation 
will not be so advantageous. Most FMUs already exceed this proportion anyway through protection of 
stream-side buffers, water catchments and inaccessible forest. 

'Mature' age class means forest that is approaching the oldest that the particular species gets before it dies. 
It is necessary to maintain a proportion of this sort of forest because it is usually the most diverse in terms 
of the species present and the habitats that are available for animals. Trees have large spreading crowns, 
sometimes broken and dead branches, large stem diameters, epiphytes may be common. Actual age may be 
from 150 to several hundred years. 

3. How will successful regeneration of utilised stands be judged?  

In eastern Bhutan, stocking estimates of harvested stands are first taken in the year following utilisation 
when it is still possible to refill any failed areas. Stocking is checked again three years after harvesting, by 
which time it is too late to establish new seedlings. For annual monitoring, the indicator is to be assessed 
using stocking for the area planted in the previous year. For five-year evaluations, the most up to date esti-
mates of stocking for each area utilised in the last five years are to be averaged and compared to the standard. 

4. How is the actual cut calculated (for comparison with the AAC)?  

FMU plans calculate an Allowable Annual Cut on the basis of the whole productive area and the expected 
rotation. Thus, all material that comes out of the Production Working Circle, not just the volumes that come 
from clear felling along cable lines, must be included in the removal that is compared with the AAC. This 
includes timber cut for rural use, either as timber trees or as fuel wood, by single tree or group selection. It 
is also crucial that all material felled but not removed is included in the 'actual cut'. An estimate of what the 
removal should be can be made from the utilised area (hectares) multiplied by the average total volume from 
the Operational Inventory. If there is a large difference between this estimate and the actual removal, there 
is something wrong with either the inventory or the actual removal. 

Some FMU Plans allow removal of forest produce form working circles (other than the Production Working 
Circle) for community use. These removals cannot be checked using the process described here because 
they are not included in the AAC. This is unlikely to be a problem because the removals should be small. 
However, the Unit-in-Charge should monitor community activities outside the the Production Working Cir-
cle to ensure that they are not locally concentrated to the extent that they affect biodiversity, water quality 
or soil stability. 
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5. What is 'Demonstrable progression' towards a CFMU?  

The initial step towards a CFMU is an expression of interest by a community, probably following RRA 
activities associated with the establishment of the FMU. A series of meetings would be necessary to explain 
the responsibilities and benefits involved and to determine the boundaries of the area needed. This is fol-
lowed by the submission of an application form and a continued series of meetings and negotiations. The 
necessary elements for 'Demonstrable progress' are the application form and the continuation of meetings 
to work towards the CFMU. 

6. What are the different ways to calculate AAC?  

The two methods considered are defined, as follows:  

• Area Only. The total area of the Production WC is divided by the rotation to give an area to be 
harvested every year. This results in variation in the volume harvested per year, because of variation 
in stocking among different stands in the forest. 

• Area and Volume. The area calculated above is multiplied by the average total volume per hectare 
to give a volume figure. This volume is the AAC. When this is used, the area utilised will be lower 
than average in well stocked stands and higher than average in poorly stocked stands. Planning for 
regeneration treatments need to take this variation into account. 

Box 1.15 Regeneration Survey Guidelines 

REGENERATION SURVEY GUIDELINES 

BACKGROUND  

Timber harvesting is permitted by management plans with the assumption that operated areas are 

successfully regenerated. An important condition in plans is that harvested areas are regularly sur-

veyed and timely remedial action taken in the event the regeneration fails. The guidelines for re-

generation survey have been developed to enable the field staff to quickly and reliably analyze the 

regeneration status to ensure timely action is taken in case of insufficient regeneration. 

REGENERATION SURVEY AREAS  

Regeneration survey is required in forest areas harvested under different silvicultural systems. 

The main silvicultural systems that are being prescribed in management plans are:  

a) Group Selection System - Small group openings of around 0.15 ha. Regeneration openings are 

arranged along cable crane corridors so that the timber can be easily extracted. The opening and 

corridors account for about one third the standing volume in the annual coupe. The group openings 

and the cable crane corridors have to be regenerated.  

b) Seed Tree System - In this system, around 20 seed trees per ha. are retained and the rest of 

the crop removed from annual coupe. This system is usually prescribed for Chir and Blue pine for-

ests. 

c) Selection System - In this system about  the growing stock is removed from the annual coupes 

giving preference to over mature and deformed trees.  

d) Clear Felling / Strip Felling System - The annual coupes are clear cut and replanted.  

TERMS AND DEFINITIONS  

In order to understand and facilitate easy explanation of the survey method, it is necessary to 

standardize terms and definitions. The terms mostly involve various parts of an annual coupe. The 

type of annual coupes can be divided into two distinct groups for the purpose of regeneration sur-

vey:  
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1) Group Selection Coupes 

2) Clear Felling Coupes, Shelterwood Coupes, or Seed Tree Coupes. 

The survey procedure discussed in this paper is not suited for selection coupes.  

Layout of a group selection coupe  

After the harvesting operations are over, an annual coupe in a group selection system appears as 

given in the diagrams. Various parts relevant to regeneration survey are marked and the terminology 

defined as follows:  

a) Cable line no.: The specific number given to each cable crane line in a coupe. Cable lines are 

numbered from 1 to the number of cable crane lines in sequence.  

b) Base line: The starting point of a cable crane line on either end of the corridor from where 

regeneration survey is started.  

c) Group opening: The area clear felled to create the regeneration opening including the portion of 

the corridor crossing the group opening. Group openings are numbered serially from one to the 

number of openings starting closest to the base line.  

d) Corridor Section: The part of the corridor between the base line and the closest group opening, 

between the groups, or between the last group and the end of the corridor. For the purpose of 

reference they are numbered serially from the base line to the other end.  

Lay out of a clear cutting or Shelterwood annual coupe  

All are familiar with a clear cutting or shel-

terwood coupe. However, for the purpose 

of regeneration survey of a large area the 

annual coupes have to be sub-divided into 

smaller units. This division should be di-

vided considering natural features, aspect, 

soil conditions etc. The definitions em-

ployed are as follows: a) Sub Coupe: Part of 

an annual coupe of not more than 2 ha 

which is divided by natural features or per-

manent manmade features such as roads, 

of uniform topography, aspect, soil condi-

tions etc. The annual coupe is divided into 

a number of sub coupes for the purpose of 

regeneration survey and given specific 

numbers and mapped for reference (see 

Figure 1). 

Others  

a) Cruiseline - This is a straight line located in a sub coupe, group opening or a cable line along which 

regeneration survey is conducted. 

b) Quadrant - It is a regeneration plot of 2 m x 2 m measured on either side of the cruiseline. The 

plots on the left side are called the (a) quadrants and the plots on the right side of the cruiseline 

are called the (b) quadrants. They are numbered serially as (a) and (b) quadrants from the start to 

the end of the cruiseline.  
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c) Regeneration count - Regeneration count is the number of seedlings found in the quadrant. A 

seedling of 5 cm height and above is counted as 1. Seedlings of below 5 cm height are counted 1 for 

three numbers only.  

Equipment  

1. Compass  

2. Altimeter  

3. Clinometer  

4. Map  

5. 2 meters length pole/stick  

6. Scale for measuring seedling height  

7. Regeneration survey form  

8. Species Codes list  

LAYING OUT OF THE CRUISELINES  

Corridors  

In each section of the corridor between the groups, stand in the middle and lay a line along the 

length of the corridor. The starting point in each section should be indicated with a stick and the 

compass direction noted. 

Group openings and or coupes Inspect the group openings or sub coupes and decide on the two best 

diagonal lines as indicated in the diagram. The diagonal lines should be of maximum possible lengths 

given the shape of the survey area and the terrain. The compass direction of each cruiseline should 

be noted (see Figure 2).  

MEASUREMENTS  

Start with recording the general information in the top of the form. Also tick the appropriate 

silvicultural system. For Clear Cutting and other systems, use the appropriate form. For Group Se-

lection System there is a separate form. Slope correction should be done by holding the tape or 

measuring stick as much as possible horizontal, thereby eliminating the need for a slope correction 

table. In steep terrain, the tape length should be adjusted accordingly with the above in mind.  
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Corridor  

In a corridor, record the cableline number and start from the baseline line (which is usually at the 

edge of the road) and record the compass direction of the corridor. Proceed 10 meter into the 

corridor to the first quadrant. After recording the first quadrant, proceed 25 meter along the 

cruiseline to the next quadrant (2a and 2b etc.) and continue in this way until the end of the cruis-

eline is reached (i.e. upon reaching a group opening or at the end of the corridor, see Figure 2). 

After completion of survey of a group, the cruiseline in the corridor should be continued. Make a 

new baseline at the edge of the group and proceed in the right bearing for first 10 meter and after 

that every time 25 meter until again at the end of the cruiseline.  

Group 

In a group, start the first quadrant 10 meters from the baseline (i.e. the edge of the group opening). 

This will be quadrant 1a and 1b. Continue moving along the cruiseline 10 meters at a time and lay out 

quadrant 2a and 2b, etc. Continue in this manner until the end of the cruiseline is reached (i.e. at 

the end of the group). Repeat the procedure on the other diagonal cruiseline.  

Sub coupe 

In a sub coupe, start from the baseline line at the edge of the sub coupe and record the compass 

direction of the cruiseline. Proceed 25 meter into the coupe to the first quadrant. After recording 

the first quadrant, proceed 50 meters along the cruiseline to the next quadrant (2a and 2b etc.) 

and continue in this way until the end of the cruiseline is reached at the end of the sub coupe. 

Repeat the procedure on the other diagonal cruiseline. 

Quadrant  

Take the 2-meter stick. Place one end to 

your body and hold it horizontal. Standing 

on the starting point of the cruiseline, hold 

the stick perpendicular to the cruiseline on 

the left side and then direct the stick along 

the cruiseline. Approximately note the 

square area (quadrant 1a) covered by the 

stick (see Figure 3). Count the number of 

seedlings and enter the number in the form 

(refer to seedling count below). Repeat the 

procedure on the right side of the cruiseline 

(quadrant 1b).  

SEEDLING COUNT  

Record the number of seedlings of the main 

commercial species in the quadrant 1 . Give 

one point to each seedling of more than 5 cm 

height and one point to every 3 seedlings 

with less than 5 cm height or to seedlings of 

inferior quality (broken top, trampled, 

browsed, etc.). Subsequently, give one point for 2 seedlings and zero points for 1 seedling. For 

instance, if one finds 1 seedling of 10 cm and 6 seedlings of 3 cm, the number to be recorded on the 

form is 3. Seedlings on stumps or stones should not be included in the counting. While counting in 

this way, 1 seedling per quadrant will give 2,500 seedlings per ha of more than 5 cm or 7,500 seed-

lings per ha of less than 5 cm. If one is interested to find out the success or failure of the planted 

seedlings in a plantation, the plants and natural regeneration can be recorded separately, e.g. by 
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dividing the regeneration count column in 2. Also analyze the main specie(s) of the quadrant by 

noting down the species codes 2 .  

SITE CONDITIONS  

The site conditions should be recorded in the appropriate columns in order to try to analyze possible 

relationships with the regeneration status.  

Weed assessment  

a) Light weed growth = L (no need for weeding)  

b) Medium weed growth = M (weeding necessary)  

c) Heavy weed growth = H (weeding necessary)  

You may add B if the weed is predominantly bamboo. 

Grazing/Trampling  

a) Light grazing/trampling        = L (fencing not required)  

b) Moderate grazing/trampling = M (fencing required)  

c) Heavy grazing/trampling = H ( fencing required)  

CALCULATIONS  

Calculations must be done for each group opening, sub-coupe or corridor section separately accord-

ing to the following formula:  

 

Where C1 and C2 is the total number of seedlings in the quadrants of each cruiseline. Q1 is the 

total number of quadrants in cruiseline 1 (A + B = 1) and accordingly for Q2.  

While recording in a corridor, there will only be one cruiseline. Therefore the formula will be ad-

justed in the following way:  

 

Analysis of results  

1. If the regeneration is more than 2,000 per ha, then the area is successfully regenerating.  

2. If the regeneration is 1,000 up to 2,000 per ha, the regeneration is doubtful. The area should be 

resurveyed in the fifth year. Some immediate action could be taken up, e.g. soil scarification, seed 

broadcasting, grazing control, etc.  

3. If the regeneration is less than 1,000 per ha, the area is not regenerating adequately. Immediate 

action is required in the blank areas (see above). If the status remains as it is till 5 years after the 

area was harvested, the area should be planted up.  

4. The distribution of the seedlings should also be analyzed. If several quadrants in a cruiseline 

have a value of 0 and some a high value, then the overall number per ha can still give a satisfying 

picture. However, regeneration is doubtful because some areas are blank. In this case action could 
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also be taken to promote regeneration in the blank areas. The area should be resurveyed in the 

fifth year.  

TIME OF SURVEY  

Regeneration survey should be conducted 3 years after harvesting or planting of the area. If the 

result is not satisfactory, it should be repeated in the 5th year after which a decision is made on 

whether the area has adequately regenerated or action is necessary. The best time of the year 

seems to be right after the winter when snow has melted and before the new growing season for 

conifer and temperate broadleaved forests. Depending on the site, the timing will vary slightly. For 

(sub-) tropical rainforest, the time of survey should preferably be done before the monsoon season 

so immediate action can be taken in case of unsatisfactory results.  

ACCURACY  

One way to improve the accuracy of the results is by making a survey unit small as possible. In the 

case of group openings, the survey unit is only around 0.15 ha in area. A reconnaissance survey of 

the area may reveal areas that are definitely not regenerated. Such areas can be separated out 

from the survey and mapped as unregenerate. The accuracy can be improved by putting in more 

cruiselines if needed. In this case systematic grid lines at regular intervals would be more appro-

priate. The parallel grid lines may run in any convenient direction. 
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2. Community Forest Management 

2.1 Background 

The concept of peoples’ participation in sustainable forest management (SFM) in Bhutan started where 
Social forestry made its first appearance in Bhutan in 1979 when His Majesty King Jigme Singye 
Wangchuck proclaimed that “The participation of the local community is the key to conservation and utili-

zation of forest resources”. Peoples’ participation in forest management became more evident when the 
community forestry program featured prominently in the Forest and Nature Conservation Act of Bhutan, 
1995. 

Community Forest (CF) is a form of forestry practice wherein the forest resource management authority is 
given to rural communities. The CF program is relatively new management regime compared to other for-
estry programs such as plantation, forest management unit (FMU) and protected area (PA) management. 
The CF program seeks to strengthen link between people and forests. Rural people usually live near forests 
and rely heavily on them for their basic needs. Forests provide them with products and services such as 
firewood, timber, fodder and pasture, foods, medicines, leaf litter, water for drinking and irrigation and 
spiritual grounds (SFED 2018). 

CF is one of the key components of Bhutan’s forest policy and is aimed at contributing to overall sustainable 

management of forests. CF contributes to conservation, reducing illegal activities, poverty reduction, im-
provement in rural household livelihood and many more benefits. Community Forestry is now firmly on the 
agenda for Bhutan as part of the Five-Year Plans and it forms part of the National Forest Policy 2011 (SFED 
2018).  

2.2 Objective 

The broad objectives are to: 

• empower rural communities to manage CF areas sustainably;  

• provide socio-economic and environmental benefits;  

• alleviate poverty and improve livelihoods;  

• contribute to overall sustainable forest management at national level; and 

• promote good governance to ensure transparency, accountability, participation, predictability, em-
powerment, inclusiveness, equity and benefit sharing, and in line with decentralization and devolu-
tion policies. 

2.3 The Community Forestry Processes 

There are four main processes in community forestry program. 

1. Application process 
2. CF management planning process 
3. Approval process 
4. Implementation process 

These processes are mostly participatory involving local communities and other stakeholders. Participatory 
Rural Appraisal (PRA) tools are used in different processes. The flow chart (Figure 2.1) shows the whole 
processes starting from establishment to implementation and revision. The processes are further divided into 
several steps. 
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2.3.1 CF Application Processes 

2.3.1.1 Formation of CFMG and Submission of Application 

In accordance with Section 78 (1) of FNCRR 2017, a village with at least five households willing to establish 
and manage a community forest can form a Community Forest Management Group (CFMG). The CFMG 
submits application (Annexure VI of FNCRR 2017) to the Gup, who shall review and recommend to the 
CFO. 

Step 1. Formation of 
CFMG and submission 
of application 

Step 2. Field verifica-
tion of proposed CF 
area 

Step 3. Approval/rejec-
tion of CF application 

 

Step 1. CF Boundary Survey and 
Demarcation 

Step 2. Participatory Forest Re-
source Mapping  

Step 3. Division of CF into Blocks 

Step 4. Forest Resource Assess-
ment 

Step 6. Forest Produce Demand As-
sessment 

Step 5. Forest Produce Prioritiza-
tion and Species Ranking 

Step 7. Calculating Carbon Stock 

Step 8. Socio-Economic Survey 

Step 11. Forest Management Matri-
ces 

Step 9. Climate Hazard and Vulner-
ability Assessment 

Step 10. Waste Management in CFs 

Step 12. Participatory Environmen-
tal Assessment 

Step 14. Writing of CF Manage-
ment Plan 

Step 13. Preparation of CFMG By-
laws 

Step 15. M&E Arrangements 

Step 1. Submission of 
CFMP to the Department 

Step 2. Review of CFMP 
and Approval 

Step 3. Issue of CF Owner-
ship Certificate 

Application  CF Management Planning  Approval  Implementation  

Community Forestry Processes 

Step 1. CFMG Gov-
ernance 

Step 2. CFMG Capac-
ity Building 

Step 3. Silviculture 
and Forest Manage-
ment 

Step 9. AWP Prepara-
tion 

Step 7. Enterprise De-
velopment and Em-
ployment in CF 

Step 5. Addressing 
Poverty and Disad-
vantaged Members  

Step 8. CFMG Ad-
ministration 

Step 6. Adapting to 
Climate Change  

Step 4. Community 
Development 

Figure 2.1 Community Forestry Process flowchart 
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2.3.1.2 Field Verification of the proposed CF area 

Upon receipt of the CF application from the Gup, the CFO shall form a field verification committee. The 
committee shall comprise of CFMG representatives, CFO, Dzongkhag Land Record Officer, Gup and adja-
cent community among other relevant agencies and officials.  The team shall check whether or not the 
proposed CF area fulfils the criteria mentioned in FNCRR 2017 (Box 2.1Error! Reference source not 
found.) or any revisions hereafter.  

Box 2.1 Selection criteria of CF sites as per FNCRR 2017 

The selection criteria for CF sites are: 

(1) Any area of State Reserved Forest Land, including degraded and barren areas for improvement, 

in the vicinity of human settlement, suitable for control and management by Community Forestry 

Management Group, as Community Forest. The designation of an area as CF shall comply to the 

following procedures and criteria: 

a. the area is traditionally used and managed by the community; 

b. the area has production potential to meet subsistence requirement of forest produce and 

income generation for CFMG members. Tsamdro /Sokshing land reverted to SRF Land shall 

not be designated as Community Forest unless the reverted Tsamdro /Sokshing is no longer 

required for lease as Tsamdro /Sokshing by the individual/community; 

c. the area is suitable for sustainable management and utilization of forest produce; 

d. the local household are willing to form and cooperate as a CFMG to manage the forest in 

accordance with the following conditions: 

i. establishment of CF in the PA and Biological Corridor within the vicinity of the existing 

settlement may be allowed, if feasible; 

ii. sacred forests or tree, significant Wetland, Heritage forests or any forest area of 

cultural and religious importance shall be protected from designation as CF; 

iii. any area of government plantation in small patch less than three years or plantation 

area measuring less than five hectares located within the proposed CF, shall be included 

in the CF for better management by the CFMG after obtaining clearance from the 

Department. 

e. the boundary and size of CF area shall be determined by the following criteria: 

(i) availability of SRF Land excluding FMUs; 

(ii) traditional and natural boundary within the village; 

(iii) customary rights and practices of resource utilization; 

(iv) level of dependence of the community on such forests; 

(v) availability of adequate area to meet the resource needs of neighboring communities; 

(vi) the maximum ceiling of CF area to be allotted to individual household (hh) shall be as 

follows: 

(1) Mixed conifer/blue pine forest 3 ha/hh. 

(2) Chir pine forest 4 ha/hh. 

(3) Mixed broadleaved and other forest type 5 ha/hh. 

f. (f) the proposed area decided by the committee comprising of representative of CFMG, 

CFO, DLRO, Gup and adjacent community shall be endorsed and shall form the basis for the 

CF establishment. 

 

Net operable (production) area for community forests should be calculated after determining the important 
areas (water source, wetland, cliff, rock outcrops, etc.) and deducting them from the overall CF area. 
However, those areas should be brought under appropriate management regime within the CFMP. 
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2.3.1.3 Approval of CF Application 

The CFO, upon field verification by the committee, approves/rejects the application for establishment of the 
CF. The CFO then instructs the concerned Forestry Official (s) to facilitate the community forest manage-
ment exercises and framing of CFMG By-laws. 

2.3.2 Community Forest Management Planning Process 

2.3.2.1 Principles of the CF Management Planning 

Th following principles should be followed during Community Forest Management Plan (CFMP) prepara-
tion (Figure 2.2Error! Reference source not found.).  

The CFMP should:  

• Contain all the 
information the CFMG 
needs to manage their 
CF. 

• Not contain extra 
information (not 
actually required for 
managing the CF). 

• Be prepared by the 
CFMG with concerned 
Forestry Officials as 
facilitators and trainers. 

• Be “owned” by the 

CFMG. 
• Be written in a national 

language  
• Include maps, diagrams, charts and 

drawings to be easily understood. 
• Include all the actual activities which the CFMG agree to implement.  
• Contain agreed responsibilities for implementation and procedures which the CFMG can follow. 

2.3.2.2 CFMP preparation process 

The CFMP shall be prepared by the CFMG with technical support and facilitation by field forestry staff.  
Detailed steps for preparation of the management plan are described below: 

Step 1. CF Boundary Survey and Demarcation  

CF boundary needs to be clearly demarcated and 
mapped. Boundary survey is done by GPS involving the 
CFMG representatives and communities from adjacent 
villages. For boundary survey, a checklist of suggested 
equipment is mentioned in Box 2.2. 

How to do a boundary survey with GPS 

• Agree on the starting point for the traverse of the CF boundary with CFMG members. This should be 
an accessible and easily locatable point e.g. on a roadside/Chorten/Lhakhang or river/stream/cliff, etc. 

• Set the reference point as the starting point on your GPS. Make notes on your GPS Survey Sheet 
(referring to the point number or name). Or record the corresponding Waypoint ID in the GPS Survey 
Sheet. 

COMMUNITY 
FOREST MAN-

AGEMENT 
PLAN 

Simple: Plan has 
a simple style; is 
short; easy to un-
derstand and use 

Flexible: Plan 
can be modified 
based on chang-
ing needs 

Participatory: Plan 
is “owned” by the 

CFMG and all 
members have 
helped to prepare it 

Realistic: Plan is 
practical and can 
be implemented 
by the CFMG 

Useful: Plan 
meets the real 
needs of the 
CFMG and ad-
dresses prob-

Equipment: GPS (e.g. Garmin), spare 

batteries, Compass, GPS Survey Sheet, 

clipboards, pen/pencils, permanent 

marker (Paints), knives. 

Figure 2.2  Principles of Community Forest Management Plan 

Box 2.2 Equipment 
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• Setup GPS position format in decimal degrees (hddd.dddddo). 

• Before starting to walk the boundary, make sure the GPS is set up properly to record the Track.  

• Turn on the Track log and mark Waypoints while walking along the CF boundary. If the area is too 
large, we may have to set the Track log recording method into auto. We also have options to record the 
Track log by distance, time and its corresponding recording intervals. If the Track logs are more than 
700, we face some problem while digitizing in ArcMap. 

• Explain to the CFMG members that you are going to record the CF boundary with the GPS. Show some 
tracks and waypoints already stored on the GPS and explain the importance of following the exact 
(proposed) boundary of the CF without taking shortcuts (the GPS shall only record the places you have 
actually been). 

• Stop at each locatable point e.g. path junctions, rock outcrops, gullies, streams and houses or specific 
forest areas and store a Waypoint on your GPS.  

• Write the GPS ID names using permanent marker or paints on the trees, rocks to help CFMG members 
in identifying the CF boundaries in future.  

• Note down any features and area names on your Form 2.1 

Form 2.1 GPS Survey Sheet 

• Continue around the entire CF boundary. As far as possible try to have the boundary following 
recognizable features like ridges, paths, roads, boundaries of cultivated land, etc. 

• When you regain the starting point you shall have a complete GPS survey of the boundary. It is usually 
convenient to upload Waypoints and Tracks through OziExplorer as you can view time, date and geo-
coordinates you travelled from that place in its Track log. You also have other options to upload GPS 
data onto your PC (DNRGPS, QGIS software, etc.).  

Steps to upload GIS data in GPS  

Open DNRGPS software from the file directory, run the exe. file 

GPS Survey Sheet 

Survey team members: Name of forest: 

Date:  

GPS ID Features Remarks 

(WPT 
No./Name) 

(Ridges, paths, road, boundaries of 
cultivated land, power line, etc.) 

(Name, condition, use, etc.) 
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When you run the exe. file , you shall see the screen below. 
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Now connect your GPS and find GPS from the top menu. It shall take some time to find your GPS and name 
of GPS occurs above the screen box as indicated in the figures below. 

 

 

 

 

Now load the waypoints/plots from the file directory as mentioned in the figure below. 
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Now upload the Waypoint to GPS from the waypoint menu and upload the waypoints until it is complete. 

 

The Waypoints/plot identity is now ready for use in the field 
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How to produce boundary map using QGIS 

a. Upload field data from GPS 

  

 

b. Add GPS raw data from GPS or downloaded file directory using add vector layer button. 

c. Select tracks multi-string type and click ok . 
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d. The boundary shall be displayed in the main screen. You shall see the layer file as track any in the 
layer menu. 

 

e. Now we have to project the raw data by saving as project file  
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f. Select the CRS format as shown and save the file in the designated directory  

 

 

g. Apply and click ok . 
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h. Digitize the data using add new shape file layer as indicated in the figure  below. 

 

 

i. Disable the original boundary file and select the new boundary. 
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j. Add land use data and finalize the map, see figure 4i below (Google map superimposed with 
required attributes and Land use map which can be incorporated in the management plan). 

 

In order to identify land use around the proposed CF area, you may officially write to National Land Com-
mission Secretariat or Dzongkhag Administration to consider providing the private land Shape files and 
their details so as to avoid boundary issues with private land owners in future. It is convenient to superimpose 
on Google map as it is more convincing to the CFMG members and other relevant stakeholders. 
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Figure above shows Google image with superimposed private lands. Figure below shows CF boundary with 
private lands, settlements and other features 

 

We can produce GIS map with recent land cover map (LULC 2016) or any other update herewith. The map 
must have several features like scale, direction marker showing North and legend. You need to print the 
map, as large as possible and preferably in color. Few copies may be needed. Calculate the area enclosed 
by the GPS survey (your GPS/GIS software shall do this). After preparation of Google/GIS map, ask CFMG 
members if the features are complete. If not, add features that they feel are important for them. The following 
layers are mandatory in google maps: 

- Private land shape files  

- Show settlements 

- Show Protected Areas, Biological Corridors, FMUs or any other forest management regime boundaries 
if available. 

- Using the add placemark function in the Google Earth; level the important features (Chorten, 
Lhakhang, Road, rivers, Gewog Administration Office, drinking water source, etc.). 
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- Update settlements using GPS (marking Waypoints) since the older versions are not accurate. 

Step 2. Participatory Forest Resource Mapping  

This PRA tool helps to get a better understanding about how forests are used by different people in the 
village, where different forest produce come from. From this exercise, a participatory forest resource map 
can be developed by villagers using google map. 

How to do Participatory Forest Resource Mapping using google earth 

• Show google earth map printed in color or over a projector if you are equipped with to the CFMG.  

• Let them locate and name the areas of specific resource collection and use. Also mark other important 
features (water source, sacred sites, etc.) on the map.  

• Let them copy on the chart and locate the resources simultaneously from the Google map (barren land, 
Tsamdro, Sokshing, water sources, forest types, plantations, etc.).  

• In the areas where electricity is not accessible, concerned Forest Officer may invite their CF Manage-
ment Committee in the office and discuss the above steps and take a printed copy of Google map for 
discussion with their members in the field.  

• As a facilitator stay in the background and only get involved if there is a problem or for clarification. 
Your role at this point is to listen carefully. 

• The groups may debate which characteristics are important, and as result, a wide variety of relevant and 
unexpected information may emerge. 

• At the end of this stage, the google map shows the resources collection location, boundaries, and the 
names of important physical features, including the village (Figure 2.3) 

•  This provides the basic framework on which the rest of the map is constructed. 

• Keep the legends as clear as possible.  
• Remember that this is not supposed to be a highly ‘accurate’ map. 

 

Figure 2.3 Participatory Forest Resource Map transferred from Google map 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        409 

Table 2.1 Checklist for Participatory Forest Resource Mapping 

Checklist for Participatory Forest Resource Mapping   
Who? Who are the forest users and what are their names? 

Who collects the forest produce? 
Do outsiders use the forest resources around the village? Who are they, where do they come 
from, what do they use, when, where, how? 
Are there any conflicts between users? 

What? What products are readily available and what are scarce? Where are they? 
What are the forest produce they use? 
What are their requirements and needs from the forest? 
What do they use these products for? 
What other forest use problems do they have? 

Where? Where are the forest produce found? 
Where do the users live? 
Which areas are used for different produce e.g. grazing, NWFP collection, fuelwood collec-
tion, etc.? 
Where other forest use areas are located e.g. FMU, Buffer Zone, PAs, Wetland, Biological 
corridors, water source, religious areas, etc.? 
Where are the “degraded” forest areas? Why are they degraded? 
Are there any areas for carrying out improvement work? 

When? When are different kind of forest produce available? 
When (in a year) are different produce collected?  
Does the village population change during the year?  
Does this affect use of the forest? 
How has the forest changed over the years? 

How? How much time does it take to collect different produce? 
How does the village collect forest produce? 
What system is used for collecting and distributing forest produce?  
Are there limits on how much can be collected at any time? 
Are there any issues on how the forest is used? 

 

Step 3. Division of CF into Blocks  

CF areas may be divided into blocks to make forest 
resource assessment (inventory) easier and to make 
the management plan more site-specific. It is not 
necessary that all CFs must be divided into blocks. 
Blocks are made when there is distinct forest type and 
condition which may require separate management 
regimes.  

Net operable (production) area for CF should be 
calculated after determining the important areas 
(water source, wetland, inaccessible area, etc.) and 
deducting them from the overall CF area. However, 
those areas should be brought under appropriate 
management regime within the CFMP. 

How to divide the CF into Blocks 

• Divide CFMG members into small groups  

• Show the CF resource use map produced in Step 2, above.  

Forest type – each block could have a differ-

ent forest type e.g. broadleaved, conifer, etc. 

Forest condition – each block is in a different 

condition e.g. degraded, dense, etc. 

Use patterns – different blocks accessible to 

or used by different households or villages 

Natural features – so that boundaries of 

blocks follow clear features that can be seen 

on the ground e.g. ridges, streams, rivers, 

footpaths, roads, cliffs, power lines. 

Number – do not have too many blocks other-

wise the management plan will become very 

complicated. 

Box 2.3 Criteria for Dividing CF into Blocks 
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• Ask each group how they would use the listed criteria to divide the CF into blocks. 

• To divide the CF into blocks, you can use Google earth and confirm through field verification. 

• Choose someone from each group to present the block map to the whole group. 

• When the whole group agree on where the block boundaries should lie and mark them permanently on 
the map. This is now your CF map (base map) showing blocks. It shall be the main map for management 
purposes. 

• Describe the boundaries of each block and write these down e.g. describe what actually lies to the North, 
South, East and West of each block. 

Measuring block areas 

There are two options to measure block area. 

(a) Measuring block area by using a GPS 

You can measure the area of each block by GPS. To do this you must walk along the boundaries of each 
block and take GPS readings. 

(b) Measuring block area by Google Earth/ArcGIS 

Once the CFMG has demarcated the block boundaries, we can follow following steps to calculate the block 
areas: 

1. Using add path function in Google earth, draw path on the Google map as desired by the CFMG mem-
bers.  

2. Save the path in a given directory. From the side bar, right click and save place mark as .kml file in the 
given folder directory. 

3. Import into ArcMap and project the kml file to drukref03. 
4. Using split tool under Analysis Tools, split the polygon on the path file we have created and save it. 

Complete and task and calculate area from attribute table. 
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Step 4. Forest Resource Assessment 

Forest resource assessment means describing and measuring 
forest to find out what resources it contains (Format 1) 

Some suggested equipment for forest resource assessment are 
listed in the Box 2.4. 

 

Hypsometer, compass, measuring 

tape and thick measuring rope, 

diameter tape, map, tally sheets, 

pen/pencil, etc. 

Box 2.4 Equipment 
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Why is forest resource assessment needed? 

• To provide information about the forest so that appropriate forest management prescriptions can be 
adopted 

• To provide information for calculating the quantities of timber and other forest produce (NWFPs, sand, 
stone and boulders, etc.) that can be sustainably harvested. 

• To provide a baseline for monitoring and evaluation. 

Forest resource assessment is conducted using sample plots involving the CFMG members. This will 
show the growing stock (of timber) in the block in order to calculate the timber available for 
harvesting during the CF Management Plan period. It will also assess the stock of any NWFPs that 
may be prescribed for sustainable management. Complete forms below, one form for each sample 
plot in the CF/block. 

Format 1. Forest Resource Assessment Format (Complete this format for each block) 

Name of Community Forest  

Date of Assessment  

Name of block  

Block area  

Name of recorder  

 

Forest & Habitat Type (tick all those present, Refer definition below) 

Forest  Thicket/pole stage  Shrubland  

Grassland  Plantation  Other  

Vegetation type 

Subtropical for-
est 

 Chir pine forest  
Warm broad-
leaved forest 

 
Blue pine for-
est 

 

Cool broad-
leaved forest 

 
Mixed conifer for-
est 

 Fir forest  OTHER  

 

Definitions 

Broadleaf forest 75% or more of the tree species present are hardwoods 

Conifer forest 75% or more of the tree species present are coniferous 

Mixed forest All other combinations of tree species 

Mature Forest Vegetation dominated by mature trees (trees > 40 cm dbh) 

Thicket/pole stage Vegetation > 3m in height consisting of young trees usually < 40cm dbh 

Shrubs Non-tree species > 2m in height (often thorny and multi-stemmed) 

Shrub-land Vegetation dominated by woody multi-stemmed plants or single stemmed plants 
and regeneration mostly < 3 m tall 
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Grassland Vegetation dominated by grass species and where only a small part of the area is 
covered by trees or shrubs. 

Crown cover  The percentage of the area covered by the crowns of trees forming the main canopy 
(usually mature trees) 

Regeneration  Seedlings, saplings and coppice regrowth of naturally occurring tree species that 
are less than 1.3 metres tall but greater than 30cm tall 

Seed trees Mature trees with healthy crowns capable of producing flowers and seed 

Soil Cover The percentage of the area with soil surface covered either by live vegetation or a 
layer of other plant vegetation 

 

Forest Condition (complete if the block is mainly forest) 

Write the names of main tree species 

Local name Scientific name 

  

  

  

Plantation 

Is there any planta-
tion? 

Yes  Approximate height 
of planted trees (m) 

 

No  

Year planted  Is the plantation? Under stocked  

Stocked  

Overstocked  

 

Forest Condition -Age 

Mature  Pole stage  Shrubland  Any  

Main canopy of mature 
trees 

Main canopy of pole-
stage trees 

Main canopy of 
shrubs, young trees or 
regeneration 

No continuous canopy. 
Isolated trees only 

 

Forest Condition - Canopy density (tick main canopy) 

Dense  Open  Very open  

Canopy density > 70% Canopy density < 70% No real canopy. Isolated trees 
only 
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Forest Condition – Regeneration (including coppice regrowth) 

Abundant  Scattered/few  None  

Regeneration easy to find in most 
places 

Regeneration only in some places 
and hard to find 

No regeneration 

Write the names of the 3 main tree species in the regeneration 

1) 2) 3) 

Regeneration: Seedlings > 30cm and < 1.3m height 

 

Forest Condition – Approximate density of seed trees 

High  Moderate  Low  

> 50 seed trees per ha 10 – 50 seed trees per ha < 10 seed trees per ha 

 

Block Condition – Summary 

(Use the forest condition class box below to get an average condition for the block)  

Poor  Average  Good  Very Good  

Does the main forest canopy consist of large, mature 
trees? Yes  No  

 

Forest Condition Class Box 

Age Canopy den-
sity 

Regeneration & cop-
pice 

Seed tree class Condition 

Mature for-
est 

Dense Abundant  Very good 

Scattered/few  Good 

Open Abundant  Good 

Scattered/few  Average 

Pole stage 
forest 

Dense Abundant  Good 

Scattered/few  Average 

Open Abundant  Average 

Scattered/few  Poor 

Shrubland 
and young 
growth 

Dense  Moderate or High Average 

Dense  Low Average 

Open  Low Poor 

Any Very open None  Poor 
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Open spaces (complete if there are significant open spaces in the block) 

Approximate total open space area (ha)  

Dominant vegetation type in the open space  

Cause of open space e.g. grazing, fire, harvesting, etc.  

 

Grazing and fodder (complete if the forest block is used for grazing or fodder) 

Grassland type 

Natural  Man-made  Mixture  Predominantly forest  

Main fodder species being used (list 3 only) 

Local name Scientific name 

  

  

  

Pasture quality (list the 3 dominant species in the grassland) 

Local name Scientific name Palatable/unpalatable 

   

   

   

Use pattern Seasonal  All year  

Type of user Migratory  Local  Both  

 

Catchment Condition (use catchment condition class box below) 

(i) Catchment condition – soil cover 

Soil cover Soil cover class 

> 50% of the soils are covered by vegetation high  

25 – 50% of the soils are covered by vegetation moderate  

< 25% of the soils are covered by vegetation low  

(ii) Catchment Condition - Soil type and erosivity 

Soil type (colour, texture and type)  

Erosive  Non-erosive  

disperses and/or breaks up in water easily stable to water flow 

(iii) Catchment Condition - Slope 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        416 

Slope (degrees) Slope steepness class 

<10º Gentle  

10º – 30º Moderate  

> 30º Steep  

Catchment Condition – Summary (Use the catchment condition class box below to get the average con-
dition for the block) 

Less critical  Moderately critical  Highly critical  

 

 

 

     

 

 

Fauna (List any animal or bird species seen or which are known from the block) 

Local Name Scientific name 

  

  

Catchment Condition Class Box 

Slope category Soil erosivity Cover class Condition class 

 

Flat 

Erosive Moderate or high Moderately critical 

 Low Highly critical 

Non erosive any Less critical 

 

 

Moderate 

Erosive Moderate or high Moderately critical 

 Low Highly critical 

Non erosive Moderate or high Less critical 

 Low Moderately critical 

 

Steep 

Erosive Moderate or high Moderately critical 

 Low Highly critical 

Non erosive Moderate or high Moderately critical 

 Low Highly critical 
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Biotic Pressures (tick those present)  

Fire Common  Occasional  Absent  

Grazing Heavy  Limited  Absent  

Fodder collection 

(list main species used) 

Common  

 

Limited  Absent  

NWFP collection Common  Limited  Absent  

(list the main products including 
bamboo & cane) 

   

Leaf litter collection Common  Limited  Absent  

Encroachment Common  Occasional  Absent  

Pole harvesting Common  Occasional  Absent  

Fuelwood harvesting Common  Occasional  Absent  

Timber harvesting Common  Occasional  Absent  

Hunting Common  Occasional  Absent  

Others (describe)  

 

Potential Management Options (list any potential management options for the CF/block) 

1  

2  

3  

4  

5  

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        418 

Forest resource assessment is conducted using sample plots involving the CFMG members. This shall show 
the growing stock (of timber) in the block in order to calculate the timber available for harvesting during 
the CF Management Plan period. It shall also assess the stock of any NWFPs that may be prescribed for 
sustainable management. Complete tally sheets (Format 2 below), one sheet for each sample plot in the 
CF/block. 

1.4.4. Format 2. Quantitative Forest Resource Assessment - Tally Sheet 

CF Name  Date  

Canopy height <5, <10, <20, <30, 30+ 

Block name  Canopy closure <10, <40, 40+ 

Plot num-
ber 

 Altitude  

Name of re-
corder  

 T = suitable for timber: N = Not suitable for timber 

 Dbh (cm) 

Species (lo-
cal name) 

Suita-
bility 

< 10 cm 
(seedlings) 

10-
19 

20-
29 

30-
39 

40-
49 

50-
59 

60-
69 

70-
79 

80-
89 

90-
99 

100+ 

 T            

 N           

 T            

N           

 T            

N           

 T            

N           

 T            

N           

 T            

N           

 T            

N           

 T            

N           

Total T            

 N           

 % N           
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How to conduct Forest Resource Assessment 

a. Calculation of number of plots and determining the grid lengths 

The forest type needs to be pre-stratified as per the Coefficient of Variation (CV) % of different forest types 
prior to determining the number of sample plots. For example, the total gross area of a CF is 600 ha (Table 
2.2).  

Table 2.2 Net production of a CF by forest type 

Forest Types Net Production Area (Ha) 
Fir 100  
Mixed Conifer 200 
Blue Pine 300 
Total 600 

 

Table 2.3 below shows the CV for typical forest types obtained on 0.05 – 0.1 ha fixed plot size. However, 
it is recommended to calculate CV % for each CF based on field available data instead of using default 
value. 

Table 2.3 CV for typical forest types 

Forest type CV% 
Fir 50 
Spruce 70 
Blue Pine 105  
Mixed Conifer 70 
Combined conifer 80 
Oak (Q. semicarpifolia) 65 
Mixed Broadleaf 85 
Combined Broadleaf 85 
Combined all 85 

 

Example of pre-stratification and generation of number of plots 

Suppose there are three strata with the following areas and estimated CV% (Table 2.4).  

Table 2.4 CV % of different forest type of a CF 

Forest Type Area (Ha) CV% Weighted CV 

Mixed Broadleaf 100 85% (85/100*100) = 85 
Mixed Conifer 200 70% (70/100*200) = 140 

Blue Pine 300 105% (105/100*300) = 315 
 600                              540 

The weighted average CV%= (540/600) *100 is therefore 90%.  

The number of plots required in each to achieve a target sampling error of 10% at 95% confidence level 
over the whole area can be calculated as under; 

 

 n =
t2 X CV%2

SE2 
 

(20) 
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Where: 

n = number of sample plots 

t = value of t distribution (see Table 2.5) 

CV% = coefficient of variation (in %) for the forest, using the same type of sample plot 

SE% = the target sampling error (in %) to be attained 

Therefore, from above example, (2)2 x (90)2 / (10)2 = 324 plots 

Table 2.5 t-table 
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The target sampling error to be attained has been set at +/- 10% (SE % = 10%) of the average gross volume 
per ha, given a confidence level of 95%. The t-value is obtained from a t-table, using the correct number of 
degrees of freedom df (df = n -1), and probability level p. The probability level, or risk level, is the opposite 
of the confidence level: if we are 95% confident, we run a risk of 100%-95%) = 5%. Our probability level 
is then p=0.05.  

Each plot should represent an average area of 1.85 ha (600/324) to proportionately allocate 324 plots within 
a CF of 600 ha.  Given the many practical advantages, it is recommended to follow systematic sampling 
resulting square sampling grid. A square grid would have sides of 136 m calculated as follows (1.85*10,000 
m² = 18,500 m2, and square root of 18,500 = 136 m). Thus, a systematic sampling grid of 136 m between 
plots on a line, with each plot representing (600/324) = 1.85 ha shall be considered for creating the sampling 
design for the CF area (plot to plot is also 136 m). 

Preparation of Sampling Design 

Preparation of sampling design can be carried out in GIS. The following steps may be followed for designing 
a sampling design of a CF area: 

i. Load the shape file of the CF in QGIS. Please note that the file must be ESRI shape file and NOT other 
types of file.  Go to tab ‘vector’ as shown in the Figure below and select Research tools on the drop down. 

Under the Research tools, select Regular points in the drop down. 
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ii. Once you click on the Regular Points, a window “Regular Points” shall pop up as shown in the Figure 
8b above. The “input boundary layer” shall be the shape file of the CF for which the sampling design is 
prepared. The Grid spacing shall be the spacing that is calculated in previous step (i). The grid thus created 
needs to be saved by giving a file name (e.g. Grid name of the CF) and saving in an appropriate folder. The 
file can be saved by choosing the appropriate folder using “Browse” tap in the window. After filling up all 
the requirements, click “OK” to generate the grid. 
 
iii. Once you click “OK”, a grid with spacing you provided shall be created as shown in the figure. For now, 
the name of the grid is given as Grid CF. However, since you need the grid just within the CF boundary, the 
grid thus created (Grid-CF) needs to be clipped with the CF boundary to get the final grid of the community 
Forest.  
How to do: 
• Go to the tap “Vector”. Click on “Geoprocessing tools” on the drop down and subsequently click on 

“Clip” as shown in the Figure 8c. 
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• A window “Clip” shall appear as shown in the Figure. “The input vector layer” shall be the Gird that 
is just created which is “Grid_CF” for this case. “The Clip layer” shall be the CF boundary shape file 
for which the sampling design is being created. The grid thus clipped needs to be saved by giving a file 
name (e.g. Grid name of the CF Final) and saving in an appropriate folder. The file can be saved by 
choosing the appropriate folder using “Browse” tap in the window. After filling up all the requirements, 
click “OK” to generate the final grid. 
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• The final grid of the CF is created as shown in the Figure below. 

 

 

b. Overlay the Grid in Google Earth 

The shape file of the Final Grid of the CF thus created can be transferred to Google Earth to have better 
view. Upon importing the shape file to Google earth, you can view the plots. 
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2) Allocation of plot ID and determining Geographical coordinates for individual plot 

Allocation of plot ID and determining Geographical coordinates for individual plot must be carried out in 
GIS.  

How to do: 

• Open the attribute table of the Gird CF final shape file. 
• Create three new fields named L2L (line to line), P2P (Point to Point) and Plot ID in the attribute table 

as shown in the Figure by using add field window. 
• Creating new fields in the attribute table. 
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• Three new fields L2L, P2P and Plot ID created. 

 
• Assign the values for L2L as AA, AB, AC, AD……. along the points vertically and P2P as 00, 01, 02, 

03, 04 … along the points horizontally. And finally generate the Plot ID by combining L2L and P2P as 

shown in the figures below. 
 
 
 
 
 
 
 
 
 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        427 

Assigning values for L2L as AA, AB, AC… 

 
 
o Assigning values for P2P as 00, 01, 02, 03, 04 

 

 
 

• Generating plot ID by combining L2L and P2P  
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The  

• Plot IDs for individual plots generated. 
•  

 
 

• Generate the Geo-coordinates for the plots by uploading the Plots in the DNR GPS (a software for 
generating the plot geo-coordinates) 

• Upload the Grid CF Final in the DNR GPS.  
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• A window shall pop up where Plot ID needs to be selected and then click OK. 

 
 

• Plot geo-coordinates are generated as shown in the figure below. 
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• Load the Plots along with its geo-coordinates in GPS  

 

 

3) Navigating to the plot by using the GPS with loaded plot IDs. 

To navigate to the plot, use the GPS which has loaded plot IDs as waypoints.  Upon reaching the plot within 
a distance of less than 10m, the GPS shall emit ‘BEEP’ sound indicating that you are approaching the plot 

center. 

4) Laying out of sample plots 

Mark the centre of the plot with a peg and write the plot number. Each plot shall consist of two circular 
plots. Major plot of 12.62 m radius (0.05 ha) and regeneration plot of 3.57 m radius (0.004 ha) are measured 
from the plot centre (Figure 2.4). The major plot shall be used for collecting tree data with dbh measuring 
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more than 10 cm. The regeneration plot shall be used for regeneration count with dbh less than 10 cm. Trees 
within the regeneration plot but measuring more than 10 cm dbh shall be counted as in major plot.  

 

 

 

 

 

 

 

Table 2.6 Major and Regeneration plots 

5) Data collection  

All recordings of the plot are entered into the tally sheet as per Format 2 given below.  

1.4.5. Format 2. Quantitative Forest Resource Assessment - Tally Sheet 
CF Name  Date  

Canopy height <5, <10, <20, <30, 30+ 
Block name  Canopy closure <10, <40, 40+ 
Plot number  Altitude  
Name of re-
corder  

 T = suitable for timber: N = Not suitable for timber 

 Dbh (cm) 

Species (lo-
cal name) 

Suita-
bility 

< 10 cm 
(seedlings) 

10-
19 

20-
29 

30-
39 

40-
49 

50-
59 

60-
69 

70-
79 

80-
89 

90-
99 

100+ 

 T            
 N           
 T            

N           
 T            

N           
 T            

N           
 T            

N           
 T            

N           
 T            

N           
 T            

N           
Total T            
 N           
 % N           

 

Plots Radius (m) Area (m2) Area (ha) dbh 

Regeneration 3.57 40 0.004 < 5 cm  

Major 12.62 500 0.05 ≥ 10 cm  

Figure 2.4 Plot Design 

12.62 m 

3.57 m 
Regeneration 
Plot 

 

Major Plot 
12.62 m 
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Proceeding clockwise, start enumeration of the plot from the north. Record the species and the dbh (to the 
nearest cm) of any live trees above 10 cm. Mark it by removing a small piece of bark/slashing the bark 
facing the plot centre. Make sure only trees with dbh above 10 cm is considered for enumeration in major 
plot and below 10 cm dbh for regeneration plot. 

6) Compilation  

After completion of the resource assessment, all data in the tally sheets must be transferred to compilation 
sheet (Format 4). The compilation sheet is filled based on the local volume table (Table 2.7) and dbh class. 
Compilation of the resources assessment data shall generate results for each species or group of species 
separately. For example, for a CF in temperate region all Broad leaves could be grouped together since they 
do not occur in sufficient numbers. However, other conifer species like Fir, Blue Pine, Hemlock, Spruce, 
etc. can be grouped separately as they are found in large numbers. Then start filling the compilation form 
(Format 4, Format 5, Format 6, and Format 7).  

• Col 1, 2 & 3 are the values from selected Local Volume Table. 
• Col 4 is the size of the plot in hectares. 
• Col 5 is the expansion factor for each dbh class which is calculated by using the expression EF = (1/size 

of the plot)/ number of plots.  
• Col 6 is the values for the total number of trees found for each diameter class which can be done by 

searching through the tally sheet.  
• Col 7 is filled by multiplying col 5 and col 6. 
• Col 8 is filled by multiplying col 7 and col 2.  
• Col 9 is filled by multiplying col 7 and col 3.  
• Finally add the values column 7-9. These are the sums for all the dbh classes combined. 
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Format 4: Forest Resource Assessment: Compilation Sheet 

 1. CF Name : .........................  
 4. Block 
Area : ………………   

 2. Block Name  : ..........................      

 3. Number of plots : ..................................  
5. Compiling 
date : ......................... 

col1 
  

col2 
  

col3 
(3 deci-
mals) 

col4 
(3 deci-
mals) 

col5 
(3 deci-
mals) 

col6 
(0 deci-
mals) 

col7 
(2 deci-
mals) 

col8 
(2 deci-
mals) 

col9 
(2 deci-
mals) 

dbh 
class 
(cm) 

basal area 
(m2) 

class 
volume 
(m3) 

plot 
size (ha) 

expansion 
factor 

Tally 
  

nrha 
(stems/ha) 

basha 
(m2/ha) 

volha 
(m3/ha) 

10-19 0.017               
20-29 0.047               
30-39 0.093               
40-49 0.156               
50-59 0.233               
60-69 0.327               
70-79 0.436               
80-89 0.561               
90-99 0.701               
100-109 0.858               
110-119 1.030               
120-129 1.217               
130-139 1.421               
140-149 1.640               
150-159 1.875               
160-169 2.125               
170-179 2.392               
180-189 2.674               
190-199 2.971               

     sum for all dbh classes       
 
Explanation:         
 
col3 : look up in volume table, for given  col6 : count and fill in   

    species group and dbh class  col7 
: col5 * 
col6    

 
col4 : plot size for given dbh class  col8 

: col7 * 
col2    

 col5 : (1/col4) / (nr. of plots)   col9 
: col7 * 
col3    

 (when rounding: round to the nearest EVEN digit; e.g. 0.635 to 0.64 but 0.665 to 0.66) 
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Spruce 
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fers 

Acer 

Betula 

Beilschmie-
dia spp. 

Cin-
namomum 

spp. 

Litsea spp. 

Michelia 
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Oak spp. 
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(C) 
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7) Generation of Results 

Stand and Stock Table Form 

Final results should be given in "Stand and Stock” tables (Format 5, 6 and 7). These are cross-tabular sum-
maries for diameter classes and species groups for our estimates of the 3 main parameters of interest:  

• Average number of trees per hectare (Format 5), 
• Average basal area per hectare (Format 6) and 
• Average volume of trees per hectare (Format 7).  

Fill in the stand and stock table form by copying the results of the compilation sheets for the appropriate 
diameter classes and species group. The above stand and stock results shall be generated automatically in 
the excel sheet (formulas developed in excel for National Forest Inventory). 
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8) Calculating Annual Allowable Cut (AAC) 

Annual allowable cut indicates the harvesting limit of trees including firewood and poles.  The Annual 
Allowable Cut of the Community Forest is calculated using the formula below: Add these together to get 
the total AAC for each size class from the CF. 

 
𝐴𝐴𝐶 (𝑚3) =  

𝑁𝑒𝑡 𝑜𝑝𝑒𝑟𝑎𝑏𝑙𝑒 𝑎𝑟𝑒𝑎 ∗ 𝐴𝑣𝑒𝑟𝑎𝑔𝑒 𝑣𝑜𝑙𝑢𝑚𝑒 𝑝𝑒𝑟 ℎ𝑒𝑐𝑡𝑎𝑟𝑒

𝑅𝑜𝑡𝑎𝑡𝑖𝑜𝑛 𝑎𝑔𝑒
 

(21) 

Where: 

Net operable area (ha) = net area of the CF meant for timber production. 

Average Vol/ha (m3/ha) = Average volume/ha derived from Stand and Stock Table  

Rotation age (year) = Average rotation age in Broadleaf = 110 year and Conifers = 120 year). 

The AAC (m3) should be calculated for different forest product categories using dbh class in equivalent 
number of trees (Table 2.8).  

Table 2.8 Annual Allowable Cut  

Annual Allowable Cut Table 
Annual Allowable 
Cut (AAC) 

Dangchung 
m3 

Tsim 
m3 

Cham 
m3 

Drashing 
m3 

Firewood 
m3 

Flag 
Poles 

Fencing 
Posts 

Block I        
Block II        
Block III        
…        
Total AAC        

Notes: for CFMG’s understanding, m3 can be converted into cft. (1 m3 = 35.32 cft).  
 

9) Non-Wood Forest Product Assessment 

The NWFPs assessment should be conducted if there is potential for commercial harvesting. Different 
resource assessment techniques have been developed for various NWFPs because: 

• Each species has a different growth pattern (annual, biennial, perennial) 

• Distribution is often heterogeneous (patchy) 

• Yield during different seasons (they may be absent during some seasons) 

• Different types of plants are involved e.g. trees, shrubs, herbs, grasses, fungi, mosses 

• Plant parts used are different for each species e.g. roots, stems, leaves, seeds, fruits, bark, resin, etc. 

• Use-patterns vary from domestic to commercial. 

 

How to Prioritize NWFPs 

• Discuss and decide with the CFMG members which NWFPs are available in CF area and commercially 
important to be included in the CFMP.  

• Complete the NWFP Priority Assessment Format (Format 3) and rank according to their priority (com-
mercial or domestic consumption).  

• If a NWFP is prioritized as commercially important, assessment needs to conducted and prescribe sus-
tainable management in the CFMP.  
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• If NWFPs are used only for domestic purposes, then you may not need to carry out resource assessment. 
However, it shall be useful to develop a set of rules for harvesting that can be included in the CF By-
laws.  

• When a NWFP becomes commercially important after initiation of the CFMP, you may include in the 
annual work plan and conduct the assessment or develop harvesting guideline to include in the CFMP. 

 

Format 3. NWFP Priority Assessment Format 

Name of NWFP Which 
blocks? 
(list block 
names/ num-
bers) 

Priority for commer-
cial (give a ranking 
between 1-5 where 1 
= highest and 5 = low-
est) 

Priority for domes-
tic consumption 
(give a ranking be-
tween 1-5 where 1 
= highest and 5 = 
lowest) 

    
    
    
    
    

NWFP resource assessment and harvesting should be done as per the guidelines developed by the Depart-
ment.  If there are no guidelines available for important NWFP species use the table below to carry out the 
resource assessment or seek assistance from SFED. 

Table 2.9 Recommended Resource Assessment for different NWFPs 

Recommended Resource Assessment for different NWFPs 

Sl. 
No. 

NWFP Local Name / common 
name 

Resource 
assessment 

Participa-
tory re-
source map-
ping 

Harvesting 
& manage-
ment rules 

1 Asparagus recemosa Nyakhachu (Dz)   ✓ 

2 Bambusa spp. Baa (Dz) ✓  ✓ 

3 Cane spp. Patsha (Dz) ✓  ✓ 

4 Mushroom spp. Shamu (Dz)   ✓ 

5 Aconitum spp. Bongkar (Dz) 
Bongnak (Dz) 

 ✓ ✓ 

6 Aconogonon tortusum Ngalacho (Dz)  ✓ ✓ 

7 Acorus calamus Chudala (Dz)  ✓ ✓ 

8 Artemisia spp. Khempa (Dz)  ✓ ✓ 

9 Asphalum punjabinum Drakzhu (Dz), Shilijit (Lh)   ✓ 

10 Casia fistula Rajbrikshay (Lh) 
Donkoshing (Sh) 

 ✓ ✓ 

11 Choerospondia axillaris Lapsi (Lh)  ✓ ✓ 

12 Ophiocordyceps sinensis Yar-tsha guenbub (Dz)   ✓ 

13 Cymbopogon spp. Lemon grass (Eng) 
Sorbhang (Sh) 

✓   

14 Daphne spp. Desho(Dz) ✓  ✓ 

15 Edgeworthia gardneri Dheykap (Dz) 
Argaylee (Lh) 

✓ ✓  

16 Diplazium esculentum Nakey (Dz)  ✓ ✓ 
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Dhawai (Sh) 

17 Diploknema butyracea Yega shi (Dz) 
Butter tree (Eng) 

 ✓ ✓ 

18 Elastosteme lineolatum Dham-boor (Dz) 
Drimom(Sh) 

  ✓ 

19 Entada eheedii Pangri (Lh) 
Kolokpa (Sh) 

  ✓ 

20 Fritillaria delavayi Tseka (Dz)  ✓ ✓ 

21 Gaultheria fragrantissima Chamze Kam (Dz) 
Machino (Lh) 

  ✓ 

22 Illicium griffithii Domleeshing (Dz) 
Khaila chinang (Sh) 

✓   

23 Juglans regia Tago (Dz), Khesey (Sh) 
Ohkar (Lh) 

 ✓ ✓ 

24 Litsea cubeba Siltimbur (Lh), Nenshing 
(Sh) 

   

25 Meconopsis paniculata 
Myricaria rosea 

Upel serpo (Dz)  ✓ ✓ 

26 Nardostachys jatamansi Wombu(Dz)  ✓ ✓ 

27 Neopicrorhiza scrophular-
iiflora 

Pangpoi (Dz), Jatamansi 
(Lh) 

 ✓ ✓ 

28 Neopicrorhiza acrophular-
iiflora/ Picrorhiza kurrooa 

Putishing (Dz), Kutki (Lh)  ✓ ✓ 

29 Paris polyphylla Satuwa (Lh)  ✓ ✓ 

30 Pedicularis longiflora lugru serpo (Dz)    

31 Pedicularis megalantha Lugru marpo (Dz)  ✓ ✓ 

32 Persia spp. Gooli (Dz, Sh)  ✓ ✓ 

33 Persia gamblei Kawla or Kathe Kaulo 
(Lh) 

 ✓ ✓ 

34 Phyllanthus emblica Churoo (Dz), Amala (Lh), 
Chorgrnsay (Sh) 

 ✓ ✓ 

35 Piper betleoides Pani or Paney (Dz) Pan 
(Lh) 

  ✓ 

36 Piper hamiltonii Jungali pan (Lh)   ✓ 

37 Piper longum Pipla/peepla Lh)   ✓ 

38 Piper pedicellatum  Pipla ✓ ✓  

39 Podophyllum 
Hexandrum 

Bamarpoo (Dz) 
 

  ✓ 

40 Resin Thangchu (Dz)   ✓ 

41 Rheum australe Chutsa (Dz)   ✓ 

42 Rheum nobile Chhukkha metog (Dz)    

43 Rhododendron anthopogon Balu (Dz), Dali Metog  ✓ ✓ 

44 Rhododendron setosum Soonpati or sunpatey (Lh) 
Sulu (Dz) 

 ✓ ✓ 

45 Rubia cordifolia Tsoy (Dz), Majito (Lh), 
Lanyi-roo (Sh) 

 ✓ ✓ 

46 Sapindus mukorossi Soap nut (En), Ritha (Lh), 
Nakapani (Dz) 

 ✓ ✓ 
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47 Swertia chirayita Chirata (Eng), Chiraito 
(Lh) 

✓ ✓ ✓ 

48 Symplocas paniculata 
 

Pangtse (Dz), Zim-shing 
(Sh), Gunilo (Lh) 

 ✓ ✓ 

49 Taracum eriopodum Khurmong (Dz)  ✓ ✓ 

50 Terminalia bellirica Baru, Baroo (Dz, Sh)  ✓ ✓ 

51 Terminalia chebula Aru, aroo (Dz, Sh), Har-ra 
or Ha ro (Lh) 

 ✓ ✓ 

52 Thysanolaena latifolia Tsakusha (Dz, Sh), Kusho 
or amlisa (Lh) 

 ✓ ✓ 

53 Zanthoxylum armatum Thinngey (Dz), Timbur or 
Timur (Lh), Gi (Sh) 

 ✓ ✓ 

54 Zizyphus mauritiana Bayer (Lh), Tshoshing 
(Dz) 

 ✓ ✓ 

55 Viscum nepalensis Nyashingjormo (Sh)  ✓ ✓ 
 

Step 5. Forest Produce Prioritization and Species Preference Ranking 

These PRA exercises are carried out to identify which product and species are important for the 
CFMG members through product prioritization and species preference ranking. It is encouraged to 
be conducted separately in male and female groups.   

How to conduct forest product prioritization 

• List the forest products on the chart as shown 
inFigure 2.5. 

• Pairwise ranking is used to find out which forest 
products are most important. Figure 2.5 is an ex-
ample which indicates water (6), as most im-
portant followed by timber (4), grazing (4), fod-
der (4), leaf litter (2) and firewood (1). In this 
case, the CFMP should contain more emphasis 
on water. 

• When a timber product is ranked as first priority, 
you should then do a species preferences and 
availability ranking as shown in Table 2.10. 

 

Table 2.10 Species Preference and Availability table 

Species Preference and Availability table 
Species/Local 
name  

Uses → Drashing Cham Fencing 
Posts 

Firewood Flag 
poles/Dangchung 

 Preference      
Availability      

 Preference      
Availability      

 Preference      
Availability      

 Preference      
Availability      

Figure 2.5 Forest Produce Prioritization Matrix 
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How to conduct species preference and availability exercise 

• If a particular species is not available in the CF, do not include in the prioritization table, even if that 
species is highly preferred by the CFMG. 

• Write the list of species down the left side of the table and products on top of the table. You can also 
include shrubs and herbs if these are important. 

• Ask participants to decide which species are the most important for each product. 

• For each species give a value (between 1 and 5 symbols) showing how important the species is for that 
particular product – this is the species preference. For example if oak is the most highly preferred species 
for fodder then give a value of 5.  Put symbol (X) to show the preference. 

• Assign a value to each species to show how scarce or abundant it is in the CF – this is availability e.g. 
if oak for fodder is scarce then give it a value of 1. Put symbol () to show the availability.  

• Some species can be used for more than one product e.g. oak can be used for timber, fodder and 
fuelwood. In this case record all information but values in preference and availability may differ. 

• Mention which species are preferred most and which species are available in the CF. Write them in the 
CFMP. 

• Use both local name and scientific names in the CFMP for the species recorded in this table. 

Mark with symbols to show rating e.g. XXXXX = high preference,  = highly available and X = 
low preference,  for less available. 

Note: When preparing the CFMP ensure that all produces with high priority are covered. Where 

there is a big gap between preference and availability, measures to address these gaps should be 

included in the management plan. 

 

Step 6. Forest Produce Demand Assessment 

Forest Produce Demand Assessment is conducted to quantify the annual forest produce requirement of the 
CFMG members. The assessment should be done annually during annual work plan preparation to get more 
accurate information. 

How to carry out Forest Produce Demand Assessment 

• Divide participants into small groups. If possible have separate groups for men and women. 

• Each group should prepare a list of forest products they use. This should be as detailed as possible and 
include all forest produce – not just those that come from the proposed CF area. For example, don’t just 

write “timber” but try to have sub-categories such as Drashing, Cham, Tsim, Dangchung/flag poles, 
fencing posts, firewood, etc. 

• Ask each group to estimate their annual household requirement for each produce. You may use local 
measurements e.g. timber should be estimated in terms of numbers of trees, poles, etc. Or if in cft or m3. 
Firewood could be measured in back loads or truck loads, or if possible in cft or m3. 

• Collect the individual household requirements during annual meetings and compile them in the table 
below 
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Table 2.11 Forest Produce Demand Assessment Format 

Produce Annual requirement   
(estimated) 

Number 
of HH that 
require 
produce 
annually  
(C) 

Total requirement of the 
produce (Annually) 

Total requirement of pro-
duce in 10 years 

 Number 
(A) 

Volume 
(in cft or 
m3)  
(B) 

Number 
(A*C) = D  

Volume (in 
cft. or m3)  
(B*C) = E 

Number 
(D*10) 

Volume (in 
cft. or m3)  
(E*10) 

For new Construction      
e.g. 
Drashing 

5 200 cft. 10 50 2000 cft. 500 20,000 cft. 

        
For renovation/extension      
e.g. 
Drashing 

2 150 cft. 15 30 2250 cft 300 22500 cft. 

        
For other construction (toilet, cowshed, etc.).    
e.g. Cham 2 100 cft. 8 16 800 cft 160 8000 cft. 
        
For other produce      
Firewood 2 150 cft. 25 50 3750 cft. 500 37500 cft. 
Bamboo 1200 - 10 12000 - 120000 - 
        

 

• For sustainable management of the CF, encourage CFMG members to write down their actual forest 
produce requirements.  

• When you have covered all the households, estimate the total CFMG annual requirement for different 
produces.  

• If all households are not present, ask participants to estimate how many households in the CFMG shall 
actually use the produce. For example if out of 60 households, only 55 actually require fodder this 
should be noted. If all households use the produce, then write “all”.  

• Calculate the forest product requirements for the whole CFMG by multiplying household use by the 
number of households. Record this information in the summary format provided below. 

Table 2.12 Example of Forest Produce Demand Assessment (Summary) 

 

Example of Forest Produce Demand Assessment (Summary) 
Produce 
 

Annual household requirement (es-
timated) 

Number of households us-
ing the produce 
(if all then write “all”) No. of trees Volume (cft. or m3) 

Drashing 80 4250 cft. 25 
Cham 16 800 cft. 8 
Tsim    
Dangchung    
Firewood 50 3750 cft. 25 
Flag Poles    
Fencing Posts    
NWFPs (bamboo) 12000  10 
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• Mention annual requirement of timber and number of households requiring the timber and calculate 
total annual in ten-year plan period. 

• Facilitate in calculating the requirements of timber and firewood in Cft or cubic meters, except for 
fencing posts and flag poles. 

• Refer Format 5 to calculate number of trees. 

• Refer Format 7 to calculate volume in m3. 

Comparison of AAC and Demand 

The table below compares the AAC (supply) from the CF and demand of the CFMG. In the comment’s 

column, write whether the AAC is sufficient to meet the demand. If not, then mention how and from where 
the demand shall be met e.g. it may be met from state reserved forests. 

Table 2.13 Annual Allowable Cut and Demand Format 

Annual Allowable Cut and Demand Format 
Produce Total AAC Total Annual Demand Difference Comments 
 No. of 

trees 
Volume 
(either in 
cft or m3) 

No. of 
trees 

Volume 
(either in cft 
or m3) 

No. of 
trees 

Volume 
(either in cft 
or m3) 

 

Drashing        
Cham        
Tsim        
Dangchung        
Firewood        
Fencing 
Posts 

    

Flag Poles     
NWFPs (list 
all NWFPs) 

    

     
 

Step 7. Calculating Carbon Stock 

An estimate of forest carbon stock is increasingly 
becoming important. Knowing how much carbon is 
stored in the forest helps to show how much the for-
est is contributing to climate change mitigation. If 
forest biomass is increasing it shall be capturing car-
bon from the atmosphere. If forest biomass is de-
creasing (or if the forest is being harvested) it shall 
lower the carbon sequestration capacity of the for-
ests. It may also release carbon back into the atmos-
phere and is thus contributing to increased levels of 
atmospheric CO2. 

With proper management, CFs have huge potential 
to enhance the carbon capture and storage. This shall 
require proper and regular measurement for monitoring of forest carbon stock. It becomes necessary to 
include it in the CFMP. Based on the forest resource assessment that has already been done it is possible to 
get an estimate of carbon stock. 

 

 

Figure 2.6 : % of total carbon in different forest components 
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Box 2.5  How to measure carbon stock 

1. There is a close relationship between carbon stock and biomass. Therefore, the first step is to 

calculate forest or tree biomass.  

2. On a large scale, forest biomass is estimated by finding out the total area of each forest type 

and using published figures for biomass (or carbon) per ha for each type.  

3. At local level it is possible to calculate the biomass of each individual tree using published bio-

mass tables or equations (usually based on tree diameter and/or height). Volume equations or 

tables based on dbh are more common. From these it is possible to estimate the stem volume 

of a tree of given dbh. Knowing this volume and other parameters such as timber density and 

branch/foliage/root proportions it is possible to estimate the tree biomass. Usually this is ex-

pressed in the form of dry weight (kg).  

4. From the sample plots from the forest resource assessment you shall know the number of trees 

per ha in different dbh classes for each block. Using volume or biomass tables you can then 

calculate the mean biomass of a tree of a particular dbh. Biomass tables show the relationship 

between dbh and total tree biomass (usually dry biomass). You can use these tables to calculate 

the biomass for each forest block. This is called above ground biomass (AGB). 

5. There is additional biomass in tree roots – this is called below ground biomass (BGB). For a given 

tree, about 30% of the biomass is BGB. Use this to calculate the total tree biomass. 

6. Roughly 50% of tree biomass consists of carbon. Therefore, calculate the total tree carbon as 

50% of AGB+BGB. 

7. As a rough approximation Bhutanese forests have about 140-150 tC per ha (if well stocked) not 

including litter and soil carbon and depending on forest type and age. 

8. Additional carbon is stored in litter and soil. Figure 13 above shows the % of total carbon in all 

4 components of the forest. 

This method shall enable you to estimate the approximate carbon stock of a CF. However, to meas-

ure it more accurately and to monitor changes in carbon stock is very complex and beyond the scope 

of this manual. We may have to develop a separate manual for carbon measurement in future. 

 

Step 8. Socio-economic Survey 

Socio-economic survey should be carried out after the member registration and the CF management 
committee election but before writing the by-laws and preparation of the CFMP. This is an important PRA 
because its outputs form part of the social information in the CFMP and it should trigger discussion on 
benefit sharing mechanism (equity) when framing the CF By-laws. All information from this PRA tool 
should be recorded on chart paper for later use. As the exercise deals with socially sensitivity, the 
information collected should be kept confidential . 

The CFMG members should be interviewed and the member household(s) should be earmarked so that 
during the time of benefit sharing discussion under the By-laws chapter, equity are taken care. The survey 
ensures first-hand information from the CFMG member households and facilitates a discussion within the 
CFMG about measures to reduce poverty and address equity. 
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Box 2.6 How to conduct Socio-economic Survey 

• Explain the purpose and procedures of the survey to the CFMG.  

• Interview the individual CFMG member to gather information 

• Compile and analyze the data after completion of the survey. You may have to discuss with your 

colleagues and group the member households into different well-being category (e.g. rich, 

medium and poor).  

• The CFMG is asked to come up with measures to reduce poverty and address equity; measures 

are written down on a chart paper and discussed; this part of the exercise can also be combined 

with the writing of the by-laws, climate vulnerability assessment. 

 

Form 2.2 Socio-economic survey sheet 

Socio-economic Survey Sheet 

Name and age of the respondent: House No.: Thram No.: 

NO. OF RESIDENT MEMBERS IN THE HH: Male: Female: 

No. of civil servants from the HH: No. of Monks/Nuns from the HH: 

No. of students from the HH: No. of members in armed forces: 

No. of HH members (others - specify):   

Total No. of HH members:  

Wetland (ac): DRYLAND (AC): Orchards:  

Kitchen garden ac/dc: KHIMSA AC: No. of HH members using cell phones: 

House type (tick) Three storeys  Two storeys One storey 

No. of cattle: No. of horses: No. of pigs: No. of poultry: 

No. of Goat: No. of Sheep: No. of Yak:  

No. of farm machiner-
ies: 

Tick and list the machineries (e.g. vehicles, Power chainsaw, Power tiller, Rice 
mill, Flour mill, Paddy trans-planter, sawmills, others 

Specify availability of any Livestock Farm 
(Poultry, Piggery, fisheries, etc.) 

 

Specify availability of any Agricultural 
Farm (Mushroom, vegetable, etc.) 

 

Source of income – specify: Average annual income (Nu.): 

 

Step 9. Climate Hazard and Vulnerability Assessment 

People living in rural areas are increasingly becoming aware of climate change and the effects on their 
livelihoods. Therefore, the assessment should be conducted to determine the impacts of climate change (and 
might be in the future) and to identify the vulnerable groups within the community. 

This shall enable the vulnerable households to climate change impacts to be more resilient through increased 
access to resources.  Various adaptation options resulting from this assessment should be included in the CF 
Management Plan. Remember that both forests and people are affected by climate change! 

Objectives 

• Assess how local climate is changing  

• Identify the most vulnerable households  
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• Identify vulnerable forest areas within the community 

• Recommend activities for coping with and adapting to climate change for inclusion in the CF 
Management Plan  

Outputs 

• A participatory map showing climate hazards 

• A ranked list of climate hazards showing which are most serious 

• A list of the groups most vulnerable to climate change 

• A suggested list of activities for coping with and adapting to climate change 

Equipment 

Flip-chart paper, colored pens, participatory map (prepared in the previous PRA exercise), well-being 
assessment matrix (prepared during the previous PRA exercise) 

Table 2.14 Climate Hazard Matrix (example #1) 

Climate Hazard Matrix (example #1) 

 Landslide Flood Drought Forest fire 
Animal dis-
ease 

Reduced crop 
yields 

Landslide x Flood Drought Forest Fire Landslide 
Reduced crop 
yields 

Flood  x Flood Forest Fire Flood Flood 

Drought   x Forest Fire Drought 
Reduced crop 
yields 

Forest Fire    x Forest Fire Forest Fire 

Animal 
disease 

    x 
Reduced crop 
yields 

Reduced 
crop yields 

     x 

Result: 1st = Forest Fire (5); 2nd = Flood (4); 3rd = Reduced crop yields (2); 4th = Drought (2); 5th = Land-
slide (1); 6th = Animal Disease (0) 

 

Table 2.15 Climate Vulnerability Assessment (example #2) 

Climate Vulnerability Assessment (example #2) (list of climate hazard based on ranking done in 
earlier exercise) 

Social group /sectors Forest 
fire 

Flood 
Reduced 
crop yields 

Drought Landslide Animal diseases 

List the social group based 
on socio-economic survey, 
e.g. rich medium and poor 
member. 

      

e.g. of sector: Forest, Agri-
culture, livestock, etc. 
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Box 2.7 How to conduct Climate Vulnerability Assessment 

1. Start by explaining the purpose of the exercise. Explain that climate seems to be changing worldwide 

and that different places are affected in different ways 

2. Ask participants to give examples about how they experience climate change and its effects in their 

village. With some facilitation many examples of these shall arise. Note them down on a piece of 

chart paper. The table gives some examples.  

3. Next show the participants the participatory resource map you prepared with them earlier. Ask them 

to show on the map where particular climate change effects seem to be taking place (this is called 

climate hazard mapping). Examples might include places that are liable to flood, drought, fire, land-

slides (due to heavy rain), springs that might be drying up etc. Mark these locations on the map (map 

the hazards) 

4. On a different piece of chart paper list all the climate hazards that have been identified and write 

them across the top and also down the left-hand side (see example #1) 

5. Ask participants to consider each pair of hazards in turn and decide which is most critical. Enter the 

most critical one in the box. After covering all the boxes, count the number of times each hazard 

was written down. The higher the number, the greater the hazard ranking. 

6. On a second piece of chart paper, list the climate hazards identified along the top of the paper in 

order of ranking (see example #2).  

7. Down the left -hand side of the paper list the social groups identified from the socio-economic survey 

and also list the major sectors in the community such as forest, agriculture, livestock horticulture, 

health, infrastructure, etc. 

8. For each social group and each sector ask participants to rate the vulnerability to each hazard iden-

tified along the top of the matrix (e.g. 0 = not vulnerable, 1 = low vulnerability, 2 = medium vulnera-

bility, 3 = high vulnerability, 4 = very high vulnerability) 

9. At the end you shall have a matrix that shows which groups and which sectors are most vulnerable 

to different climate hazards.  

10. Selecting those that are most vulnerable – ask participants what activities they think can be carried 

out to reduce the vulnerability. List these activities. 

 

Step 10. Waste Management in CFs 

Waste is a concern in the community forest areas. Waste management particularly the non-degradable waste 
in the CFs shall be addressed in consultation with the CFMGs. Waste prevention and management provi-
sions of the Waste Prevention and Management Regulation 2012 should be incorporated in the CFMP. 

Step 11. Forest Management Matrix 

The forest management matrix brings together information and ideas from other steps to identify problems, 
opportunities and objectives for the block and/or whole CF. CFMG members should identify activities to 
be included in the CFMP to achieve the CF management objectives (see Error! Reference source not 
found. to differentiate between the objective and activities).  

Box 2.8 Management Objectives 

Objectives are commonly confused with activities, 

e.g. “thinning” or “planting” are activities not objectives. The real objectives may be “to improve the 

timber crop in the future” or “to restore degraded forest areas”. 

If timber shortage is a problem, then the management objective might be “to increase the sustainable 

production of timber from the block”. 

Think of management objectives in terms of addressing the causes of any problems rather than their 

solutions. The solutions tend to relate to activities. 
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Table 2.16 Block-wise CF Management Procedures 

Block-wise CF Management Procedures – e.g. Block I 

1 Produce/services Drashing Firewood NWFPs 

2 Main species Blue Pine Oak Mushroom Yula 

3 Problems Forest fire Over lopping for 
fodder 

 Over harvest-
ing 

4 Opportunities 1. Surplus quantity 
2. Enterprise dev. 
3. Employment genera-

tion 

 Excess re-
source 

 

5 Management ob-
jectives (reflecting 
problems and/or 
opportunities) 

1. Income generation 
2. Reduce forest fire 

1. Reduce over 
lopping  

Income 
generation 

 

6 Activities to 
achieve the objec-
tive (mark as H, M 
or L) 

1. Sale of surplus timber 
(M) 

2. Value addition (H) 
3. Awareness (M)  
4. Creation of fire line (L) 

1. Support pasture 
dev. (L) 

2. Supply fodder 
seedlings (M) 

3. Restrict collec-
tion from CF 
(H) 

Sale of 
mush-
rooms 

 

7 Procedures 1. Follow timber market-
ing guidelines 

2. Seek support for fund, 
training on product de-
sign and dev. 

3. Seek support from rel-
evant office for aware-
ness before onset of the 
fire season 

4. Members to contribute 
labour, technical sup-
port from forest office 

1. Seek support 
from livestock 
department. 

2. Fodder seedling 
procurement 
from forest 
nurseries 

3. Regulate fodder 
collection from 
CF area 

…  

8 Responsibilities CFMG, concerned Forest office… 

Definitions 

Problem An issue which needs to be addressed in the management plan 

Opportunity A potential benefit which could be utilised in the management plan 

Objective The aim of carrying out certain management activities 

Activity The detailed tasks that have to be done to achieve an objective i.e. What? 

Procedure The way in which the activity shall be carried out i.e. How? 

Responsibilities The person(s) responsible for carrying out the activity i.e. Who? 
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Box 2.9 How to carry out Forest Management Matrix 

How to carry out Forest Management Matrix 

1. Prepare a separate forest management matrix for each block. Write the block name clearly at 

the top of this. 

2. Row 1. Write the main forest produce for the block. This information shall come from the Forest 

Product Prioritization Matrix and the Forest Resource Assessment. 

3. Row 2. List the tree, shrub or other plant species which are particularly important for this 

produce. 

4. Row 3. Describe any problems i.e. shortages in availability of different forest produce or mis-

match between the supply (AAC) and demand. Refer the Annual Allowable Cut and Demand For-

mat (Step 6). Also write down any biotic problems that were identified in the block during the 

Forest Resource Assessment and during PRAs such as fire, grazing, erosion, etc. 

5. Row 4. Identify any opportunities e.g. if there is a surplus of forest products that can be har-

vested to meet the demand or if useful NWFP species could be introduced by planting. 

6. Row 5. Based on the problems and opportunities, discuss and agree on management objectives 

(see box). It is helpful to think of management objectives in terms of the causes of problems 

rather than their solutions. 

7. Row 6. List the activities that need to be done to achieve the management objectives. Be as 

detailed as possible. Different activities shall be needed in different blocks. For each activity 

decide if it is high (H), medium (M) or low (L) priority and write this down. Check that all the 

activities are really needed by asking: If we carry out all these activities, then shall the objec-

tive be achieved? Several activities shall be needed to achieve each objective. Will all the prob-

lems be addressed? 

8. Row 7. Write down the detail procedures for each activity on how to carry out the activities. 

9. Row 8. Write down responsibilities for carrying out each activity. Responsibilities can be for 

individual, in group or for an agency. 

 

Step 12. Participatory Environmental Impact Assessment 

Environmental Impact assessment should be conducted to provide a broad view of environmental impacts 
and should also include socio-economic impacts. Environmental assessment should be carried out at the end 
of the CF management planning process but before the plan is finalized for approval so that all activities 
proposed for the CF can be included and assessed. Participatory Environmental Impact Assessment should 
be carried out by the CFMG: 

a) As a pre-requisite of the Environmental Assessment Sector Guidelines for Forestry (1999)  
b) To identify and avoid any negative environmental impacts of CF management activities.  
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Box 2.10 How to carry out participatory environmental impact assessment 

How to carry out participatory environmental impact assessment 

1. Prepare a chart as shown in the example below. In the boxes across the top, write 

down the potential impacts as shown here. 

2. List the activities proposed for the CFMP down the left-hand side of the paper. This 

information on activities should come from the Forest Management Matrix (Step 11). 

3. For each activity consider the potential environmental and socio-economic factors 

listed along the top row. For each of these discuss whether the proposed activity shall 

have a positive effect, negative effect, or no effect. Show positive impacts by (+), 

negative impacts by (-), and no impacts by (0). The number of plusses or minuses should 

show how strong the potential effect is e.g. if timber harvesting is thought to have a 

strong negative effect on soils (if it might cause erosion), then get the group to put -

---- in the relevant box (see example shown) 

4. In a separate table drawn on a large sheet of paper, list each activity which has one 

or more minus sign in the participatory environmental assessment chart taking partic-

ular note of: 

• Areas close to public roads and forest roads 

• Steep slopes 

• Areas lying near streams, rivers and water bodies 

• Blocks with highly critical catchment condition, etc. 

For each activity describe in a separate box any procedures that shall be taken to avoid 

or reduce negative impacts. These procedures must then become part of the CF Manage-

ment Plan (see examples in Table 2.17). 
 

Table 2.17 Example of a Completed Participatory Environmental Assessment Chart 

Example of a Completed Participatory Environmental Assessment Chart 

 Potential Environmental 
Effects 

Potential Socio-Economic Effects 

Activity proposed in CFMP 
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il 
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Plantation establishment + +++ 0 + -- 0 -- 0 

Fuelwood harvesting - - - - 0 0 0 ++ 

Flag pole harvesting 0 0 0 - + ++++ 0 ++ 

Timber harvesting --- --- -- --- + + ++ ++ 

Grazing control ++ ++ + ++ - 0 0 -- 

Fire control + + ++ +++ 0 0 0 0 

NWFP collection 0 0 0 - + ++ + + 

Forest protection 0 0 ++ +++ ++ + 0 -- 

Soil and water conservation activities ++ ++ + ++ 0 0 + 0 

POSITIVE EFFECT SHOWN BY + + +    NEGATIVE EFFECT SHOWN BY - - -   NO EFFECT (OR 
NOT RELEVANT) SHOWN BY 0 
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Example of Procedures to address potential negative effects 

Activity Procedure 

Plantation establishment Local graziers shall be provided with alternative grazing areas.  
Grass shall be available for cut and carry from plantation areas 
Native or local species shall be planted 

Fuelwood harvesting Quantities shall be controlled 
No felling on steep slopes shall be allowed 

Timber harvesting Felling shall be regulated according to sustainable harvest levels.  
No felling on slopes > 50% 
No log rolling down slopes  
No felling within 20 m of water courses 
Timber shall be distributed within the CFMG according to priority of needs 

Grazing control As for plantation establishment 

NWFP collection The following rare species shall not be collected (list of species) 

Forest protection All CFMG members shall take part in protection 
Wherever possible, forest products shall be utilised from the CF providing this 
can be done sustainably. 

 

Step 13. Preparation of CFMG By-laws 

CFMG By-Laws should be prepared; 

(a) For legal reasons 

In accordance with Section 78 (3) of the FNCRR 2017, “CFMG shall adopt by-laws with clear management 
objective, rights and responsibility, allocation and utilization of forest resources, fund management 
addressing the issues of sustainability”. That is why we have fund management section in this manual. 

In accordance with Section 78 (4), “The management plan shall have separate section for the by-laws 
prepared by the CFMG in accordance with the relevant policy and laws”. 

In accordance with Section 79, “CFMG shall prepare and adopt by-laws observing good governance 
principles such as participation, transparency, accountability, equity and inclusiveness”.  

(b) Promote good governance of the CFMG in order to: 

• Identify and target disadvantaged households  

•  Ensure that CFMG members opinions and views are heard  

• Have transparent and fair decisions 

• Ensure CFMG committee represents all the interest groups in the village 

• Emphasize and encourage women participation in decision making body  

 

 

 

 

 

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        455 

Box 2.11 How to frame CFMG By-laws 

How to frame CFMG By-laws 

All the members of the CFMG shall be present during framing of the by-laws. The CFMG should not 

include anything in their by-laws that contravenes the FNCRR 2017. All the topics in the table below 

can be included – as well as any additional items e.g. covering CFMG governance, equity and benefit 

sharing, fund management, etc. it is important that everyone in the CFMG should understand the 

by-laws and agree with it. Refer specific Chapter and Steps of this manual when framing the by-

laws. Specific steps are as follows: 

1. By the time you reach this step you may already have prepared the CFMP. Bring all the materials 

you have from this. Ensure that you also have a copy of the FNCRR 2017. 

2. Organise a meeting with all members of the CFMG. You might expect this meeting to last for a 

full day, so plan with this in mind.  

3. Start the meeting by explaining what the By-laws are and how these differ from the CFMP. 

4. Go through the list of items for the By-laws. As you go through each item first check to see 

whether anything has already been agreed in earlier planning stages (the forest management 

matrix shall probably be the useful sources of information). If anything has already been dis-

cussed and agreed, then read it out and record it. 

5. Ask participants what can be written in the By-laws in addition to what has already been agreed 

during earlier planning steps. For each of the items in the By-laws, some questions have been 

provided in the table for you to ask and discuss. 

6. It is extremely important to record all the answers (once they have been agreed). Write them 

down on a large sheet of paper. 

7. Finally, read everything that has been written down to the whole group.  

8. It may be helpful to divide into sub-groups of different stakeholders e.g. women, youth, etc. 

and get each subgroup to go through everything that has been written down. At the end let 

them give their comments or agreement/disagreement to the whole group. 

9. This written material can only become the formal by-laws if everyone agrees.  

10. Back in the office the by-laws need to be typed out.  

 

Content of By-laws Checklist for facilitator(s) 

CFMG Name What is the name of the CF and the CFMG? (It can be same) 

1. Membership arrangements How is membership defined? 
Who is eligible for membership of the CFMG? 
What are the procedures for becoming a new member?  
What are the procedures for leaving the CFMG? 
For both new members joining use Annex 12 and for members 
leaving the CFMG, use Annex 13 as an application form. 
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Content of By-laws Checklist for facilitator(s) 

2. CF Management Committee for-
mation 

• It is recommended to have three posts in the CFMGs to make 
it standard and uniform. They are Chairperson, Secretary and 
Treasurer.  

• These posts are highly recommended to be elected though se-
cret voting procedures and each and every CFMG members 
should vote.  

• You should facilitate and ensure that at least one of the CF 
Management Committee member is women.  

• Let the CFMG decide the term for the management commit-
tee and the procedures for leaving or appointment of the com-
mittee 

• Ensure formal handing/taking between the new and old post 
holders as per Annex 16.  

3. ToRs for CF Management Com-
mittee 

There are suggested ToRs for CF Management Committee 
(Chairperson, Secretary and Treasurer), refer Chapter V Step 1.3) 
However, you can ask the CFMG members to add on. 

4. Roles and Responsibilities of 
the CFMG  

• Add general roles and responsibilities of the CFMG. 
• Refer Section 86 of FNCRR 2017 and see what are they em-

powered with? 

4. Benefit sharing mechanism • What procedures shall be put in place to ensure equity? 
• What procedures must be followed for harvesting forest pro-

duce (both timber and NWFPs) from the CF e.g. timing, 
marking, etc.? 

• What are the rules about collecting different forest produce? 
E.g. what produce, quantities, collection times, seasons, etc. 

• What provisions shall be made for particular household e.g. 
disadvantaged, single woman-headed household, etc.? 

5. Fees (products/ services fees, 
membership fees, etc.) 

• Nominal membership fees have to be collected but the 
amount and frequency shall be decided by the CFMG.  

• Fees (royalty) for CF produce including NWFPs, sand, boul-
ders and other services shall be decided by the CFMG. How-
ever, the royalty rate shall not exceed the existing rural subsi-
dized rates. 

6. Managing CFMG Fund • What are the possible sources of funds for the CFMG? E.g. 
sale of surplus products, fees, fines, etc.  

• How CFMG fund should be managed?  
• Details on fund management is given in Chapter V, Step 8.4 

of this manual. 

7. Timber marketing (and marketing 
of other forest products) 

• Check whether the CF have potential in marketing of the tim-
ber or other forest produce. 

• What products can be marketed?  
• How value addition can be done to enhance the income for 

the CFMGs? 
• Refer “Marketing Guidelines for Wood-based Products from 

Community Forest 2017” and for NWFPs, refer the “Frame-

work for Management and Marketing of Non-Wood Forest 
Products”. 
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Content of By-laws Checklist for facilitator(s) 

8. Record Keeping • What records shall the CFMG keep?  
• Who is responsible for keeping them?  
• How it shall be shared among the CFMG members and with 

concerned forestry offices? 

9. Meetings • It is recommended to have at least one CFMG general meet-
ing/assembly in a year.  

• The frequency of CF Management Committee meetings can 
be decided by the CFMG, based on need. But ask the follow-
ing questions to the CFMG. 

• How often shall the CF Management Committee meet and for 
what purpose?  

• How the minutes of the meetings are maintained and shared? 

10. Offences and Penalties • The amount of fines and penalties for both CFMG members 
and outsiders related to natural resources shall be based on 
the provisions mentioned in Section 416 of the FNCRR 2017.  

• The fines and penalties collected from both CFMG members 
and outsiders can be deposited in the CF account as per the 
fund management section in this manual.  

• Fines and penalties collected from other offences related to 
wildlife, birds, hunting/poaching, forest fire, etc. shall be col-
lected by the concerned forestry offices based on existing sys-
tems.  

• CFMGs can decide on the amount of fines and penalties and 
impose if their member(s) are absent from CF developmental 
activities, meetings, etc.  

• CFMG may also frame fines and penalties if the CF Manage-
ment Committee members are misusing their powers and not 
performing their duties as per the ToRs.  

• The concerned forestry offices shall assist the CFMGs in col-
lecting the fines and penalties with regard to CF and its re-
sources/services.  

11. Conflict management • How shall conflict be resolved/managed? 
• If not resolved, where it shall be forwarded? 

12. Amendments of the CFMG By-
laws 

• CFMGs can amend their CFMG By-laws with prior approval 
from the Department.  

 

Step 14. Writing the CF Management Plan 

The Community Forest Management Plan (CFMP) should be written, in national language. Otherwise, the 
English version of the Plan should be translated to Dzongkha. The Plan should be prepared as per the stand-
ard format/template in. Table 2.18 This section refers to this format and explains where the information to 
complete each section comes from.  
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Table 2.18 CFMP content/template 

CFMP Content/Template 
Cover Page/Title 
Approval Sheet 
Table of Contents 
Acronyms 
Executive Summary 
Part I: Introduction 
Total community forestry area ________________________hectare/acre 
Community Forestry Map (2 maps, 1: map with boundary, 2: GIS Land use/land cover map, showing net 
production area of the CF) 
Community Forest boundaries  

Boundaries Permanent Features 
West   
East  
South  
North  

 
Social Information 

 Description 
Name of the villages  
Ethnic groups with CFMG  
Basic amenities  
Total Household (HH) number of CFMG  
Population of CFMG  
% male and % female  
Main source of income  
Cattle population of the CFMG  
Main crops  
Cropping pattern  
Any other information  

 
Forest Information (whole forest) 
 
Annex 1, Format 1 shall be written here! (Format 1 is used for each CF block). Each block with respective 
AAC 
Forest Management (including objectives) 
Demand assessment 
AAC and demand comparison 
Participatory Environmental assessment including procedures to address negative environmental effects 
Climate hazard assessment 
Forest produce ranking matrix 
Monitoring Plans (Forest Resource Monitoring Plan, social & institutional monitoring plan) 
AWP 
 
Part II - By-Laws (refer Annex 5 for the contents/template for By-laws) 
Annexes under the CFMP 

1. CF application along with CFMG member list signed  
2. CF boundary GPS coordinates 
3. CF sample plot GPS coordinates 
4. Compilation sheet 
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If all the steps 1-13 above have been completed, all the necessary information to complete the CFMP shall 
already be available. All the PRA tools need not be written in the CFMP. However, the results or the outputs 
of the PRA tools may be included in the CFMP. 

Step 15. Monitoring and Evaluation Arrangements 

The arrangements for monitoring and evaluation are extremely important and must be included in the CFMP 
from the beginning. The different stages of monitoring and evaluation that can be used for these are de-
scribed fully in Error! Reference source not found. of this chapter. 

2.3.3 Approval Process of the Community Forest 

After preparing the CF Management Plan and By-laws, the CFMG should submit the plan through the CFO 
to the Social Forestry & Extension Division (SFED) for technical review and approval by the Department. 
This involves following steps: 

Step 1. Submission of the CFMP to the Department  

After final review of the draft CFMP by the CFO, the CFMP should be submitted to the Department through 
SFED. 

Step 2. Review by SFED 

SFED should review the CFMPs in detail. Upon review, SFED shall return the management plan to the 
Divisions/Parks for any necessary changes. If there are any pertinent issues that warrants a visit, SFED may 
make a field visit. After incorporating the necessary changes, SFED should seek approval of the plan from 
the Department and notify the Division/Park. 

Step 3. Issuance of the CF Ownership Certificate 

Upon approval of the CFMP by the Department, the CFO of the concerned Division/Park and the Gup of 
the concerned Gewog shall co-sign the Community Forest Ownership Certificate (Annex VII of the FNCRR 
2017) and formally hand over to the concerned CFMG along with a copy of approved plan.  

After the Community Forest Ownership Certificate has been awarded, the CFMG can start to implement its 
CF Management Plan and By-laws with the technical support from forestry staff for:  

• Participating in CFMG meetings 
• Conflict management 
• Skills development and training 
• Monitoring, reporting and planning  
• Helping to solve specific problems 
• Developing linkages with other CFMGs  
• Developing commercial linkages for forest product development and marketing 
• Others 

2.3.4 Implementation 

The implementation of the CF shall be guided by Sections 86 to 89 of FNCRR 2017. Forestry staff shall 
provide technical support for implementation of all activities. CFMG and management committee members 
often lack basic technical and administrative skills and self-confidence to implement their CFMP from the 
start. To help them to become more self-reliant and to keep them motivated, capacity building shall be 
needed. This could be in the form of training events covering different topics or simply on-the-job training 
and support. The support role of the Forestry staff includes: 

• Technical assistance for implementing the CF management plan 

• Tree marking e.g. for thinning or harvesting 
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• Seedling raising, distributing and planting 

• Encouraging the committee to meet regularly and facilitating the meetings 

• Helping to get good participation including gender during meetings 

• Communicating between the CFMG and the CFO 

• Training and developing new skills amongst CFMG members 

• Helping to resolve conflicts  

• Providing information to the CFMG about the FNCRR and other legal matters 

• Helping the committee to keep records and accounts 

• Monitoring CFMG activities and helping with self-monitoring  

 

The main implementation responsibilities of CFMGs (according to FNCRR 2017) 

1. Marking of forest produce (90) 

2. Issuing permits (90) 

3. Harvesting (93-95) 

4. Royalties and permits (101) 

5. Sale of forest produce (98-100) 

6. Transportation of produce (96-97) 

7. Formation of CF Networks and Association (108-109) 

Step 1. CFMG Governance 

Governance is about how the CFMG operates as an institution. It focuses especially on the processes and 
relationships within the CFMG and the extent to which they follow certain principles of ‘good governance’:  

Transparent Are decisions made in an open and easily understood manner? 

Accountable Are decision makers accountable to the wider group (CFMG members) and can 
sanctions be effectively imposed in case of infringement or poor decisions? 

Responsive Are decisions and activities responsive to the needs of the wider group – espe-
cially poorer and disadvantaged members? 

Equitable Are benefits distributed fairly and in favour of disadvantaged members? 

Participatory Are decisions and all processes made in a way that involves a range of different 
stakeholders? 

Legal Does the group and its members and representatives operate in compliance with 
the law? 

Efficient (cost effec-
tive) 

Are decisions and activities those which shall give the best or greatest results at 
the least possible cost? 

 

Good governance in CFMG is critical for ensuring the effectiveness and sustainability. A number of weak-
nesses in CFMG governance are identified and support is required to address these. Some of the perceived 
weakness include transparent decision-making, equity (including pro-poor decision-making and benefit 
sharing); record keeping; fund management and monitoring. 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        461 

CFMG Meetings and Decision-Making 

CFMGs should function as democratic and accountable institutions. All decisions should be taken during 
meetings where CFMG members have an opportunity to discuss and share ideas. Usually there should be 2 
types of meetings;  

(i) CFMG meetings (sometimes called general assemblies) which are held infrequently (perhaps annually) 
and  

(ii) (CF Management Committee meetings which are held more often depending on the need. 

An important aspect of CFMG governance concerns how such meetings are organised.   

Table 2.19 CFMG Meetings 

Why are CFMG meetings needed? 

• For information sharing and communicating within the CFMG members. 

• For decision making and planning by the CFMG. 

• For building the capacity of CFMG members. 

• For addressing problems and issues as they arise. 

• For fund management and transparency. 

How to conduct CFMG meetings 

There are 4 steps for conducting an effective CFMG meeting (this applies to both CFMG meetings and to 
CF Management Committee meetings): 
(a) Preparing for the meeting; (b) Conducting the meeting; (c) Recording the meeting; (d) Evaluating the 
meeting 
(a)  Preparing for a meeting 
1. Plan the meeting and prepare an agenda beforehand listing the topics to be covered. An example of a 

meeting schedule is given below. 
2. Ensure that each session of the meeting has a clear objective 
3. Decide how each session shall be conducted (it is often better if different sessions are facilitated by 

different people) 
4. Make sure that a copy of the CFMP and the FNCRR 2017) is available during the meeting. 
5. Decide who should attend the meeting and issue invitations – especially to anyone from outside the 

CFMG e.g. the concerned Gewog Forestry Officer, other Local Government officials. 
6. Issue invitations in good time and mention the purpose of the meeting, the date, time and venue. 
7. When about two-thirds of the expected participants have assembled you can start the meeting. If not, 

wait for half an hour for the full or required number of participants to assemble. 
8. Arrange the seating in such a way that all the participants and facilitators can see each other. Seat 

them in a circle to ensure full participation.  
9. Avoid a situation where some people sit on chairs and others on the floor. This is to maintain a feeling 

of equality and a non-domineering atmosphere. If there aren’t enough chairs then everyone should sit 

on the floor. 
(b) Conducting a meeting 
1. Welcome all the participants to the meeting. Stress that their participation is vital for the meeting’s 

success. 
2. If some participants are sick or drunk (and therefore unable to fully participate) ask them politely to 

leave and rest in their houses. 
3. Tell participants that they should ask questions for clarification during the presentations. Whoever 

wants to do so should raise their hands first. 
4. Follow the planned schedule. Present each session clearly, slowly and loud enough for everyone to 

hear.  
5. After discussions and when decisions have been reached, summarize the important points for partici-

pants. Repeat all-important points several times so that participants shall remember them. 
6. Control persons who speak for too long. This is to give others a chance to speak. 
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7. Encourage shy participants to speak by politely asking them questions about the point being discussed.  
8. Use jokes but don’t embarrass any of the other participants. 
9. Keep the duration of the meetings in mind. As far as possible stick to the schedule. If necessary, you 

can postpone some points until the next meeting. 
10. If some participants sleep or cannot concentrate fully call a short break. You may have to change your 

style of presentation to make it more interesting.  
11. If somebody talks endlessly and is affecting the time allotted politely ask them to allow other partici-

pants to give their views.  
12. If someone becomes angry or argumentative give the person’s points to the whole group to make their 

suggestions about how to deal with the issues. 
13. If everybody starts talking simultaneously raise your hands or clap your hands to get attention. Say 

that it is difficult to hear anything if everybody speaks at a same time. Those wishing to speak should 
raise their hands for them to be given the opportunity to speak one at a time. 

(c) Recording the meeting 
1. During every meeting keep notes. After the meeting the Secretary prepares the minutes so that a record 

of the agenda, issues discussed, actions decided and CFMG member attendance is kept.  A format for 
recording meetings is given in Annex 2 Format 9. 

2. The minutes are read out at the start of the next meeting to remind participants what was agreed and 
discussed. 

3. Minutes should be filed in a separate folder and kept in a safe place. 
(d) Evaluating the meeting 
• After the meeting, consider the following questions: 
• Were the objectives of the meeting met 
• How well was the meeting conducted? 
• What lessons can be learnt from this meeting that are useful for conducting future meetings more 

effectively? 

 

Equity and Benefit Sharing 

Equity is an important aspect of CFMG governance because community forestry is expected to benefit 
poorer people. Equity concerns the distribution of benefits as well as CFMG decision-making and contribu-
tions of labour and other resources by CFMG member households. The CFMG should address the issues of 
poverty. The first step is to identify the poorest and most disadvantaged households and the reasons from 
the socio-economic survey. This shall indicate which households require most support and the kind of as-
sistance they may need. 

The Table 2.20 indicates the types of questions that need to be discussed by the CFMG in order to improve 
their equity and benefit sharing systems to become more pro-poor. Some of these may already have been 
discussed during preparation of the CFMG by-laws but they shall need to be reinforced through regular 
discussion.  

Table 2.20 Type of questions to be discussed 

Area of question Type of questions 

Social capital About representation of disadvantaged households in the CFMG and their 
effective participation. Is this sufficient? Are there problems? 

Human capital About trainings that are provided for CFMG members? Who normally ben-
efits? Are the most disadvantaged households involved?  

Natural capital About arrangements for forest product distribution for disadvantaged house-
holds. What are the arrangements? 

Financial capital About use of CFMG funds, credit, subsidies and interest rates and how these 
affect disadvantaged households. Who benefits? Who loses? 
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Physical capital About the any infrastructure activities carried out by the CFMG. Do these 
have any benefits/costs for disadvantaged households? 

Rule of law About provision for disadvantaged groups in the CFMG By-laws and man-
agement plan. Are these provisions effective? Are they being followed? 

Identification of disadvan-
taged households 

About the well-being assessment. How was it was done? What were the re-
sults? Are they being used to target poorer households>? 

 

Box 2.12 Key aspects of equity in CFMG benefit distribution 

Key aspects of equity in CFMG benefit distribution 

• All CFMG members are eligible to use forest products from the CF. 

• Produce should be equitably distributed among CFMG members – this means according to their 

requirements rather than their ability to pay. 

• If there is high demand for forest products from both CFMG members and outsiders, CFMG 

members must have priorities. 

• If there is high demand for forest products within CFMG members, those CFMG members who 

are socio-economically disadvantaged have priority over others.  

• Particular attention needs to be given to ensuring that all CFMG members are involved in making 

decisions – especially those which concern distribution of forest products e.g. rates, quantities, 

timing etc. 

• Contributions of labor e.g. during planting activities, should also be equitable – this means that 

disadvantaged households should not be expected to contribute more labor than others. 

 

CF Management Committee 

Committee members should be elected bearing in mind that there is considerable responsibility involved. 
They are expected to attend meetings and implement tasks on a regular basis. Only individuals who are 
prepared to take on these responsibilities should be elected. CFMG members elect their own representatives 
for the CF Management Committee through secret ballot. The CF management committee should genuinely 
represent all the CFMG members including women.  

Composition of the CF Management Committee 

To maintain uniformity, three posts: Chairperson, Secretary and Treasurer are suggested in all the CFs. Their 
term shall be decided by the concerned CFMG facilitated by the concerned Forestry Officials. Other mem-
bers like Resoop, Messenger, etc. can also be nominated based on need decided by the CFMG. The CF 
Management Committee must have good representation of men and women. 

Suggested roles and responsibilities for the CFMC are described below. However, additional tasks and re-
sponsibilities can also be added.  

1. Represents the CFMG in its interactions with other agencies including the forestry staff 

2. Represents CFMG members during preparation and implementation of the CFMP. 

3. Coordinates and organizes the administration of CF activities and operations and ensures that CFMG 
members fulfil their management responsibilities. 

4. Responsible for the equitable distribution of benefits amongst CFMG members. 

5. Responsible for management of forest resources. 
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6. Responsible for enforcing the by-laws of the CFMG and for collecting fines and penalties. 

7. Responsible for ensuring that all the legal requirements for CF are met (including all types of records 
that need to be kept). 

8. Responsible for establishing and maintaining the CFMG fund using monies collected from various 
sources. 

9. Responsible for organizing and conducting CFMG meetings when required. 

Add if any other responsibilities are identified by the CFMG. 

In addition to the above responsibilities, the three suggested standard post bearers (Chairperson, Secretary 
and Treasurer) have specific roles and responsibilities.  

Suggested ToRs of the Chairperson  

1. Heads the CFMG. 

2. Calls meetings whenever necessary and informs concerned persons about date, time and place and the 
reasons for the meeting. 

3. Chairs and facilitates meetings and makes sure each person is allowed to speak, thereby giving everyone 
a fair chance to speak and raise issues  

4. Approves applications for forest products (with Secretary). 

5. Countersigns financial transaction and authorization to draw cash from the bank account (with 
Treasurer). 

Add if any other responsibilities are identified by the CFMG members.  

Suggested ToRs of the Secretary 

1. Assists the Chairperson and officiate him/her during his/her absence. 

2. Manages the correspondence (writing of letters and minutes of meetings) for the CFMG. 

3. Maintain the files of the CFMG. 

4. Maintains the list of CFMG members. 

5. Approves applications for forest products (with Chairperson). 

6. Keeps minutes of CFMG meetings. 

7. Prepares Annual Progress Report (with other CF Management Committee members). 

Add if any other responsibilities are identified by the CFMG members. 

Suggested ToRs of the Treasurer 

1. Looks after any financial transactions on behalf of the CFMG.  

2. Keeps records of expenditure and labor contribution during CF activities 

3. Gives a detailed account of how much money or labor has been contributed, how much has been spent 
and how much is still left, at every CFMG meeting (or as required) 

4. Prepares the Annual Financial Report for the CFO (with the assistance of other CF Management 
Committee members). 

5. Countersigns financial transaction and authorization to draw cash from the bank account (with 
Chairperson). 

Add if any other responsibilities are identified by the CFMG members. 
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Roles and Responsibilities of CFMG 

All individuals and households with traditional claim to forest produce from the CF can seek membership 
of the CFMG. It is particularly important that disadvantaged households are identified and encouraged to 
become CFMG members because they can sometimes be missed out. Other eligible member has the choice 
to join the CFMG.  

Box 2.13 Roles and responsibilities of CFMG as per FNCRR 2017 

The CFMGs are vested with the following roles and responsibilities as per FNCRR 2017: 

(1) The CFMG shall harvest the forest produce from their CF in accordance with the CFMP 

(2) The CFMG shall obtain permit from the Chairperson of the CFMG for harvesting of any forest 

produce from their CF. 

(3) The CFMG shall be allowed to sell the surplus produce to any buyers within the country provided 

the timber is not sold in standing form. 

(4) The prices for the sale of surplus forest produce shall be as per the rates decided by the CFMG. 

(5) The CFMG shall be allowed to form CF network and association to strengthen good governance, 

sustainable utilization of resources, equity and common market access. 

 

Additional suggested roles of CFMG members are to; 

1. Follow the procedures and rules of the CFMG as outlined in the CFMP and By-laws. 

2. Participate in CFMG planning and decision-making. 

3. Elect CF Management Committee members. 

4. Participate in drafting of the CF management plan and CFMG by-laws. 

5. Participate in CFMG meetings. 

6. Co-operate with the CF Management Committee in carrying forest management and other management 
operations especially by contributing labor if required. 

7. Co-operate with the CF Management Committee regulating forest use by other CFMG members and by 
outsiders 

8. Involve in other CFMG activities as planned 

Conflict Management 

Conflict management is a complex process. Identifying and categorizing types of conflict is essential before 
attempting to resolve. Some conflicts require different strategies to resolve while some can be resolved by 
CFMG themselves. The approach to conflict resolution is based on consensus building. This involves iden-
tifying common ground and working voluntarily towards finding a mutually acceptable solution to the prob-
lem. Conflicts are initially solved by the CF Management Committee. However, when the CFMG calls on 
the concerned forestry official(s) to resolve the conflict he/she can act as the mediator.  

The followings are the suggested procedures to help in resolving the conflicts: 

1. The mediator calls the conflicting parties together to discuss the problem. 
2. The parties define the problem as they experience it and agree that it needs to be resolved (this is im-

portant). 
3. The mediator presents the formulated and defined problem on a chart and asks both parties if it is cor-

rectly defined. 
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4. The mediator then asks the parties to work separately and propose solutions to the problem. Chart paper 
is given and they are asked to note their proposed solutions. 

5. The parties present their proposed solutions in turn. 
6. After the first solution is presented the mediator asks the other party if the solution proposed is accepta-

ble to them. If yes, then the problem is solved. If no then the mediator asks for amendments to the 
proposed solution (more discussion may be needed for this). If the second party out rightly rejects the 
proposed solution then they are asked present their proposed solution. 

7. If all the solutions are exhausted and there is no agreement, then the session is adjourned for further 
reflection by both parties.  

8. A time is fixed for another meeting and they are asked to return with ideas for further discussion.   
9. This process may take several meetings to resolve. The mediator must stay neutral at all times and 

cannot propose a solution – this must come from the 2 parties involved. 

Step 2. CFMG Capacity Building 

Capacity building for CFMGs shall be a continuous process from the initiation of CF till monitoring and 
evaluation of CF. The capacity building programs are aimed at enhancing the knowledge and skills   of the 
CFMG to manage the CF independently, efficiently and equitably, making it self-sustaining local institution 
in the long run. 

Before initiating any capacity building plans , it is necessary to identify the capacity gaps hindering the 
implementation of CFMG activities and existing skills and capacity of the CFMG. Job and Jobholder Anal-
ysis shall be conducted to identify the capacity gaps, which should be included in the capacity building plan. 

Job and Jobholder Analysis 

Job and Jobholder Analysis is used to identify which activities CFMG members are required to undertake 
and whether they can actually carry them out. These should be done through the following steps; 

1. Discuss with CF Management Committee members about their jobs and prepare a list of tasks (things 
they are expected to do). Lists the responsibilities of the CF Management Committee.  

2. Discuss with the CF Management Committee about this list of tasks. For each task let them first decide 
whether it is a high (H), medium (M) or low (L) priority for them. Fill the Job Analysis column indicat-
ing the agreed priority. 

3. Next, categorise each task according to whether CFMG Management Committee members are already 
able to do it. Put an X in the appropriate column for “can do”, “partly do” or “can’t do” according to the 

CFMG Management Committee’s own assessment and that of the concerned Forestry staff. 
4. The completed table is the basis for a capacity building plan. You could prepare a similar table for other 

aspects e.g. forest management, or monitoring 

Table 2.21 Example of Job and Jobholder Analysis 

Example of Job and Jobholder Analysis 

 Tasks Can do Partly do Can’t do Priority 

GENERAL ADMINISTRATION 

1 Write letters  X  M 

2 Dispatch letters (send) X   L 

3 Record letters (receive) X   L 

2 File correspondence   X H 

3 Prepare work plans  X  M 

4 Prepare Progress Reports   X H 

5 Conduct meetings  X  M 

6 Draft meeting minutes  X  M 
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Example of Job and Jobholder Analysis 

7 Record penalties and compensation X   L 

8 Use the CFMG seal x   H 

9 Keep inventory of CFMG property   x H 

10 Enforce Bylaws x   H 

 

Preparing a Capacity Building Plan 

A capacity building plan should be prepared to guide the concerned Forestry staff in organizing technical 
support to CFMGs.  

How to Prepare the Capacity Building Plan 

1. Using the Job and Job Analysis table, list all the tasks which are ‘high priority’ but which are also 

categorised as ‘can’t do’. These are the most important tasks for capacity building.  
2. Next, look for high priority tasks which are categorised as ‘partly do’ and also medium priority tasks 

which are categorised ‘can’t do’. These are the next most important for the capacity building plan.  
3. Finally list all the other tasks and complete the table (example below) 
4. For each activity decide on the objectives i.e. what the CFMG would like to achieve after the capacity 

building activities have been done. 
5. Next, set the dates or months during which you plan to carry out capacity building activities. Record 

this in the period column but remember that some capacity building activities shall be continuous. 
6. Under the Inputs column identify any inputs (financial, physical, administrative, and technical) that shall 

be required to carry out capacity building. An example is shown below 
7. Finally, include all the planned capacity building activities into the Annual Work Plan for the year. 

Table 2.22 Example of a capacity building plan 

Example of a capacity building plan  

Task Objective Activity Period Input 

Operate a 
bank ac-
count 

CF Management 
Committee mem-
bers are able to de-
posit and withdraw 
money, issue 
cheques, use the 
passbook and keep 
records of transac-
tions. 

Prepare materials. April 2020 Funds for purchase of material. 
Assistance of staff in material 
preparation 

Make arrange-
ments with finan-
cial institution 

 Letter of CFO to Bank 

Conduct a Bank-
ing & Book keep-
ing Training for 
three CFMGs. 

 Venue at Dzongkhag. 
Funds for refreshments for CFMG 
members. 
Concerned Forestry staff facilita-
tion inputs 

Manage 
forest 
product 
utilisation 

CF Management 
Committee mem-
bers are able to se-
lect, measure, and 
mark trees for 
thinning and har-
vesting. 

Silviculture train-
ing 

January 
2020 

Funds 
Forest site for practical exercise 
Technical resource person 

Hands on training 
in the forest 

February 
2021 

Concerned Forestry staff to spend 
time with CF management commit-
tee during tree marking 

Post-harvesting 
inspection 

May 2021 CF management committee and 
concerned Forestry staff inspect 
site after harvesting and discuss 
any problems 
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Step 3. Silviculture and Forest Management 

A major role for the CFMG is to implement the forest management activities specified in the CFMP. These 
aspects are covered by a separate forestry field manual for Bhutan “Silviculture and Other Forestry Opera-

tions" Second Edition 2016. 

Step 4. Community Development 

Besides CF management, the CFMG should also focus on community development in order to bring imme-
diate benefit to CFMG members in the short term – especially disadvantaged members. The level of these 
activities that can be carried out depends on local needs and on the resources available within the CFMG.  

Suggested community development activities can include: 

• Activities for creating local employment 
• Water supply and sanitation activities 
• Agriculture and irrigation development  
• Health related activities e.g. support for health facilities, awareness and capacities 
• Education including infrastructure, resources and awareness 
• Infrastructure such as village roads, footpaths, culverts, footbridges and community buildings etc. 
• Soil conservation 

Step 5. Addressing Poverty and Disadvantaged Members 

One of the aims of community forestry is to contribute in reducing poverty amongst CFMG members. Dur-
ing the preparation of the CFMG by-laws, a discussion should take place about what activities or special 
provisions can be included for addressing poverty. The best ideas for tackling poverty shall come from the 
target households themselves and this should be considered 

Managing CFMG Fund specifies that not more than 50% of their CF fund should be allocated for loan and 
CFMG enhancement which includes targeted actions for poverty reduction. Suggested poverty activities can 
include the following: 

1. Subsidized rates for forest produce. 

2. Special provisions for collecting certain forest produce e.g. NWFPs. 

3. Support for disadvantaged households to set up small scale income generation activities 

4. Lower interest rates or interest free loans for disadvantaged households. 

5. Creation of employment opportunities for disadvantaged households in CF management and other 
CFMG activities. 

6. Encourage to include disadvantaged households in the CF Management Committee. 

7. Establishment of emergency funds to help disadvantaged households in times of need. 

8. Provision of support for disadvantaged households for medical treatment, education, agricultural inputs 
and other social services. 

 
Those components, wherever applicable should be given importance and considered as crucial part of CF 
management. The success of the enterprise development shall have direct impacts on addressing poverty. 

Step 6. Adapting to Climate Change 

Climate change adaptation supports the individuals, communities and natural systems to deal with the ad-
verse effects of climate change that cannot be avoided. It involves taking practical actions to manage risks, 
protect communities and enhance resilience. However, the ability to cope and adapt differs among individ-
uals and households. To enhance and build resilience of households and communities against the negative 
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impact of climate change identified through Vulnerability Assessment, the following suggested possible 
coping and adaptation options should be included in the CMFP; 

1. Provision of water storage facilities (household level and community level) 

2. Spring protection 

3. Soil conservation and land management activities 

4. Agricultural support activities such as new horticulture and crop varieties, irrigation facilities, and pest 
control measures 

5. Forest fire control measures 

6. Crop and livestock produce storage facilities 

Step 7. Enterprise Development and Employment 

Community Forestry program can lead to sustainable management of forest resources and provide avenues 
for livelihood improvement through enterprise development. Some potential community-based enterprise 
development within CF are listed below: 

• Ecotourism (Menchu/hot stone bath, home stay, trekking, recreational centres, picnic spots, bird watch-
ing, handicrafts production, camping sites, horse riding, safari, rafting, etc.) 

• Payment for Environmental Services 
• Marketing of surplus sand and stones 
• Potential NWFPs (production, product diversification, value addition, marketing, etc.) 
• Marketing of surplus timber (value addition, product diversification, wood-based industries) 
• Firewood/Wood chips 
• Bottling plants for mineral water/package from Drupchus, Menchus, etc. available within the CF area. 

Step 8. CFMG Administration 

For efficient and effective administration of CFMGs, the following administrative processes should be fol-
lowed; 

Filing Systems 

Correspondence e.g. letters and other documents should be properly maintained. Correspondence, letters 
and documents are first sorted according to specified subjects and dates and kept in labelled files for easy 
identification and retrieval.  

The CF Hammers 

The CF hammers (Marking and Passing hammer) (Figure 2.7) shall be issued by the Department through 
office order or notification. The hammers contain Dzongkhag Code (DC) and Serial Number (SL.NO.). The 
registered hammers shall be under the custody of CFO/Forest Officer for proper safety and the Forest Of-
ficer shall use the marking hammer.  

Figure 2.7 shows the 2 hammers. ‘CF’ indicates that the 

hammer is for Community Forests. ‘DC’ is for Dzongkhag 

Code and then serial number for the CF. ‘M’ indicates that 

the hammer is used for marking timber for felling while on 
the other hammer the ‘P’ for passing refers to timber marked 
for sale. Note that hammers may change from time to time 
as regulations for community forestry evolve. Ensure that 
you are fully updated with the current system for timber 
marking. 

 

Figure 2.7 CF hammers 

 

CF Marking   CF Passing 

 

DC/SL.NO 

M 

CF 

DC/SL.NO. 

P 

CF 
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The CF marking hammer is used to mark trees that have been approved for felling by the CF Management 
Committee and for felled and cut logs on the ground. The passing hammer is used to mark timber that are 
sold and for transportation.  

CFMG Record Keeping  

A set of standard formats has been developed to simplify record keeping. The concerned Forestry Office 
shall provide these formats to the CFMG after approval of the CF for the initial plan period. The CFMG is 
obliged to maintain these records, which should be made available to the CFMG members and to the forestry 
staff on demand.  

Format 1. Annual Work Plan and Progress Report  

Format 2. Seedling and Plantation Record  

Format 3. Attendance Register (Annual Labour Register)  

Format 4. Record of Penalty and Compensation  

Format 5. Collection Permit  

Format 6. Records of Forest Produce Utilisation  

Format 7. Money Receipt  

Format 8. Cash Book 

Format 9:  Meeting Minutes 

Format 10:  Loan Record 

Format 11:  Stock Register 

Format 12: Calculation of payables to group members from forest sales 

Format 13: Calculation of payables to individual group members from the forest sales based on  

collection 

Format 14: Calculation of payables to individual group members from the sale based on labour  

contribution 

Format 15:  Payable Form 

Format 16:  Receivable Form 
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་ཁ་
གྱང
ས། 

Nu
mb

er 
of 

pa
ym

en
ts 

pe
r 
ye
ar:
  

ཟླ་རི
མ་ད

ངུལ
་སདོ

་དགོ
པ། 

 
Sc
he
du
le 

pa
ym

en
ts:
 

སྐྱེད
་ཡངོ

ས་བ
སམོ

ས་ 
 

To
tal
 in

ter
est

 (N
u):
  

སྐྱིན
་འགྲུ

ལ་མ
ཇུག

་བསྡུ
་ནིའི

་ཚེས
་གྲང

ས། 
 

Liq
uid

ati
on
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ate

:  
 

ཚགོ
ས་པ

་གྱི་
སྐྱིན
་འགྲུ

ལ་ད
བང
་འཛི

ན་གྱི
་མཚ

ན་རྟ
གས

། 
Sig

na
tur

e 
of 

san
cti
on
ing

 a
uth

ori
ty 

of 
the

 g
rou

p: 
 

སྤྱི་ཚེ
ད།་
 

Da
te 

སྐྱིན
་འགྲུ

ལ་མ
་རྩ་
 P

rin
-

cip
al 

am
ou
nt 

(N
u) 

སྐྱེད
་ཡངོ

ས་བ
སམོ

ས་ 
Int

ere
st 

am
ou
nt 

(N
u) 

དངུ
ལ་ཀྲ

མ་བ
སམོ

ས། 
To
tal
 a
mo

un
t 

(N
u) 

དུས
་རིམ

་དངུ
ལ་ས

དོ། 
Pe
rio
d 
ins

tal
me

nt 
pa
ym

en
t 
(N
u) 

ལྷག
་ལུས

་ཡངོ
ས་བ

སམོ
ས། 

Ba
lan

ce 
tot

al 
am

ou
nt 

(N
u) 

སྐྱིན
་འགྲུ

ལ་ལེ
ན་

མིའི
་་རྟག

ས། 
Sig

-
na
tur

e 
of 

the
 b
orr

ow
er 

ཡིག
་ཚང

་དབ
ང་འ

ཛིན
་གྱི་
མཚ

ན་
རྟག
ས། 

Sig
na
tur

e 
of 

the
 o
ffi
ce 

ho
lde

r 
in 

ch
arg

e 
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F
or

m
at

 1
1.

 S
to

ck
 R

eg
is

te
r 

མཛ
དོ་ཁ

ང་ཐ
་ོདེབ

། S
toc

k 
Re
gis

ter
 

སྡེ་ཚ
ན་གྱི

་མིང
་། 
Na

me
 o
f 
CF

MG
/N
WF

P 
Gr
ou
p: 

___
___

___
___

___
___

___
___

___
___

___
___

___
___

___
___

___
___

___
___

___
__ 

ཅ༌ཆ
ས༌/
ཐནོ
༌སྐྱེད

༌། 
Ite
m/
pr
od
uc
t: 

དབྱི
ན༌ཚེ

ས༌།
 

Da
te 

རྩི་འ
བྱརོ
། R

ece
ipt
 

སདོ
༌པ༌
། I
ssu

ed
 

ལྷག
༌ལུས

། B
ala

nc
e 

དྲན
༌གས

།ོ R
em

ark
s 

ཅ༌ཆ
ས༌ག

༌ལས
༌ འ

བྱུང
༌བ༌
། P

art
icu

lar
s 

(fr
om

 w
ho
m)
 

གྲང
ས༌།
 Q

ty.
* 

 
ཅ༌ཆ

ས༌ག
༌ལུ༌
སདོ

༌པ༌
། P

art
icu

lar
s 
 

(to
 w

ho
m)
 

གྲང
ས༌།
 Q

ty.
* 

 
གྲང
ས༌།
 Q

ty.
* 
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F
or

m
at

 1
2.

 C
al

cu
la

ti
on

 o
f 

pa
ya

bl
es

 t
o 

gr
ou

p 
m

em
be

rs
 f

ro
m

 f
or

es
t 

sa
le

s 
ནག

ས་ཚ
ལ་ཐ

ནོ་སྐྱེ
ད་ཀྱི

་ཚངོ
་སྒྱུར

་ལས
་ཚགོ

ས་པ
་ལུ་
སདོ
་དགོ

་པའི
་རཙི

ས། 
Ca
lcu

lat
ion

 o
f 
pa
ya
ble

s 
to 

gr
ou
p 
me

mb
ers

 f
rom

 f
ore

st 
pr
od
uc
t 
sa
les
 

ཨང
་  

Sl.
 N

o 
གན

ད་ད
ནོ་ 

Pa
rti
cu
lar

s 
སྡེ་ཕྲ

ན་ 
Un

it 
ཁ་གྱ

ངས
། Q

ua
nti

ty 
གོང
་ཚད

་  
Ra
te 

(N
u) 

དངུ
ལ་ཀྲ

མ་ཡ
ངོས
་བས

མོས
་  

To
tal
 A
mo

un
t (
Nu

) 
 

ཐནོ
་སྐྱེད

་བཙ
ངོ་ལ

ས་འ
ངོ་འ

བབ
། R

ev
en
ue
s 
fro

m 
sel
lin
g 
pr
od
uc
ts 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

ཀ 
A 

འོང
་འབ

བ་ཡ
ོངས
་བས

ོམས
། T

ota
l r

ev
en
ue
s 

 
 

 
 

 
 

 
 

 
 

 
ཚངོ
་འབྲེ

ལ་གྱི
་འགྲོ

་སངོ
་། 
Ex
pe
ns
es 

for
 m

ark
eti
ng
 p
rod

uc
ts 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

ཁ 
B 

འགྲོ
་སོང

་ཡོང
ས་བ

སོམ
ས། 

To
tal
 e
xp
en
ses

 
 

 
 

 
  

 
 

 
 

  
 

 
 

 
ག C ཁེབ

་ས་
ངེས
་ཏིག

། N
et 

Inc
om

e 
(A
-B)

 
 

 
 

 

No
te:
 ག
སོག

་འཇོ
ག་་
བཞ

ག་མི
་ལུ་
གཞི

་བཞ
ག་ཞི

ན་ན
་ ཚ

ོགས
་པའི

་འཐུ
ས་མི

་རེ་
རེ་བ

ཞིན
་དུ་
ལུ་ས

ོད་ད
གོ་པ

འི་རྩི
ས། 

Ca
lcu

lat
ion

 o
f r

ate
 to

 b
e 
pa
id 

to 
ind

ivi
du
al 

gr
ou
p 
me

mb
ers

 b
ase

d 
on
 c
oll
ect

ion
, 

ཚོག
ས་པ

འི་འ
ཐུས

་མི་
ལུ་ས

 ོད་ད
གོ་པ

འི་ཡ
ོངས
་བས

ོམས
་/ 
ཚོག

ས་པ
་གིས

་གས
གོ་འ

ཇོག
་འབ

ད་མི
འི་ཁ

་གྱང
ས། 

To
tal
 p
ay
ab
les
 t
o 
gr
ou
p 
me

mb
ers

/ t
ota

l q
ua
nti

ty 
col

lec
ted

 b
y 
the

 g
rou

p, 
 

ཚོག
ས་པ

འི་འ
ཐུས

་མི་
ལུ་ 

ཉིན
་གྲང

ས་ལ
ས་མི

་ལུ་
གཞི

་བཞ
ག་ཞི

ན་ན
་ ས

ོད་ད
གོ་པ

འི་རྩི
ས། 

Ca
lcu

lat
ion

 o
f 
rat

e 
to 

be
 p
aid

 t
o 
ind

ivi
du
al 

gr
ou
p 
me

mb
ers

 b
ase

d 
on
 la

bo
ur
 d
ay
s, 

ཚོག
ས་པ

འི་འ
ཐུས

་མི་
ལུ་ས

 ོད་ད
གོ་པ

འི་ཡ
ོངས
་བས

ོམས
་/ 
ཚོག

ས་པ
་གིས

་ལཱ་
འབ
ད་ཡ

ོད་པ
འི་ཉི

ན་གྲ
ངས
་། 
To
tal
 p
ay
ab
les
 t
o 
gr
ou
p 
me

mb
ers

/ t
ota

l l
ab
ou
r 
da
ys
 in

ve
ste

d 
by
 t
he
 g
rou

p. 
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F
or

m
at

 1
3.

 C
al

cu
la

ti
on

 o
f 

pa
ya

bl
es

 t
o 

in
di

vi
du

al
 g

ro
up

 m
em

be
rs

 f
ro

m
 t

he
 f

or
es

t 
sa

le
s 

ba
se

d 
on

 c
ol

le
ct

io
n 

ནག
ས་ཚ

ལ་ཐ
ནོ་སྐྱེ

ད་ཀྱི
་ཚངོ

་སྒྱུར
་ལས

་ཚགོ
ས་པ

འི་འ
ཐུས

་མི་
རེ་རེ

་བཞི
ན་དུ

་ལུ་
སདོ
་དགོ

་པའི
་ཙིས

། 
Ca
lcu

lat
ion

 o
f 
pa
ya
ble

s 
to 

ind
ivi
du
al 

gr
ou
p 
me

mb
ers

 f
rom

 f
ore

st 
pr
od
uc
t 
sal

es 
ba
sed

 o
n 
col

lec
tio
n 

ཨང
་ N

o 
མིང
་ N

am
e 

ཐནོ
་སྐྱེད

་ P
rod

uc
t 

བསྡུ
་གས

གོ་ཡ
དོ་པ

འི་ཁ
་

གྱང
ས། 

ཀེ་ཇི
། Q

ty.
 

col
lec

ted
 (k

g) 

གོང
་ཚད

་ཀེ་
ཇི་རེ

་ལུ་
 ད
ངུལ

་
ཀྲམ

། R
ate

 (N
u/k

g)*
 

ཡངོ
ས་བ

སམོ
ས་ 

To
-

tal
 (N

u) 

དངུ
ལ་ཐ

ོབ་མི
་གི་
རྟག
ས། 

Sig
na
tur
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of 
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t 
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 p
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-
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* ཚ

གོས
་པའི

་འཐུ
ས་མི

་རེ་
རེ་བ

ཞིན
་དུ་
ལུ་ས

དོ་ད
གོ་པ

འི་གོ
ང་ཚ

ད་ཨི
ན། 

བར
་ཚངོ

་པ་
གིས

་སདོ
་མི་
གོང
་ཚད

་འདི
་མེན

། R
ate

 a
s 
ca
lcu

lat
ed
 t
o 
be
 p
aid

 t
o 
the

 in
div

idu
al 

gr
ou
p 
me
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ers

; n
ot 

the
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e 
as 
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aid

 b
y 
the

 t
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F
or

m
at

 1
4.

 C
al

cu
la

ti
on

 o
f 

pa
ya

bl
es

 t
o 

in
di

vi
du

al
 g

ro
up

 m
em

be
rs

 f
ro

m
 t

he
 f

or
es

t 
sa

le
s 

ba
se

d 
on

 la
bo

r 
co

nt
ri

bu
ti

on
 

ནག
ས་ཚ

ལ་ཐ
ནོ་སྐྱེ

ད་ཀྱི
་ཚོང

་སྒྱུར
་ལས

་ཚགོ
ས་པ

འི་འ
ཐུས

་མི་
རེ་རེ

་བཞི
ན་དུ

་ལུ་
ཉིན
་གྲང

་གླ་
འཐུ
ས་ཞི

་བཞ
ག་ས

ོད་ད
གོ་པ

འི་རྩི
ས།
' 

Ca
lcu

lat
ion

 o
f 
pa
ya
ble

s 
to 

ind
ivi
du
al 

gr
ou
p 
me

mb
ers

 f
rom

 f
ore

st 
pr
od
uc
t 
sal

es 
ba
sed

 o
n 
lab

ou
r 
con

tri
bu
tio
n 

ཨང
་ N

o 
མིང
་ N

am
e 

ཐོན
་སྐྱེད

་ P
rod

uc
t 

ལ་འ
བད
་བའི

་ཉིན
མ་གྱ

ངས
་ཁ།
 

No
. o

f 
La
bo
ur
 D

ay
s 

གོང
་ཚད

་༼
དངུ
ལ་ཀྲ

མ༽
 

Ra
te 

pe
r 
da
y 
(N
u)*
 

དངུ
ལ་ཡ

ོངས
་

བས
ོམས

།  
To
tal
 (N

u) 

དངུ
ལ་ཐ

ོབ་མི
་གི་
རྟག
ས། 

Sig
-

na
tur

e 
of 

rec
ipi
en
t 

up
on
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ay
me

nt
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

* གོ
ང་ཚ

ད་འ
དི་འ

ཐུས
་མིའི

་གྲོས
་ཆད

་ལྟར
་དུ་
སོད
་དགོ

པ། 
Ra
te 

pe
r 
La
bo
ur
 D

ay
 a
s 
ca
lcu

lat
ed
 t
o 
be
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aid

 t
o 
the

 i
nd
ivi
du
al 

gr
ou
p 
me

mb
ers

; n
ot 

the
 s
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as 

go
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nt
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ur
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ay
 r
ate
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F
or

m
at

 1
5.

 P
ay

ab
le

s 
F

or
m

 
དངུ
ལ་ཀྲ

མ་ས
ོད་ནི

འི་དྲི
་ཤགོ

། P
ay
ab
les
 f
orm

 

ཨང
་ S

l. 
No

 

དངུ
ལ་ཀྲ

མ་ལེ
ན་མི

འི་མི
ང་ད

ང་ཁ
་བྱང

་
Pa
ya
ble

 t
o 

(na
me

 &
 a
dd
res

s) 
ཁ་ག

སལ
་ D

esc
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Managing CFMG Fund 

CFMG by-laws should address the fund management. Based on the provisions in their respective by-laws, 
CF fund can be utilized either in group or by the individuals who are the member of CFMG. Management 
of CFMG fund is mainly the responsibility of the CF Management Committee. The Treasurer shall maintain 
all transaction records and should provide an update of the fund status during CFMG and Committee meet-
ings.  

The fund sources are included in the CFMG’s by-laws. The probable sources of CF fund are: 

• Membership fees 
• Contributions from CFMG members and outsiders 
• Fines paid by CFMG members and outsiders 
• Forest product fees 
• Sale of forest products (timber, NWFPs, sand and boulders)  
• Sale of services (ecotourism and ecosystem services)  
• Donations  
• Interest returns.   

How to Manage the CF Fund 

CF fund should support in fulfilling the activities for CF development as reflected in respective CFMP (i.e. 
CF development activities like plantation, thinning, cleaning, fire line creation, etc.). 

CFMG should emphasize on poverty targeted activities: Support to poorer/disadvantaged households based 
on need rather than the ability to pay. It is important that the CFMG integrates the principles of sustainability 
(i.e. long-term benefits), Equity in benefit sharing (fair rather than equal) and pro-poor provisions.  

Box 2.14 Equity vs Equality 

Equity often means that all members receive an equal share of benefits. A better way to think of 

equity is in terms of fairness – what is fair under the prevailing circumstances? Regarding income 

generation and fund management an important aspect is equity in benefit sharing which should en-

sure that the poor or disadvantaged people are not made absolutely or relatively worse off. 

Example: a poor household is waived off with membership fees and labor contribution. A single and 

elderly woman headed household is waived off the loan interests, etc. 

It is the responsibility of the CFMG to decide how much fees should be contributed by each member. It is 
important to make certain consideration for those members who cannot pay (i.e. disadvantaged members). 
Fixing fee rates should therefore take into account equity (rather than equality). 

Box 2.15 Some examples for pro-poor provisions 

• Provide support for disadvantaged households for medical expenses, education, agricultural 

inputs, food and others. 

• Emergency fund to poor households in times of dire need, e.g. in case of death, sickness, natural 

disasters. 

• Give loans for poorer households (at interest-free or lower interest rates).  

• Give incentives to committee members of poorer background in order to reduce their transac-

tion costs. 

The concerned Forestry Officer shall attend the CFMG meetings/assemblies, whenever possible. He/she 
shall provide guidance on fund management. 
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Box 2.16 Transaction Costs 

Transaction costs refers to the costs (financial and others) involved in transacting the business 

associated with CF. this include things such as the time spent in meetings and in negotiations, as well 

as direct costs such as contributing labor in tree planting and other CF developmental activities. 

There are economic consequences associated with transaction costs that are often quite severe, 

particularly for poor people who might have to forego livelihood or income generating activities in 

order to participate in CF related activities. 

 

All CFMG members have the right to know about the status of their fund. All documents related to CF fund 
should be available for inspection by CFMG members to ensure transparency and accountability. 

The CFMG shall produce all documents for review, inspection, auditing, monitoring by concerned Forestry 
Officer at any time. All documents related to CF fund shall be maintained properly by the CF Management 
Committee. 

Box 2.17 Pro-poor Loan Scheme 

Smaller loans first: the CFMG shall decide to distribute first the smaller amounts and then the 

bigger amounts. 

Interests Rates: the CFMG may decide to give loans to disadvantaged members at lower interest 

rates or even interest-free loans). 

Purpose: the CFMG may decide and prioritize loan disbursement based on the purpose (e.g. activities 

to reduce poverty, education, health, emergency cases). 

 

Procedures in CF Fund Management 

• All CFs should open a bank account within one month from the day of award of CF Ownership 
Certificate 

• The account shall be operated under the joint signatory of the CF Chairperson and the Treasurer or 
as reflected in the respective By-laws 

• Money receipts should be issued for all payments received 
• Contingency fund of Nu. 5,000 may be kept with the Treasurer. 
• Amount over Nu. 5,000 (five thousand only) should be deposited within 10 days. Failure to deposit 

on time, the Treasurer shall be liable to pay the interest rate and deposit in the CF account. 
• All money received should be recorded in the Cash Book by the Treasurer 
• The Treasurer collects all contributions, fees, fines, donations and maintain records 
• The Treasurer shall present the schedule of collections to the CFMG at least annually.  
• There should not be any over-writing, use of correction of fluid, tearing of pages, etc. in the record 

keeping books and money receipts including permit books. 
• All financial records should be made available to authorized auditing team/inspection team anytime. 

 

Suggested CF Fund Utilization Areas 

The followings are some of the areas where CFMG can utilize their CF fund. Based on the table below, the 
CFMG shall allocate the CF fund on different priority areas. The CFMG shall discuss and decide on fund 
utilization during the preparation of the CF Management Plan and shall be reflected in the by-laws. 
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Table 2.23 Allocation of CF Fund 

Areas of fund Use   Limit (%) 
CF development activities (CF review, nursery creation, plantation, thinning, clean-
ing, salvage operation, sanitation, boundary demarcation, fire line creation, etc.) 

Not less than 25 

CFMG enhancement (Loan, capacity building, study visits, meeting, workshops, 
networking, visitors in CF, income generation and enterprises development, etc.). 

Not more than 50 

Reserve fund in the Bank (security) Not less than 5 
Others (to be decided by the CFMG members on e.g. incentives to victims of natu-
ral calamities, incentives to disadvantaged members/households, contribution to 
community Lhakhangs, water supply, farm road, etc.) 

Not more than 20 

 

Disbursement Procedures 

• Any expenditure up to Nu. 10,000 shall be decided by the CF Management Committee and beyond that 
amount the decision shall be made by the 2/3rd majority of the CFMG members. 

• The Treasurer shall maintain all detail expenditure records (receipts, vouchers, bills, including minutes 
of meetings, etc.). All such expenses shall be immediately recorded in the cash book. 

• The Treasurer shall present the details of expenditure to the CFMG members and concerned inspection 
team(s). 

• The concerned Forestry Officer shall ensure the compliance of above provisions. 
 

CFMG Fund for Loans and its Procedures 

Once the particular CF generates income, they can allocate not more than 50% of the total fund for loan. 
The CF by-laws should have provisions to facilitate CFMG fund for loan. The borrower shall submit an 
application as per Form 2.3.  
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Form 2.3 Loan application form 

 

 

Annex 9: Loans Application for CFMG members 
 
Loan Application Form  སླིན་འགྲུལ་ཞུ་ཡླིག་བླིས་ཤགོ    Date སླི་ཚེས:…………………….……..... 

Name མླིང: ………………………………………………………………. 

Village གཡུས: ………….…………………………………………… 

Gung No. དགུང་ཨང: …………………………………….  

Thram No. ཁྲམ་ཨང: ………………………………………………  

CID No. ངོ་སོད་ལག་ཁྱེར་ཨང: ………………………………….……………  

Mobile No. འགྲུལ་འཕླིན་ཨང: ………………………………………… 

Amount Applied Nu: མ་དངུལ་བསོམ་ཞུ་ནླི ………………………… (in words ༼ཡཡླིག་ོོག་

ཁར༽)……………………………………………….…….. 

Purpose གནས་དོན: 

…………………………………………………………………………………………………………,,,…
……..…………………….............................................................................................................................
....................................................................................................................................................................... 
Mortgageཡགཏའ་མ༽ (optional) 

a)ཀ༽ 

b)ཁ༽ 

c)ག༽ 

Total value of mortgage (s) 

གཏའ་མའླི་བརླི་མོོང་བསོམ 

 

 
Third Party Guaranty (if any):ཁས་ལྱེན་ཁག་འགན་འབག་མླིཡཡོད་པ་ཅླིན༽ 

Name, CID No. M. No. Thram No. Gung No. 

མླིང/ ངོ་སོད་ལག་ཁྱེར་ཨང /འགྲུལ་འཕླིན་ཨང/ཁྲམ་ཨང/དགུང་ཨང 

 

 

 

Signature and Date 

མླིང་རྟགས་དང་དབླིན་ཚེས 

 
Signature and Date of Applicant with legal stamp: 
ཁྲླིམས་དོན་འགྱེམས་རྟགས་བཅས་མླིང་རྟགས་དང་དབླིན་ཚེས་ 
 
 
 
 
Sanctioned by:་གནང་བ་སོད་མླི 
 
 
 
 
 
Treasurer     Secretary   Chairperson 
བརླིས་དྲུང དྲུང་ཆྱེན ཁྲླི་འཛིན 
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Eligibility Criteria for Loan 

Every CFMG member shall be given opportunity to avail loan from their respective CFMG fund.  

• Loan from CFMG fund shall not be given to non CFMG members. 
• The borrower must be of 18 years and above. 
• Only one member from the household is eligible for loan at a time. 
• Should not have any outstanding loan in the CFMG. 
• The borrower should have his/her census in a household who is member of the CF. 
• Need of mortgage or guarantor shall be decided by the CFMG. 

Interest Rates 

CFMG members shall decide on the interest rate during general meeting/assemblies with 2/3rd majority 
following the provisions mentioned in the CF by-laws. The interest rate shall be on annual basis. However, 
the interest rate should not exceed 15 % per annum in accordance with Section 17 (1) of the Movable and 
Immovable Property Act of Bhutan 1999.  

CFMG may apply different interest rate e.g. lower interest or interest-free loan for members of disadvan-
taged and single woman headed households.  

Loan Term 

The loan term shall be decided by the CFMG depending on the repayment capability of the borrower. How-
ever, all loans and other dues must be cleared before the expiry of the CFMP.  

Repayment Schedule and Process 

The borrower shall pay the principal amount including the interest on instalment basis annually or upon 
completion of the loan term. It is the duty of the CF Management Committee (Treasurer) to maintain proper 
records of all financial transactions. Fresh loan can be availed only after repayment of the previous loan.  

Penalties 

The CFMG shall decide penalties in case of non-repayment of the loan and it should be reflected in the loan 
agreement and the respective CF by-laws. Refer Annex 10 for loan agreement. However, the penalties 
charge shall not exceed 24% per annum as per financial rules. 

If the borrower has serious financial trouble but assures the CF Management Committee that the loan shall 
be repaid, the CF Management Committee can exceptionally decide to reschedule the loan after an evalua-
tion of the repayment problems. However, the CF Management Committee shall ensure that the borrower 
repays loan and other dues before the expiry of the CFMP period. 

Mortgage and Guarantor 

Requirement of mortgage and guarantor shall be decided by the CFMG. In case they decide to have mort-
gage, the minimum mortgage value shall be 150% of the loan amount. Mortgage value shall be assessed by 
the CF Management Committee prior to loan approval as follows:  

• Detailed description of the collateralized goods. 
• Valuation of the goods on the basis of their market value. 
• Collateral agreement signed during the loan request. 
• The applicant shall produce “No Objection Certificate” from household members in the event of 

mortgaging the collateral. 

Allowable collateral: 

• House, buildings and land with legal property documents. 
• Cars, vehicles with the official government certificate of the property. 
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• Livestock (Cattle/horses/pigs). 
• Poultry/dairy farms. 
• Agriculture machineries (power tiller, rice mill, etc., decided by the CFMG). 

Loan Approval and Disbursement Process 

Upon fulfilling the eligibility criteria, the CFMG shall approve the loan based on general consensus or with 
2/3rd majority. The borrower and the lender shall sign the loan agreement before the loan disbursement. The 
loan agreement is prepared in two copies, one for CF Management Committee and one for the borrower. 
The CF Management Committee shall withdraw/transfer the amount from their respective bank account and 
disburse to the borrower.  

Loan Review 

At the end of each year, the CF Management Committee shall review all the loans and repayments. The 
information shall be shared during the CFMG general meetings/assemblies. 

Step 9. Annual Work Plan Preparation 

An annual work plan (AWP) should be prepared every year during the Community Forest Management 
Group general meeting based on the Forest Management Matrix (Step 11) prepared and approved in the 
Community Forest Management Plan (CFMP). It may be helpful to start this process (during the first year) 
by doing a seasonal calendar (PRA tool). 

2.3.5 Monitoring, Evaluation and Reporting 

Monitoring and evaluation are parts of the action learning cycle (Figure 2.8). Actions are implemented and 
information about their effects is collected and discussed. The reflection on what has happened leads to 
improvement and revision of future actions. Monitoring and evaluation are important to ensure the achieve-
ment of objectives, implementation of actions and the accountability of stakeholders. The action learning 
cycle happens on many levels in community forestry. 
Different stakeholders are involved at different 
stages.  

Monitoring means collection of information as indi-
cation for the achievement of objectives. 

Evaluation means assessment of information in or-
der to review the achievement of objectives and to 
decide about how to go on.  

Indicators are things that can be measured to moni-
tor an objective.  

Activities are actions like harvesting, thinning or pa-
trolling taken to produce specific outputs. 

Outputs are products and services like timber or in-
come which directly result from activities.  

Outcomes and impacts are the bigger medium-and long-term effects like sustainable forest management or 
poverty reduction which result from the combination of different outputs and which are influenced by mul-
tiple other factors.  

The objectives, the responsibilities and the processes (including their timing) need to be clearly defined to 
facilitate monitoring and evaluation. Answering the following questions can help to do so:  

• What do we want to monitor and evaluate?  
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Figure 2.8 Action learning cycle 
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• Who does the monitoring and evaluation?  

• How is the monitoring and evaluation carried out?  

Step 1. Self-Monitoring and Evaluation by the CFMG 

CFMG shall conduct self-monitoring to check its own progress against the CF management objectives by 
using various indicators. The CFMG shall monitor the followings: 

• Achievement of the overall CF management objectives. 

• Achievement of block-wise management objectives. 

• Implementation of planned activities (in the CF management plan and AWP). 

• Implementation of the CFMG By-laws. 

Step 2. Participatory Monitoring 

Participatory monitoring by the CFMG needs to cover all 3 aspects i.e. (i) participatory forest resource 
monitoring, (ii) social and institutional monitoring and (iii) environmental impact monitoring. 

Monitoring of all these should be carried out in a participatory way so that all CFMG members understand 
the system, take responsibility for monitoring and for ensuring that as a group they are achieving their 
planned and agreed objectives.  

Step 2.1 Participatory Forest Resource Monitoring 

During implementation of the CFMP the CFMG needs to 
continuously check that the management objectives for 
each block are being achieved. This is done by monitoring 
against a set of agreed indicators for each activity.  

1. Make a list of all the management activities that have 
been included in the CF management plan (from the 
Forest Management Matrices in Step 11). 

2. Discuss each activity with the CFMG and try to iden-
tify 2 or 3 indicators that could be used to monitor the 
achievement of the activity. For example: If the activ-
ity is “establish plantation in degraded forest”, then 

possible indicators might include survival rate/per-
centage; etc. in the block. If the activity is “patrolling, 

to stop illegal activities”, then indicators might include 
the numbers of culprits apprehended, fines and penal-
ties levied. 

3. Out of this list, discuss with the CFMG whether it shall 
be possible for them to measure them.  Remember that 
the measuring system needs to be simple, practical and 
understandable.  

4. Finalise a short-list of indicators which shall be monitored by the CFMG over the period of the CF 
management plan (3 or 4 key indicators shall be sufficient). 

5. For each indicator, discuss with the CFMG about the procedure for measuring and recording it e.g. 
How? Who? How often? How shall it be recorded etc.?  

6. Various possible monitoring indicators are described here and an example of a completed participatory 
forest resource assessment table is also shown in.Table 2.24. 

 

Table 2.24 Example of a Participatory Forest Resource Impact Monitoring Table 

• Regeneration 

• Numbers and diameters of trees of 

different species 

• Canopy density 

• Grass cover 

• Vegetation cover 

• Soil cover 

• Level of soil erosion 

• Quantity of leaf litter 

• Water quantity e.g. from a source 

• Level of grazing pressure  

• Frequency of fires 

• Evidence of illicit cutting of trees 

• Availability of various forest prod-

ucts e.g. fuel wood, fodder, NWFPs 

• Survival and growth of planted seed-

lings 

Box 2.18 Indicators to monitor forest resources 
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A. Example of a Participatory Forest Resource Impact Monitoring Table 
Activity Indicator How it shall be 

monitored 
Responsibility Comments 

Establishment of 
plantation in de-
graded areas 

Survival percent-
age, numbers of 
seedlings growing 

Survival of planted 
seedlings measured 
in the plantation 
area 

CF Management 
Committee to or-
ganise 

TD/PO staff shall 
support 

Patrolling within 
CF to stop illegal 
activities 

No. of patrolling 
conducted and 
culprits appre-
hended 

Regular patrolling 
and monitoring of 
the CF area 

CF Secretary 
shall record the 
information 

Resoop may sub-
mit patrolling re-
port to the CF 
Chairperson/ Sec-
retary 

Construction of 
fire lines 

Length of fire line 
constructed  

Labour contribu-
tion made for fire 
line construction 
and physical verifi-
cation  

CF Management 
Committee and 
all other members 

TD/PO staff shall 
give support for 
fire line width and 
length 

Step 2.2 Participatory Social and Institutional Monitoring 

Other activities carried out by the CFMG aim to achieve socio-economic and institutional objectives 
such as contributing to poverty reduction amongst CFMG members or improving CFMG govern-
ance. These aspects also need to be monitored by the CFMG by monitoring against agreed indicators. 
Discuss these poverty and good governance activities with the CFMG members to identify possible 
indicators (examples are given in the table below). Indicators can also be developed to cover Climate 
Hazard and Vulnerability Assessment ( 

Step 9. Climate Hazard and Vulnerability Assessment). 

Table 2.25 B. Example of a Participatory Social and Institutional Impact Monitoring Table 

B. Example of a Participatory Social and Institutional Impact Monitoring Table 
Activity Indicator How it shall 

be monitored 
Responsibility Comments 

Providing loan for 
CFMG member 
HH income gener-
ation 

Number of households 
provided with loan 

Records in 
Fund Manage-
ment 

CFMG with 
TD/PO staff facili-
tation 

Carried out during 
loan repayment 

Resource alloca-
tion based on eq-
uity 

No. of single woman 
headed household, no. 
of disadvantaged 
households, etc. 

Record books CF Management 
committee 

 

Review of socio-
economic survey 

No. of single woman 
headed household, no. 
of disadvantaged 
households, etc. 

Participatory 
review  

CF management 
committee with 
TD/PO staff facili-
tation 

 

CFMG General 
meeting 

No. of participation of 
CFMG members in 
meetings 

Meeting rec-
ords 

CF management 
committee 

Collect names of 
participants during 
every meeting 

CF Management 
Committee meet-
ing 

No. of women at-
tended the committee 
meetings 

CFMG rec-
ords 

CFMG Overall aim is 1 
woman out of 
three committee 
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Step 2.3 Participatory Environmental Impact Monitoring 

The indicators identified from the environmental impact assessment need to be monitored to minimise neg-
ative environmental impacts. 

1. A participatory environmental impact assessment is carried out during CF management plan prepara-
tion. This identifies a number of potential negative environmental and social impacts. 

2. List the areas where major potential environmental risks are identified. For each of these develop one 
or more indicators (see Table 2.26). 

3. Complete the participatory environmental impact monitoring table showing monitoring methods (how) 
and responsibility. 

4. Finally, having completed table for forest resource, social and institutional and environmental monitor-
ing, combine and include under monitoring section of the CFMP.  

Table 2.26 Example of a Participatory Environmental Impact Monitoring Table 

Example of a Participatory Environmental Impact Monitoring Table 
Possible negative 
impact 

Indicator How it shall be 
monitored 

Responsibility Comments 

Reduced water 
flow in springs 

Quantity of dis-
charge during dri-
est month 

Time to fill a 
bucket of known 
volume 

CF management 
committee 

Records to be kept 
by CFMG 

Damage to natural 
regeneration  

No. of seedlings 
damaged 

Counting in a sam-
ple plot 

CF management 
committee and 
forestry staff 

Participatory as-
sessment 

Loss native spe-
cies 

Occurrence of in-
vasive species 
sighted. 

Anecdotal evi-
dence. 
Growing sites of 
invasive species 

All CFMG mem-
bers to report 

Will give qualita-
tive data only 

 

Step 3. Monitoring of CF and CFMG 

Annual monitoring should be carried out by the concerned forestry office jointly with the CF Management 
Committee. Regular information should be updated in the database.  

Step 4. Mid-term and Final Evaluation 

The CFMP is prepared for a 10-year period. Mid-term evaluation of CFMP shall be carried out at the last 
quarter of the 5th year of the plan period. Final evaluation and revision of the CFMP shall be done at the 
last quarter of the 9th year of the plan period. The mid-term evaluation shall enable to identify issues which 
can be incorporated in the AWP. The final evaluation shall be an important input for preparation of the next 
10-year CFMP. 

Key questions for the mid-term and final evaluations include: 

• What was planned and how much was actually carried out? 
• What were the main impacts (on the forest, on the socio-economic status of households and on the wider 

environment)? 
• What problems occurred? How were they addressed? 
• What are the main outstanding issues? 

Although mid-term or final evaluations may not be extensive, there is a minimum data set that should be 
included (Table 2.27). 
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Table 2.27 Reporting template for Mid-term and Final Evaluation 

Format 2: Reporting Template for Mid-term and Final Evaluation 
Name of the CF: 

Gewog: 

Dzongkhag: 

Division/Park: 

Executive Summary 

 

Acronym 

 

Table of Contents 

 

Introduction 

 

Key achievement highlights  

 

Mid-term and final evaluation of CFMP/CFMG based on the indicators/criterion set for evaluation in 

the CF manual (Annex 6, Format 2). Key achievement highlights contributed by the activities.   

 

Constraints 

Problems or constraints faced during the implementation of CFMP (difficulties faced, etc.). 

 

Feedback 

Feedbacks received (from the implementer) and sought (reporting agency). 

 

Lessons learned  

Lessons learned from the implementation of CFMP (experiences, shortcoming and opportunities etc.). 

 

Recommendation 

Way forward follow-up actions for improvement (mid-term monitoring and evaluation) and for revision 

(final evaluation) of the CFMP. 

 

Conclusion 

 

References 

 

Annexure  
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Step 5. Reporting 

5.1 Annual Reporting by the CFMG 

The CFMG shall prepare and submit a financial report of its activities to the Beat/Range Office with a copy 
to the CFO within one month of the end of the fiscal year. The report shall contain the following information: 

a. Activities completed as prescribed under the Management Plan; 
b. Quantity of each type of forest produce harvested; 
c. Quantity of forest produce sold to persons and entities other than the CFMG and its members, and 

the amount of proceeds of those transactions; 
d. Summary of financial accounts for the year (income, expenditure, and the disbursement of profits); 
e. Other information concerning the operations, activities and management of the CF as the Depart-

ment or the Royal Government may require. 

Since the CFMG shall have already collected all information in the regular CFMG record keeping books, 
the CFMG report can simply be a photocopy of the following formats: 

Format 1:  Annual Work Plan and Progress Report 

 Format 1: Annual Work Plan and Progress Report 

ལ།ོ  Year: གོངས་སྱེ་ནགས་ཚལ་གླི་མླིང་། Community Forest Name:   རངོ་ཁག། Dzongkhag:  

ལ་ོསྟར་འཆར་གཞླི། Annual Work Plan ལོ་སྟར་འགྲུབས་འབས་སྙན་ཞུ། Annual Progress Report 

དམླིགས་ཡུལ། Ob-

jective 

ཨང་། 

SI. 
No 

ལ་ཱརླིགས། Ac-

tivity 

ས་གནས་ཡང་ན་ས་ས།ོ 
Block or lo-
cation 

ཁ་གངས། 

Quantity 

སྱེ་ཕན་ 

Unit 

ཟླཝ། 

Month 

འགྲུབས་འབས་ཚད་གཞླི། 
Quantity 
achieved 

དྲན༌གསོ། Re-

marks 

         

         

         

         

         

Add more rows if required 

 

 

 

ཡཁྲླི་འཛནི༽ (Chairperson)  ཡདྲུང་ཆྱེན༽(Secretary) 
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Format 2:  Seedling Plantation Record  

Format 2. Seedling and Plantation Record 

ཤླིང་ལྕངམ་དང་འཛུགས་སོང་གླི་ོོ། Seedling and Plantation Record 

 Name of CF: རོང་ཁག། Dzongkhag: 

Gewog: ལོ། Year: 

ཟླཝ། 
Month 

ས་གནས་་ཡང་ 
ས་ཁོངས། Lo-

cation or 
Block 

འཛུགས་སོང་གླི་དབྱེ་

ཁག།་ Category 

of plantation 

ཤླིང་རླིགས། 
Species 

ཤླིང་བཙུགས་པའླི་ས་

ཁོངས་རྒྱ་ ཚད། Area 

planted (ha) 

ལྕངམ་གླི་གངས་ 
ཁ། Number 
of seed-
lings 

འཛིན་སོང་གླི་་རླིང་གོང་། ཡདངུལ༌རྐྱང༌། Plantation 

Costs 

(cash only, not in-kind) 
དྲོན་གསོ། Re-

marks 
ལྕངམ་གླི་རླིན་

གོང་། Seed-

ling cost 

བསྱེལ་འགྱེན་གླི་ 
རླིན་གོང་། 
Transport 
cost 

རླིན་གོང་
གཞན། 

Other 
Costs 

རླིན་གོང་
ཡོངས་ 
བསོམས། 
Total 
cost 

           

           

           

           

Add more rows if required 

 

 

 

 

ཡཁྲླི་འཛནི༽ (Chairperson)    ཡདྲུང་ཆྱེན༽ (Secretary) 
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Format 5:  Collection Permit 

Format 5: Collection Permit 

བསྡུ་ལྱེན་ཆོག་ོམ། Collection Permit 

ཡང་། No. སླི་ཚེས།་Date: 

ཆགོ་ོམས་འཆང་མླི་གླི་མླི་། Name of permit holder: 

གཡུས། Village: རྱེད་ལོག། Gewog: 

Dzongkhag: Permit No: 

དུས་ཡུན། Du-

ration 

འོནོ་ཁུངས་ཁ་གསལ། Details 

of products 

ས་གནས་ཡང་ན་ས་ས།ོ Loca-

tion or Block 

ཚད་གཞླི། 

Quantity 

རླིང་གོང་ཡདངུལ་ཀྲམ༽ 

Rate (Nu) 
ཡདངུལ་ཀྲམ་ཡོངས་བསོམ། To-

tal amount 

དྲན་གས།ོ Re-

marks 

       

       

       

       

 

 

 

 

ཡཁྲླི་འཛནི༽ (Chairperson)                                ཡདྲུང་ཆྱེན༽ (Secretary) 
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5.2 Annual Reporting by the Forestry Offices 

The Field Office staff must submit an annual status report as per the “Guidelines for Monitoring & Evalua-

tion of community Forestry, 2016”. The TD/PO staff should provide information on CFs in their respective 
jurisdiction for the national CF database that is maintained by FRMD. This needs to be based on reports 
prepared for each CF and on the CFMG annual financial reports.  

2.3.6 Revision of Community Forest Management Plan and By-laws 

The Community Forest Management Plan follows a 10-year cycle plan. Upon completion of the 10 years 
plan period, the plan shall have to be revised. Revision of the CFMP shall be done at the last quarter of the 
9th year of the plan period. It is likely that the CFMG shall require some help in preparing a new management 
plan, but the same (or similar) methodology can be used as for the initial plan with the following consider-
ations: 

• The renewal and approval of the revised CF plan shall be subject to findings of the final evaluation of 
the CF implementation for the past 10 years.  

• The revised CFMP should be built on experiences from the previous plan. 

• Summary of key findings of the previous plan should be mentioned in the introduction part of the revised 
plan. 
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3. Local Forest Management Area 

3.1  Management Context  

The Local Forest Management Plan (LFMP) is designed to bring all State Reserves Forest land (SRFL) 
under management regimes for sustained supply of forest products and ecosystem services. This focuses on 
sustainable management of all forest resources which are not covered by other management regimes. The 
effective implementation of this guideline shall ensure sustainable management of forest resources and 
achieving the goal of bringing all of country’s forest resources under sustainable management.  

3.2  Roles and Responsibilities 

The Divisional Forest Offices (DFO) is entrusted with the responsibility of preparing the LFMP of a Gewog. 
Forest Resources Management Division (FRMD) shall provide technical support in the preparation and im-
plementation of the management plan. 

3.3 Planning  

Figure 3.1 shows the steps in preparation and implementation of a LFMP, which is further discussed in 
Table 3.1. 

Step 6. Preparation of Management Plan

Step 5 Data Analysis

Step 7. Submission of LFMP to CFO, FRMD for review 
and approval

2. Review and Approval 

3. Implementation

Step 1. Endrosement of LFMP by FRMD, Technical 
Committee and the Director, DoFPS

Step 4. Forest Resource Assessment

Step 2. Approval of the LFMP by Head of the Ministry, 
MoAF for implementation

Record Keeping

Implementation of Plan as per the Management Prescription

1. Planning

Annual Monitoring by CFO

Step1. Reconnaissance survey
4. Monitoring 

Step 2. Spatial Ogranization

Step 3. Forest Function Mapping

Plan revision

 

Figure 3.1 Management Planning Process 
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3.3.1 Reconnaissance survey  

Reconnaissance survey is the preliminary survey that is carried out within the area of interest to examine 
the area with respect to Forest Types, Wildlife, NWFPs, general topography, road connectivity and acces-
sibility, cultural significance, past and current management history, socio-economic status of the people 
living within the area, climate, weather, etc.  

3.3.1.1 Objective 

To provide preliminary information on social, environmental, topographic and economic information that 
is required in order to prepare a sustainable Forest Management Plan for Local Forest Management area 
within a Gewog. The information collected must guide the planner at the later phase of planning in deter-
mining the Management area, Forest Types, accessibility for resource extraction, delineating barren and 
degraded forests, important water catchment areas, areas of cultural significance and important wildlife 
habitats. 

3.3.1.2  Preparation of Survey 

All available information on forest cover and land use types should be collected. The objective is to prepare 
a base map indicating actual forest/non-forest boundary, preliminary forest types and potential operable and 
accessible areas. For this purpose, the following working documents are required: 

1. Topographic map with 40 m contour lines at a scale of 1:50,000 (including Gewog boundary); 
2. LULC (latest available Land Use Land Cover map) at a scale of 1.50,000; 
3. Others (Satellite image, Aerial photos etc. (if available)). 

 

3.3.1.3 General Description and Current Situation 

Basic information with respect to the location, forest types, forest composition, accessibility, past and cur-
rent Management history and socio-economic status of the people living within the Gewog.  In order to 
collect more accurate information, public consultation with the people living within the Management area 
is highly recommended 

3.3.1.4 Identification of LFMA boundary  

The LFMA boundaries should be based on Gewog boundary. One Gewog is one LFMA. The planner must 
validate the boundaries by carrying out field visits and consulting the Local leaders preferably Gups in order 
to confirm the Gewog boundary. Field validation of the boundaries can be done by using topographic maps 
with a scale of 1:50000. 

3.3.2 Spatial Organization of the area 

The objective of the spatial organization of the LFMA is to sub-divide the LFMA in order to aid in the 
preparation and implementation of annual activities. 

3.3.2.1 Exclusion of Areas Managed under other Management Regimes 

Local Forest Management Plans are prepared for areas which fall outside other existing Management re-
gimes to bring all forest under management. Thus, all the areas falling within any of the managed regimes 
or those planned to be brought under any management shall  be excluded from the Local Forest Management 
area.  
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Figure 3.2 Local Forest Management Area 

3.3.2.2 Demarcation of Future Management area  

Any other areas from which extraction of rural timbers is practically not feasible during this plan period due 
to reasons of inaccessibility, remoteness from the settlements or other factors must be demarcated and 
mapped as Future Management area. Although, these areas cannot be operated during the current plan 
period, it may be brought under or production management in the future. The areas thus demarcated must 
be clearly mapped in the Management Map as “Future Management Area”. A detailed explanation with 

regards to the “Future Management Areas” must be included in the plan with probable future management 

options. 

However, if all the areas within the Gewog outside managed regimes are accessible for rural timber extrac-
tion during the current plan period, there may not be the need for demarcation of Future Management Area. 
In such instances the Future Management Area shall be zero. 

Note: The Future Management Area shall be identified as a separate Block with no compartments and shall 
be mapped under Non-Production circle. 

3.3.2.3 Demarcation of Current Management Area. 

The Management Area for the current plan period, hereafter referred to as the Current Forest Manage-
ment Area shall be the area left after exclusion of areas as described under 3.3.2.1 & 3.3.2.2. However, for 
protected areas (National Park, Wildlife Sanctuary and Biological Corridor) the identification of resource 
allocation area and area exclusion should be based on park zonation. 

3.3.2.4 Local Forest Management Area 

The “Local Forest Management Area” for the plan period shall be the sum total of “Future Management 
Area “and “Current Forest Management Area” as determined under section 3.3.2.2 and 3.3.2.3 respec-
tively. 
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3.3.2.5 Compartmentalization 

Compartmentalization is the process of sub-dividing Forest Management area into Blocks and Compart-
ments. Compartmentalization is done in order to identify the production forest area for rural use and to 
subdivide this area into more uniform units for the purpose of management and monitoring.  

Note: Compartmentalization is done within the Local Forest Management Areas as determined under 
section 3.3.2.4. 

Objectives 

The overall objectives of compartmentalization are to: 

1. divide the entire forest management area into more uniform units for management. 
2. focus on specific management interventions and prescriptions in a smaller area. 

Blocks and Compartments 

Blocks 

The blocks are the basic orientation and administrative units within the LFMA. They are essentially major 
water-catchments separating easily recognizable major parts of the Forest Management Areas. Therefore, 
the block boundaries shall in most cases follow ridges separating individual water-catchments. Other prom-
inent topographical features such as large streams or rivers can also be used to identify block boundaries. 
For all practical purposes, the number of Blocks must be kept as minimum as possible to a maximum of 5-
10 Blocks with an average area of a block of about 1500 to 2500 hectares (if determined by topography it 
can be much smaller, or larger). It should be kept in mind that eventually, with increased management 
intensity, the block could become an administrative unit within the LFMA, such as a beat. 

The name of a block must be an easily recognizable, commonly used name for that particular area. In name 
selection, care has to be taken to avoid using unfamiliar or confusing names. 

Compartments 

The compartments are basically orientation units created to facilitate easy orientation within each unit and 
to provide for easy administration, recording and monitoring of operations within the LFMA. Compartments 
are created in order to identify more or less uniform forest areas, which requires the same silvicultural 
treatment and management prescription. Furthermore, it serves for the spatial organization of forest use and 
for the purpose of monitoring.  

The Compartment is the unit for forest resource assessment and planning in Current Forest Management 
Areas. The boundaries of the compartments follow easily identifiable topographic or planimetric features 
such as roads, streams, rivers, main ridges, etc. In some cases, boundaries could follow major forest type 
lines. The size of the compartment would depend on the intensity of management, intensity of road network 
and a topographic makeup of the area. Typically, it would be anywhere between 100 and 500 hectares. 

Dividing the areas into compartments should be based on the forest types and natural features, the size of 
which shall vary accordingly.  Furthermore, it serves for the spatial organization of forest use and for the 
purpose of monitoring. 

Process 

Compartmentalization (preparation of blocks and compartments) should be done within Local Forest Man-
agement Area as determined under section 3.3.2.4. The entire process of compartmentalization is carried 
out using Google Earth in combination with Geographical Information System (GIS). The final outcome of 
compartmentalization shall be a spatial organization map which reflects blocks and compartments within 
the forest management area. The steps for compartmentalization is as given below. 

Determination of areas of Blocks and Compartments 
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The areas of each block and compartment can be calculated in GIS or Google Earth. Along with the spatial 
organization map , the area statement of each block and compartment should be calculated and recorded as 
well. 

Naming of Block and Compartment 

Blocks are named with the name of the village or with any local name of a place falling within the Block 
(eg; Kawang Block, Chang Block, etc.,). If the area where the block is located is known by some local name 
it is very important that this name is used/ entered on the maps. By doing this the block shall become 
associated with the name with which local people are familiar with. This shall again facilitate easy orienta-
tion. 

Compartments are named by Roman Numerals (I, II, III). The compartment naming is usually carried out 
clock-wise starting from north.  

GIS Steps 

GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

Defining the Boundary of LFMA 

Gewog boundary is considered as LFMA boundary 

Open QGIS 

➢ Add Gewog of Bhutan file 

 

Select the gewog of interest for LFMA boundary 

➢ Right click gewog file > Click Filter 
➢ Enter the following expression: 

             "GeogName" = 'Dechhenling' 

➢ Click Ok 
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Save the selected gewog on interest 

➢ Right click on filtered layer > Export > Save Features As 
➢ Format: Select ESRI Shapefile 
➢ Save the file with appropriate name in working directory 
➢ Click OK 

 

 

 

➢ Right Click on New file (Dechenling) > Click Zoom to Layer 
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This is gewog is going to be the boundary of LFMA. Now within this boundary, Blocks and Compartments 
needs to be delineated. We shall Google Earth Pro to delineate the boundary of Blocks and Compartments. 

Convert the shapefile into Keyhole Markup Language (KML) file 

➢ Right click on layer > Export > Save Features As 
➢ Format: Select Keyhole Markup Language (KML) 
➢ Save the file with appropriate name in working directory 
➢ Click OK 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        519 

 

 

 

 

 

 

 

 

 

 

 

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        520 

Open Google Earth Pro 

 

Add the LFMA boundary (KML) file  

Click File > Open  

 

Navigate to the folder where kml file was saved 

Select the LFMA boundary kml file > Click Open 
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Now based on this LFMA, delineate Blocks and Compartment Boundary as line features 

➢ Right click on My Place > Add > Folder 
➢ Give appropriate name to the folder and save it 
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Draw boundary for Blocks using line features 

➢ Right click on newly created folder (Dechenling) > Add > Path 
➢ Draw the line taking natural features which can be served as boundary of Blocks (Note: it need not 

be one single line to cover the boundary of Blocks. Multiple segments of lines can be used to make 
the boundary by joining them, however, make sure end on one segment of line is over lapped with 
starting point of another segment of line as shown in the figure below) 
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Similarly draw boundary using line features (Path) for all Block boundary 
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Draw boundary for Compartments using line features. 

➢ Right click on newly created folder (Dechencling) > Add > Path 
➢ Draw the line taking natural features which can be served as boundary of Compartments (Note: it 

need not be one single line to cover the boundary of Compartments. Multiple segments of lines can 
be used to make the boundary by joining them, however, make sure end on one segment of line is 
over lapped with starting point of another segment of line, overlap with boundary of LFMA, 
Blocks and Compartments). 

 

 

 

Repeat the process to draw the boundary of Sub-compartment if required. 
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Once the delineation of all boundaries of Blocks, Compartments and Sub-compartments as line features is 
completed, import the Keyhole Markup Language (KML) file to QGIS. 

➢ Right click on newly created folder (Dechenling) > Save Place As 
➢ Save the file KML file in the designated folder. 

 
 

 

Once all the line features of Blocks, Compartments and Sub-compartments are saved as KML file, next step 
should be carried out in QGIS 

➢ Open QGIS 
➢ Navigate to Layer < click Add Layer >Click Add Vector Layer… 
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➢ In the source, browse your KML file 
➢ Select the KML file > click open 
➢ Click Add 
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KML file need to be converted into ESRI Shapefile format for further analysis. 

➢ Right click on file > Export > Save Features As  
➢ Format: Select ESRI Shapefile 
➢ CRS: DRUKREF 03/ Bhutan National Grid 
➢ Save the file with appropriate name in working directory 
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➢ Add LFMA boundary 

 

Convert the LFMA from polygon feature to line feature 

➢ ype polygon to line in processing toolbox Navigate to SAGA > Vector line tools > select Convert 
polygons to lines 

➢ In Input Layers: Select the polygon feature (LFMA boundary) you want to convert to line feature  
➢ Save the file with appropriate name in working directory 
➢ Click run 
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Now there are two line features life (LFMA boundary and Blocks and Compartments). We need to merge 
these two files as one single shapefile. 

➢ Type Merge in the processing toolbox 
➢ Navigate to SAGA and select Merge vector layers 
➢ In Input Layers: Check all line features (LFMA boundary and Block and compartments)  that needs 

to be merged 
➢ Save the file with appropriate name in working directory 
➢ Click run 
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Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        532 

 

 

 

Merged shapefile is still in line features. Now we need to convert the line features into polygon features.  

➢ Type Polygonize in processing toolbox 
➢ Navigate to Vector geometry and select Polygonize tool 
➢ In Input Layers: Select the file you want line feature file 
➢ Save the file with appropriate name in working directory 
➢ Click run 
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Now the line features have been converted into polygon features. We need to give the appropriate name of 
LFMA, Blocks, Compartments and Sub-compartments. 

➢ Right click on polygon layer > Click Open Attribute Table 
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➢ Click Toggle Editing Mode 

 

 

 

➢ Click on New field  
➢ Name: Type FMU 
➢ Type: Select Text(String) 
➢ Length : 50 
➢ Click Ok 
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➢ Click Open Field Calculator 
➢ Check Update existing field  
➢ Select LFMA 
➢ In the expression box; type Name of LFMA within inverted coma e.g. (‘Dechenling LFMA’) 
➢ Click ok 
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➢ Click on New field  
➢ Name: Type Block 
➢ Type: Select Text(String) 
➢ Length : 50 
➢ Click Ok 
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➢ Minimize attribute table 
➢ Click Select Feature  
➢ Identify each different Blocks, we need to name the block one at a time 
➢ Move your mouse and click one polygon (it shall be highlighted yellow). We can also select multiple 

polygons by pressing control on keyboard and clicking on multiple polygons to be selected. Select 
all the polygons that falls under one Block 
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➢ Open/maximize attribute table 
➢ Select Show Selected Features (this shall show only polygons that are selected) 

 

➢ Click Open Field Calculator 
➢ heck Update existing field  
➢ Select Block 
➢ In the expression box; type Name of Block within inverted coma e.g. (‘Dechenling’) 
➢ Click ok 
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Repeat the process to name all the Blocks 
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➢ Click on New field  
➢ Name: Type Compart (Full compartment cannot be typed due to restriction in number of letters for 

field title) 
➢ Type: Select Text(String) 
➢ Length : 50 
➢ Click Ok 

 

➢ Minimize attribute table 
➢ Click Select Feature 
➢ Identify each different Compartment that’s need to be delineated as Future Management 
➢ Move your mouse and click one polygon (it shall be highlighted yellow). We can also select multiple 

polygons by pressing control on keyboard and clicking on multiple polygons to be selected. Select 
all the polygons that needs to be marked as Future Management 

➢ Open/maximize attribute table 
➢ Select Show Selected Features (this shall show only polygon that is selected) 
➢ Click Open Field Calculator 
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➢ Check Update existing field  
➢ Select Compart 
➢ In the expression box; type Number of Compartment within inverted coma in Roman numerals e.g. 

(‘I’) or (‘II’) or (‘III’) 
➢ Click ok 

 

 
 

 
➢ Minimize attribute table 
➢ Click Select Feature 
➢ Identify each different Compartment, we need to name the Compartment one at a time 
➢ Move your mouse and click one polygon (it shall be highlighted yellow).  
➢ Open/maximize attribute table 
➢ Select Show Selected Features (this shall show only polygon that is selected) 
➢ Click Open Field Calculator 
➢ Check Update existing field  
➢ Select Compart 
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➢ In the expression box; type Number of Compartment within inverted coma in Roman numerals e.g. 
(‘I’) or (‘II’) or (‘III’) 

➢ Click ok 

 

 

 

Repeat the process to name all the Compartments 

 

 

 

Once all the naming of FMU, Blocks, Compartments and Sub-comparted are completed save the edits 

➢ Click Toggle editing mode > Click Save 
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Display Blocks in different colour in map viewer. 

➢ Right click on polygon layer > Click Open Attribute Table > Click Properties. 

 

➢ Click Symbology > Select Categorized  
➢ In the Value: Select Block 
➢ Click Color ramp and select appropriate colour 

 

➢ Click Classify 
➢ Click Apply  
➢ Click OK 
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Display the name of Blocks, Compartments and Sub-compartments in Map Viewer 

➢ Click Labels > Select Rule-based Labelling  
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➢ Click Add Rule 
➢ In the Label Value: Select Blocks 
➢ In Placement: Select Horizontal 
➢ Click OK 

 

➢ To add more rules :click Add Rule 
➢ In the Label Value: Select Compart 
➢ In Placement: Select Horizontal 
➢ Click OK 
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➢ In the Layer Properties dialogue box click Apply and OK 
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Since area of gewog is very large and it may not be feasible to bring all area into sustainable forest man-
agement at once. Therefore, we need to segregate the area into current management and future management 
area.  

➢ Click on Select features by area or single click 

 

 

➢ Move your mouse and click one compartment to select (it shall be highlighted yellow). We can also 
select multiple compartments by pressing control on keyboard and clicking on multiple compart-
ments to be selected. Select all the compartment that need to be brought under current management.  
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➢ Right click on layer > Export > Save Features As  
➢ Format: Select ESRI Shapefile 
➢ CRS: DRUKREF 03/ Bhutan National Grid 
➢ Save the file with appropriate name in working directory 
➢ Encoding: Check Save only selected features 
➢ Click OK 
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3.3.3 Forest Function Mapping  

Objective 

Forest function mapping is an essential step for sustainable forest management planning. The func-
tion mapping is a process of defining the forest management area into categories of area based on 
its function. The forest function map provides information on total sustainable production area, 
area for conservation and areas of ecologically, environmentally and socially important functions 
which needs to be protected with certain management restrictions.  
The main objectives of Forest Function Mapping are to provide spatial information on: 

● areas which are ecologically, environmentally and socially important and needs to be protected 
(Protection); 
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● non-forested area for management intervention (Non-production); and  
● the total area that can be brought under sustainable forest management to meet the rural timber 

demand (production). 

Scope 

Forest function mapping shall be carried out only within Current Forest Management area as indentified 
under section 3.3.2.3. Based on the forest function mapping, the entire Management Area is segregated into 
three management circles viz Protection Management Circle, Production Management Circle and Non-Pro-
duction Management Circles (Figure 3.3 Management Circles and its components). In addition to these 
three Management circles, Non-Wood Forest Product Management Circle shall be an overlapping Manage-
ment Circle which may cover all the other three regular management circle. 

 

Figure 3.3 Management Circles and its components 

3.3.3.1 Management Circles 

Management circle is defined as specific area within Management area which is designated to cater to spe-
cific socio-environmental functions based on its topography, land use type and forest functions. 

Protection Management Circle 

The Protection Management Circle is an area under protection where timber extraction activities cannot 
take place. However, extraction of timber may be permitted under specific circumstances such as outbreak 
of pest and diseases, forest fire and other unforeseen natural hazards with prior approval of the Head of the 
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Department. The Protection Working Circle is the sum of all protection functions such as wildlife protec-
tion, soil protection, riparian reserve protection, religious site protection, road buffer protection and local 
water supply protection as indicated in Figure 3.3 Management Circles and its components. 

The mapping of all protection functions under Protection Management Circle can be carried out in GIS. 
The slope classification can be done using Digital Elevation Model (DEM) preferably of higher resolutions. 
In addition to the protection areas mentioned above, areas of wildlife importance (key biodiversity areas or 
wildlife hotspots) should be mapped out and demarcated under protection management circle.  The criteria 
for mapping for each of these protective functions is as mentioned under Chaper 1: Forest Management 
Units, section 1.9 (Forest Function Mapping) of this Code. 

Soil Conservation Function 

GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

Open QGIS 
➢ Add Local Forest Management Area (LFMA) boundary layer 
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Create a buffer of 500 m around the LFMA boundary to use it as area of interest (aoi). Buffer is being 
created to increase the extent of LFMA as next steps involve using combination of vector and raster file. 

➢ Click Vector > Geoprocessing Tools > Buffer 

 

 

 

➢ Save the buffer layer with appropriate name in working directory 
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➢ Add Digital Elevation Model (DEM). DEM is raster data. 

 

 

 

 

Clip the DEM within the aoi (500m buffer LFMA boundary layer) 

➢ Click Raster > Extraction > Clip Raster by Mask Layer 
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➢ Input layer: Select DEM of Bhutan 
➢ Mask layer: Buffered LFMA boundary shapefile 
➢ Target CRS: Select EPSG:5266-DRUKREF 03/Bhutan National Grid 
➢ Save the clipped DEM with appropriate name in working directory 

 

 

 

 

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        556 

 

 

Generate SLOPE using DEM 

➢ Click Raster > Analysis > Slope 

 

 

 

➢ Input layer: select LFMA Dem  
➢ Leave the rest default 
➢ Save the SLOPE with appropriate name in working directory 
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Reclassify the SLOPE into following classes 

1. 0-35 
2. 35-45 
3. 45 and above 

 
➢ To carry out this process open NOTEPAD and type as following and save the text file with name 

slopereclass. 
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*:35:1 

35:45:2 

45:*:3 

 

 

 

Open the processing toolbox, if the toolbox is not open 

➢ Click Processing > Toolbox 

 

 

 

➢ Type r.recode in the search box of processing toolbox and open script by double clicking 
 

1 means 35 degree and below slope 

2 means 35 to 45 degree slope 

3 means 45 degree and above slope 
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➢ Input layer: select LFMA Slope 
➢ File containing recode rules: browse the text file containing reclassification code and insert 
➢ Recoded: Save the reclassified SLOPE with appropriate name in working directory 
➢ Click Run 
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Convert the reclasified slope rater file into vector file 

➢ Click Raster > Conversion > Polygonize (Raster to Vector) 

 

 

 

 

➢ Input: Select reclassified slope 
➢ Leave the rest default 
➢ Vectorized: Save the file with appropriate name in working directory 
➢ Click run 
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We need to segregate the slope with more than 45 degree from reclassified slope as Soil Protection 

➢ Right click vector reclassified slope file > Filter 
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Enter expression as shown in the figure 

➢ Double click DN > Click = sign > click All (this shall display all DN value present in attribute 
table) > double click 3 > ok 
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Export the selected layer 

➢ Right click on filtered vector reclassified slope file > Export > Save Features As  
➢ Format: Select ESRI Shapefile 
➢ File name: Save the file with appropriate name in working directory 
➢ CRS: Select EPSG:5266-DRUKREF 03/Bhutan National Grid 
➢ Click Ok 
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In the exported slope layer, there are several smaller areas surrounded by steep area. Accessing such areas 
are impossible, therefore, we need to include those areas under soil protection. 

➢ In the Processing Toolbox type “delete holes” >double click Delete holes tools 
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➢ In Input layer select soil protection layer 
➢ In Remove holes with area less than: enter 100000 m2 (10 ha) 
➢ Cleaned: Save the file with appropriate name in working directory 
➢ Click run 
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Calculate the area of layer 

➢ Right click on layer > click Open Attribute Table 
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Calculate the area of each polygon 

➢ Click Toggle editing mode > Click Open Field Calculator  
➢ Check in the Create a new field and type as follows 

o Output field name: Area_ha 
o Output field type: Decimal number (real) 
o Output field length 10 and Precision 3 

The expression field should be filled with area calculating expression 

➢ Click Geometry > double click $area  
➢ In the expression box divide $area with 10000; this is to convert the calculated area unit from m2 

to hectare.  

 

 

➢ Close the editing mode by undo toggle editting 

There are also several isolated smaller steep areas, this should be removed from soil protection layer.  

To remove the isolated small patches (of area less than 5 ha) of steep area, filter the area of the soil protection 
layer for area greater than or equal to 5 ha (>= 5 ha) 

➢ Right click on working layer > click filter > and enter the expression as shown in picture below in 
Query Builder 
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Export the filtered layer and save it as soil protection layer 

➢ Right click on filtered vector reclassified slope file > Export > Save Features As  
➢ Format: Select ESRI Shapefile 
➢ File name: Save the file with appropriate name in working directory 
➢ CRS: Select EPSG:5266-DRUKREF 03/Bhutan National Grid 
➢ Click Ok 
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The exported soil protection layer contains area even outside the LFMA boundary as we generated the slope 
for 500 m buffered LFMA boundary. We also don’t need soil prtection in future management area. 

Therefore, we need to extract soil protection layer within current management LFMA boundary 

➢ Add current management  
➢ Type clip in processing toolbox 
➢ Navigate to SAGA > Vector polygon tools 
➢ Select Polygon clipping  

 

 

➢ In Clip features: select whole Soil protection layer 
➢ In input features: select current management LFMA boundary layer 
➢ Output features: Save the file with appropriate name in working directory 
➢ Click run 
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Creation of soil conservation (Protecttion) function is complete. 

Water and Watershed Conservation Function 

GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

➢ Open QGIS 
➢ Add LFMA boundary layer 
➢ Add River networks layer 
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Clip with LFMA Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select LFMA boundary layer 
➢ In input features: select River network layer 
➢ Output features: Save the file with appropriate name in working directory 
➢ Click Run 
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Create buffer of 30m around the rivers 

➢ Click Vector > Geoprocessing Tools > Buffer 
➢ In Input layer: Select river layer 
➢ In distance: enter 30  
➢ Check dissolve result 
➢ Rest parameter leave as default 
➢ Buffered: Save the file with appropriate name in working directory 
➢ Click run 
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The exported river buffer layer extends beyound current management LFMA boundary. Therefore, we need 
to extract river buffer layer within LFMA boundary 

Clip with LFMA Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select LFMA boundary layer 
➢ In Input features: select river buffer layer 
➢ Output features: Save the file with appropriate name in working directory 

 

 

Note: Any stream that is being used as source of local water supply needs to be mapped as local water 
supply by generating 60m buffer on either side.   

➢ Add water source point layer 
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Clip with LFMA Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select LFMA boundary layer 
➢ In Input features: select water source point layer 
➢ Output features: Save the file with appropriate name in working directory 
➢ Click Run 

 

Create buffer of 60m around the water source point 

➢ Click Vector > Geoprocessing Tools > Buffer 
➢ In Input layer: Select water source point layer 
➢ In distance: enter 60  
➢ Check dissolve result 
➢ Rest parameter leave as default 
➢ Buffered: Save the file with appropriate name in working directory 
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If the generated buffer is extending beyond LFMA boundary, it needs to be clipped with LFMA boundary. 

Note: If there is any wetland or watershed area that demands protection form sustainable timber harvesting, 
then such area can be designated as watershed special management area.  

Social Function 

GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

➢ Open QGIS 
➢ Add FMU boundary layer 
➢ Add Religious sites layer 

 

Clip with LFMA Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select LFMA boundary layer 
➢ In input features: select religious site point layer 
➢ Output features: Save the file with appropriate name in working directory 
➢ Click Run 

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        576 

 

Create buffer of 100m around religious sites 

➢ Click Vector > Geoprocessing Tools > Buffer 
➢ In Input layer: Select water source point layer 
➢ In distance: enter 100 
➢ Check dissolve result 
➢ Rest parameter leave as default 
➢ Buffered: Save the file with appropriate name in working directory 
➢ Click Run 
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Since the buffer is extending beyond the current management LFMA boundary, clip religious sites buffer 
with LFMA boundary 

Clip with LFMA Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select FMU boundary layer 
➢ In input features: select religious site buffer layer 
➢ Output features: Save the file with appropriate name in working directory 
➢ Click Run 

Nature Conservation Function  

If there is any threatened and protected flora, fauna and avi-fauna is present within the LFMA boundary, 
their habitat should be mapped out using GPS or other technology. If there are no such threatened and 
protected species, mapping this function may not be necessary. Similarly, in this LFMA, there are no such 
species. In such cases, soil protection function can be an overlapping function. Soil protection function can 
be also mapped as wildlife protection function. 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

➢ Open QGIS 
➢ Add FMU boundary layer 
➢ Add Soil Protection layer 
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Export this soil protection layer as wildlife protection layer 

➢ Right click on filtered vector reclassified slope file > Export > Save Features As 
➢ File name: Save the file with appropriate name in working directory 
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Road Buffer 

GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

➢ Open QGIS 
➢ Add current management LFMA boundary layer 
➢ Add Road network layer 

 

Clip with current management LFMA Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select LFMA boundary layer 
➢ In input features: select road network layer 
➢ Output features: Save the file with appropriate name in working directory 
➢ Click Run 
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Open attribute table and look at the column Road_Type. There are different types of road 

➢ Right click on Road layer > Click Open attribute table 

 

Select Primary National Highway through filtering process 

➢ Right click road network layer > Filter 
➢ Enter expression as shown in the figure 
➢ Double click Road_Type > Click = sign > click All (this shall display road types present in attribute 

table) > double click Primary National Highway > ok 
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Create buffer of 180 m on either side of Primary National Highway 

➢ Click Vector > Geoprocessing Tools > Buffer 
➢ In Input layer: Select filtered Primary National Highway layer 
➢ In distance: enter 180 
➢ Check dissolve result 
➢ Rest parameter leave as default 
➢ Buffered: Save the file with appropriate name in working directory 
➢ Click Run 
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Select Dzongkhag Road, Farm Road, Access Road and Thromde Road 

➢ Right click road network layer > Filter 
➢ Click Clear the selection 
➢ Enter expression following expression: 

"Road_Type" = 'Access' OR "Road_Type" = 'Dzongkhag' OR "Road_Type" = 'Farm' OR 
"Road_Type" = 'Thromde' 

➢ Click Ok 
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Create buffer of 30 m on either side of Dzongkhag, Farm, Access and Thromde road 

➢ Click Vector > Geoprocessing Tools > Buffer 
➢ In Input layer: Select filtered Primary National Highway layer 
➢ In distance: enter 30 
➢ Check dissolve result 
➢ Rest parameter leave as default 
➢ Buffered: Save the file with appropriate name in working directory 
➢ Click Run 
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Now there are two different road buffer layers, we need to merge it together. 
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➢ Type merge in processing toolbox 
➢ Navigate to SAGA and select Merge vector layers 
➢ In Input Layers: Select the file you want to merge (PrimaryNationalHighway_Buffer and 

Otherroad_Buffer) 
➢ Rest parameter leave as default 
➢ Merged Layer: Save the file with appropriate name in working directory 
➢ Click Run 
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Dissolve merged layers 

➢ Click Vector > Geoprocessing Tools > Dissolve  
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➢ In input layer: Select the layer to be dissolved 
➢ Dissolved: Save the file with appropriate name in working directory 
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Dissolved road buffer layer extends beyond current management LFMA boundary 

Clip with LFMA Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select LFMA boundary layer 
➢ In input features: select dissolved road buffer layer 
➢ Output feature: Save the file with appropriate name in working directory 
➢ Click run 
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Soil protection layers, water and watershed conservation layer, religious sites protection layers, nature con-
servation layers, and road buffer needs to be considered as protected areas where timber harvesting is re-
stricted. 

➢ Add soil protection layers 
➢ Add riparian reserve buffer layer 
➢ Add local water supply buffer layer 
➢ Add religious site buffer layer 
➢ Add road buffer layer 

 

Merge all these layers as one layer 

➢ Type merge in processing toolbox 
➢ Navigate to SAGA and select Merge vector layers 
➢ In Input Layers: Select the file you want to merge (Soil protection layers, Riparian reserve buffer 

layer, Local water supply buffer layer, Religious site buffer layer and road buffer layer) 
➢ Rest parameter leave as default 
➢ Save the file with appropriate name in working directory 
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Dissolve the merged layers 

➢ Type dissolve in Processing Toolbox 
➢ Navigate to GDAL tool and select Dissolve > double click to open the toolbox 
➢ Input layer: Select merged protection layers 
➢ Save the file with appropriate name in working directory 
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If we closely check the dissolve layers there are smaller polygons surrounded by protection layers after 
merging and dissolving the protection layer. We need to delineate these smaller polygons under protection 
management circle as these areas shall be inaccessible due to surrounding protection layer. 

➢ In the Processing Toolbox type “delete holes” >double click Delete holes tools 
➢ In Input layer select protection management layer 
➢ In Remove holes with area less than: enter 100000 
➢ Cleaned: Save the file with appropriate name in working directory 
➢ Click run 
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Non-production Management Circle 

The Non-Production Management Circle comprises of non-forested areas which includes built up areas, 
rocky outcrops, settlements, agricultural use areas (Kamzhing and Chuzing), shrubs, alpine scrubs, mead-
ows, etc. (Figure 3.3)  Further, the Future Management Area must also be included under Non-Production 
Management Circle as no resources shall be extracted from these areas due to remoteness of the area. In 
non-production management circle, reforestation, afforestation and soil/water conservation activities can be 
carried out. 

Non-Production layer can be extracted from Land Use and Land Cover (LULC) layer. But before extracting 
non-production layer from LULC, LULC needs to be updated with protection management circle layer. 
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GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

➢ Open QGIS 
➢ Add LFMA boundary layer 
➢ Add Land use and land cover (LULC) layer 

 

Clip with current management LFMA Boundary 

➢ Type clip in processing toolbox 
➢ Select Polygon clipping from SAGA Tools 
➢ In Clip features: select LFMA boundary layer 
➢ In input features: select LULC layer 
➢ Output feature: Save the file with appropriate name in working directory 
➢ Click Run 
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Protected area needs to be updated in LULC  

➢ Type update in Processing Toolbox > select polygon update tool > double click to open the tool  
➢ In Layer A: select LULC of LFMA 
➢ In Layer B: select Protection Management Circle layers 
➢ Updated polygons: Save the file with appropriate name in working directory 
➢ Click Run 

 

 

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        595 

 

Select only non-production area (Area other than forests and protected layer) 

➢ Right updated LULC(LULC_and_PrtMgtCir) > Filter 
➢ Enter expression following expression: 

"CLASS" = 'Built up' OR "CLASS" = 'Cultivated Agriculture' OR "CLASS" = 'Landslides' OR 
"CLASS" = 'Non Built up' OR "CLASS" = 'Shrubs' OR "CLASS" = 'Water Bodies' 

➢ Click Ok 

 

Export the filtered layer and save it as non-production layer 

➢ Right click on filtered layer > Export > Save Features As 
➢ Format: Select ESRI Shapefile 
➢ File name: Save the file with appropriate name in working directory 
➢ Click Ok 
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Production Management Circle 

The Production Management Circle comprises of forest area that can be brought into sustainable manage-
ment of forest  to meet the rural timber demand.  Forest area left after identifying the Protection Management 
Circle and Non-Production Management Circle  is considered as Production Management Circle. This man-
agement circle constitutes areas which are more stable and stocked with merchantable timbers of important 
species which can be allotted for rural use. The area would be harvested for rural timber supply.  

GIS Steps 

This GIS analysis step is demonstrated in QGIS version 3.12; therefore, it is advised to used QGIS version 
3.12 and above. 

➢ Open QGIS 
➢ Add LFMA boundary layer 
➢ Add updated Land use and land cover (LULC_and_PrtMgtCir) layer 
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Select only forest area as Production Management Circle 

➢ Right updated LULC > Filter 
➢ Enter expression following expression: 

"CLASS" = 'Forests' 
➢ Click Ok 

 

Export the filtered layer and save it as Production Management Circle 

➢ Right click on filtered layer > Export > Save Features As 
➢ Format: Select ESRI Shapefile 
➢ File name: Save the file with appropriate name in working directory 
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NWFP Overlapping Management Circle 

Non-Wood Forest Products (NWFPs) are important source of income for improvement of rural people’s 

livelihoods. However, unregulated collection of NWFPs may not only exceed the production potential of 
NWFPs in the forest, but would also cause genetic erosion in the wild in near future. NWFPs in the Man-
agement area must be identified, assessed and harvesting as per guidelines prescribed in Volume V of the 
Code. 

The Management Circle shall overlap with all other Management Circles, including Protection and Non-
Production Management circles of the Local Forest Management Area. The overall objective of this Man-
agement Circle is to manage the NWFPs on sustainable basis, and ensure low impact through regulated 
collection. 

The details on criteria, management restrictions and mapping can be referred to Section 1.9 Forest Function 
Mapping of this Volume of the Code. 

3.3.3.2 Field Validation 

The objective of field validation is to verify whether the boundaries of Protection, Non-Production and 
Production Management Circles as determined through function mapping, prepared using GIS, correspond 
with field condition. The planner must prepare a base map reflecting all the functions prior to going to the 
field for field validation. The planner may set predetermined random geolocations within the Forest Man-
agement Area and conduct visits to those locations in the field using GPS for field validation. Preferably 
bird eye view points must be selected for better view and validation of the Management area. The intensity 
of field validation shall depend on the accuracy of Digital Elevation Model and the Land Use Land Cover 
Maps used. The planners should make necessary changes on the function maps (if any) based on the field 
validation exercise. 

3.3.3.3 Preparation of Forest Management Maps 

Upon completion of the forest function mapping and field truthing, the forest management maps should be 
prepared which shall guide the inventory crews and the planner to carry out forest resources assessment. 
The following maps must be prepared and attached to the Local Forest Management Plan for ready reference 
during implementation. 

Table 3.2 List of function maps and its components 

Sl. No. Name of the Map Components to be Included 
1 Location Map ● Location of Gewog  

● National and Gewog Boundary 

2 Overview Map  ● Map showing all existing Management Regimes 
in the Gewog 

● Road network 

3 Management Circle Map ● Production Management Circle 
● Protection Management Circle 
● Non-production Management Circle 

4 Land Use and Land Cover Map ● All Land Uses (forest and non-forest) 
5 Spatial Organization Map ● Map showing Blocks and Compartments 
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3.3.4 Forest Resources Assessment 

Forest Resource Assessment (FRA) is the systematic assessment of quantity and quality of forest resources 
available for management by collecting relevant data and information. In order to determine the sustained 
yield for the forest, the forest manager need to know what resources currently exist and how fast do the 
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resources grow and what changes occur in response to management. The method of forest resource assess-
ment may vary based on the management objectives. 

Note: Forest Resource Assessment is done within Current Forest Management Area of 

each Gewog as determined under section 3.3.2.3 as a “Management Unit”. Resource assess-

ment within Future Management area is not required and will be deferred to the next 

planning period. 

3.3.4.1 Objectives 

The objective of the FRA is to provide, in fast and simple way, the information for each compartment on 
the following: 

1. Growing stock 
2. Forest type and conditions in the forest management area. 
3. Current use of the forest by local people. 
4. Management option and potential use for rural supply and NWFP extraction. 
5. Required silvicultural measures in each compartment.  

3.3.4.2 Area of Assessment 

The resources assessment should be done for the current Forest Management Area as determined under 
section 3.3.2.3 as a “management unit”. However, resource assessment within the Future Management Area 

is not required for the current plan and is to be deferred to next plan. 

3.3.4.3 Sampling Method 

The sampling grid is generated using the systematic sampling design and data for trees are collected using 
point sampling method while regeneration and sapling data area collected from fixed radius circular plots. 
This method is applied for all type for forest stand and stand age.  

3.3.4.4 Forest Inventory 

The stratified systematic sampling is used for the inventory of Local Forest Management Area inventory. 
The different forest types constitute the stratum for inventory design and data analysis.  The point of location 
of prism swiping is considered as plot center and regeneration plot of 3.57 m radius circular plot laid and 
all type of regeneration data area collected (0.3-1.3 m height or less than 10 cm diameter).   

3.3.4.4.1 Objectives of Forest Inventory 

The objectives of the inventory may generally be stated as to provide essential information for preparation 
of local forest management plan. More specifically, the objectives of inventory are to: 

1. provide a relatively accurate overview of the growing stock and regeneration potential of the nat-
ural forest in the area, according to major forest types; 

2. give an overview of the general site characteristics of the natural forest, in terms of soils, non-tree 
vegetation and use by the local population; and 

3. provide an indication of timber quality in the different forest types. 

3.3.4.4.2 Forest Inventory Design and Sampling plots  

Inventory design 

LFMA (Local Forest Management Area) inventory shall adopt systematic sampling design as in case of 
NFI but at much finer spatial resolution. LFMA inventory should be designed to achieve estimates at 95% 
confidence interval and 10% margin of error/ sampling error.  The systematic sample uses a fixed grid to 
assign plots in a regular pattern and its advantages are;  
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• Maximize the average distance between plots and therefore minimize spatial correlation on obser-
vations  

• Increase statistical efficiency  
• Can be representative in most cases and this is most common in forestry 

Sampling design  

The systematic sampling design is used for forest management inventory. In this method, a sample grid is 
created at a predetermined sampling intervals or plot to plot distance. The sampling for LFMA inventory is 
designed to achieve results at 95% confidence interval at 10% standard error.  

Number of sample plots  

                                                                                                                  Table 3.3:  CV% of forest type 

The sampling intensity for each LFMA is deter-
mined by the forest type of the particular LFMA 
which in turn is determined by the coefficient of var-
iation. Higher the coefficient of variation, larger the 
sample size. The coefficient of variation for typical 
forest types of Bhutan (for plot area of 0.05 - 0.1 ha) 
is described in Table 1.26. The use of Land Use and 
Land Cover data, 2016 or any other update/latest 
land use and cover product is recommended for 
stratification of forest types and land use stratifica-
tion.  

The sample size is the function of coefficient of var-
iation (Table 1.26) and percentage sampling error 
(10%) and level of confidence. The commonly used 
formula is :              

 

 

 

 n =
t2 X CV%2

SE2 
 (1) 

Where,  

n is number of sample plots or it is also called sample size  

t is t value for 95% confidence interval from t-distribution table  

CV% is coefficient of variation  

SE is standard error or desired margin of error 

The coefficient of variation (CV) is a statistical measure of the dispersion of data points in a data series 
around the mean expressed in percentage. The coefficient of variation represents the ratio of the standard 
deviation to the mean, and it is a useful statistic for comparing the degree of variation from one data series 
to another, even if the means are drastically different from one another. It shows the extent of variability of 
data in a sample in relation to the mean of the population. The coefficient of variation is determined by 
Equation (2)(9).  

Sl No. Forest Type  CV% 

1 Fir 50 

2 Spruce  70 

3 Blue Pine  105 

4 Mixed Coniferous forest  70 

5 Combined conifers  80 

6 Oak (Quercus semecarpifolia) 65 

7 Mixed broadleaf  85 

8 Combined broadleaf  85 

9 Combined all 85 
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 𝐶𝑉% =  
𝑠

𝑥̅  
 𝑋 100     (2) 

Where,  

CV% of coefficient of variation in percentage  

S is sample standard deviation  

x̄ is sample mean  

For a sample with a mean of x̄ = 20 and a standard deviation of s = 8 we would estimate the coefficient of 
variation as CV% =0.40 or 40 percent. This coefficient of variation can be used for determining the sample 
size for your inventory area.  

The sample mean and standard deviation can be generated for basal area, tree count, tree height and tree 
volume. However, it is recommended to use the basal area to generate the sample mean and standard devi-
ation to estimate CV%.  

Sample size Calculation  

Let us consider the example of a LFMA of 9157 ha and estimate the sample size  

Step 1: Define the total LFMA  

In this case LFMA  = 9157 ha   

Step 2: Stratify the LFMA into different forest types using the latest available land use land cover/ forest 
type data. For example, lets assume the LFMA has four forest types of Blue Pine, Broadleaf, Fir and 
Mixed Conifer forest from 2016 land use and land cover data (Table 3.4).  

Table 3.4: Forest Type of LFMA 

Sl. No. Forest Type  Area Coefficient of variation (cv%) 
1 Blue pine 2312.67  105 
2 Broadleaf 370.52  85 
3 Fir 1076.59  50 
4 Mixed conifer 4732.14  85 

  Grand Total 8491.92   
 

Step 3: Apply the CV% of each forest type to determine the weighted area by CV% of the forest type. This 
is estimated by the equation (3) and (4) and described in Table 3.5. 

 𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐴𝑟𝑒𝑎 𝑏𝑦 𝐶𝑉% = 𝐴1𝐶𝑉1 +  𝐴2𝐶𝑉2+ … . . +𝐴𝑛𝐶𝑉𝑛 (3) 

 𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑  𝐶𝑉% =
𝐴1𝐶𝑉1 +  𝐴2𝐶𝑉2+ … . . +𝐴𝑛𝐶𝑉𝑛

𝐴1 + 𝐴2 … +  𝐴𝑛
 (4) 

   

Where, A1, A2, … An is area of a particular forest type in ha  

            CV1, CV2,… CVn, is CV% of corresponding forest type  

e.g. for current LFMA the weighted area by CV% is calculated as follow: 
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Table 3.5: Weight CV% for LFMA 

Sl. No Forest Type CV% Area (ha) Weighted area 

1 Blue pine forests 105 2312.67 2428.3035 

2 Broadleaf Forest  85 370.52 314.942 

3 Fir forest 50 1076.59 538.295 

4  Mixed Conifer forests 85 4732.14 4022.319 

 Sum  8491.92 7303.8595 

 

Therefore,  

𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑  𝐶𝑉% =
7303.8595

8491.92
 x 100 

         = 86% 

Step 4: Applying the formula in Equation 1 above, the number of plots or sample size calculated at confi-
dence interval is 95% with corresponding t-value of 1.96 (rounded to 2), CV% of 86 as determined in step 
3 and sampling error (used a synonymous with margin of error (MoE) and Standard Error) of 10%.  

Therefore, number of plots is determined using equation 1 as follows;  

   𝑛 =
22 𝑋 862

102 
 

        = 295.9 plots ≈  296 plots 

Step 5: Allocate number of sample plots to each strata and validate the total number of plots for different 
strata using equation 5 and 6 ( 

Table 3.6). 

 𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐶𝑉% 𝑏𝑦 𝑠𝑡𝑟𝑎𝑡𝑎 =
𝑊𝑒𝑖𝑔𝑡𝑒𝑑  𝑎𝑟𝑒𝑎 𝑜𝑓 𝑠𝑡𝑟𝑎𝑡𝑎

𝑇𝑜𝑡𝑎𝑙 𝑤𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝑎𝑟𝑒𝑎
 (5) 

 

𝑃𝑙𝑜𝑡 𝑏𝑦 𝑠𝑡𝑟𝑎𝑡𝑎 = 𝑇𝑜𝑡𝑎𝑙 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑝𝑙𝑜𝑡    𝑋    𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐶𝑉% 𝑏𝑦 𝑠𝑡𝑟𝑎𝑡𝑎              (6) 

 

Table 3.6: Number of plots by strata in LFMA 

Sl. 
No 

Forest Types 
CV
% 

Area 
(ha) 

Weighted 
area 

weighted CV by 
strata 

No. of plots by 
strata 

1 Broadleaf for-
est  

85 370.52 314.942 0.043119942 12.75942767 

2 Fir forest 50 1076.59 538.295 0.073700076 21.80825714 

3 Blue pine for-
ests 

105 2312.67 2428.3035 0.332468539 98.37926627 

4 Mixed Coni-
fer 

85 4732.14 4022.319 0.550711442 162.9585395 

  Total    8491.92 7303.8595   295.9054906 ≈ 296 
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Step 6: Generate sampling grid area and determine the plot to plot distance using equation 7  and 8. The 
sampling grid is generated using the formula;  

 

                          𝐺𝑟𝑖𝑑 𝑎𝑟𝑒𝑎 =
𝐿𝐹𝑀 𝑓𝑜𝑟𝑒𝑠𝑡 𝑎𝑟𝑒𝑎

𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑝𝑙𝑜𝑡𝑠
                                   (7) 

 𝑃𝑙𝑜𝑡 𝑡𝑜 𝑝𝑙𝑜𝑡 𝑑𝑖𝑠𝑡𝑎𝑛𝑐𝑒 = √𝐺𝑟𝑖𝑑 𝑎𝑟𝑒𝑎    (8) 

 

For example, the grid area for LFMA is  

    𝐺𝑟𝑖𝑑 𝐴𝑟𝑒𝑎 =  
8491.92

296
 

= 28.6889.189 ha, which is equivalent to 286889.189 m2    

And the 𝑃𝑙𝑜𝑡 𝑡𝑜 𝑝𝑙𝑜𝑡 𝑑𝑖𝑠𝑡𝑎𝑛𝑐𝑒 = √286889.189 𝑚2 

= 535.62 meters.  

But for the practical purpose, it is rounded to lower 50th value. Therefore, the final plot to plot distance is 
500 m.       

Note: The plot to plot distance is rounded to lower 50th value using the function = floor (estimated 

plot to plot distance, 50) in excel. In this case, = floor (535.62) = 500 m.  

 

Step 7:  Determine the new grid area based on plot to plot distance estimated in step 6 (Equation 9) in ha.   

 𝐺𝑟𝑖𝑑 𝑎𝑟𝑒𝑎 =
(𝑝𝑙𝑜𝑡 𝑡𝑜 𝑝𝑙𝑜𝑡 𝑑𝑖𝑠𝑡𝑎𝑛𝑐𝑒)2

10000
    (9) 

 

                  

𝐺𝑟𝑖𝑑 𝑎𝑟𝑒𝑎 =
5002

10000
 

       = 25 ha  

Step 8. Determine the final number of plots with new grid area estimated in step 7 using equation 10. 

 𝑁𝑜. 𝑜𝑓 𝑝𝑙𝑜𝑡𝑠  =
 (𝑎𝑟𝑒𝑎 𝑜𝑓 𝑓𝑜𝑟𝑒𝑠𝑡 𝑢𝑛𝑑𝑒𝑟 𝐿𝐹𝑀𝐴)

𝐺𝑟𝑖𝑑 𝐴𝑟𝑒𝑎
   (10) 

 

 

                     For               a) total LFMA  

𝑁𝑜. 𝑜𝑓 𝑝𝑙𝑜𝑡𝑠  =
9157

25
 

   = 366 (rounded to nearest whole number)  

b) For forest area only  
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                                                   𝑁𝑜. 𝑜𝑓 𝑝𝑙𝑜𝑡𝑠  =
𝟖𝟒𝟗𝟏.𝟗𝟐

25
  = 340 

 

Step 9: Calculate no of plots by strata as per the no. of plots calculated in step 8 using equation  

𝑃𝑙𝑜𝑡 𝑏𝑦 𝑠𝑡𝑟𝑎𝑡𝑎 = 𝑇𝑜𝑡𝑎𝑙 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑝𝑙𝑜𝑡    𝑋    𝑊𝑒𝑖𝑔ℎ𝑡𝑒𝑑 𝐶𝑉% 𝑏𝑦 𝑠𝑡𝑟𝑎𝑡𝑎              

 

Sl. 
No 

Forest Types 
CV
% 

Area 
(ha) 

Weighted 
area 

Weighted CV by 
strata 

No. of plots by 
strata 

1 
Broadleaf for-
est  

85 370.52 314.942 0.04311994 15 

2 Fir forest 50 1076.59 538.295 0.07370008 25 

3 
Blue pine for-
ests 

105 2312.67 2428.3035 0.33246854 113 

4 Mixed Conifer 85 4732.14 4022.319 0.55071144 187 

   Total    8491.92 7303.8595   340 

 

Generate Sampling Grid  

The regular sampling grid can be generated in ArcGIS, QGIS and any other GIS software. To generate the 
grid, you need to have physical boundary of the LFMA inlcluding clear boundaries for Future manage-
ment and Current management area either in the .kml file or shape file, which shall be used for clipping 
the area such that only grid intersection falling inside the Current Management Area boundary is selected 
for further assessment. 

Note: In many cases, you shall need to confirm the coordinate system of the LFMA boundary. If it 

is in DrukRef, it has to be converted into WGS coordinate system. For each grid point, we then 

generate the northing and easting or coordinates for each point in degree minute second or decimal 

degrees as may be needed. If you are using QGIS, it is strongly recommended to use WGS coordi-

nate system and coordinate in decimal degrees.   

Another point to be noted here is that using the plot to plot distance (sampling grid), which in this 

example is 500 m, the sampling points or sample points shall be generated. Often the sampling 

points generated from GIS may not be exactly same as generated using equation 9 above. This is 

because in GIS we use regular plot distance (500 m) but the actual boundary of theLFMA is irreg-

ular, hence the slight variation between calculated plot number vis-à-vis the one generated from 

GIS. However, this is not a huge cause of concern, just ignore it. 
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In QGIS, you can generate the systematic sampling points following the following step;  

Load your forest boundary (LFMA boundary in this case) shape file or .kml file, which is a vector layer  

Open Vector –> Research Tools –> Regular Points, a new window pops up.  

 

In the Input Extent, Select Extent on Canvas and select the extent of canvas by dragging the mouse covering 
whole LFMA boundary 
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In the point spacing/count, type the plot to plot distance (e.g. 500 )  and save the file as systematic_points 
or with any desired name and click on run. A systematic points shall be generated  
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Systematic sample points shall be generated  

 

Since we only want points falling inside the Current Forest Management Area, we need to clip the points 
using clip function in QGIS. Open Vector  -> Geoprocessing Tools -> Clip  
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Select ‘systematic_points’ as input layer and the Current Forest Management Area boundary as clip 
layer. Name the file as desired and save and run the algorithm  

 

 

 

 

 

 

 

 

 

 

Go to the Attribute table for the sampling_point. 

Enable the edit mode. 

Open the Field calculator and name the new column Plot_ID  

Set the Output field type to :Text (string) or as desired  

Similarly generate coordinate for each sampling points  

Export the sampling point as GPS exchange format for loading into GPS for locating the plots in the field  

Forest Inventory Equipment 

The following equipment are required for the conduct of LFM forest inventory.  Equipment shall be ar-
ranged by concerned office and they should ensure that each of them are functioning properly before moving 
to the field.  

● Wedge Prism (with basal area factor of 2) 
● GPS 
● Altimeter 
● Compass 
● Smartphones with SW Maps installed (optional) 
● Diameter Tape 
● Measuring Tape 
● Forest Inventory design map 
● Base Map reflecting Blocks and Compartments. 
● Data Sheets/Tally Sheets 

Field Work 

Field Work should involve mainly data collection from inventory plots. Specifically, it shall involve meas-
urement and records of dbh of all trees which are above 10 cm dbh within a plot, besides, collecting infor-
mation on regeneration and site conditions. 

Formation of Inventory crew 

The Divisional Forest Offices shall be responsible for conducting the forest resource assessment for LFMA. 
The fieldwork may be coordinated by Range Officers for areas falling under his/her jurisdiction. For the 
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ease and fastness of the inventory work, the Range Officer concerned can form Inventory crews comprising 
of three to four members. The number of inventory crews shall depend on the number of inventory plots to 
be assessed within a Local Forest Management Area. The Data collected by each inventory crew shall be 
submitted to the Data Manager assigned by the Range Officer based at the Range Office.  

 

Figure 3.4 Inventory crew 

Navigation to Sample Plot 

Prior to navigation, it is crucial to upload all the Inventory Plots as waypoints into the GPS and SW map 
(optional). Once the inventory plots are uploaded into the GPS, the crew members can navigate to the plot 
center of every plot using GPS.  

The open source SW map is very useful for navigation and can complement GPS in locating the plot center. 
In-ternet connectivity is important for using SW map for viewing the background google map and locating 
the plots. However, it is likely that the crews may not have access to internet in the field. Therefore, it is 
recom-mended to load the project area google map, plots and view the plot before moving to the plot at a 
location where there is a good internet connectivity. The offline maps thus generated works perfectly in 
absence of in-ternet connection in the field.   

If your sample plot falls into an open area, or in a very dense and difficult place, do not change position 
because you feel this is not typical or assessment work is too difficult! If the plot is not accessible or inop-
erable, treat it as a zero plot and proceed to the next plot (mark the plot as inoperable). This is explained in 
subsequent chapters. 

Data Collection 

There are three different tally sheets, one for conifer/mixed conifer forest, one for hardwood forests (tem-
perate) and one for tropical forests. Depending on the forest type, appropriate tally sheet should be selected 
(Table 3.7 and Table 3.8). The actual assessment should always follow the same sequence as described in 
Table 3.9 This shall ensure that the measurements are not forgotten.  
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Table 3.7  Example of a Tallysheey (Conifer) 

 

Table 3.8 Compartment description

 

Table 3.9 Sequence of steps for resource assessment 

Step Description Where/When 

1 Fill header of tally sheet At 1st sample plot  

2 Decide whether plot is accessible or inaccessible  For each sample plot  

3 Regeneration sample (3m radius)  For each accessible plot  

4 Prism sweep  For each accessible plot  

5 Tabular description  For each accessible plot 

6 Verbal stand description + management prescriptions  At the end of the assessment 
 

Forest Resources Assessment Tally Sheet Officer Sheet No.

Date Prism factor 2

Geog accessible

Block Inaccessible

Compartment
accessible

Inaccessible

Species
0.3 - 1.3 m height > 1.3m, < 10cm 10<20 20<30 30<40 40<50 50<60 60<70 70<80 80<90 size

R
T
F
R
T
F
R
T
F
R
T
F
R
T
F
R
T
F
R
T
F
R
T
F
R
T
F
R
T
F
R
T
F

Betula

Rhododendron

Other Broadl.

Acer

Oak

2. Point sample with prism 

Other Conifers

Chirpine

Bluepine

Hemlock

Fir

Spruce

Plot No
41  42  43  44  45  46  47  48  49  50  51  52  53  54  55  56  57  58  59  60  61  62  63  64  65  66  67  68  69  70 71  72  73  74 

41  42  43  44  45  46  47  48  49  50  51  52  53  54  55  56  57  58  59  60  61  62  63  64  65  66  67  68  69  70 71  72  73  74 

1. Sample circle (r=3m)

  1  2  3  4  5  6  7  8  9  10  11  12  13  14  15  16  17  18  19  20  21  22  23  24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40

  1  2  3  4  5  6  7  8  9  10  11  12  13  14  15  16  17  18  19  20  21  22  23  24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40
Plot No.

gentle (<25%) moderate (25-50%) steep (50-100%) stable moderate unstable high moderate low

12. Wildlife
Hemlock Fir Spruce Mixed Conifer Blue Pine Chirpine Hardwood Mixed H/C

young/pole immature mature old/over-mat. plantation natural coppice

dense (>70%) closed (40-70%) open (10-40%) unstocked (< 10%) good average poor

planting thinning felling (Firewood) felling (Timber) no activity

10. Forest Use intensive extensive 11. NWFP abundant sparse

Grazing Firewood

Soskhing Bamboo

Lopping Cane

Daphne

Compartment Description

4. Forest Type

5. Age Class 6. Stand Type

7. Canopy Closure 8. Condition

Site condition

13. Stand Description 14. Management Prescription

Single choice only from 1-9 (the total number of records per box must be equal to the total number of accessible sample plots)

1. Slope 2. Erosiveness 3. Soil Cover

Multiple choice possible from 10-11 (the total number of records must not be equal to the total number of accessible plots)

9. Silvicultural Measures
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The details of the sequence of steps for resource assessment are explained hereunder: 

Step 1: Fill Header 

a) Fill all the fields. 

b) Enter Sheet No. 

Note: For each Compartment only one tally sheet is required. However, in case the space within a cell is 
not sufficient, a second tally sheet shall be attached. In this case the field “Sheet No.” should be filled as 

follows:  

Sheet 1: 1/2  

Sheet 2: 2/2  

Note: this is very important; otherwise the 2nd sheet may be left out during data entry and analysis 

c) Enter the prism basal area factor. This factor is marked on the prism, default factor is 2. 

Step 2: Decide, whether plot is accessible or not. 

A plot is considered as in-accessible, if the plot center is located on Steep slope which is difficult to access 
for any kind of silviculture measures. 

Depending on its nature, encircle/strike through the number of the plot in the respective line and mark it 
also on your base map. 

Note: It is very important that the number of plots, which were actually assessed, is indicated on the 

tally sheet, otherwise data analysis shall be wrong! (Note: during data analysis, the number of counted 

trees shall be divided by the number of sample plots). 

Table 3.10 Recording Plots according to accessibility 

Plot 
No.  

accessible 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 

In-accessible 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26  

 

If a plot is inaccessible, then no measurements shall be taken. In that case, proceed to the next plot! 

Step 3: Regeneration Sample 

Within a circle of 3.57 meters radius, all trees above 30 cm height and below 10 cm in diameter are assessed. 
This refers only to live trees of timber species (e.g. Lyonia is not counted). The radius of the sample plot is 
measured with a 3.57 metres long stick. The radius is horizontal distance. If you have measured the slope 
distance using measuring tape, the correction factor must be used to convert slope distance into horizontal 
distance. Assessment is always done clockwise starting from North to avoid double counting or missing 
them all together. Coppice shoots are counted as single trees, if they sprout directly from the stock or root. 
Branches or other sprouts are not counted.  

Recording: Mark each tree with a vertical line in the respective column and a dash as shown in the example 
below. When assessing the next sample plot just continue recording by using the same cells for the same 
species. 
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Table 3.11 Recording Plots according to accessibility 

Species 1. Regeneration sample circle (r=3m) 
  0.3 - 1.3 m height > 1.3m height < 10cm dbh  
Bluepine        
Chirpine     

 

Step 4: Prism Sweep 

Sample trees are identified with the help of a wedge prism. Whether a tree is a sample tree or not depends 
on its basal area and the distance to the plot centre (i.e. probability according to size). Large trees can be 
located further away than small trees.  Dead trees are not counted. (Note: if there are dead trees, which can 
be used for firewood, this is considered in the box "NWFP"). 

From the sample point a 360° prism sweep is taken clockwise starting from the North for the ease of field 
work and to avoid double counting and missing any ‘IN’ trees. The prism needs to be held directly above 
the sample plot center. (Note: The person should be right in the centre of the sample point and not the 
prism). 

As it depends on the distance and the dbh whether a tree is "IN" or "OUT", slope correction is necessary 
especially on steep areas. This is done by pointing with the prism (use the prism like you would be using a 
stick) to the tree at breast height (usually at 1.3 metres height). Then turn the prism 90° and check whether 
the tree is "IN" or "OUT" (Figure 3.5). 

 

Figure 3.5 Identification of sample trees with the wedge prism 

How to treat borderline trees?  

Borderline trees are treated half and counted as half. For the ease of tally, generally adopted method in LFM 
is to count as follows: the 1st is "IN", the 2nd "OUT", the 3rd "IN" and so on. The counting continues through-
out the Compartment for all sample points. 

What to do, if the tree is not visible or behind another tree? 

This problem can be solved in different ways: 

• Move your position sideward from the sample point, until you can see the tree clearly or The easiest 
way is observe if the trees of same dbh or smaller further way from hidden tree. However, it is very 
important, that the distance to the tree is kept constant. 
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• Check whether the tree is "IN" on higher part of the stem. If it is "IN" or at borderline, then the tree 
is "IN". If the tree is almost in, then treat as a boundary tree. If it is clearly out, then it should be 
treated as "OUT". 

• Remove shrub or objects, which obscure visibility. 
• If you can't see the tree stem at all, then check the critical distance as a last resort. 

Measure the dbh of the tree and multiply the dbh with 0.3535 (this is the critical distance factor for basal 
area factor 2). This gives you the critical horizontal distance in metres. If the horizontal distance to the tree 
is less than the critical distance, then the tree is "IN". E.g.: dbh = 49 cm, then the critical distance is 
49*0.3535 = 17.3 m, if the tree is 16.9 m away, then it is a sample tree. 

For each "IN"-tree the following observations and measurements are taken and recorded: 

• dbh-class (check with tape if you are in doubt, especially for larger dbh) 
• Should the tree be extracted within the next 10 years for silvicultural reasons5? If yes, then it needs 

to be decided whether it can be used for timber (T) or only as firewood (F). Depending on the result, 
a dash must be marked in one of the following lines: 

o R (remain):   trees that shall not be harvested; 
o T (timber): could be extracted and used as drashing, cham, tsim, shingleps, flagpoles, poles, 

posts and other construction purposes; 
o F (firewood): could be extracted and used for firewood, only. 

 

Note: This is a very important element of the resource assessment, as this shall provide the infor-

mation, on how many trees could be removed from the sub compartment and for what purpose it could 

be used based on the “production potential” of the forest. The decision whether a tree could be used 

shall be based entirely on silvicultural considerations, and should be done very carefully. Follow the 

prescriptions of the silvicultural guidelines. In case of doubt, mark the tree as remainer, especially if 

canopy closure is open. 

Table 3.12 Recording sample trees (basal area sampling) 

  2. Point sample with prism  *1: 100, 150 

  10<20 20<30 30<40 40<50 50<60 60<70 70<80 80<90 Size 

R                        95.125 *1 

T             

F                    

 

In case the dbh is larger than 90 cm then note the dbh in column "size" as shown in the example above. If 
there are more large trees than there is space in the cell, just note it somewhere on the tally sheet (indicate 
with *1, as shown in Table 3.12 Recording sample trees (basal area sampling). 

Step 5: Tabular Compartment Description (Back-Page of the Tally Sheet) 

After completion of the sample plot assessment, the tables on the back-page (Compartment Description) 
need to be filled for each sample plot. The description refers to the immediate vicinity (approximately on 
tree length in radius) of the sample point. For the boxes 1-9, a single choice must be made (i.e. the total 
number of records must be equal to the total number of accessible plots). The different criteria are assessed 
based on "expert valuation"; some indicators are specified in Table 3.9 . The boxes 10-12 must only be 
filled if required, multiple choices is possible. 
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Table 3.13 Tabular assessment of site and forest condition (1-8)  

Criteria  Indicator Remark 

1 Slope 

(Refers to the slope, 
where the plot centre is 
located) 

gentle Slope  < 25% If the slope is > 100% 
then the plot is consid-
ered as "inoperable" moderate Slope 25-50% 

steep Slope 50-100% 

2 Soil Cover 

(Refers to the coverage 
of the soil with vegeta-
tion and is an indicator 
for surface runoff and 
water infiltration) 

good Soil is covered by dense under-
growth (tree regeneration, herbs, 
shrubs, etc.), rain does not fall di-
rectly on soil 

 

moderate There is little shrubby vegetation or 
undergrowth, crown cover dense to 
closed 

low Very little vegetation, heavily 
browsed areas; rain falls directly on 
the ground, surface run off 

3 Erosiveness 

(Refers to the risk of 
erosion if trees are re-
moved) 

stable Gentle to moderate slopes, good 
soil cover, erosion risk low 

 

moderate Moderate to steep areas, clayish 
soil, little ground vegetation 

high Waterlogged areas on moderate to 
steep slopes, already some signs of 
erosion, high risk for land slides 

4 Forest type 

(Refers to the forest type 
within a tree length dis-
tance) 

  For mixed Hard-
wood/Conifer the per-
centage of broadleaves or 
conifers should be at 
least 10%. 

5 Age class 

(Refers to the age of the 
forest, for natural un-
even aged forests it re-
fers to the development 
stage) 

young/pole Even-aged: thicket and pole size, 
no timber size trees 

Sometimes it may be dif-
ficult to determine the 
age class, as there might 
be a mix of different age 
classes. In this indicate 
the dominating age.  

  

immature Even-aged: majority of trees imma-
ture 

Uneven-aged: development stage, 
no mature trees, few over-mature 
trees 

mature Even-aged: majority of trees have 
reached harvestable size 

Uneven-aged: consolidation phase, 
most of the trees have reached har-
vestable size 
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over-mature Even-aged: majority of trees over-
mature, some signs of die-back and 
decay, trees should be harvested as 
soon as possible 

Uneven-aged: regeneration phase: 
over-mature trees with groups of 
regeneration and pole size trees in 
lower storey  

6 Stand Type 

(Refers to type of stand 
establishment) 

plantation Trees have been planted   

natural Trees grown from natural regenera-
tion of seeds  

coppice Trees grown from coppice shoots, 
only common in broadleaved for-
ests  

7 Canopy closure 

(Refers to the closure of 
the main canopy) 

dense > 70%   

closed 40-70%  

open 10-40%  

unstocked < 10% 

8 Condition 

(Refers to health, form, 
stocking density and dis-
tribution) 

good Mature and immature forests: trees 
of good form, no signs of decay or 
die-back, closed canopy; 

Young/pole age: commercial spe-
cies are equally distributed 
throughout the area, closed  

 

average No particularities 

poor Over-mature forest with signs of 
decay and die back, lack of natural 
regeneration, shrubs/bamboo dom-
inate under-storey.  

Young/pole: dense, non-commer-
cial species dominate 

 

9. Silvicultural measure  

There are broadly five main silviculture measures identified for LFMP. They are Planting, Thinning, 
Felling (Firewood), Felling (Timber) and No Activity. For each sample plot decide what silvilcultural 
operation is required. If trees are marked for removal, specify the type of operation, i.e “Felling (fire-

wood)” or “Felling (Timber)”. If the plot needs stand improvement silviculture measures specify the 
type of operation i.e, “Planting” or “Thinning”. Elaborate. If the plot does not require any kind of silvi-
culture operation specify the operation as “No activity”. Mark only one option per plot. Multiple choices 

are not possible. Total number of records must be equal to the total number of accessible plots.  

Note: The filling of these boxes allows the calculation of the approximate area where the operation shall 
be carried out. 
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10. Forest Use and 11. NWFP 

The occurrence of NWFP and their current use is assessed by visually evaluating the forest in the imme-
diate surrounding of the sample point. If you observe the availability of any NWFP, record type and 
mark, whether it occurs in abundance or you can only see a few or a single specimen (sparse). Firewood 
in this context refers to the availability of deadwood, which can be collected. Evaluate the intensity of 
grazing, soksing and lopping and mark it in the respective column. If there is none, then don't mark. There 
is an empty row, where you can enter an additional use. 

Table 3.8 Recording of NWFP, firewood and other forest use 

NWFP abundant sparse Forest Use intensive extensive 

 Firewood     Grazing     

 Bamboo     Shoksing     

 Cane      Lopping     

 Daphne         

 Ferns   

 

12. Wildlife  

If you observe any sign of endangered or totally protected wildlife, while walking along the inventory 
plots, indicate wildlife species on tally sheet. 

Table 3.9 Example for wildlife recording 

Wildlife 
Snow Leopard 
Black Bear  

 

Step 6: Stand Description and Management Prescription (back-page of tally sheet) 

This is done once the last plot has been assessed. It provides guidance for the assessment for stand descrip-
tion and providing management prescription.  

Box 3.1 Guide for stand description and management prescription (13-14) 

13. Stand Description 

The description refers to the whole compartment and includes observations, which are observed 

while walking along the inventory plots through the compartment. 

In this box one has to briefly describe stand condition of the whole compartment. It shall include: 

age class, forest type, canopy closure, condition, type, age or forest type distribution, health con-

dition, etc. Significant differences in stand composition and peculiarities should be additionally 

indicated on the draft compartment map. For the formulation of the stand description the tabular 

description may serve as a valuable aide. Emphasis has to be given to any spatial differences in 

stand condition, which cannot be depicted from the tabular description. 

14. Management Prescription: 

In this box, the potential uses shall be described and, if only a part of the compartment is usable, 

the location needs to be specified. Also, reference should be made to the accessibility (i.e. distance 

from road or village). Need for protection measures, e.g. control of grazing, etc. should be speci-

fied.  
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3.3.5 Data Analysis 

3.3.5.1 Requirements 

The entire data analysis must be carried out in pre-designed excel sheets. Therefore, the planner should have 
adequate knowledge on use of Microsoft excel program. 

3.3.5.2 Data Entry and Print-out of Compartment Register 

Data analysis is done by simply transferring the data recorded in the tally sheet into an EXCEL spreadsheet. 
There are three different spreadsheets, one for conifer/mixed conifer zone (Compartment register-coni-
fer.xls), one for the hardwood zone (Compartment register-hardwood.xls) and one for tropical forests (Com-
partment register tropical.xls). Once data are entered, the spreadsheet shall automatically carry out all the 
calculations and fill the Compartment sheet, which can be printed out. 

 

Figure 3.6 Example of a Compartment register –Hardwood (Data Entry) 
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Figure 3.7:Example of results sheet- hardwood 
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3.3.5.3 Steps for Data entry and analysis 

Data entry and analysis should be done as follows (note: it is very important that the database structure is 
always the same for each Gewog.) 

1. Create a new folder with the name of the forest management area, e.g.: Kawang 
2. Under this folder create a new sub-folder with the name “Gewog name + compartment register”, 

e.g. “Kawang Compartment Register” 
3. Within the sub-folder “compartment register”, create for each compartment again a sub-folder with 

the number and name of the compartment, e.g. “Dompola-1”  
4. Select the corresponding spreadsheet (Compartment register-conifer.xls, Compdata-hardwood.xls 

or Compartment register-tropical.xls)) and copy it into sub-folder (e.g. “Dompola-1”). - Open 
Compdata-?.xls and rename it with the name of the compartment, e.g. “Dampola-1”  

5. Each "compartment" spreadsheet consists of the two sheets: "data entry" and "results"  
6. Open sheet "data entry"  
7. Transfer data from the tally sheet in the blue marked cells.  
8. During data entry, check on plausibility. The total number in the following boxes must be equal to 

the total number of accessible sample plots:  
● Forest Type  
● Age Class  
● Type  
● Canopy – 
● Condition  
●  Soil Cover  
● Steepness  
●  Erosiveness  
● Silviculture measures 

9. For the other boxes (Forest uses and NWFP) it may be less or more (multiple choice)  
10. Stand Description and Management Prescription has to be directly entered in the sheet "Results".  

Once all data are entered, then the Compartment Record (= "Result" sheet) can be printed. Make at least 
one back-up copy on hard drive. For future reference, the original tally sheets and the field map must be 
kept for the entire planning period. 

3.3.5.4 Calculation of Results 

The calculation of the results is done based on an EXCEL spreadsheet named “Summary Sheet.xls”. The 

capacity of the summary sheet is limited to 20 Blocks and 100 compartments. In case the forest management 
area consists of more Blocks or/and compartments, then the spreadsheet needs to be changed in consultation 
with FRMD. For the calculation of results, the data from the compartment register should be transferred 
into the summary sheet. This can be done by two persons; one should read the data and the other one should 
enter it into the spreadsheet. 

 

Paro Geog

2

No Name
1 Jangsa
2 Kudophu
3 Bjishinggang
4 Zega
5 Brekha
6 Zonglela
7 Betekha
8 Korilla

Dzongkhag

Basal Area Factor

Block

Shari
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Figure 3.8:Summary Sheet 

Steps 

1. Open folder "Gewog name", e.g.: “Kawang” (i.e. it is the same folder, where the compartment 

register is kept)  
2. Copy “Summary Sheet.xls” into this folder § Rename copied “Summary Sheet.xls” in “Gewog 

name + Summary Sheet”, e.g. “Kawang summary sheet.xls”  
3. open the spreadsheet and De-activate Macros and Select sheet “Data Input” which is the sheet at 

the utmost left (the EXCEL file consists of a number of individual sheets)  
4. Enter name of Dzongkhag and Gewog in blue cells  
5. Enter Basal area factor (i.e. 2) in blue cell. 
6. List all Blocks and Compartments . 
7. Transfer all data from compartment register into the blue cells of the box: “summary data”. 
8. Always save spreadsheet after entering data of one Compartment. 

Once all data are entered, re-check all entries! Make at least one back-up copy on a hard drive. The calcu-
lation of results is done by the spreadsheet automatically.  

Note: The soft copies of Tallysheets, Compartment registers and summary sheets are available at FRMD. 
Therefore, the planner can collect the sheets from FRMD whenever required. 

 

3.3.6 Preparation of Forest Management Plan, Approval and Implementation 

3.3.6.1 Preparation of Local Forest Management Plan 

The management plan should be prepared by trained forest officers and reviewed by the concerned CFO. 
To ensure same standard, quality and compatibility of the plans and to minimize the effort of writing, a 
template has been developed. This provides – as far as possible – standard formulations. The writer only 
has to add forest management area specific information in predefined places. 

The use of a template may shorten approval procedures considerably, as all the plans shall be of the same 
format and all calculations are done in exactly the same way. This makes an intensive technical check 
redundant. For the preparation of the plan, FRMD shall provide technical assistance. 

Planning period 

The plan period for the Local Forest Management Plan shall be for 10 years. 

Plan layout 

The layout of the plan is as per  Figure 3.9.This is the minimum requirement of the plan. However, the 
planner can include additional sections and information if deemed necessary. The softcopies of the Plan 
layout is available at FRMD. 

 

Block Name Comp No Non-Production Protection Inaccessible Net Production Hemlock Fir Spruce Mixed C. Bluepine Chirpine Hardwood Mixed HC
1 Jangsa I 45.3 3.2 17.0 17.8 144.2 88 21 5 43 19 5 29
1 Jangsa II 53.3 7.4 23.3 18.2 175.3 73 19 5 95
1 Jangsa III 62.4 57.1 3.3 17.2 17.7 143.3 88 21 5 43 19 5 29
1 Jangsa IV 48.3 31.7 1.6 18.7 9.0 69.2 81 23 65 9 26
2 Kudophu I 48.0 20.1 30.1 33.9 304.0 73 15 47 53
2 Kudophu II 25.0 7.4 54.6 10.3 71.9 73 22 41 5 55
2 Kudophu III 25.0 8.4 61.6 5.5 39.2 98 22 95 5
2 Kudophu IV 33.2 12.2 18.2 13.9 107.9 98 15 20 80
2 Kudophu V 42.0 13.2 16.8 16.1 159.9 71 14 21 79
2 Kudophu VI 30.0 6.4 13.6 26.1 230.8 64 17 47 6 47
3 Bjishinggang I 23.0 12.0 18.0 14.3 132.7 100 15 73 27
3 Bjishinggang II 54.0 16.0 24.0 16.5 166.0 98 15 5 67 13
3 Bjishinggang III 26.0 8.4 61.6 28.5 247.1 100.0 22 5 9 86
3 Bjishinggang IV 27.0 28.0 42.0 32.1 318.7 94.0 15 7 20 73
3 Bjishinggang V 20.0 12.0 48.0 24.1 239.0 94 20 20 25 55
4 Zega I 15.0 11.4 29.2 24.0 202.4 96 18 11 6 61 11 11
4 Zega II 25.0 9.6 30.4 22.1 175.7 91 19 68 11 21
4 Zega III 14.3 13.2 33.8 14.6 154.5 97 18 28 28 44
4 Zega IV 20.0 19.9 42.3 8.8 101.6 100 17 94 6
4 Zega V 8.0 2.2 53.3 23.8 175.3 88 24 4 38 27 4 38
5 Brekha I 45.3 3.2 17.0 17.8 144.2 88 21 5 43 19 5 29

Volume/haBA/ha
Area (ha) Forest Type (%)No of 

accessible 
sample plots

Vconifer %Block No
Compartment
Summary data
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Figure 3.9: Plan Layout 
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3.3.6.2 Planning Schedule 

Table 3.14 Planning Schedule 

Activity Components Approximate Man days 

Reconnaissance Survey ● General survey of Gewog Area 
● Collection of data on roads, riv-

ers, drinking water sources, reli-
gious sites, future management 
areas, etc. 

● Public Consultation  

10 days 

Compartmentalization 
and Forest Function Map-
ping 

● Preparation of Blocks and Com-
partments  

● Preparation of Map using GIS 
tools 

● Field truthing 

30 days 

Forest Resource Assess-
ment 

● Inventory  
● Data Collection 

6-10 Plots/Crew/Day 

Data Compilation and 
Analysis 

● Data Entry 
● Analysis 

15 days 

Plan Writing ● Plan Writing 
● Map Preparation 
● Divisional Level Review 
● Submission 

15 days 

Review and Approval ● Review of Plan at FRMD 
● Approval from Department and 

the Ministry 

30 days 

Printing ● Printing 10 days 

Note: The above schedule and the mandays indicated are tentative and are only estimates. The actual re-
quirement of mandays and planning schedule may vary depending on the area extend of Local Forest Man-
agement area, topographic features and other factors within the locality. 

 

 

 

 

 

 

 

 

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        625 

3.4  Review and Approval 

Following administrative protocols should be followed for review and approval of the Local Forest Man-
agement Plan. 

Range Officer

Director, DoFPS

CFO, FRMD

CFO, Territorial Division/
Parks

Secretary, MoAF

1. Preparation of Local Forest Management Plan
2. Submits the draft plan to CFO

1. Reviews the draft plan submitted by the Range Officer
2. Recommends for technical review and approval to CFO, 
FRMD

1. Approves the Plan for Implementation

1. Recommends the Plan for approval of the Ministry

1. Reviews the Plan
2. Submits it to the Director for review and endorsement of TAC

 

Figure 3.10 Review and approval procedure 

3.4.1 Provision for amendment and plan revision 

The approved Plan may be revised during the implementation period if major changes occur in the area of 
LFMA and in the event of major disasters. 

The Head, Department of Forests and Park Services, can authorize revision based on proposal for amend-
ment from the respective divisions. 

3.5  Implementation  

Once the plan is approved by the Department and the Ministry, the approved plan should be handed over to 
concerned Divisional Forest Office/ Parks for implementation. The Division and Park shall implement the 
plan as per the plan prescriptions. The timber allotment from the Local Forest Management area shall be 
restricted within the AAC prescribed in the plan. 

3.5.1 Sliviculture system 

Single tree selection system shall be applied for extraction of timber from Local Forest Management Area. 
The details guidelines for Single Tree Selection Silviculture system is prescribed under section “Implemen-
tation Framework < Silviculture Implementation Guidelines” of Chapter 1: Forest Management Units of 

this volume. 

3.6  Monitoring 

Monitoring is the continuous/periodic review undertaken by management at every level of implementation 
of an activity to ensure that input deliveries, work schedules, targeted output and other required actions are 
proceeding according to the plan.  
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Regular Monitoring should be carried out by the concerned Range Officer. Periodic monitoring of Local 
Forest Management Area should be carried out by the concerned CFO of the division, preferably during the 
month of January of every year. The monitoring report must be submitted to the Department latest by 28th 
February every year. FRMD should conduct mid-term and final monitoring of the LFMP.  

3.6.1 Objectives 

The main objectives of the monitoring are: 

1. To ensure that the allocation of rural timbers is within the AAC prescribed. 
2. To ensure that reforestation/ afforestation and thinning activities are carried out as per the plan 

prescription and requirements. 

3.6.2  Annual Monitoring Process 

The Local Forest Management Plans shall be monitored on an annual basis. The Annual Monitoring report 
must consist of following components: 

1. Dully filled annual Monitoring Form. 
2. Observations 
3. Recommendations 
4. Annexures:  

i. Report sheet of the tree marking book. 
ii. Monitoring sheet of the tree marking book. 

 

Annual Monitoring Form 

Table 3.15 Annual Monitoring Form 

Indica-
tor No. 

Indicator Definition Progress/ Achievement Corrective 
Measures/ 
Remarks 

1 Annual Timber 
Volume Re-
moved 

This indicator constitutes 
the volume of timber pre-
scribed for removal annu-
ally (AAC) 

Quantity as per Tree Mark-
ing book**and the moni-
toring report (m3)*** 

 

2 Annual Removal 
of Firewood 

This indicator constitutes 
the volume of firewood al-
lotted/ removed annually 
(AAC) 

Quantity as per marking 
book and monitoring re-
port (m3) 

 

3 Plantation Crea-
tion 

Plantation creation in the 
management area (in hec-
tares)  

Plantation Area in Hectare  

4 Thinning Area of forest within the 
management area in which 
thinning is carried out 

Thinning Area in Hectare  

 

Note: The tree marking book** and the monitoring reports** are to be maintained in excel based 

predesigned format as explained in the following pages. Both the report sheet and Monitoring sheet 

must be printed and attached with the annual monitoring report of the Local Forest Management Area 

as annexures. 
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Observations 

The annual monitoring team should list down the observations from the field and should include (but not 
limited to) the following:  

● Field observations to be reflected by the concerned field CFO. 
● This section shall give only general observation regarding the implementation of the plan.  
● It shall include both positive as well as negative observations.  

Recommendations 

Based on the observation in the field and the prescriptions of the management plan, the annual monitoring 
team should recommend certain corrective measures. The recommendations should be precise and in align-
ment with the prescription of the management plan. 

Annexures 

The Monitoring sheet and the Report sheet of the tree marking book must be attached to the annual moni-
toring report as annexures. 

3.7  Record Keeping 

3.7.1 Tree Marking Book 

Tree marking book is a excel based predesigned and automated sheet where the marking officer concerned 
shall enter information of marked trees based on its multiple use (Construction, Renovation, Other Con-
struction, Other purposes. etc). The tree marking book has following salient features: 

1. The location where the tree is marked shall be specified  
2. The purpose (i.e. construction, renovation, etc.) is recorded  
3. The volume of the marked tree shall be calculated based on a volume table  
4. The use of the tree is specified (e.g. drashing)  
5. The data shall also be recorded in electronic format 

Recording the location of the harvested trees helps that a specific area is not over-cut (not more trees shall 
be allotted than the overall production potential or “silvicultural AAC” of a specific compartment). Speci-

fying the purpose allows calculation of the production data as required for the annual statistics. The calcu-
lation of the actual volume is necessary in order to control the keeping of the fixed AAC. To keep it also in 
an electronic format considerably facilitates the calculation of the total harvested volume and the monitoring 
of the already harvested trees versus the production potential of a specific compartment. 

The “tree marking book.xls” consists of 7 individual sheets:  

1. Construction;  
2. Renovation;  
3. Other construction;  
4. Other purpose;  
5. Firewood;  
6. Report;  
7. Monitoring. 

“Construction, Renovation, Other Constr., Other Purpose and Firewood” contain the entries from the tree 

marking book, here the specifications of the marked tree are entered. The “Report” sheet automatically 
calculates the total number and standing volume of marked trees and compares it with the AAC (annual 
allowable cut). The “Monitoring” sheet provides an overview of the current production potential. It subtracts 

the harvested trees from the production potential on compartment level. 
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Data entry from the hardcopies of the tree marking books of the various ranges/beats within the forest 
management area into the electronic format is done as follows: 

Select the sheet depending on the purpose of wood allocation (i.e. “Construction, Renovation, Other Constr., 

Other Purpose, Firewood”). The following screen shall appear. Enter data as shown in the example and use 
always the same format as described below. 

Table 3.16 Tree marking book (construction) 

 

Year: Format: 2005  

Date: Format: 14/4  

Location: Name of the compartment: Format Jangsa-1; it is very important to write the compartment name 
correctly; otherwise the computer cannot calculate the monitoring sheet! The location always refers to the 
compartment of the forest management area. 

Species: common name  

Dbh:  enter the DBH and corresponding standing volume in m3 from the volume table; decide on the type 
of product and enter volume in respective column. For Dangchung size trees (i.e. dbh less than 10 cm) only 
the total number needs to be entered. It is not necessary to measure the dbh of the individual Dangchung 
size trees and its corresponding volume. Enter the number of trees marked in the No. column of the respec-
tive product. 

Reporting sheet: 

The “Reporting sheet” gives the overall allotment of rural timbers (product wise) against the AAC of the 

Local Forest Management Area. Select sheet “Report” - Enter year, name of Forest Management Area and 
AAC in the blue cells at the top of the sheet. The computer shall automatically up-date the report. - Enter 
“balance from last year” in the AAC table, e.g. –/+50 (this means, that the AAC of the years before have 
been either over-used or under-used for a total of 50 m3). The report can be printed in hard copies. 

Monitoring sheet 

The “monitoring sheet” is the most important tool for the range/beat officer to identify the location (i.e. 

compartment) from where trees for a specific purpose can be allotted. It shows for each compartment the 
production potential, the amount of already harvested trees and the remaining stock. 

The first step after installation of the spreadsheet “tree marking book.xls” into the computer, the production 
potential of all compartments needs to be entered. This has only to be done once at the beginning of the 
planning period, as described in the following: 

- Open the sheet “Monitoring”  
- Enter the name of the compartment, format: Jangsa-1 (Note: it is very important to use exactly the same 

spelling as used in the data input sheets). 
- Enter the production potential by compartment in the shaded column “Pro”. This information can be 

derived from the compartment record sheets (i.e. compartment register) or from the sheet “Production 

N” of the respective “Summary Sheet.xls”.  
- The computer shall do the rest. 

 

 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        629 

Table 3.17 Recording of “monitoring” sheet 

 

Explanation of the columns: 

Pro: contains the production potential as determined by the forest resources assessment  

Use: the number of trees already harvested.  

Bal: the number of trees still available in the compartment for harvesting. 

3.7.2 Gewog Register 

In addition to the hardcopy, the Gewog registers should be kept in electronic format. This considerably 
reduces the time requirement for checkup, whether an applicant is eligible for timber allotment (refer to 
“search for past allotments in the sub-chapter below). 

For each Gewog, a separate register is kept. A new Gewog register is opened for every new management 
period. This is done as follows: 

- Copy “Gewog register.xls” in Gewog directory e.g. “Kawang” - Rename copied “Gewog register.xls” in 

e.g. “Kawang register.xls” 

The spreadsheet combines all the 4 different registers. The same information is entered as in the current 
hardcopy. The spreadsheet itself comprises of 5 sheets: •Construction; •Renovation; •Other construction; 

•Other purpose; •Annual reports. 

In the first four sheets, the same information is entered as in the already existing hardcopy registers. It is 
important, that the “Year” is entered in the correct way, e.g. “2005” for every line, otherwise the annual 

report shall not be calculated correctly. 

The sheet “annual report” provides a summary of the number of allotted for the selected year. The data of 
this “report” should correspond with the data of the “report” from the “Tree marking book.xls”. 

3.7.3  Data Management and Documentation 

All data and documents produced as part of the management plan preparation should be well documented. 
These implies to both spatial and non-spatial data to be maintained in soft and hard copies. The entire 
shapefiles and the data collected for the plan preparation should be submitted to FRMD along with the draft 
plan.. 

  



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        630 

3.8  Bibliography 

BHUTAN, ROYAL GOVERNMENT OF (1995) Forest and Nature Conservation Act of Bhutan, 1995.  
Thimphu. 

BHUTAN, ROYAL GOVERNMENT OF (2017) Forest and Nature Conservation Rules of Bhutan (Re-
vised), 2017.  Thimphu. 

BHUTAN, ROYAL GOVERNMENT OF (2004) Forest Management Code of Bhutan, Forest Resources 
Development Division, Department of Forests.  

BHUTAN, ROYAL GOVERNMENT OF (2004) Community Forestry Manual for Bhutan, Part I – IV, 
Social Forestry Division, Department of Forests. 

LAUMANS,P.(1994) Guidelines for Forest management Inventory, UNDP/FAO Forest Resources Man-
agement and Institutional Development Project, Department of Forestry, Ministry of Agriculture. 

SCHINDELE, W. and DHITAL, D.B. (1997) Guidelines for the Preparation of a Forest Function Map and 
definition of Management Prescriptions/Restrictions.  Bhutan-German Sustainable RNR Develop-
ment Project.  Working Paper No. 11.  Ministry of Agriculture, Royal Government of Bhutan. 

SCHINDELE, W.; 1996: Guidelines for a Reconnaissance Forest Inventory. 2nd 
Draft. Mission Report on Forest Resources Assessment and Forest Management 
within the Scope of the Bhutan-German Integrated Forest Management Project. 
BG-IFMP, Working Paper No. 6. 

SCHINDELE, W.; 1996: Angle-Count Sampling and the Use of the Relascope. 
Mission Report on Forest Resources Assessment and Forest Management within 
the Scope of the Bhutan-German Integrated Forest Management Project. 
BG-IFMP, Technical Paper No. 4. 

SCHINDELE, W.; Forest Resources Potential Assessment of Bhutan. Bhutan-German Sustainable 
RNR Development Project.  Working Paper, Ministry of Agriculture, Royal Government of Bhu-
tan. 

Management Plans of all FMUs in the country, Forest Resources Management Division, Department of 
Forests and Park Services. 

  



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        631 

 

 

 

 

 

 

4. Private Forestry 
  



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        632 

Author: 
Tashi Wangchuk, Dy. Chief Forestry Officer, SFED 
 
Contributors: 
1. Karma Jigme Temphel, Chief Forestry Officer, SFED 
2. Sither Wangdi, Dy. Chief Forestry Officer, SFED 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        633 

4.  Private Forestry  

4.1 Management Context 

Establishment of Private Forestry aims to facilitate raising forestry crop on registered land to accrue eco-
logical, social and economic benefits. Private Forest shall constitute planting of tree and any other forest 
crop including those species listed in Schedule I, or growing on private registered land. 

The land category where the private forests are established shall be guided by the relevant laws of the coun-
try. In cas, any private land owner wishes to establish a private forest, the field office shall render all possible 
technical support in the preparation and management of the forest.  

4.2 Resource Inventory & Data Processing 

4.2.1 Stand Map 

Stand map should be prepared as and when the private forest owner(s) seek support from the Department. 

4.2.2 Use the most appropriate of the following methods 

Total Enumeration: If the private forest is less than 1 ha, you should conduct a full count of all of the trees 
that are pole-size (20 – 40 cm dbh) and timber size (larger than 40 cm dbh). 

4.2.3 Sample plots 

If the total enumeration is not possible for practical reasons such as difficult terrains, area of the plantation 
and/or other circumstances, sampling may be best method to estimate the forest and tree parameters of the 
forest.   

Sampling intensity of 2 % is recommended for assessment of the private forest for planning purpose. For 
example, if your stand is 1 ha (10,000 m2), measure 2 sample plots of 10m x 10m (100 m2 each). Lay transect 
as deemed appropriate and the sample plots can be laid along the transect based on professional judgement. 
Calculate the number of trees in the two categories: pole-size (20 – 40 cm dbh) and timber size (larger than 
40 cm dbh). 

4.2.4 Management Prescriptions 

The Field offices should provide appropriate recommendations for the management of the private forest.  

4.3  Management Planning 

Respective field offices shall assist the owner in developing Private Forest Management Plan (PFMP). 
While preparing management plan, keep the following: 

• Prepare the management plan in consultation with the owner to be consistent with his/her requirements 
and capabilities. 

• Make the management prescriptions easily understandable by avoiding technical terms. 
• Help the owner maximize production from his/her private forest. 

4.3.1 Stand Description 

The description must include the following information:  

• Species, age, quality of natural regeneration, and estimated stand area in ha   
• Include the year of establishment for plantations.   
• Other information, if appropriate, such as: tree height, quality, distribution pattern, existence of 

NWFPs, ground cover, aspect, slope gradient, traditional and present use, and soil description, should 
be included. 
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4.3.2 Plantation Works 

Forestry field offices should provide technical support with regard to plantations within private forest areas 
if the owner needs.  

4.3.3 Thinning 

Forestry field offices should provide technical support with regard to thinning if required. In case areas 
prone to land slide and erosion, field offices may recommend phase wise thinning.  

4.3.4 Harvesting 

If the private forest consists predominantly of mature trees, the field offices should advise the owner to 
follow one of the following options: 

• Harvest the most mature ones on a single tree basis. This method is appropriate in mixed stands where 
not all the species are mature. 

• Harvest most of the trees except a small number of the best quality seed trees. This method may be 
appropriate in conifer forests with good potential for natural regeneration. The remaining seed trees 
can be harvested once the new stand is well established. 

• Harvest all trees at once (clear cut). This method may be appropriate in evenaged and monospecific 
stand which does not have the potential to regenerate naturally, or if the owner wants to promote other 
species. 

4.3.5 Management of NWFPs and fodder trees 

The management prescriptions for NWFP and fodder trees shall vary considerably in different regions.  The 
field office should provide appropriate recommendations to ensure sustainability and maximize production. 
Social Forestry and Extension Division may provide technical support if the private forest owner(s) needs. 

  



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        635 

5. List of Contributors 

1. Former taskforce members for the FMCB (2014) 

Sl. No Name Designation  Office 

1 Ratu Wangchuk Dy. Chief Forestry Officer NCD 

2 Kinley Dorji Dy. Chief Forestry Officer SFED 

3 Tshewang Dorji Sr. Forestry Officer UWICER 

4 Kezang Dema Dy. Chief Forestry Officer NCD 

5 Sonam Choden Dy. Chief Forestry Officer SFED 

6 Tshering Dorji Sr. Forestry Officer FPED 

7 Dimple Thapa Chief Forestry Officer Tsirang Division 

 

2. FMCB Internal Review Workshop (22-27th December 2019) 

Sl . No Name Designation  Office 

1 Pasang Wangchen Norbu Specialist/Advisor DoFPS 

2 Norbu Wangdi (PhD) Chief Forestry Officer FRMD 

3 Arun Rai Principle Forestry Officer FRMD 

4 Dawa Zangpo Dy. Chief Forestry Officer FRMD 

5 Tashi Norbu Waiba Dy. Chief Forestry Officer FRMD 

6 Lhab Tshering Sr. Forestry Officer FRMD 

 
3. Second Consultation Workshop, DoFPS Conference Hall (3rd January 2020) 

Sl . No Name Designation  Office 

1 Lobzang Dorji Director DoFPS 

2 Pasang Wangchen Norbu Specialist/Advisor DoFPS 

3 Kinley Tshering Chief Forestry Officer FPED 

4 Kaka Tshering (PhD) Principle Forestry Officer UWICER 

5 Sigyel Delma Chief Forestry Officer WMD 

6 Norbu Wangdi (PhD) Chief Forestry Officer FRMD 

7 Sonam Wangdi Chief Forestry Officer NCD 

8 K.J Tempel Chief Forestry Officer SFED 

9 Arun Rai Principle Forestry Officer FRMD 

10 Dorji Wangdi Dy. Chief Forestry Officer FRMD 

11 Yonten Phuntsho Dy. Chief Forestry Officer FRMD 

12 Dawa Zangpo Dy. Chief Forestry Officer FRMD 

13 Tashi Norbu Waiba Dy. Chief Forestry Officer FRMD 

14 Kinley Dem Dy. Chief Forestry Officer FRMD 

15 Tashi Wangchuk Dy. Chief Forestry Officer SFED 

16 Kezang Dema Dy. Chief Forestry Officer NCD 

 
 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        636 

4. Writeshop in Phuentsholing (3-7th February 2020) 

Sl . No Name Designation  Office 

1 Pasang Wangchen Norbu Specialist/Advisor DoFPS 

2 Arun Rai Principle Forestry Officer FRMD 

3 Dorji Wangdi Dy. Chief Forestry Officer FRMD 

4 Yonten Phuntsho Dy. Chief Forestry Officer FRMD 

5 Dawa Zangpo Dy. Chief Forestry Officer FRMD 

6 Tashi Norbu Waiba Dy. Chief Forestry Officer FRMD 

7 Kinley Dem Dy. Chief Forestry Officer FRMD 

8 Tashi Wangchuk Dy. Chief Forestry Officer SFED 

9 Sither Wangdi Sr. Forestry Officer SFED 

10 Jigme Tenzin (PhD) Dy. Chief Forestry Officer WMD 

11 Jamyang Phuntsho Principle Meteorological  Officer WMD 

12 Ram Bdr Mongar Sr. Forestry Officer FPED 

13 Tashi Yangchen Forestry Officer FPED 

14 Tshering Pem Sr. Forestry Officer NCD 

15 Namgay Bidha Sr. Forestry Officer NCD 

16 Thinley Choden Dy. Chief Forestry Officer UWICER 

17 Karma Thukten Sr. Research Officer UWICER 

 

5. Consultation with Chief Forestry Officer (8-10th February 2020) 

Sl . No Name Designation  Office 

1 Lobzang Dorji Director DoFPS 

2 Pasang Wangchen Norbu Specialist/Advisor DoFPS 

3 Shacha Dorji Director UWICER 

4 Kinley Tshering Chief Forestry Officer FPED 

5 Norbu Wangdi  (PhD) Chief Forestry Officer FRMD 

6 Sonam Wangdi Chief Forestry Officer NCD 

7 Tempa Tshering (PhD) Chief Forestry Officer BTC 

8 Sonam Tobgay Chief Forestry Officer JKSNR 

9 Pema Wangda Chief Forestry Officer Gedu Division 

10 Lhendup Tharchen Chief Forestry Officer Paro Division 

11 Thinley Wangdi Chief Forestry Officer Samtse Division 

12 Arun Rai Principle Forestry Officer FRMD 

13 Dorji Wangdi Dy. Chief Forestry Officer FRMD 

14 Yonten Phuntsho Dy. Chief Forestry Officer FRMD 

15 Dawa Zangpo Dy. Chief Forestry Officer FRMD 

16 Tashi Norbu Waiba Dy. Chief Forestry Officer FRMD 

17 Kinley Dem Dy. Chief Forestry Officer FRMD 

18 Tashi Wangchuk Dy. Chief Forestry Officer SFED 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        637 

19 Sither Wangdi Sr. Forestry Officer SFED 

20 Jigme Tenzin (PhD) Dy. Chief Forestry Officer WMD 

21 Jamyang Phuntsho Principle Meteorological Officer WMD 

22 Ram Bdr Mongar Sr. Forestry Officer FPED 

23 Tashi Yangchen Forestry Officer FPED 

24 Tshering Pem Sr. Forestry Officer NCD 

25 Namgay Bidha Sr. Forestry Officer NCD 

26 Thinley Choden Dy. Chief Forestry Officer UWICER 

27 Karma Thukten Sr. Research Officer UWICER 

 

6. Writeshop in Punakha (25-30th July, 2020)  

Sl . No Name Designation  Office 

1 Pasang Wangchen Norbu Specialist/Advisor DoFPS 

2 Norbu Wangdi (PhD) Chief Forestry Officer FRMD 

3 Arun Rai Principle Forestry Officer FRMD 

4 Dorji Wangdi Dy. Chief Forestry Officer FRMD 

5 Kinley Dem Dy. Chief Forestry Officer FRMD 

6 Saran Pradhan Dy. Chief Forestry Officer FRMD 

7 Sither Wangdi Sr. Forestry Officer SFED 

8 Jigme Tenzin (PhD) Dy. Chief Forestry Officer WMD 

9 Kuenzang Om Sr. Agriculture Officer WMD 

10 Tshering Pem Sr. Forestry Officer NCD 

11 Namgay Bidha Sr. Forestry Officer NCD 

12 Thinley Choden Dy. Chief Forestry Officer UWICER 

 

7. Finalization workshop in Thimphu (12-24th October 2020) 

Sl. No Name Designation  Office 

1 Passang Wangchen Norbu Specialist/ Advisor DoFPS 

2 Norbu Wangdi (PhD) Chef Forestry Officer FRMD 

3 Kinley Dem Dy. Chief Forestry Officer FRMD 

4 Tashi Norbu Waiba Dy. Chief Forestry Officer FRMD 

5 Sither Wangdi Sr. Forestry Officer SFED 

6 T.B Rai Sr. Forest Ranger I SFED 

7 Tashi Wangchuk Dy. Chief Forestry Officer SFED 

8 Sonam Choden Dy. Chief Forestry Officer SFED 

9 Jigme Tenzin (PhD) Dy. Chief Forestry Officer WMD 

10 Tshering Pem Forestry Officer NCD 

11 R.B Mongar Forestry Officer FPED 

12 Sherab Specialist UWICER 

13 Sangay Dy. Chief Forestry Officer UWICER 



Forest and Nature Conservation Code of Best Management Practices of Bhutan 

Volume III: Sustainable Forest Management   |        638 

14 Tshewang Dorji Sr. Forest Ranger I SFED 

15 Ugyen Tshering Sr. Forestry Officer SFED 

16 Arun Rai Principle Forestry Officer FRMD 

17 Dorji Wangdi Dy. Chief Forestry Officer FRMD 

18 Dawa Zangpo Dy. Chief Forestry Officer FRMD 

19 Jamyang Choden Forestry Officer FRMD 

 


